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Copyrights
The Motorola products described in this document may include copyrighted Motorola computer
programs. Laws in the United States and other countries preserve for Motorola certain exclusive rights
for copyrighted computer programs. Accordingly, any copyrighted Motorola computer programs
contained in the Motorola products described in this document may not be copied or reproduced in any
manner without the express written permission of Motorola.
© 2015 Motorola Solutions, Inc. All Rights Reserved

No part of this document may be reproduced, transmitted, stored in a retrieval system, or translated
into any language or computer language, in any form or by any means, without the prior written
permission of Motorola Solutions, Inc.

Furthermore, the purchase of Motorola products shall not be deemed to grant either directly or by
implication, estoppel or otherwise, any license under the copyrights, patents or patent applications of
Motorola, except for the normal non-exclusive, royalty-free license to use that arises by operation of
law in the sale of a product.

Disclaimer
Please note that certain features, facilities, and capabilities described in this document may not be
applicable to or licensed for use on a particular system, or may be dependent upon the characteristics
of a particular mobile subscriber unit or configuration of certain parameters. Please refer to your
Motorola contact for further information.

Trademarks
MOTOROLA, MOTO, MOTOROLA SOLUTIONS, and the Stylized M Logo are trademarks or
registered trademarks of Motorola Trademark Holdings, LLC and are used under license. All other
trademarks are the property of their respective owners.

European Union (EU) Waste of Electrical and Electronic Equipment (WEEE)
directive

The European Union's WEEE directive requires that products sold into EU countries must have the
crossed out trash bin label on the product (or the package in some cases).

As defined by the WEEE directive, this cross-out trash bin label means that customers and end-users
in EU countries should not dispose of electronic and electrical equipment or accessories in household
waste.

Customers or end-users in EU countries should contact their local equipment supplier representative or
service centre for information about the waste collection system in their country.
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Contact Us
Motorola Solution Support Center
The Solution Support Center (SSC) is the primary Motorola Solutions support contact. Call:

• Before any software reload.

• To confirm troubleshooting results and analysis before removing and replacing a Field Replaceable
Unit (FRU) and Field Replaceable Entity (FRE) to repair the system.

For... Phone

United States Calls 800-221-7144

International Calls 302-444-9800

North America Parts Organization
For assistance in ordering replacement parts or identifying a part number, contact the Motorola Parts
organization. Your first response when troubleshooting your system is to call the Motorola SSC.

For... Phone

Phone Orders 800-422-4210 (US and Canada Orders)

For help identifying an item or part number, select choice 3
from the menu.

302-444-9842 (International Orders)

Includes help for identifying an item or part number and for
translation as needed.

Fax Orders 800-622-6210 (US and Canada Orders)

Comments
Send questions and comments regarding user documentation to 
documentation@motorolasolutions.com.

Provide the following information when reporting a documentation error:

• The document title and part number

• The page number with the error

• A description of the error

We welcome your feedback on this and other Motorola manuals. To take a short, confidential survey
on Motorola Customer Documentation, go to docsurvey.motorolasolutions.com or scan the following
QR code with your mobile device to access the survey.
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About GTR 8000 Expandable Site
Subsystem
This manual provides descriptive and procedural information on the GTR 8000 Expandable Site
Subsystem. Included in the manual are descriptions of the components of the GTR 8000 Expandable
Site Subsystem and their function, specifications for the various configurations, and procedures on
installation, configuration, optimization, operation, troubleshooting, and FRU/FRE replacement. Finally
a reference section provides information on LED indicators and RFDS equipment specifications.

This manual is intended for technicians and system operators as a resource for understanding and
installing the GTR 8000 Expandable Site Subsystem. The manual should be used with the ASTRO® 25
system documentation and the Motorola Standards and Guidelines for Communication Sites manual.

What Is Covered In This Manual?
This manual contains the following chapters:

• GTR 8000 Expandable Site Subsystem Description on page 41 provides a high-level description
of the GTR 8000 Expandable Site Subsystem and the function it serves on your system.

• GTR 8000 Expandable Site Subsystem Theory of Operations on page 97 explains how the GTR
8000 Expandable Site Subsystem works in the context of your system.

• GTR 8000 Expandable Site Subsystem Installation on page 131 details installation procedures
relating to the GTR 8000 Expandable Site Subsystem.

• GTR 8000 Expandable Site Subsystem Configuration on page 255 details configuration
procedures relating to the GTR 8000 Expandable Site Subsystem.

• GTR 8000 Expandable Site Subsystem Optimization on page 291 contains optimization
procedures and recommended settings relating to the GTR 8000 Expandable Site Subsystem.

• GTR 8000 Expandable Site Subsystem Maintenance on page 329 describes periodic maintenance
procedures relating to the GTR 8000 Expandable Site Subsystem.

• GTR 8000 Expandable Site Subsystem Operation on page 331 details how the GTR 8000
Expandable Site Subsystem operates once it is installed and operational on your system.

• GTR 8000 Expandable Site Subsystem Troubleshooting on page 335 provides fault management
and troubleshooting information relating to the GTR 8000 Expandable Site Subsystem.

• GTR 8000 Expandable Site Subsystem FRU Procedures on page 347 lists the Field Replaceable
Units (FRUs) and Field Replaceable Entities (FREs) and includes replacement procedures
applicable to the GTR 8000 Expandable Site Subsystem.

• GTR 8000 Expandable Site Subsystem Reference on page 429 contains supplemental reference
information relating to the GTR 8000 Expandable Site Subsystem.

• GTR 8000 Expandable Site Subsystem Disaster Recovery on page 457 provides references and
information that enable you to recover a GTR 8000 Base Radio, GCP 8000 Site Controller, or GPB
8000 Reference Distribution Module in the event of a failure.

Helpful Background Information
Motorola offers various courses designed to assist in learning about the system. For information, go to 
http://www.motorolasolutions.com/training to view the current course offerings and technology paths.
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Related Information
In addition to the information in the following table, see the Related Information Guide.

Related Information Purpose

Standards and Guidelines for Communica-
tion Sites

Provides standards and guidelines that should be followed when
setting up a Motorola communications site.
This may be purchased on CD 9880384V83, by calling the North
American Parts Organization at 800–422–4210 or the international
number at 302–444–9842.

System Documentation Overview For an overview of the ASTRO® 25 system documentation, open
the graphical user interface for the ASTRO® 25 system documenta-
tion set and select the System Documentation Overview link.
This opens a file that includes:

• ASTRO® 25 system release documentation descriptions

• ASTRO® 25 system diagrams

• ASTRO® 25 system glossary

For an additional overview of the system, review the architecture
and descriptive information in the manuals that apply to your sys-
tem configuration.

Dynamic System Resilience Provides all the information required to understand, operate, main-
tain, and troubleshoot the Dynamic System Resilience feature.

GTR 8000 Base Radio Provides all the information required to understand and operate the
standalone GTR 8000 Base Radio.

System Gateways – GGM 8000 Provides all the information required to understand and operate the
GGM 8000 Gateway.

Quick Guide for Implementing MLC 8000s Provides the information required to understand and operate the
analog conventional MLC 8000 Comparator in a conventional ana-
log IP-based simulcast overlay at an ASTRO® 25 trunked site.

Trunked IP Simulcast Subsystem Remote
Site
HPD Standalone System -- Infrastructure

ASTRO 25 Repeater Site -- Infrastructure

ASTRO 25 Express Standalone – Infra-
structure

Provides the information required to understand and operate the
GTR 8000 Expandable Site Subsystem in an ASTRO® 25 site.

Conventional Operations Provides the information required to understand and operate the
GTR 8000 Expandable Site Subsystem in a conventional architec-
ture.

Quick Guide for Replacing a Trunked 3600
QUANTAR with a GTR 8000 Base Radio

Provides the information required to understand and operate the
trunked GTR 8000 Base Radio in a 3600 bps system.
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Chapter 1

GTR 8000 Expandable Site Subsystem
Description
This chapter provides a high-level description of the GTR 8000 Expandable Site Subsystem and its
components within the prime and expansion cabinets or racks and the function they serve in your
system. For information on the site the GTR 8000 Expandable Site Subsystem resides in, see the
following manuals.

• Trunked IP Simulcast Subsystem Remote Site

• HPD Standalone System - Infrastructure

• ASTRO 25 Repeater Site - Infrastructure

• ASTRO 25 Express Standalone – Infrastructure

• Conventional Operations

GTR 8000 Expandable Site Subsystem Overview
Throughout this manual, the term “base radio” is used to denote the transceiver module, power
amplifier module, fan module, and power supply module to be one physical base radio. As viewed in
these applications, one “base radio” is one of several in a GTR 8000 Expandable Site Subsystem
configuration.

NOTICE: RFDS information provided in this documentation pertains to the RFDS equipment
included in the GTR 8000 Expandable Site Subsystem.

The GTR 8000 Expandable Site Subsystem is an integrated open rack or cabinet that consists of GTR
8000 Base Radios (transceiver module, power amplifier module, fan module, and power supply module
for each transmission channel). The GTR 8000 Expandable Site Subsystem may also contain GCP
8000 Site Controller modules or GPB 8000 Reference Distribution Modules (RDMs), XHub modules,
GGM 8000 Gateways, and optional RFDS equipment. This configuration provides a major advantage
in terms of reduced site cabling and costs. All the required connections between the base radios and
the site controllers, XHubs, or RDMs are contained in the backplane; whereas individual units mounted
in a 19-inch rack or cabinet require external cabling. Also, the site controller, XHub, RDM, or gateways
in a GTR 8000 Expandable Site Subsystem do not have a power supply of their own, but draw power
from the base radio power supply modules.

Each GTR 8000 Expandable Site Subsystem cabinet contains a maximum of either five or six base
radios, depending upon the system configuration. Additional GTR 8000 Expandable Site Subsystem
racks or cabinets can be added to increase the number of channels at a site. The base radios
transceiver module includes the functionality for the exciter, receiver, and station control with an
optional transceiver option card. The base radio software, configuration, and network management, as
well as inbound/outbound traffic handling, are performed through the control section of the base radios
transceiver module. On-board serial and Ethernet ports are on the transceivers module for local
servicing through Configuration/Service Software (CSS) and the Unified Network Configurator (UNC).
The power amplifier module amplifies the low-level modulated RF signal from the transceiver module
and delivers the amplified signal on the path to the transmit antenna. The power supply module
supports the transceiver and power amplifier modules. Radio Frequency Distribution System (RFDS)
provides the interface between the transceivers and the site antennas and between the power amplifier
and the site antennas. Each transceiver has an Ethernet connection to the site controller, XHub, or
RDM modules.
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Various messaging and signaling across the backplane includes inbound/outbound traffic flow,
frequency reference and synchronization signaling, network management traffic, and status failover
related messaging. A bank of power supplies along the bottom of the cabinet/ rack supply power to the
modules. The cabinet/rack is supplied with up to five or six AC power connections. DC power or
backup batteries can also be connected. The cabinet/rack can run on a combination of AC power and
backup battery power, while continuing to charge the backup batteries. Installation and replacement for
all the modules in the cabinet/rack is accessible through the front of the cabinet/rack.

For detailed information on the functionality, configuration, and operation of the site controller in the
GTR 8000 Expandable Site Subsystem in a repeater or HPD configuration, see the GCP 8000 Site
Controller manual.

GTR 8000 Base Radio Components

Table 1: Base Radio Modules and Function

Base Radio Description

Power Supply Operates from either an AC or DC input and provides the DC
operating voltage for the base radio. Also provides a separate
battery charger to maintain the charge on a 48 VDC nominal
system, positive or negative ground.

Power Amplifier (PA) Accepts a low-level modulated RF signal from the transceiver
module and amplifies it for transmission through the site
transmit antenna. Also provides a low-level RF feedback sig-
nal to the transceiver module to achieve the required transmit-
ter linearity. Also performs functions related to the fan mod-
ule.

Transceiver (XCVR) Provides the control, exciter, and receiver functions for the
base radio.

Transceiver Option Card An optional board that attaches to the control board of the
transceiver. Provides an internal 10 MHz frequency refer-
ence. For conventional base radio operation, it also provides
the analog interfaces and WildCard I/Os. The transceiver op-
tion card is available in two categories:

• OCXO (Oven Controlled Crystal Oscillator)

• TCXO (Temperature Compensated Crystal Oscillator)

NOTICE: The OCXO board when initially powered
on takes a few minutes to reach its operational
temperature. During the warm-up period, if the
base radio is configured to use the OCXO frequen-
cy reference, the base radio may report a frequen-
cy reference failure. This alarm condition automati-
cally clears once the OCXO board has warmed up
sufficiently to provide a stable reference.

Fan Provides intermittent forced air cooling for the power amplifier
and transceiver modules.

Supported System Configurations
The GTR 8000 Expandable Site Subsystem is available in the following system configurations:
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• High Performance Data (HPD) Site

• ASTRO® 25 Repeater Site

• ASTRO® 25 Express System Configuration

• Trunked IP Simulcast Subsystems

• Trunked Single-Site Repeater Configuration

• Centralized Conventional Architecture

• Trunked 3600 SmartZone® Systems

Supported Frequencies for Trunked IV and D
The GTR 8000 Expandable Site Subsystem is available in the following frequency bands:

• 700, 800 MHz

• 900 MHz

• UHF R1 (380-435 MHz)

• UHF R2 (435–524 MHz)

• VHF (136–174 MHz)

Supported Frequencies for Conventional Operation
The GTR 8000 Expandable Site Subsystem is available in the following frequency bands:

• 700, 800 MHz (700 MHz analog conventional is not available within the U.S.A. or Canada)

• UHF R1 (380-435 MHz)

• UHF R2 (435–524 MHz)

• VHF (136–174 MHz)

Supported Frequencies for HPD
The GTR 8000 Expandable Site Subsystem is available for 25 kHz operation in the following frequency
bands:

• 700 MHz

• 800 MHz

Overview of a GTR 8000 Expandable Site Subsystem in an
ASTRO Repeater Site
The GTR 8000 Expandable Site Subsystem in an ASTRO® 25 repeater site is set up in a single
trunked site, with one active control channel and a number of voice channels at the site, with a total of
28 channels at the site. If packet data services are supported at the site, a number of voice channels
can be configured with packet data channel capability. Voice traffic is routed from each of the base
radios to the system for distribution to other sites and is repeated by the base radios to support other
local subscribers. However, data traffic is routed to the GCP 8000 Site Controller. The site controller
routes these packets upstream to the zone core for further processing and routing.
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Overview of a GTR 8000 Expandable Site Subsystem in an
ASTRO 25 Express System
The GTR 8000 Expandable Site Subsystem in an ASTRO® 25 Express System is a trunked single-site
repeater site configuration that supports up to three cabinets or racks and 18 channels with one active
control channel and up to 17 voice channels. The GCP 8000 Site Controller manages the resources for
the ASTRO® 25 Express System. There is no connection to a zone core.

Overview of a GTR 8000 Expandable Site Subsystem in a
Trunked Single-Site Repeater Configuration
This configuration consists of GTR 8000 Base Radios and GCP 8000 Site Controllers in a single-site
repeater configuration. The base radios may be colocated with the site controllers within the GTR 8000
Expandable Site Subsystem cabinet, or be separated (standalone, non-colocated) from the site
controllers.

NOTICE: This configuration can only be used in non-voting configurations.

Support is provided only for FDMA when the base radios are physically separated from and not
colocated with the site controllers. TDMA requires the use of a frequency reference and timing
reference that can only be provided through the site controller CP3 links, which cannot be extended to
non-colocated base radios when the distance exceeds the noted limits.

An Ethernet cable is used to extend the site controller signal to the first non-colocated base radio from
the Network Aux A port on the junction panel to the SC-A port on the base radio. The site controller Net
AUX port must be enabled and configured using the CSS for 100/FULL (speed and duplex). When the
distance between the site controller and the first non-colocated base radio exceeds 328 ft (100 m), an
external HP 2620 24-port Ethernet LAN switch must be used to extend the site controller signal. When
there are additional non-colocated base radios and those base radios are more than 328 ft from the
previous non-colocated base radio, additional Ethernet LAN switches are required to continue to
extend the site controller signal. See Figure 1: Single-Site Repeater Configuration 1 on page 44.

Figure 1: Single-Site Repeater Configuration 1

If the distance between the first non-colocated base radio and subsequent non-colocated base radios
is less than 328 ft (100 m), a single Ethernet LAN switch can be used to distribute the site controller
call control signaling to those non-colocated base radios. The stated distance limit for a shielded
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twisted pair Ethernet cable (CAT5) is 328 ft (100 m) before the signal degrades too much to be used.
See Figure 2: Single Site Repeater Configuration 2 on page 45.

Figure 2: Single Site Repeater Configuration 2

Once the site controller link is extended, the control plane could be open to access from elements
other than the base radios. Each Ethernet LAN switch must be manually configured to provide MAC
Port lockdown to make sure that only the proper devices can communicate with each other. MAC Port
lockdown may also be applied on any unused Expansion Ports on the site controller. See the MAC
Port Lockdown manual to lock down the site controller. The switch ports may be enabled or disabled
according to specific security guidelines. See “Enabling/Disabling Ports on HP Switches Using Local
Access” in the System LAN Switches manual.

Each non-colocated base radio is equipped with a transceiver option card, which provides an internal
10 MHz frequency reference. See the “Reference Oscillator Alignment Procedures” of the base radio
Alignment Screens in the Configuration/Service Software (CSS) Online Help for alignment details. The
base radios that are colocated with the site controllers do not require the transceiver option card.

See the “Installation” chapter in the GTR 8000 Base Radio manual for rack mounting and cabling
connections for the non-colocated standalone base radios.

When the Ethernet LAN switch is used in a configuration that does not include centralized network
management, the switch must be programmed manually. See the System LAN Switches manual.

Configuring The Ethernet LAN Switch

When and where to use: Use this procedure to configure either an HP 2620 LAN switch for a Trunked
Single-Site Repeater Configuration.

Procedure:
1 Enter the following commands at the prompt: ProCurve Switch 2620-24#
2 ProCurve Switch 2620-24#erase startup-config

(This command removes any existing switch configuration)

3 ProCurve Switch 2620-24#config
(This command puts the switch into configuration mode)
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4 ProCurve Switch 2620-24(config)#int X
(Using Port X as an example)

5 ProCurve Switch 2620-24(eth-X)#speed-duplex 100-Full
(This command sets the interface X to 100MB/Full Duplex)

6 ProCurve Switch 2620-24(eth-X)#write memory
(This command saves the configuration changes to persistent memory)

Overview of a GTR 8000 Expandable Site Subsystem in a
Trunked IP Simulcast Subsystem
The base radio captures inbound signals through external receive (Rx) antennas from the subscriber/
mobile radios and then amplifies, filters, and demodulates the signals into voice packets which are
forwarded to a comparator. The comparator processes the received voice packets for a particular call
and forwards the best quality voice packets to the zone core, which routes them to the associated base
radio at each remote site. At a predetermined time, all base radios transmit the voice packets
simultaneously on the same frequency to complete the communication.

A maximum of 30 base radios can be installed per remote site. Each base radio has an Ethernet
connection to a switch at the site for the Network Management interface.

There are two types of simulcast remote site configurations for the GTR 8000 Expandable Site
Subsystem:

• Standard configuration
• High availability configuration
See GTR 8000 Expandable Site Subsystem for Trunked IP Simulcast on page 50 for details.

Overview of a GTR 8000 Expandable Site Subsystem in a High
Performance Data (HPD) Site
The GTR 8000 Expandable Site Subsystem in an HPD site is set up in a single HPD site. The GTR
8000 Expandable Site Subsystem amplifies, filters, and demodulates the signals into data packets
which are forwarded to the GCP 8000 Site Controller. The site controller routes these packets
upstream to a base site zone controller for further processing and routing.

Overview of a GTR 8000 Base Radio in Conventional
Architectures
Throughout this manual, the term “conventional” addresses either an analog only base radio or an
ASTRO® 25 Conventional base radio that operates in either digital mode or mixed (analog/digital)
mode. The conventional base radios within a GTR 8000 Expandable Site Subsystem operate within a
Centralized Conventional Architecture. Each conventional base radio uses either:

• a 2- or 4-wire TRC or 4-wire E&M interface in an analog infrastructure

• a V.24 interface for digital voice and data traffic to either a Channel Bank, Digital Interface Unit,
CCGW, MLC 8000, or ASTRO-TAC 3000 Comparator and an optional 4-wire link for analog voice in
a mixed mode configuration

• an IP interface for digital voice and data traffic to a CCGW or GCM 8000 Comparator.

Up to a maximum of four conventional base radios can be installed in a trunked GTR 8000 Expandable
Site Subsystem cabinet/rack. The conventional base radios do not operate in trunked mode. All base
radios must be in the same frequency band.
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Up to a maximum of six conventional base radios can be installed in a conventional only GTR 8000
Expandable Site Subsystem cabinet/rack. The cabinet/rack can be either within a trunked site or within
a conventional site. All base radios must be in the same frequency band.

NOTICE: For an overview of connecting to an ASTRO® 3.1 Conventional System, see the
Conventional Operations manual. The base radio can be IP managed while using the 4-wire/V.
24 interface for channel traffic.

ASTRO 25 Conventional Base Radio
ASTRO® 25 Conventional base radio features include:

• Separate Tx and Rx network access code

• Console or repeat priority

• Repeater set-up knockdown from the console

• Voice and data

• Control Messages (TSBK)

• Standalone repeater

• Control station

• Receive-only station

• Voting

• Multicast

• Simulcast

• Console Control

- Monitor Mode

- Repeat Control

- Frequency Select

- Scan Control (supported for the Gold Elite console)

- Receive Qualifier Control (supported for the Gold Elite console)

• WildCard Operation

• Multi-Channel – up to 16 channels with base station or repeater functionality

• Multiple Network Access Code (Multi-NAC) Operation

• Scan Operation

• Analog Phone Patch

A GTR 8000 Expandable Site Subsystem with ASTRO® 25 Conventional base radios can be used in
the following architectures:

• ASTRO® 25 Trunked Repeater Site with Conventional Channels

• Trunked IP Simulcast Remote Site with Conventional Channels

• HPD Site with Conventional Channels

• Zone Core with Colocated Conventional Channels

• Dispatch Console Site with Colocated Conventional Channels

• Conventional-Only Remote Site
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Analog Conventional Base Radio
Analog conventional base radio features include:

• 12.5 kHz analog channel operation with HearClear settings (800 MHz)

• Repeater Access Control

• Multi-Channel – up to 16 channel with base station or repeater functionality

• Alarm tones over-the-air and over-the-wireline

• Transmit Antenna Relay Control and Simplex Operation

• WildCard Operation

• E&M Interface; Ext PTT keying and COR receiver I/O

• Analog simulcast support using Gen Tx and PL Analog inputs and Ext PTT and Ext PTT keying

• Multi-PL receive operation

• RA/RT configuration with analog 4-wire connections

• Analog Wireline Automatic Level Control (ALC)

• Wideband Receiver Operation

• Telephone Interconnect

• PL/DPL

• Tone Remote Control (TRC)

• Fall Back In-Cabinet Repeat (Automatic Mode)*

• In-Cabinet Repeater (External Mode)*

• Control Station

• Interfaces for local microphone and speaker

• Simplex operation

• Scan Operation

• Voting

• Multicast

• Simulcast

* For detailed information on the differences between the automatic Fallback In-Cabinet Repeat and
the externally wired In-Cabinet Repeat functions, see the Conventional Operations manual.

An analog conventional base radio can be used in the following architectures:

• Zone Core with Colocated Conventional Channels

• ASTRO® 25 Trunked Repeater Site with Conventional Channels

• Trunked IP Simulcast Remote Site with Conventional Channels

• Dispatch Console Site with Colocated Conventional Channels

• Conventional-Only Remote Site

Overview of a GTR 8000 Expandable Site Subsystem in a
Trunked 3600 System
In a trunked 3600 system, the GTR 8000 Expandable Site Subsystem control channel runs at 3600
bps, and the voice channels can be configured for analog or ASTRO® 25 voice operation.
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The GTR 8000 Expandable Site Subsystem can be used in the following trunked 3600 SmartZone®

systems:

• Trunked SmartX – 6809/MTC 3600 Site Controller Simulcast Subsystem

• Trunked SmartX – IntelliRepeater System

Depending on the system capabilities, each base radio can be configured for analog voice (4-wire
interface), digital voice (V.24 interface) or mixed-mode (4-wire and V.24 interfaces). These interfaces
connect to either a channel bank or ASTRO-TAC 3000 Comparator.

The GTR 8000 Expandable Site Subsystem is available in the following frequency bands:

• 800 MHz

• 900 MHz (analog only)

• UHF R1 (380–435 MHz)

• UHF R2 (435–524 MHz)

• VHF (136–174 MHz)

NOTICE: A GTR 8000 Expandable Site Subsystem can be implemented as a QUANTAR®

station replacement within a trunked 3600 SmartZone® system. The implementation details can
be found in the Quick Guide for Replacing a Trunked 3600 QUANTAR with a GTR 8000 Base
Radio manual.

Power Efficiency Package
The GTR 8000 Base Radio is available in a Power Efficiency Package, which provides low standby
power consumption (see Table 2: Standby Power Consumption on page 50) functionality for
ASTRO® 25 Conventional base radios and trunked base radios operating in the UHF-R1 and UHF-R2
frequency bands. The Power Efficiency Package optimizes the power consumption for supported base
radios and allows for the use of power generated from alternate energy sources such as solar or wind.

The Power Efficiency Package hardware includes a modified transceiver, power amplifier, power
supply, fan, an optional transceiver option card (internal reference) along with additional software
configurations through CSS.

The following conditions must be met to obtain a power consumption of less than or equal to 35 W:

• DC source only

• Speaker turned OFF (if equipped with a transceiver option card)

• No activation of Aux Out Relays (if equipped with a transceiver option card)

• No 29 V AUX loads. For example: site controllers, XHubs, GPB 8000 Reference Distribution
Modules, and RMC)

• CSS configured for applications not requiring receiver diversity

• CSS Fan Holdover configured to “short” (length of time the base radio fan stays ON after
transmission)

• Ambient temperature of 104 °F (40 °C) or less

• Transceiver, power amplifier, power supply, fan, and optional TCXO transceiver option card
(internal reference) are all power efficiency package versions

6871022P87-C
Chapter 1:  GTR 8000 Expandable Site Subsystem Description

Send Feedback   49

http://docsurvey.motorolasolutions.com


NOTICE: The TCXO transceiver option card is available only for non-simulcast conventional
systems. The OCXO transceiver option card is available for trunked or simulcast systems, but
does not guarantee 35 W.

Table 2: Standby Power Consumption

Conventional
Non-Simulcast

Conventional
Simulcast

Trunked Non-
Simulcast

Trunked Si-
mulcast

Internal Reference Ca-
pable

35 W 40 W 35 W 40 W

Not Internal Reference
Capable

35 W 35 W 35 W 35 W

GTR 8000 Expandable Site Subsystem for Trunked IP Simulcast

Standard Configuration
The GTR 8000 Expandable Site Subsystem in a standard configuration is an integrated cabinet or
open cabinet/rack with XHubs and RFDS equipment available for most frequency bands. A standard
configuration supports IP links. Figure 3: GTR 8000 Expandable Site Subsystem for Trunked IP
Simulcast – Standard Configuration on page 51 shows an example of the RFDS equipment
configured for a one branch RMC.
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Figure 3: GTR 8000 Expandable Site Subsystem for Trunked IP Simulcast – Standard
Configuration

For trunked IP simulcast operation, the cabinet/rack includes the following components:

• XHub modules

• Up to six trunked transceiver modules

• Up to four conventional transceiver modules

• Up to six power amplifier modules

• Up to six power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths

• Junction panel, for connection to other devices at the site, such as site gateway(s), Rx and Tx
antennas, and optional MOSCAD Network Fault Management.

The XHubs, transceiver modules, and power amplifier modules are arranged in the slots of the
subsystem. Each transceiver, power amplifier, and power supply represents a channel in the
subsystem. The GTR 8000 Expandable Site Subsystem supports up to 30 channels. Therefore, a
maximum of six transceivers, power amplifiers, and power supplies may be installed in the cabinet/rack
with a maximum of six cabinets/racks.

6871022P87-C
Chapter 1:  GTR 8000 Expandable Site Subsystem Description

Send Feedback   51

http://docsurvey.motorolasolutions.com


High Availability Configuration
The GTR 8000 Expandable Site Subsystem in a trunked IP simulcast high availability configuration is
an integrated cabinet or open cabinet/rack with GPB 8000 Reference Distribution Modules (RDMs),
gateways, and RFDS equipment available for most frequency bands. The high availability configuration
is designed so that the failure of any one item at a site limits the loss to system availability to one base
radio. Each base radio receives frequency and time reference information and Ethernet access
independently from each RDM and its associated XHubs. A high availability configuration supports IP
links. Figure 4: GTR 8000 Expandable Site Subsystem for Trunked IP Simulcast — High Availability
Configuration on page 52 shows an example of the RFDS equipment configured for a one branch
RMC.

Figure 4: GTR 8000 Expandable Site Subsystem for Trunked IP Simulcast — High Availability
Configuration

For trunked IP simulcast high availability operation, the cabinet/rack includes the following
components:

• GPB 8000 Reference Distribution Modules (RDMs)

• Up to six trunked transceiver modules

• Up to four conventional transceiver modules

• Up to six power amplifier modules

• Up to six power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths
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• GGM 8000 Gateways

• Junction panel, for connection to other devices at the site, such as site gateways(s), GPS units, Rx
and Tx antennas, and optional MOSCAD Network Fault Management.

The RDMs, transceiver modules, and power amplifier modules are arranged in the slots of the
subsystem. Each transceiver, power amplifier, and power supply represents a channel in the
subsystem. The GTR 8000 Expandable Site Subsystem supports up to 30 channels. Therefore, a
maximum of six transceivers, power amplifiers, and power supplies may be installed in the cabinet/rack
with a maximum of six cabinets/racks. Any expansion cabinets/racks attached to the prime cabinet/
rack use XHubs instead of RDMs.

Both RDMs provide integrated Ethernet LAN switching and redundant integrated site reference
distribution over the backplane of the GTR 8000 Expandable Site Subsystem.

GTR 8000 Expandable Site Subsystem for ASTRO 25 Repeater
The GTR 8000 Expandable Site Subsystem is an integrated cabinet or open rack with site controllers,
channel equipment, and RFDS equipment available for most frequency bands. Figure 5: GTR 8000
Expandable Site Subsystem for Repeater Site Module Configuration on page 53 shows an example
of the RFDS equipment configured for a one branch RMC.

Figure 5: GTR 8000 Expandable Site Subsystem for Repeater Site Module Configuration

For repeater site operation, the cabinet/rack includes the following components:

• Redundant site controller modules
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• Up to six trunked transceiver modules

• Up to four conventional transceiver modules

• Up to six power amplifier modules

• Up to six power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths

• GGM 8000 Gateways (optional)

• Junction panel, for connection to other devices at the site, such as site gateway(s), Rx and Tx
antennas, and optional MOSCAD Network Fault Management.

The site controller modules, transceiver modules, and power amplifier modules are arranged in the
slots of the cabinet/rack as illustrated in the diagram. Each transceiver, power amplifier, and power
supply represents a channel in the subsystem. The GTR 8000 Expandable Site Subsystem supports
up to 28 channels. Therefore, a maximum of six transceivers, power amplifiers, and power supplies
may be installed in the cabinet/rack with a maximum of six cabinets/racks. Any expansion cabinets/
racks attached to the primary cabinet/rack use XHubs instead of site controllers.

The active site controller module communicates with the channels and sends status messages over
the backplane of the GTR 8000 Expandable Site Subsystem chassis. The standby site controller
module passively monitors status messages on the backplane to determine whether the active site
controller is still operational.

The GTR 8000 Expandable Site Subsystem can be ordered in a cabinet (Option CA00293AA) or 7.5 ft
open rack (Option X882AH) or 7 ft open rack (Option CA01402AA).

The Site RMC (LNA) module displayed in the upper half of Figure 5: GTR 8000 Expandable Site
Subsystem for Repeater Site Module Configuration on page 53 may not be present in your installation,
depending on the options purchased from Motorola.

The following options are only valid for 700/800/900 MHz and UHF R2 (435–524 MHz):

• Option CA00862AA includes the one Site RMC module, which provides expansion of up to 24
channels on a single Rx antenna.

• Option CA00861AA does not include Site RMCs. It provides basic RMC functionality that is limited
to a single cabinet or rack.

• Option CA00877AA does not include Site RMCs. It is intended for use in expansion cabinets that
are wired to the primary Rx cabinet through the junction panel, and in other configurations using
RMC equipment outside the cabinet.

• Option CA01943AA includes two Site RMC modules for Phase 2 TDMA operation, dual branch
receive diversity. See “Appendix B” in the Dynamic Dual Mode for TDMA Operation manual.

GTR 8000 Expandable Site Subsystem for ASTRO 25 Express
System
The GTR 8000 Expandable Site Subsystem is an integrated cabinet or open rack with site controllers,
channel equipment, and RFDS equipment available for most frequency bands.

The site controller modules, transceiver modules, and power amplifier modules are arranged in the
slots of the subsystem as shown in Figure 6: GTR 8000 Expandable Site Subsystem for ASTRO 25
Express System – Module Configuration on page 55.
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Figure 6: GTR 8000 Expandable Site Subsystem for ASTRO 25 Express System – Module
Configuration

For an ASTRO® 25 Express System single-site configuration, the cabinet/rack includes the following
components:

• Redundant site controller modules

• Up to six transceiver modules

• Up to six power amplifier modules

• Up to six power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths

• Junction panel

Each transceiver, power amplifier, and power supply represent a channel in the subsystem. A
maximum of six channels may be installed in each cabinet/rack. The ASTRO® 25 Express System
single-site configuration supports up to three racks, or 18 channels. Any expansion cabinets/racks
attached to the prime cabinet/rack use XHubs instead of site controllers.

A bank of power supplies along the bottom of the cabinet/rack supplies power to the modules. The
cabinet/rack is supplied with up to six AC power connections. DC power or backup batteries can also
be connected. The rack can run on a combination of AC power and backup battery power, while
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continuing to charge the backup batteries. Installation and replacement for all the modules in the rack
is accessible through the front of the cabinet/rack.

NOTICE: The GTR 8000 Expandable Site Subsystem open rack is Option X882AH.
The Site RMC (LNA) module displayed in the upper half of Figure 6: GTR 8000 Expandable
Site Subsystem for ASTRO 25 Express System – Module Configuration on page 55 may not be
present in your installation, depending on the options purchased from Motorola. See RFDS
Modules on page 116 for more information on these options.

GTR 8000 Expandable Site Subsystem for HPD
The GTR 8000 Expandable Site Subsystem is an integrated cabinet or open rack with site controller,
base radio equipment, and RFDS equipment. Figure 7: GTR 8000 Expandable Site Subsystem for
HPD Module Configuration on page 56 shows an example of the RFDS equipment configured for a
two branch RMC.

Figure 7: GTR 8000 Expandable Site Subsystem for HPD Module Configuration

For HPD operation, the rack includes the following components:

• Redundant site controller modules

• Up to five trunked transceiver modules

• Up to four conventional transceiver modules

• Up to five power amplifier modules
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• Up to five power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths

• GGM 8000 Gateways (optional)

• Junction panel, for connection to other devices at the site, such as site gateway(s), GPS units, Rx
and Tx antennas, and optional MOSCAD Network Fault Management.

The site controller modules, transceiver modules, and power amplifier modules are arranged in the
slots of the subsystem. Each transceiver, power amplifier, and power supply represents a base radio in
the subsystem. The GTR 8000 Expandable Site Subsystem supports up to five base radios. Therefore,
a maximum of five transceivers, power amplifiers, and power supplies may be installed in the
subsystem rack.

The active site controller module communicates with the channels and sends status messages over
the backplane of the GTR 8000 Expandable Site Subsystem. The standby site controller module
passively monitors status messages over the backplane to determine whether the active site controller
is still operational.

GTR 8000 Expandable Site Subsystem for Conventional
The GTR 8000 Expandable Site Subsystem in a conventional only configuration is an integrated
cabinet or open cabinet/rack with XHubs, gateways, and RFDS equipment available for most
frequency bands. A conventional only configuration supports IP, V.24, 2-wire, or 4-wire links. Figure 8:
GTR 8000 Expandable Site Subsystem – Conventional Only Configuration on page 58 shows an
example of the RFDS equipment configured for a one branch RMC.
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Figure 8: GTR 8000 Expandable Site Subsystem – Conventional Only Configuration

For conventional only operation, the cabinet/rack includes the following components:

• XHub modules

• Up to six conventional mixed mode and/or analog transceiver modules

• Up to six power amplifier modules

• Up to six power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths

• GGM 8000 Gateway

• Junction panel, for connection to other devices at the site, such as site gateways(s), GPS units, Rx
and Tx antennas, and optional MOSCAD Network Fault Management.

The XHubs, transceiver modules, and power amplifier modules are arranged in the slots of the cabinet/
rack. Each transceiver, power amplifier, and power supply represents a base radio in the cabinet/rack.
The GTR 8000 Expandable Site Subsystem cabinets/racks support up to 40 channels. Therefore, a
maximum of six transceivers, power amplifiers, and power supplies may be installed in the cabinet/rack
with a maximum of seven cabinets/racks.
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GTR 8000 Expandable Site Subsystem for Trunked 3600
IntelliRepeater Site
The GTR 8000 Expandable Site Subsystem in a trunked 3600 IntelliRepeater site configuration is an
integrated cabinet or open rack with GPB 8000 Reference Distribution Modules (RDMs), channel
equipment, and RFDS equipment available for most frequency bands. Figure 9: GTR 8000 Expandable
Site Subsystem — Trunked 3600 IntelliRepeater Site on page 59 shows an example of the RFDS
equipment configured for a one branch RMC. Each base radio receives frequency and time reference
information and Ethernet access independently from each RDM and its associated XHubs in the
expansion cabinets/racks.

Figure 9: GTR 8000 Expandable Site Subsystem — Trunked 3600 IntelliRepeater Site

For a trunked 3600 IntelliRepeater site, the cabinet/rack includes the following components:

• Redundant GPB 8000 Reference Distribution Modules (RDMs)

• Up to six trunked transceiver modules

• Up to six power amplifier modules

• Up to six power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths

• GGM 8000 Gateways

• Junction panel, for connection to other devices at the site, such as site gateway(s) and Rx/Tx
antennas.
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The RDMs, transceiver modules, and power amplifier modules are arranged in the slots of the
subsystem. Each transceiver, power amplifier, and power supply represents a base radio in the
cabinet/rack. The GTR 8000 Expandable Site Subsystem cabinets/racks support up to 28 channels.
Therefore, a maximum of six transceivers, power amplifiers, and power supplies may be installed in the
cabinet/rack with a maximum of six cabinets/racks. Any expansion cabinets/racks attached to the
prime cabinet/rack use XHubs instead of the RDMs.

Both RDMs in the prime cabinet provide integrated Ethernet LAN switching and redundant integrated
site reference distribution over the backplane of the GTR 8000 Expandable Site Subsystem.

GTR 8000 Expandable Site Subsystem for Trunked 3600
Simulcast Subsystem
The GTR 8000 Expandable Site Subsystem in a 3600 simulcast subsystem configuration is an
integrated cabinet or open rack with XHubs and RFDS equipment available for most frequency bands. 
Figure 10: GTR 8000 Expandable Site Subsystem – Trunked 3600 Simulcast Subsystem on page 60
shows an example of the RFDS equipment configured for a one branch RMC.

Figure 10: GTR 8000 Expandable Site Subsystem – Trunked 3600 Simulcast Subsystem

For a trunked 3600 simulcast subsystem, the cabinet/rack includes the following components:

• XHub modules

• Up to six trunked transceiver modules

• Up to six power amplifier modules
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• Up to six power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths

• Junction panel, for connection to other devices at the site, such as site gateway(s) and Rx/Tx
antennas.

The XHubs, transceiver modules, and power amplifier modules are arranged in the slots of the
subsystem. Each transceiver, power amplifier, and power supply represents a channel in the
subsystem. The GTR 8000 Expandable Site Subsystem supports up to 28 channels. Therefore, a
maximum of six transceivers, power amplifiers, and power supplies may be installed in the cabinet/rack
with a maximum of six cabinets/racks.

Ordering Options
The GTR 8000 Expandable Site Subsystem can be ordered in a cabinet (Option CA00293AA) or 7.5 ft
open rack (Option X882AH) or 7 ft open rack (Option CA01402AA).

The Site RMC (LNA) module may not be present in your installation, depending on the options
purchased from Motorola. The following options are only valid for 700/800/900 MHz and UHF R2 (435–
524 MHz).

• Option CA00862AA includes two Site RMC modules, which provide support for expansion of up to
24 radios on a single Rx antenna (HPD only supports five base radios, the remaining ports are
available for other receivers at the site.)

• Option CA00861AA does not include Site RMCs. It provides basic RMC functionality that is limited
to a single cabinet or rack.

• Option CA00877AA does not include Site RMCs. It is intended for use in expansion cabinets that
are wired to the primary Rx cabinet through the junction panel, and in other configurations using
RMC equipment outside the cabinet.

• Option CA01943AA includes two Site RMC modules for Phase 2 TDMA operation, dual branch
receive diversity. See “Appendix B” in the Dynamic Dual Mode for TDMA Operation manual.

The integrated GGM 8000 Gateway options are available for all GTR 8000 Expandable Site
Subsystem configurations, except UHF R2. Consult your Motorola sales representative for details.

• Option CA01536AA includes two RDMs

• Option CA00885AA includes high availability XHubs for expansion cabinets/racks.

• Option CA01706AA includes the GGM 8000 Gateway

• Option CA01707AA includes the GGM 8000 Gateway and analog/V.24 interface

• Option CA01708AA includes the GGM 8000 Gateway and encryption

• Option CA01709AA includes the GGM 8000 Gateway, analog/V.24, and encryption

GTR 8000 Expandable Site Subsystem RFDS Transmit Path
The transmit part of the RFDS includes the following equipment:

• Cavity Combiner: Includes an isolator at each input port (700/800 MHz and UHF R2 435–524
MHz)

• Hybrid Combiner: Modular; 2-6 channels, 1 or 2 antennas (900 MHz)

• Transmit filter: (700/800/900 MHz and UHF R2 435–524 MHz)

• Power Monitor Unit (PMU): (900 MHz, VHF 136–174 MHz, UHF R1 380–435 MHz, and UHF R2
435–524 MHz)

NOTICE: The PMU is not supported and is reserved for future use.
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The combiner aggregates all the transmit signals to a common line for the transmit antenna. It includes
integrated isolators to protect the transceivers from reflected signaling and to improve intermodulation
performance. The transmit filter removes any remaining noise in the receive sub-band. It includes a
power monitor to measure forward and reverse power on the transmit line. The output is sent to the
transmit antenna port.

If 700/800 MHz channels at the site are in different cabinets, then a diplexer is used in place of the
Transmit filter.

Figure 11: GTR 8000 Expandable Site Subsystem for Transmit Path (700/800/900 MHz/UHF R2)

GTR 8000 Expandable Site Subsystem RFDS Receive Path
The receive part of the RFDS includes the following equipment for 700/800/900 MHz and UHF R2
(435–524 MHz):

• Cabinet Receive Multicouplers/low noise amplifiers: Provide a low noise amplifier with a 6-way
splitter used to distribute inbound signaling to the base radios over the backplane to complete the
receive path. Two Cabinet RMC modules are used for Phase 2 TDMA operation, dual branch
receive diversity. See “Appendix B” in the Dynamic Dual Mode for TDMA Operation manual.

• Site Preselector: Provides signal filtering for the inbound signal. RF input and output connectors on
the front of the device are connected to the junction panel and a receive multicoupler. An input port
for injecting test signals is also provided.

• Site Receive Multicouplers/Low Noise Amplifiers: If option CA00862AA is purchased, each
receive path includes a receive multicoupler/low noise amplifier (RMC/LNA) with a balanced
amplifier and a 4-way splitter that can be used to distribute inbound signaling to multiple expansion
racks. RF input and output connectors on the front of the device are connected to the preselector,
junction panel, and the cabinet RMC/LNA. If Option CA01943AA is purchased, it includes two Site
RMC modules for Phase 2 TDMA operation, dual branch receive diversity. See “Appendix B” in the
Dynamic Dual Mode for TDMA Operation manual.

System connections are made through the junction panel on the top of the rack. This panel includes
the inputs for RF antennas and outputs for expansion cabinets.

Tower Top Amplifiers (TTAs) are only present if supplied by your organization.
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Figure 12: GTR 8000 Expandable Site Subsystem for Receive Path (700/800/900 MHz/UHF R2)

Figure 13: GTR 8000 Expandable Site Subsystem for HPD Receive Path

The receive part of the RFDS includes the following equipment for VHF (136–174 MHz) or UHF R1
(380–435 MHz):

• RMC Pass Through Module: For VHF or UHF R1, the receive path always includes an RMC Pass
Through module. Six RF input connectors on the front of the device are connected to the junction
panel. This module routes the Rx signals to the backplane for distribution to the six base radios.
There are no active components, splitters, or combiners on this module.
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Figure 14: GTR 8000 Expandable Site Subsystem for Receive Path (VHF or UHF R1)

GCP 8000 Site Controller Modules (HPD, ASTRO 25 Repeater,
and ASTRO 25 Express)
The GTR 8000 Expandable Site Subsystem for an HPD, ASTRO® 25 repeater site, or ASTRO® 25
Express system is designed to work with the GCP 8000 Site Controller modules. The site controller
modules provide integrated Ethernet LAN switching, eliminating external HP LAN switches at the site.
The site controller manages the site and the channels, administers broadcast, and provides a time and
frequency reference signal to the base radios. For HPD and repeater sites, the site controller also
handles mobile subscriber unit (MSU) mobility messaging to/from the zone controller, and handles data
messaging to/from the Radio Network Gateway (RNG).

One site controller module acts as the active module and the second module as the standby. The
redundancy ensures that any single point of failure at the site does not reduce overall functionality.

Figure 15: GCP 8000 Site Controller Module
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GCP 8000 Site controller modules share the same card cage, backplane, and junction panel as the
transceivers and XHubs.

The site controller software download and configuration is performed through serial and Ethernet ports
on the module for local servicing using Configuration/Service Software (CSS). For HPD and repeater
sites, network management is performed using Unified Network Configurator (UNC).

For details on the GCP 8000 Site Controller modules and configuration, see the GCP 8000 Site
Controller manual.

GPB 8000 Reference Distribution Module
The GPB 8000 Reference Distribution Module (RDM) is supported in a trunked IP simulcast remote
site with high availability and in a trunked 3600 IntelliRepeater site.

Figure 16: GPB 8000 Reference Distribution Module

The RDMs provide integrated Ethernet LAN switching, eliminating external HP LAN switches.

XHubs allow the RDMs to support additional GTR 8000 Expandable Site Subsystem cabinets with
channels beyond what the RDMs can support on their own. One RDM supports up to five XHubs with
each XHub supporting up to six base radios.

The RDMs software download and configuration is performed through serial and Ethernet ports on the
module for local servicing using Configuration/Service Software (CSS).

Trunked IP Simulcast Remote Site With High Availability
The RDMs provide redundant integrated site reference distribution through two GPS units as timing
reference sources to all the base radios at the site, eliminating the need for the TRAK 9100 Simulcast
Site Reference at the site.

The RDMs are also capable of monitoring RFDS equipment for failures and provide the interface to the
MOSCAD Network Fault Management. Configuration of the RDMs is performed using CSS and Unified
Network Configurator (UNC).

NOTICE: The RDMs do not provide site reference to base radios located outside of the GTR
8000 Expandable Site Subsystem cabinets or racks. A TRAK SSR is required at the site to
provide for the external base radios. If there are no available Ethernet ports in the RDMs for the
external base radios, an external Ethernet LAN switch is required at the site.

Trunked 3600 IntelliRepeater Site
The RDMs provide redundant integrated site reference distribution through the internal oscillator to all
the base radios at the site.
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Expansion Hub
The Expansion Hub (XHub) is a switching and interface module that operates in the following systems:

• Trunked IP simulcast remote site (all cabinet/racks)

• Trunked IP simulcast remote site configured with high availability (expansion cabinets/racks)

• Conventional only site (expansion cabinets/racks)

• ASTRO® 25 Repeater Site (expansion cabinets/racks)

• ASTRO® 25 Express System (expansion cabinets/racks)

• Trunked Single-Site Repeater Configuration (expansion cabinets/racks)

• Trunked 3600 IntelliRepeater Site (expansion cabinets/racks)

• Trunked 3600 Simulcast Subsystem (all cabinets/racks)

Figure 17: Expansion Hub

Function in an ASTRO 25 Repeater Site, ASTRO 25 Express Site, Trunked
Single-Site Repeater Site
The XHubs connect to the GCP 8000 Site Controller and allow the site controller to support additional
GTR 8000 Expandable Site Subsystem cabinets/racks with channels beyond what the site controller
can support on its own. One site controller supports up to five XHubs with each XHub supporting up to
six base radios.

The Expansion Hub provides the following functions at the site:

• Switches Ethernet traffic between the attached base radios and the site controller

• Distributes time and frequency references from the site controller to the base radios

• Monitors base radios and RF distribution equipment

• Routes redundant Ethernet paths

Function in a Trunked IP Simulcast Remote Site (Standard Configuration),
Trunked 3600 Simulcast Remote Site, or Conventional Site
The XHub provides an Ethernet pathway between the site switch and the base radios. Also provides
signal buffering for the time and frequency necessary for the base radios.

Function in a Trunked IP Simulcast Remote Site (High Availability
Configuration) or Trunked 3600 IntelliRepeater Site
The XHubs connect to the GPB 8000 Reference Distribution Modules (RDMs) and allow the RDMs to
support additional GTR 8000 Expandable Site Subsystem cabinets/racks with channels beyond what
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the RDMs can support on their own. One RDM supports up to five Expansion Hubs with each XHub
supporting up to six base radios.

The Expansion Hub provides the following functions at the site:

• Switches Ethernet traffic between the attached base radios and the RDMs

• Distributes time and frequency references from the RDMs to the base radios

• Routes redundant Ethernet paths

GGM 8000 Gateway
A GGM 8000 Gateway handles traffic between a remote site network and is the link to either a prime
site or master site. The gateway distributes network management traffic between the equipment in the
site network.

The Conventional Channel Gateway (GGM 8000 with analog/V.24 interface kit) in an ASTRO® 25
conventional base radio site supports:

• Up to four channels using an analog interface.

• Up to four channels using a V.24 interface.

• Up to ten IP conventional channels.

The GGM 8000 with the Enhanced Low Density Conventional Gateway in an ASTRO® 25 conventional
base radio site supports:

• Up to four channels using an analog interface.

• Up to four channels using a V.24 interface.

• Up to 16 IP conventional channels.

For detailed information on the GGM 8000 Gateway and the systems and interfaces it supports, see
the System Gateways – GGM 8000 manual.

GTR 8000 Expandable Site Subsystem Specifications
The following G-Series Product Specifications reference the TIA specifications for the base radio,
including the following Methods and Performance recommendations:

Phase 1 (includes Linear Simulcast):

• Methods: TIA-102.CAAA-C, “Digital C4FM/CQPSK Transceiver Measurements Methods”
September 2008

• Performance: TIA-102.CAB-C, “Land Mobile Radio Transceiver Performance Recommendations,
Project 25 – Digital Radio Technology, C4FM/CQPSK Modulation” January 2010

Phase 2:

• Methods: TIA-102.CCAA, “Two-Slot Time Division Multiple Access Transceiver Measurement
Methods” August 2011

• Performance: TIA 102.CCAB, “Two-Slot Time Division Multiple Access Transceiver Performance
Recommendations” October 2011

IMPORTANT: Specifications are subject to change without notice.
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Specifications for GTR 8000 Expandable Site Subsystem for HPD
(700/800 MHz)

Table 3: General Specifications for GTR 8000 Expandable Site Subsystem for HPD (700/800 MHz)

General Specifications

Model Number T7054A or SQM01SUM7054A

Maximum Number of Channels 5

Height

Cabinet Version (Option CA00293AA): 84.8 in. (215 cm) 43 Rack Units

7.5 ft. Open Rack Version (Option X882AH): 90.4 in. (230 cm) 48 Rack Units

7 ft. Open Rack Version (Option CA01402AA): 84.3 in. (214 cm) 44 Rack Units

Footprint (W x D)

Cabinet Version (Option CA00293AA): 23.6 x 23.6 (60 x 60 cm)

Open Rack Version (Option X882AH CA01402AA): 20.5 x 23.5 in. (52 x 60 cm)

Weight (fully configured without gateways)

Cabinet Version (Option CA00293AA): 526 lbs (240 kg)

Open Rack Version (Option X882AH CA01402AA): 475 lbs (215 kg)

Weight (fully configured with gateways)

Cabinet Version (Option CA00293AA): 571 lbs (260 kg)

Open Rack Version (Option X882AH CA01402AA): 520 lbs (235 kg)

Temperature Range, Operating*

Open Rack: -22 to 140 °F (-30 to 60 °C)

Cabinet without Doors: -22 to 140 °F (-30 to 60 °C)

Cabinet with Doors: -22 to 131 °F (-30 to 55 °C)

Temperature Range, Storage -40 to 185 °F (-40 to 85 °C)

Operating Altitude Up to 1800 meters (5900 ft.) above mean sea
level
Above 1800 meters (5900 ft.), the derating is 1.5
°C/km (0.8 °F/1000 feet)

Maximum operational altitude is 5000 meters
(16900 ft.)

Power Supply Input AC: 90-264 VAC, 47-63 Hz
DC: 43.2–60 VDC

Power Consumption (without gateways)** AC: 2410 W max.
DC: 2130 W max.

Power Consumption (with gateways)** AC: 2490 W max.
DC: 2210 W max.

Power Supply Type Switching

Battery Revert Included
Table continued…
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General Specifications

Input/Output Impedance 50 Ohms

Antenna Connector Types

Tx: 7/16 Female

Rx: N female

Channel Spacing 25 kHz

Transmit Combiner Spacing 150 kHz

Frequency Stability GPS Synthesized

* = If the cabinet or rack includes a site gateway for Analog/V.24 conventional channel interfaces, the
maximum operating temperature is 122 °F (50 °C) for an open rack and 113 °F (45 °C) for a cabinet
with doors.

** = AC power consumption values increase by 1000 W when the batteries are being charged.

Table 4: Transmitter (Cabinet Output)** Specifications for GTR 8000 Expandable Site Subsystem for
HPD (700/800 MHz)

Transmitter Specifications: Including RFDS

Frequency Range 769-775, 775-776, 851–870 MHz

Average power output per channel* 1-20 W

Error Vector Magnitude 10%

Spurious and Harmonic Emissions Attenuation 90 dB

Modulation 64 QAM, 16 QAM, QPSK

Emissions Designators 17K7D7D

Adjacent Channel Power Ratio

25 kHz offset, 22 kHz BW: 58 dB

37.5 kHz offset, 25 kHz BW: 65 dB

Intermodulation Attenuation 80 dB

* Full transmitter output power is available during battery revert at the junction panel.
** Includes Transmitter RF Distribution System.

Table 5: Transmitter RF Distribution System for GTR 8000 Expandable Site Subsystem for HPD
(700/800 MHz)

Transmitter RF Distribution System Specifications

Frequency Range 769-775, 775-776, 851–870 MHz

Insertion Loss (150 kHz spacing) 3.1 dB typ

Tx-Tx Insolation (150 kHz spacing) 32 dB
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Table 6: Receiver Specifications (Top of Cabinet) for GTR 8000 Expandable Site Subsystem for HPD
(700/800 MHz)

Receiver Specifications, including RFDS

Frequency Range 792–825 MHz

Modulation 64 QAM, 16 QAM, QPSK

Digital Sensitivity 1% Bit Error Rate Static (BER)

64 QAM: -101 dBm

16 QAM: -108 dBm

QPSK: -115 dBm

Faded Sensitivity 1% Bit Error Rate TU50 (BER)

64 QAM: -93 dBm

16 QAM: -99 dBm

QPSK: -104 dBm

Faded Sensitivity 5% Bit Error Rate HT200 (BER)

64 QAM: -93 dBm

Faded Sensitivity 2% Bit Error Rate HT200 (BER)

16 QAM: -97 dBm

Faded Sensitivity 1% Bit Error Rate HT200 (BER)

QPSK: -101 dBm

Intermodulation Rejection* 75 dB

Spurious and Image Response Rejection* 90 dB

Intermediate Frequencies

1st: 73.35 MHz

2nd: 2.16 MHz

Digital Adjacent Channel Rejection* 50 dB

Electronic Bandwidth Full Bandwidth

Blocking Immunity* 90 dB

Conducted Spurious -57 dBm

Bit Error Rate Floor 0.01%

Co-Channel Rejection QPSK 11 dB

RF Input Connector Type N female

RF Impedance 50 Ohms

* Reference signal is QPSK
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Table 7: Receiver RF Distribution System for GTR 8000 Expandable Site Subsystem for HPD (700/800
MHz)

Receiver RF Distribution System Specifications

Frequency Range 792–825 MHz

Typical Limit

Noise Figure 3.8 dB 5 dB

Gain 13 dB -16 to 24 dB adjustable

3rd Order Output Intercept 21 dB

Amplifier Intercept 35 dBm

Preselector Bandwidth 792–825 MHz

RF Input Connector Type N

RF Output Connector Type BNC

Table 8: FCC Identification for GTR 8000 Expandable Site Subsystem for HPD (700/800 MHz)

FCC Identification

Frequency Range Type Power Output Type Acceptance
Number

769-775, 775-776 MHz Transmitter 2–50 W ABZ89FC5812B

851-870 MHz Transmitter 2–50 W ABZ89FC5810B

792-825 MHz Receiver N/A ABZ89FR5811B

GTR 8000 Expandable Site Subsystem Industry Canada for HPD (700/800
MHz)

Table 9: Industry Canada for GTR 8000 Expandable Site Subsystem for HPD (700/800 MHz)

IC Approval
Number Frequency Range Type Power Output IC Model

Number

109AB-5810B Tx 851–866 MHz, Rx 806–866 MHz HPD Variable 2-50 Watts (average) T7039–800B

109AB-5812B Tx 768–776 MHz, Rx 798–806 MHz HPD Variable 2-50 Watts (average) T7039–700B

Specifications for GTR 8000 Expandable Site Subsystem for
Integrated Voice and Data (700/800 MHz)

Table 10: General Specifications for GTR 8000 Expandable Site Subsystem for IV&D (700/800 MHz)

General Specifications

Model Number T7054A or SQM01SUM7054A

Maximum Number of Channels 6

Height

Cabinet Version (Option CA00293AA): 84.8 in. (215 cm) 43 Rack Units
Table continued…
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General Specifications

7.5 ft. Open Rack Version (Option X882AH): 90.4 in. (230 cm) 48 Rack Units

7 ft. Open Rack Version (Option CA01402AA): 84.3 in. (214 cm) 44 Rack Units

Footprint (W x D)

Cabinet Version (Option CA00293AA): 23.6 x 23.6 (60 x 60 cm)

Open Rack Version (Option X882AH CA01402AA): 20.5 x 23.5 in. (52 x 60 cm)

Weight (fully configured without gateways)

Cabinet Version (Option CA00293AA): 526 lbs (240 kg)

Open Rack Version (Option X882AH CA01402AA): 475 lbs (215 kg)

Weight (fully configured with gateways)

Cabinet Version (Option CA00293AA): 571 lbs (260 kg)

Open Rack Version (Option X882AH CA01402AA): 520 lbs (235 kg)

Temperature Range, Operating*

Open Rack: -22 to 140 °F (-30 to 60 °C)

Cabinet without Doors: -22 to 140 °F (-30 to 60 °C)

Cabinet with Doors: -22 to 131 °F (-30 to 55 °C)

Temperature Range, Storage -40 to 185 °F (-40 to 85 °C)

Operating Altitude Up to 1800 meters (5900 ft.) above mean sea
level
Above 1800 meters (5900 ft.), the derating is 1.5
°C/km (0.8 °F/1000 feet)

Maximum operational altitude is 5000 meters
(16900 ft.)

Power Supply Input AC: 90-264 VAC, 47-63 Hz
DC: 43.2–60 VDC

Power Consumption (without gateways)**

AC: C4FM, FM: 2890 W max.
H-DQPSK, LSM: 3250 W max.

DC: C4FM, FM: 2650 W max.
H-DQPSK, LSM: 3010 W max.

Power Consumption (with gateways)**

AC: C4FM, FM: 3010 W max.
H-DQPSK, LSM: 3370 W max.

DC: C4FM, FM: 2770 W max.
H-DQPSK, LSM: 3130 W max.

Power Supply Type Switching

Battery Revert Included

Input/Output Impedance 50 Ohms
Table continued…
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General Specifications

Antenna Connector Types Tx: 7/16 Female
Rx: N female

Channel Spacing 12.5/25 kHz

Transmit Combiner Spacing 150 kHz

Frequency Stability (High Availability configuration) GPS locked or Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
Internal Reference (transceiver
option card)

Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
External Reference

TRAK

Frequency Generation Synthesized

* = If the cabinet or rack includes a site gateway for Analog/V.24 conventional channel interfaces, the
maximum operating temperature is 122 °F (50 °C) for an open rack and 113 °F (45 °C) for a cabinet
with doors.

** = AC power consumption values increase by 1200 W when the batteries are being charged.

Table 11: Transmitter (Cabinet Output)** Specifications for GTR 8000 Expandable Site Subsystem for
IV&D (700/800 MHz)

Transmitter Specifications: Including RFDS

Frequency Range 769-775, 775-776, 851–870 MHz

Average power output per channel* 1-40 W

Modulation Fidelity 5%

Spurious and Harmonic Emissions Attenuation 90 dB

Modulation C4FM, LSM, H-DQPSK, FM

Analog FM Hum and Noise

12.5 kHz 45 dB

25 kHz 50 dB

Analog Audio Distortion Less than 2% at 1000 Hz

Emissions Designators 8K70D1E, 8K70D1D, 8K70D1W 8K10F1E,
8K10F1D, 8K10F1W 9K80D7E, 9K80D7D,
9K80D7W 10K0F1E, 10K0F1D,
800 W only:
10K0F1W, 16K0F1D,16K0F3E, 11K0F3E,
14K0F1D, 14K0F3E

Adjacent Channel Power Ratio
Table continued…
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Transmitter Specifications: Including RFDS

12.5 kHz offset, 6 kHz BW: 67 dB

Intermodulation Attenuation 80 dB

* Full transmitter output power is available during battery revert at the junction panel.
** Includes Transmitter RF Distribution System.

Table 12: Transmitter RF Distribution System for GTR 8000 Expandable Site Subsystem for IV&D
(700/800 MHz)

Transmitter RF Distribution System Specifications

Frequency Range 769-775, 775-776, 851–870 MHz

Insertion Loss (150 kHz spacing) 3.1 dB typ

Tx-Tx Insolation (150 kHz spacing) 32 dB

Table 13: Receiver (Top of Cabinet) Specifications for GTR 8000 Expandable Site Subsystem for IV&D
(700/800 MHz)

Receiver Specifications, including RFDS

Frequency Range 792–825 MHz

Modulation C4FM, H-CPM, FM

Analog Sensitivity (12 dB SINAD)

12.5 kHz -123 dBm

25 kHz -122 dBm

Digital Sensitivity 5% Bit Error Rate Static (BER)

C4FM: -123 dBm

H-CPM: -121 dBm

Faded Sensitivity 5% Bit Error Rate (BER)

C4FM: -115 dBm

Intermodulation Rejection 80 dB

Digital Adjacent Channel Rejection 60 dB

Analog Adjacent Channel Rejection (EIA603) Ana-
log 12.5 kHz

75 dB

Analog Adjacent Channel Rejection (TIA603D)

Analog 12.5 kHz 50 or 60 dB (adjustable)

Analog 25 kHz 80 dB

Spurious and Image Response Rejection 100 dB

Analog Audio Response +1, -3 dB from 6 dB per octave de-emphasis; 300–
3000 Hz referenced to 1000 Hz at line output

Analog Audio Distortion 3% or 5% (adjustable)

Analog FM Hum and Noise
Table continued…
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Receiver Specifications, including RFDS

12.5 kHz 45 dB

25 kHz 50 dB

Blocking Immunity 100 dB

Signal Displacement Bandwidth 1 kHz

Intermediate Frequencies

1st: 73.35 MHz

2nd: 2.16 MHz

Electronic Bandwidth Full Bandwidth

Conducted Spurious -57 dBm

Bit Error Rate Floor 0.01%

Table 14: Receiver RF Distribution System for GTR 8000 Expandable Site Subsystem for IV&D
(700/800 MHz)

Receiver RF Distribution System Specifications

Frequency Range 792–825 MHz

Typical Limit

Noise Figure 3.8 dB 5 dB

Gain 13 dB -16 to 24 dB adjustable

3rd Order Output Intercept 21 dB

Amplifier Intercept 35 dBm

Preselector Bandwidth 792–825 MHz

RF Input Connector Type N

RF Output Connector Type BNC

Table 15: FCC Identification for GTR 8000 Expandable Site Subsystem for IV&D (700/800 MHz)

FCC Identification

Frequency Range Type Power Output Type Acceptance
Number

769-775, 775-776 MHz Transmitter 2-100 W ABZ89FC5812B

851–870 MHz Transmitter 2-100 W ABZ89FC5810B

792–825 MHz Receiver N/A ABZ89FR5811B
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GTR 8000 Expandable Site Subsystem Industry Canada for Integrated
Voice and Data (700/800 MHz)

Table 16: Industry Canada for GTR 8000 Expandable Site Subsystem for IV&D (700/800 MHz)

IC Approval
Number Frequency Range Type Power Output IC Model Num-

ber

109AB-5810B Tx 851–869 MHz, Rx 806–824
MHz

LSM Variable 2-100 Watts (aver-
age)

T7039–800B

109AB-5810B Tx 851–869 MHz, Rx 806–824
MHz

C4FM, FM Variable 2-100 Watts T7039–800B

109AB-5812B Tx 768–776 MHz, Rx 798–806
MHz

LSM Variable 2-100 Watts (aver-
age)

T7039–700B

109AB-5812B Tx 768–776 MHz, Rx 798–806
MHz

C4FM, FM Variable 2-100 Watts T7039–700B

Specifications for GTR 8000 Expandable Site Subsystem for
Integrated Voice and Data (900 MHz)

Table 17: General Specifications for GTR 8000 Expandable Site Subsystem for IV&D (900 MHz)

General Specifications

Model Number T7054A or SQM01SUM7054A

Maximum Number of Channels 6

Height

Cabinet Version (Option CA00293AA): 84.8 in. (215 cm) 43 Rack Units

7.5 ft. Open Rack Version (Option X882AH): 90.4 in. (230 cm) 48 Rack Units

7 ft. Open Rack Version (Option CA01402AA): 84.3 in. (214 cm) 44 Rack Units

Footprint (W x D)

Cabinet Version (Option CA00293AA): 23.6 x 23.6 in. (60 x 60 cm)

Open Rack Version (Option X882AH CA01402AA): 20.5 x 23.5 in. (52 x 60 cm)

Weight (fully configured without gateways)

Cabinet Version (Option CA00293AA): 550 lbs (250 kg)

Open Rack Version (Option X882AH CA01402AA): 495 lbs (225 kg)

Weight (fully configured with gateways)

Cabinet Version (Option CA00293AA): 595 lbs (270 kg)

Open Rack Version (Option X882AH CA01402AA): 540 lbs (245 kg)

Temperature Range, Operating

Open Rack: -22 to 140 °F (-30 to 60 °C)

Cabinet without Doors: -22 to 140 °F (-30 to 60 °C)

Cabinet with Doors: -22 to 122 °F (-30 to 50 °C)
Table continued…

6871022P87-C
Chapter 1:  GTR 8000 Expandable Site Subsystem Description

76  Send Feedback

http://docsurvey.motorolasolutions.com


General Specifications

Temperature Range, Storage -40 to 185 °F (-40 to 85 °C)

Operating Altitude Up to 1800 meters (5900 ft.) above mean sea
level
Above 1800 meters (5900 ft.), the derating is 1.5
°C/km (0.8 °F/1000 feet)

Maximum operational altitude is 5000 meters
(16900 ft.)

Power Supply Input AC: 90-264 VAC, 47-63 Hz
DC: 43.2–60 VDC

Power Consumption*

AC: C4FM: 3700 W max.
LSM: 4100 W max.

DC: C4FM: 3400 W max.
LSM: 3700 W max.

Channel Spacing 12.5 kHz

Transmit Combiner Spacing 12.5 kHz (hybrid)
150 kHz (cavity)

Power Supply Type Switching

Battery Revert Included

Input/Output Impedance 50 Ohms

Antenna Connector Types Tx: 7/16 Female (with cavity combiner)
Tx: N female (with hybrid combiner)
Rx: N female

Frequency Stability (High Availability configuration) GPS locked or Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
Internal Reference (transceiver option card)

Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
External Reference

TRAK

Frequency Generation Synthesized

* = AC power consumption values increase by 1200 W when the batteries are being charged.
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Table 18: Transmitter (Cabinet Output)** Specifications for GTR 8000 Expandable Site Subsystem for
IV&D (900 MHz)

Transmitter Specifications: Including RFDS

Frequency Range 935–941 MHz

Average power output per channel*

Single PA Output, no combining: 2-80 W

Hybrid Single Output 2-way: 1-37 W

Hybrid Single Output 3-way: 1-22 W

Hybrid Single Output 4-way: 1-17 W

Hybrid Single Output 5-way: 1-12 W

Hybrid Single Output 6-way: 1-10 W

Hybrid Dual Output 2-way: 1-37 W

Hybrid Dual Output 3-way: 1-22 W

Modulation Fidelity 5%

Spurious and Harmonic Emissions Attenuation 90 dB

Modulation H-DQPSK, FM

Emissions Designators 8K70D1W, 8K10F1E, 8K10F1D, 9K80D7W

Adjacent Channel Power Ratio

12.5 kHz offset, 6 kHz BW: 67 dB

Intermodulation Attenuation 80 dB

* Full transmitter output power is available during battery revert at the junction panel.
** Includes Transmitter RF Distribution System.

Table 19: Transmitter RF Distribution System for GTR 8000 Expandable Site Subsystem for IV&D (900
MHz)

Transmitter RF Distribution System Specifications

Frequency Range 935–941 MHz

Insertion Loss (150 kHz spacing) 2-way loss: 4.4 dB typ
3-way loss: 6.3 dB typ
4-way loss: 7.6 dB typ
5-way loss: 8.8 dB typ
6-way loss: 9.7 dB typ

Tx-Tx Insolation (150 kHz spacing) 20 dB

Table 20: Receiver (Top of Cabinet) Specifications for GTR 8000 Expandable Site Subsystem for IV&D
(900 MHz)

Receiver Specifications, including RFDS

Frequency Range 896–902 MHz

Modulation C4FM
Table continued…
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Receiver Specifications, including RFDS

Digital Sensitivity 5% Bit Error Rate Static (BER)

C4FM: -123 dBm

Faded Sensitivity 5% Bit Error Rate (BER)

C4FM: -115 dBm

Intermodulation Rejection 80 dB

Digital Adjacent Channel Rejection 60 dB

Spurious and Image Response Rejection 100 dB

Blocking Immunity 100 dB

Signal Displacement Bandwidth 1 kHz

Intermediate Frequencies

1st: 73.35 MHz

2nd: 2.16 MHz

Electronic Bandwidth Full Bandwidth

Conducted Spurious -57 dBm

Bit Error Rate Floor 0.01%

Table 21: Receiver RF Distribution System for GTR 8000 Expandable Site Subsystem for IV&D (900
MHz)

Receiver RF Distribution System Specifications

Frequency Range 896–902 MHz

Typical Limit

Noise Figure 3.8 dB 5 dB

Gain 13 dB -16 to 24 dB adjustable

3rd Order Output Intercept 21 dB

Amplifier Intercept 35 dBm

Preselector Bandwidth 896–902 MHz

RF Input Connector Type N

RF Output Connector Type BNC

Table 22: FCC Identification for GTR 8000 Expandable Site Subsystem for IV&D (900 MHz)

FCC Identification

Frequency Range Type Power Output Type Acceptance
Number

935–941 MHz Transmitter 2-120 W ABZ89FC5823B

896–902 MHz Receiver N/A ABZ89FR5824B

6871022P87-C
Chapter 1:  GTR 8000 Expandable Site Subsystem Description

Send Feedback   79

http://docsurvey.motorolasolutions.com


GTR 8000 Expandable Site Subsystem Industry Canada for Integrated
Voice and Data (900 MHz)

Table 23: Industry Canada for GTR 8000 Expandable Site Subsystem for IV&D (900 MHz)

IC Approval
Number Frequency Range Type Power Output IC Model

Number

109AB-5824B Tx 935–940 MHz, Rx 896–901 MHz H-DQPSK, FM Variable 2-120 Watts
(average)

T7039–900B

Specifications for GTR 8000 Expandable Site Subsystem for
Integrated Voice and Data (UHF R1, 380–435 MHz)

Table 24: General Specifications for GTR 8000 Expandable Site Subsystem for IV&D (UHF R1, 380–
435 MHz)

General Specifications

Model Number T7054A or SQM01SUM7054A

Maximum Number of Channels 6

Height

Cabinet Version (Option CA00293AA): 84.8 in. (215 cm) 43 Rack Units

7.5 ft. Open Rack Version (Option X882AH): 90.4 in. (230 cm) 48 Rack Units

7 ft. Open Rack Version (Option CA01402AA): 84.3 in. (214 cm) 44 Rack Units

Footprint (W x D)

Cabinet Version (Option CA00293AA): 23.6 x 23.6 in. (60 x 60 cm)

Open Rack Version (Option X882AH CA01402AA): 20.5 x 23.5 in. (52 x 60 cm)

Weight (fully configured without gateways)

Cabinet Version (Option CA00293AA): 495 lbs (225 kg)

Open Rack Version (Option X882AH CA01402AA): 430 lbs (195 kg)

Weight (fully configured with gateways)

Cabinet Version (Option CA00293AA): 540 lbs (245 kg)

Open Rack Version (Option X882AH CA01402AA): 475 lbs (215 kg)

Temperature Range*

Open Rack: -22 to 140 °F (-30 to 60 °C)

Cabinet without Doors: -22 to 140 °F (-30 to 60 °C)

Cabinet with Doors: -22 to 131 °F (-30 to 55 °C)

Temperature Range, Storage -40 to 185 °F (-40 to 85 °C)

Operating Altitude Up to 1800 meters (5900 ft.) above mean sea
level
Above 1800 meters (5900 ft.), the derating is 1.5
°C/km (0.8 °F/1000 feet)

Table continued…
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General Specifications

Maximum operational altitude is 5000 meters
(16900 ft.)

Power Supply Input AC: 90-264 VAC, 47-63 Hz
DC: 43.2–60 VDC

Power Consumption (without gateways)**

AC: C4FM, FM: 3070 W max
H-DQPSK, LSM: 3370 W max

DC: C4FM, FM: 2830 W max.
H-DQPSK, LSM: 3130 W max.

Power Consumption (with gateways)**

AC: C4FM, FM: 3190 W max.
H-DQPSK, LSM: 3490 W max.

DC: C4FM, FM: 2950 W max.
H-DQPSK, LSM: 3250 W max.

Power Supply Type Switching

Battery Revert Included

Input/Output Impedance 50 Ohms

Antenna Connector Types Tx: six N female
Rx: six BNC female

Channel Spacing 12.5/25 kHz

Frequency Stability (High Availability configuration) GPS locked or Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
Internal Reference (OCXO transceiver option card)

Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
Internal Reference (TCXO transceiver option card)

Aging:
1000 ppb/yr
Temperature: 500 ppb

Frequency Stability
External Reference

TRAK

Frequency Generation Synthesized

* = If the cabinet or rack includes a site gateway for Analog/V.24 conventional channel interfaces, the
maximum operating temperature is 122 °F (50 °C) for an open rack and 113 °F (45 °C) for a cabinet
with doors.

** = AC power consumption values increase by 1200 W when the batteries are being charged.

6871022P87-C
Chapter 1:  GTR 8000 Expandable Site Subsystem Description

Send Feedback   81

http://docsurvey.motorolasolutions.com


Table 25: Transmitter (Cabinet Output) Specifications for GTR 8000 Expandable Site Subsystem for
IV&D (UHF R1, 380–435 MHz)

Transmitter Specifications

Frequency Range 380–435 MHz

Average power output per channel* 2-110 W C4FM, FM
2-100 W LSM, H-DQPSK

Modulation Fidelity 5%

Spurious and Harmonic Emissions Attenuation 90 dB

Analog FM Hum and Noise

12.5 kHz: 45 dB

25 kHz: 50 dB

Analog Audio Distortion Less than 2% (1% typical) at 1000 Hz

Modulation C4FM, LSM, H-DQPSK, FM

Emissions Designators 8K70D1W, 8K70D1E, 8K70D1D, 8K10F1W,
8K10F1E, 8K10F1D, 9K80D7W, 9K80D7E,
9K80D7D, 16K0F3E, 11K0F3E, 16K0F1D,
10K0F1D

Adjacent Channel Power Ratio

12.5 kHz offset, 6 kHz BW: 67 dB

Intermodulation Attenuation 65 dB

* Full transmitter output power is available during battery revert at the junction panel.

Table 26: Receiver (Top Cabinet) Specifications for GTR 8000 Expandable Site Subsystem for IV&D
(UHF R1, 380–435 MHz)

Receiver Specifications

Frequency Range 380–435 MHz

Modulation C4FM, H-CPM, FM

Analog Sensitivity (12 dB SINAD)

12.5 kHz: -117 dBm

25 kHz: -116 dBm

Digital Sensitivity 5% Bit Error Rate Static (BER)

C4FM: -117 dBm

H-CPM: -115 dBm

Faded Sensitivity 5% Bit Error Rate (BER)

C4FM: -109 dBm

Intermodulation Rejection 85 dB

Digital Adjacent Channel Rejection 60 dB

Analog Adjacent Channel Rejection (EIA603) Analog 12.5
kHz

75 dB

Table continued…
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Receiver Specifications

Analog Adjacent Channel Rejection (TIA603D)

Analog 12.5 kHz: 50 or 60 dB (adjustable)

Analog 25 kHz: 80 dB

Spurious and Image Response Rejection 85 dB

Analog Audio Response +1, -3 dB from 6 dB per octave de-empha-
sis; 300–3000 Hz referenced to 1000 Hz at
line output

Analog Audio Distortion 3% or 5% (adjustable)

Analog FM Hum and Noise

12.5 kHz: 45 dB

25 kHz: 50 dB

Blocking Immunity 100 dB

Signal Displacement Bandwidth 1 kHz

Intermediate Frequencies

1st: 73.35 MHz

2nd: 2.16 MHz

Electronic Bandwidth Full Bandwidth

Conducted Spurious -57 dBm

Bit Error Rate Floor 0.01%

Table 27: FCC Identification for GTR 8000 Expandable Site Subsystem for IV&D (UHF R1, 380–435
MHz)

FCC Identification

Frequency Range Type Power Output Type Acceptance
Number

406.1–435 MHz Transmitter
2-110 W C4FM, FM
2-100 W LSM, H-DQPSK ABZ89FC4821B

380–435 MHz Receiver N/A ABZ89FR4822B

GTR 8000 Expandable Site Subsystem Industry Canada for Integrated
Voice and Data (UHF R1, 380–435 MHz)

Table 28: Industry Canada for GTR 8000 Expandable Site Subsystem for IV&D (UHF R1 380–435
MHz)

IC Approval
Number Frequency Range Type Power Output IC Model Num-

ber

109AB-4821B Tx 406.1–430 MHz, Rx 406.1–430
MHz

C4FM, FM Variable 2-110 Watts T7039–UHFR1B

109AB-4821B Tx 406.1–430 MHz, Rx 406.1–430
MHz

LSM, H-DQPSK Variable 2-100 Watts T7039–UHFR1B
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Specifications for GTR 8000 Expandable Site Subsystem for
Integrated Voice and Data (UHF R2, 435–524 MHz)

Table 29: General Specifications for GTR 8000 Expandable Site Subsystem for IV&D (UHF R2, 435–
524 MHz)

General Specifications

Model Number T7054A or SQM01SUM7054A

Maximum Number of Channels 6

Height

Cabinet Version (Option CA00293AA): 84.8 in. (215 cm) 43 Rack Units

7.5 ft. Open Rack Version (Option X882AH): 90.4 in. (230 cm) 48 Rack Units

7 ft. Open Rack Version (Option CA01402AA): 84.3 in. (214 cm) 44 Rack Units

Footprint (W x D)

Cabinet Version (Option CA00293AA): 23.6 x 23.6 in. (60 x 60 cm)

Open Rack Version (Option X882AH CA01402AA): 20.5 x 23.5 in. (52 x 60 cm)

Weight (fully configured with cavity combiner, no
gateways)

Cabinet Version (Option CA00293AA): 610 lbs (280 kg)

Open Rack Version (Option X882AH CA01402AA): 565 lbs (260 kg)

Weight (fully configured with gateways, no cavity
combiner)

Cabinet Version (Option CA00293AA): 540 lbs (245 kg)

Open Rack Version (Option X882AH CA01402AA): 475 lbs (215 kg)

Temperature Range*

Open Rack: -22 to 140 °F (-30 to 60 °C)

Cabinet without Doors: -22 to 140 °F (-30 to 60 °C)

Cabinet with Doors: -22 to 131 °F (-30 to 55 °C)

Temperature Range, Storage -40 to 185 °F (-40 to 85 °C)

Operating Altitude Up to 1800 meters (5900 ft.) above mean sea
level
Above 1800 meters (5900 ft.), the derating is 1.5
°C/km (0.8 °F/1000 feet)

Above 3,000 meters (9,800 feet), the peak power
derating for the Tx filter is 1dB/1km (0.3dB/1,000
ft.)

Maximum operational altitude is 5000 meters
(16900 ft.)

Power Supply Input AC: 90-264 VAC, 47-63 Hz
DC: 43.2–60 VDC

Table continued…
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General Specifications

Power Consumption (with cavity combiner, no gate-
ways)**

AC: C4FM, FM: 2830 W max.
H-DQPSK, LSM: 3130 W max.

DC: C4FM, FM: 2590 W max.
H-DQPSK, LSM: 2890 W max.

Power Consumption (with gateways, no cavity
combiner)**

AC: C4FM, FM: 2950 W max.
H-DQPSK, LSM: 3250 W max.

DC: C4FM, FM: 2710 W max.
H-DQPSK, LSM: 3010 W max.

Power Supply Type Switching

Battery Revert Included

Input/Output Impedance 50 Ohms

Antenna Connector Types

Tx: 7/16 Female

Rx: N female

Channel Spacing 12.5/25 kHz

Transmit Combiner Spacing 150 kHz

Frequency Stability (High Availability configuration) GPS locked or Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
Internal Reference (OCXO transceiver option card)

Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
Internal Reference (TCXO transceiver option card)

Aging:
1000 ppb/yr
Temperature: 500 ppb

Frequency Stability
External Reference

TRAK

Frequency Generation Synthesized

* = If the cabinet or rack includes a site gateway for Analog/V.24 conventional channel interfaces, the
maximum operating temperature is 122 °F (50 °C) for an open rack and 113 °F (45 °C) for a cabinet
with doors.

** = AC power consumption values increase by 1200 W when the batteries are being charged.

6871022P87-C
Chapter 1:  GTR 8000 Expandable Site Subsystem Description

Send Feedback   85

http://docsurvey.motorolasolutions.com


Table 30: Transmitter (Cabinet Output)** Specifications for GTR 8000 Expandable Site Subsystem for
IV&D (UHF 450–512 MHz) Including RFDS

Transmitter Specifications: Including RFDS

Frequency Range 450–512 MHz

Average power output per channel*

C4FM, FM: 1-33 W

H-DQPSK, LSM: 1-30 W

Modulation Fidelity 5%

Spurious and Harmonic Emissions Attenuation 90 dB

Modulation C4FM, LSM, H-DQPSK, FM

Analog FM Hum and Noise

12.5 kHz: 45 dB

25 kHz: 50 dB

Analog Audio Distortion Less than 2% (1% typical) at 1000 Hz

Emissions Designators 8K70D1W, 8K70D1E, 8K70D1D, 8K10F1W,
8K10F1E, 8K10F1D, 9K80D7W, 9K80D7E,
9K80D7D, 16K0F3E, 11K0F3E, 16K0F1D,
10K0F1D

Adjacent Channel Power Ratio

12.5 kHz offset, 6 kHz BW: 67 dB

Intermodulation Attenuation 80 dB

* Full transmitter output power is available during battery revert at the junction panel.

** Includes Transmitter RF Distribution System.

Table 31: Transmitter RF Distribution System for GTR 8000 Expandable Site Subsystem for IV&D
(UHF 450–512 MHz)

Transmitter RF Distribution System Specifications

Frequency Range 450–512 MHz

Insertion Loss (150 kHz spacing) 4.5 dB typ

Tx-Tx Insolation (150 kHz spacing) 32 dB

Table 32: Receiver (Top of Cabinet) Specifications for GTR 8000 Expandable Site Subsystem for IV&D
(UHF 450–512 MHz) Including RFDS

Receiver Specifications, including RFDS

Frequency Range 450–512 MHz

Modulation C4FM, H-CPM, FM

Analog Sensitivity (12 dB SINAD)

12.5 kHz: -121.5 dBm

25 kHz: -120.5 dBm
Table continued…
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Receiver Specifications, including RFDS

Digital Sensitivity 5% Bit Error Rate Static (BER)

C4FM: -121.5 dBm

H-CPM: -119.5 dBm

Faded Sensitivity 5% Bit Error Rate (BER)

C4FM: -113.5 dBm

Intermodulation Rejection 80 dB

Digital Adjacent Channel Rejection 60 dB

Analog Adjacent Channel Rejection (EIA603) Ana-
log 12.5 kHz

75 dB

Analog Adjacent Channel Rejection (TIA603D)

Analog 12.5 kHz: 50 or 60 dB (adjustable)

Analog 25 kHz: 80 dB

Spurious and Image Response Rejection 100 dB

Analog Audio Response +1, -3 dB from 6 dB per octave de-emphasis; 300–
3000 Hz referenced to 1000 Hz at line output

Analog Audio Distortion 3% or 5% (adjustable)

Analog FM Hum and Noise

12.5 kHz: 45 dB

25 kHz: 50 dB

Blocking Immunity 100 dB

Signal Displacement Bandwidth 1 kHz

Intermediate Frequencies

1st: 73.35 MHz

2nd: 2.16 MHz

Electronic Bandwidth 2.0 or 3.5 MHz

Conducted Spurious -57 dBm

Bit Error Rate Floor 0.01%

Table 33: Receiver RF Distribution System for GTR 8000 Expandable Site Subsystem for IV&D (UHF
450–512 MHz)

Receiver RF Distribution System Specfications

Frequency Range 450–512 MHz

Typical Limit

Noise Figure 4.6 dB 5.5 dB

Gain 10 dB –16 to 24 dB adjustable

3rd Order Output Intercept 19 dB

Amplifier Intercept 40 dBm
Table continued…
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Receiver RF Distribution System Specfications

Preselector Bandwidth 2 or 3.5 MHz

RF Input Connector Type N

RF Output Connector Type BNC

Table 34: FCC Identification for GTR 8000 Expandable Site Subsystem for IV&D (UHF R2, 435–524
MHz)

FCC Identification

Frequency Range Type Power Output Type Acceptance
Number

435–512 MHz Transmitter
2-110 W C4FM, FM
2-100 W LSM, H-DQPSK ABZ89FC4819B

435–524 MHz Receiver N/A ABZ89FR4820B

GTR 8000 Expandable Site Subsystem Industry Canada for Integrated
Voice and Data (UHF R2, 435–524 MHz)

Table 35: Industry Canada for GTR 8000 Expandable Site Subsystem for IV&D (UHF R2, 435–524
MHz)

IC Approval
Number Frequency Range Type Power Output IC Model Num-

ber

109AB-4819B Tx 450–470 MHz, Rx 450–470
MHz

C4FM, FM Variable 2-110 Watts
(average)

T7039–UHFR2B

109AB-4819B Tx 450–470 MHz, Rx 450–470
MHz

LSM, H-
DQPSK

Variable 2-100 Watts T7039–UHFR2B

Specifications for GTR 8000 Expandable Site Subsystem for
Integrated Voice and Data (VHF 136–174 MHz)

Table 36: General Specifications for GTR 8000 Expandable Site Subsystem for IV&D (VHF, 136–174
MHz)

General Specifications

Model Number T7054A or SQM01SUM7054A

Maximum Number of Channels 6

Height

Cabinet Version (Option CA00293AA): 84.8 in. (215 cm) 43 Rack Units

7.5 ft. Open Rack Version (Option X882AH): 90.4 in. (230 cm) 48 Rack Units

7 ft. Open Rack Version (Option CA01402AA): 84.3 in. (214 cm) 44 Rack Units

Footprint (W x D)

Cabinet Version (Option CA00293AA): 23.6 x 23.6 in. (60 x 60 cm)
Table continued…
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General Specifications

Open Rack Version (Option X882AH CA01402AA): 20.5 x 23.5 in. (52 x 60 cm)

Weight (fully configured without gateways)

Cabinet Version (Option CA00293AA): 495 lbs (255 kg)

Open Rack Version (Option X882AH CA01402AA): 430 lbs (195 kg)

Weight (fully configured with gateways)

Cabinet Version (Option CA00293AA): 540 lbs (275 kg)

Open Rack Version (Option X882AH CA01402AA): 475 lbs (215 kg)

Temperature Range*

Open Rack: -22 to 140 °F (-30 to 60 °C)

Cabinet without Doors: -22 to 140 °F (-30 to 60 °C)

Cabinet with Doors: -22 to 131 °F (-30 to 55 °C)

Temperature Range, Storage -40 to 185 °F (-40 to 85 °C)

Operating Altitude Up to 1800 meters (5900 ft.) above mean sea
level
Above 1800 meters (5900 ft.), the derating is 1.5
°C/km (0.8 °F/1000 ft.)

Maximum operational altitude is 5000 meters
(16900 ft.)

Power Supply Input AC: 90-264 VAC, 47-63 Hz
DC: 43.2–60 VDC

Power Consumption (without gateways)**

AC: C4FM, FM: 3070 W max.
H-DQPSK, LSM: 2530 W max.

DC: C4FM, FM: 2830 W max.
H-DQPSK, LSM: 2230 W max.

Power Consumption (with gateways)**

AC: C4FM, FM: 3190 W max.
H-DQPSK, LSM: 2650 W max.

DC: C4FM, FM: 2950 W max.
H-DQPSK, LSM: 2350 W max.

Power Supply Type Switching

Battery Revert Included

Input/Output Impedance 50 Ohms

Antenna Connector Types Tx: six N female
Rx: six BNC female

Channel Spacing 12.5/15/25/30 kHz

Frequency Stability (High Availability configuration) GPS locked or Aging:

Table continued…
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General Specifications

30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
Internal Reference (transceiver option card)

Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb

Frequency Stability
External Reference

TRAK

Frequency Generation Synthesized

* = If the cabinet or rack includes a site gateway for Analog/V.24 conventional channel interfaces, the
maximum operating temperature is 122 °F (50 °C) for an open rack and 113 °F (45 °C) for a cabinet
with doors.

** = AC power consumption values increase by 1200 W when the batteries are being charged.

Table 37: Transmitter Specifications for GTR 8000 Expandable Site Subsystem for IV&D (VHF, 136–
174 MHz)

Transmitter Specifications

Frequency Range 136–174 MHz

Average power output per channel* 2-100 W C4FM, FM
2-60 W H-DQPSK, LSM

Modulation Fidelity 5%

Spurious and Harmonic Emissions Attenuation 90 dB

Modulation C4FM, LSM, H-DQPSK, FM

Analog FM Hum and Noise

12.5 kHz: 45 dB

25 kHz: 50 dB

Analog Audio Distortion Less than 2% (1% typical) at 1000 Hz

Emissions Designators 8K70D1W, 8K70D1E, 8K70D1D, 8K10F1W,
8K10F1E, 8K10F1D, 9K80D7W, 9K80D7E,
9K80D7D, 16K0F3E, 11K0F3E, 16K0F1D,
10K0F1D

Adjacent Channel Power Ratio

12.5 kHz offset, 6 kHz BW: 67 dB

Intermodulation Attenuation 55 dB

* Full transmitter output power is available during battery revert at the junction panel.

6871022P87-C
Chapter 1:  GTR 8000 Expandable Site Subsystem Description

90  Send Feedback

http://docsurvey.motorolasolutions.com


Table 38: Receiver Specifications for GTR 8000 Expandable Site Subsystem for IV&D (VHF, 136–174
MHz)

Receiver Specifications

Frequency Range 136–174 MHz

Modulation C4FM, H-CPM, FM

Analog Sensitivity (12 dB SINAD)

12.5/15 kHz: -118 dBm

25/30 kHz: -117 dBm

Digital Sensitivity 5% Bit Error Rate Static (BER)

C4FM: -118 dBm

H-CPM: -116 dBm

Faded Sensitivity 5% Bit Error Rate (BER)

C4FM: -110 dBm

Intermodulation Rejection 85 dB

Digital Adjacent Channel Rejection 60 dB

Analog Adjacent Channel Rejection (EIA603) Ana-
log 12.5 kHz

75 dB

Analog Adjacent Channel Rejection (TIA603D)

Analog 12.5 kHz: 50 or 60 dB (adjustable

Analog 25 kHz: 80 dB

Spurious and Image Response Rejection 90 dB

Analog Audio Response +1, -3 dB from 6 dB per octave de-emphasis; 300–
3000 Hz referenced to 1000 Hz at line output

Analog Audio Distortion 3% or 5% (adjustable)

Analog FM Hum and Noise

12.5 kHz: 45 dB

25 kHz: 50 dB

Blocking Immunity 100 dB

Signal Displacement Bandwidth 1 kHz

Intermediate Frequencies

1st: 44.85 MHz

2nd: 2.16 MHz

Electronic Bandwidth Full Bandwidth

Conducted Spurious -57 dBm

Bit Error Rate Floor 0.01%
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Table 39: FCC Identification for GTR 8000 Expandable Site Subsystem for IV&D (VHF, 136–174 MHz)

FCC Identification

Frequency Range Type Power Output Type Acceptance
Number

136–174 MHz Transmitter
2-100 W C4FM, FM
2-60 W LSM, H-DQPSK ABZ89FC3790B

136–174 MHz Receiver N/A ABZ89FR3791B

GTR 8000 Expandable Site Subsystem Industry Canada for Integrated
Voice and Data (VHF 136–174 MHz)

Table 40: Industry Canada for GTR 8000 Expandable Site Subsystem for IV&D (VHF 136–174 MHz)

IC Approval
Number Frequency Range Type Power Output IC Model

Number

109AB-3790B Tx 138–174 MHz, Rx 138–174 MHz C4FM, FM Variable 2–100 Watts T7039–VHFB

109AB-3790B Tx 138–174 MHz, Rx 138–174 MHz LSM, H-DQPSK Variable 2–60 Watts T7039–VHFB

Specifications for the GCP 8000 Site Controller and GPB 8000
Reference Distribution Module

Table 41: GCP 8000 Site Controller and GPB 8000 Reference Distribution Module Technical and
Environmental Specifications

General Specifications

Temperature

Operating temperature: -30 to 60 °C (-22 to 140 °F)

Storage temperature: -40 to 85 °C (-40 to 185 °F)

Relative humidity 90% relative humidity at 50 °C non-condensing

Input supply voltage See the individual frequency bands for the GTR 8000 Expanda-
ble Site Subsystem specifications

Power consumption See the individual frequency bands for the GTR 8000 Expanda-
ble Site Subsystem specifications

Operating altitude Up to 5,000 m (16,400 ft) above mean sea level

Frequency Stability GPS locked or Aging:
30 ppb/yr
100 ppb/5yr
Temperature: 40 ppb
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Specifications for the Expansion Hub

Table 42: Expansion Hub Technical and Environmental Specifications

XHubs Specifications

Temperature

Operating temperature: -30 to 60 °C (-22 to 140 °F)

Storage temperature: -40 to 85 °C (-40 to 185 °F)

Relative Humidity: 90% relative humidity at 50 °C (122 °F) non-condensing

Input Supply Voltage: See the individual frequency bands for the GTR 8000 Expanda-
ble Site Subsystem specifications

Power Consumption: See the individual frequency bands for the GTR 8000 Expanda-
ble Site Subsystem specifications

Operating Altitude: Up to 5,000 m (16,400 ft) above mean sea level

GPS Unit Cable Length Specifications
The GPS units used with the GPB 8000 Reference Distribution Modules in the high availability
configuration includes the antenna and a receiver/modem. The actual receiver is integrated with the
antenna and the connection between the GPS unit and the RDM is a 6-pair twisted pair cable.

See GPS Unit Cable Length Delay Offset Calibration on page 287 for determining the delay offset to
be programmed in the GPS unit.

Receive Expansion Cable Length Specifications
The receive expansion cables connect the Expansion Cabinets and are not provided. Cable length is
not critical; however, maintain the lengths within ±50% of the values listed in the table to achieve a
good balance between all receivers. A nominal loss of 1 dB is recommended.

Table 43: GTR 8000 Receive Expansion Cable Length Specifications

Cable Type Length (ft) Length (m)

EnviroFlex™ EF142 6.6 2

1/4” Superflex or equivalent 19 5.8

3/8” Superflex or equivalent 28 8.5

1/2” Superflex or equivalent 31 9.5

GCP 8000 Site Controller Port Default Speed/Duplex Settings

Table 44: GCP 8000 Site Controller Port Default Speed/Duplex Settings

Switch Port Speed/Duplex

Net/Aux Auto-Negotiate

Site Controller Expansion 1 100BaseT/Full Duplex

Site Controller Expansion 2 100BaseT/Full Duplex
Table continued…
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Switch Port Speed/Duplex

Site Controller Expansion 3 100BaseT/Full Duplex

Site Controller Expansion 4 100BaseT/Full Duplex

Site Controller Expansion 5 100BaseT/Full Duplex

Service Port Auto-Negotiate

Gateway Port 100BaseT/Full Duplex

SC to Base Radio 1 100BaseT/Full Duplex

SC to Base Radio 2 100BaseT/Full Duplex

SC to Base Radio 3 100BaseT/Full Duplex

SC to Base Radio 4 100BaseT/Full Duplex

SC to Base Radio 5 100BaseT/Full Duplex

SC to Base Radio 6 100BaseT/Full Duplex

Alarm Auto-Negotiate

XHub Port Default Speed/Duplex Settings

Table 45: XHub Port Default Speed/Duplex

Switch Port Speed/Duplex

Base Radio 1 100BaseT/Full Duplex

Base Radio 2 100BaseT/Full Duplex

Base Radio 3 100BaseT/Full Duplex

Base Radio 4 100BaseT/Full Duplex

Base Radio 5 100BaseT/Full Duplex

Base Radio 6 100BaseT/Full Duplex

Alarm Auto-Negotiate

Site Controller Expansion 100BaseT/Full Duplex

Net Aux Auto-Negotiate

GPB 8000 Reference Distribution Module Port Default Speed/
Duplex Settings

Table 46: GPB 8000 Reference Distribution Module Port Default Speed/Duplex Settings

RDM Port Speed/Duplex

Net/Aux Auto-Negotiate

RDM Expansion 1 100BaseT/Full Duplex

RDM Expansion 2 100BaseT/Full Duplex

RDM Expansion 3 100BaseT/Full Duplex
Table continued…
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RDM Port Speed/Duplex

RDM Expansion 4 100BaseT/Full Duplex

RDM Expansion 5 100BaseT/Full Duplex

Service Port Auto-Negotiate

Router 100BaseT/Full Duplex

Base Radio 1 100BaseT/Full Duplex

Base Radio 2 100BaseT/Full Duplex

Base Radio 3 100BaseT/Full Duplex

Base Radio 4 100BaseT/Full Duplex

Base Radio 5 100BaseT/Full Duplex

Base Radio 6 100BaseT/Full Duplex

Alarm Auto-Negotiate
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Chapter 2

GTR 8000 Expandable Site Subsystem
Theory of Operations
This chapter explains how the GTR 8000 Expandable Site Subsystem works in the context of your
system.

For an understanding of the way the GTR 8000 Expandable Site Subsystem components contribute to
a system, review the modules that provide the GTR 8000 Expandable Site Subsystem functionality, the
modules that provide RF distribution functionality (RFDS), and the modules that connect GTR 8000
Expandable Site Subsystems to the rest of the site (backplanes and junction panels).

Functions of the GTR 8000 Expandable Site Subsystem
Modules
The following lists the GTR 8000 Expandable Site Subsystem modules:

• GTR 8000 Base Radio Transceiver (XCVR) module (with or without a transceiver option card)

• Power amplifier module

• Fan module

• Power supply module

• RFDS (transmit and receive) modules

• GCP 8000 Site Controller Module (ASTRO® repeater, ASTRO® 25 Express, or HPD site)

• Expansion Hub Module

• GPB 8000 Reference Distribution Module

• GGM 8000 Gateway

Function of the Transceiver Module
The transceiver module provides the control, exciter, receiver, and optional transceiver option card for
the base radio.

Figure 18: Transceiver Module (Front View)

The transceiver generates the station reference, which typically must be locked on to one of many
possible external sources. The external source can be either the site controller TDM clocks or the
external reference operating at 5 MHz or 10 MHz.

The transceiver SPI bus allows communication with its receiver and exciter circuitry, as well as the
power supply module and power amplifier module.
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Two or three circuit boards in the transceiver are:

Transceiver Control Board
Performs the control management, digital signal processing, and transmit and receive data
formatting for the base radio.

Transceiver RF Board
Contains DC power conversion/regulation and performs receiver and exciter functions.

Transceiver Option Card
An optional board that attaches to the control board. Provides an internal 10 MHz frequency
reference. For conventional operation, it also provides the analog interfaces and WildCard I/Os.
The transceiver option card requires an internal frequency reference oscillator alignment at different
intervals mandated by its category and frequency band. See Base Radio Service Help > Service
Screens > Alignment Screens in the CSS Online Help for the alignment procedures and mandated
intervals.
The transceiver option card is available in two categories:

• OCXO (Oven Controlled Crystal Oscillator) – operates at 0.1 ppm and is inclusive to
temperature and aging. The OCXO Transceiver Option Card is available in 700/800 MHz, UHF
R1/R2, and VHF frequency bands.

• TCXO (Temperature Compensated Crystal Oscillator) – operates at 1.5 ppm, of which 0.5
ppm is allocated to temperature, and 1.0 ppm is allocated to aging. Reference precision with the
TCXO is traded for lower power consumption. The TCXO mandates shorter maintenance
intervals. The TCXO transceiver option card is available in UHF R1/R2 frequency bands. The
TXCO is only available for non-simulcast conventional systems.

Transceiver Control Board

The main operating software for the base radio is loaded in the XCVRs control section. As the main
manager for the base radio, the XCVR control board provides operational control over the other station
modules. It handles three types of information flow, in the following ways:

• Serves as a gateway between the network and RF functionality, by distributing the RF payload to
and from the network.

• Supports operational and diagnostic functions with digital control data (for example: site information,
channel assignments, and identification numbers for call processing).

• Ensures the flow of other network management configuration information.

Figure 19: Transceiver Control Board Information Flow on page 98 shows the information flow
through the transceiver control and RF sections for trunked and conventional operation.

Figure 19: Transceiver Control Board Information Flow
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Transceiver RF Board 

In addition to DC power conversion/regulation, the XCVR RF board provides circuitry for the following
exciter and receiver functions.

Exciter 

The exciter on the XCVR RF board provides the transmitter functions for the base radio. The exciter
circuitry generates a low-level, modulated RF signal that passes to the power amplifier. It supports
various modulation types as well as bandwidths up to 25 kHz, through software programming.

The exciter also provides a controlled output power level to the power amplifier.

Receiver 
The receiver provides either single receiver input or dual (HPD or TDMA) receiver inputs for dual
diversity. The receiver also provides enhanced diagnostic capabilities using an on board noise source
generator. It includes a wide tuning range (electronic varactor-tuned) preselector. The preselector is
electronically tuned to the desired receive frequency anywhere between 792–825 MHz, 896–902 MHz,
UHF R1 380–435 MHz, UHF R2 435–524 MHz, or VHF 136–174 MHz.

Transceiver External Interfaces
The transceiver external interfaces include seven external ports, a switch, and LEDs. If a transceiver
option card is part of the transceiver, there are four additional external ports. See Front Transceiver
Ports on page 167 for the port connections. See LEDs on page 429 for information on the LEDs.

Transceiver Switch

The multifunction RESET switch on the front of the transceiver module is accessible through the drop-
down door to the left of the fans. The RESET switch has two functions:

Figure 20: Transceiver RESET Switch (viewable through the drop-down door)

Table 47: Transceiver Front RESET Switch Functions

User Action Result

Press switch for less than 1 second Toggles between Tx Inhibit and Tx Enable (LED 3
blinks amber)

Press switch for more than 3 seconds, then release Transceiver Control Module Reset
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Transceiver Option Card Intercom Button

The intercom button on the front of the transceiver option card is accessible behind the fan module.
Pressing the intercom button toggles the intercom function between the ON and OFF states.

Figure 21: Transceiver Option Card Intercom Button (behind the fan module)

Transceiver Ports (Rear)
The transceiver interconnects to the backplane using a 120-pin HVDML digital connector and 8-pack
RF connector, as shown in the figure. These connections handle multiple signals including power
supply communications, power amplifier communications, fan interface, and peripheral interface. The
digital connection receives alarm data and the site controller or RDM Time Division Multiplexing (TDM)
signals, which are used to pass reference and control data to the base radio.

The site controllers, RDMs, XHubs, and transceivers connect directly through a common backplane.
The backplane connects the transceiver RF inputs with the associated receive multicouplers (Cabinet
RMCs/LNAs).

Figure 22: Transceiver Module (Backplane Connections)

Function of the Power Amplifier Module

The Power Amplifier (PA) is a forced convection-cooled RF power amplifier. It accepts a low-level
modulated RF signal from the transceiver module, and amplifies it for transmission through the site
transmit antenna. To complete the Cartesian correction loop (linearization method), the PA provides a
low-level RF feedback signal to the transceiver module to achieve the required transmitter linearity.

Transmit power output is set using Configuration/Service Software (CSS). See Configuring Tx Power
Values and Battery Type on page 277 in the Configuration chapter.

The power amplifier also performs functions related to the fan module, including reporting of the fan
module status and supplying power to the fan power bus.
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Figure 23: Power Amplifier Module

The power amplifier is comprised of six internal modules:

• Core Board

• Converter Board

• Driver Amplifier Board

• Final Amplifier Board

• Distribution Board

• Output Circuitry

Power Amplifier Input/Output Connections
There are three electrical connection assemblies on the power amplifier:

• RF output (front QN quick-N connector) on the front of the power amplifier module, which is cabled
to the RFDS combiner transmit connector.

• DC power supply/control signal (backplane connection)

• RF input/feedback (backplane connection).

Figure 24: Power Amplifier (Backplane Connections)
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Function of the Fan Module
The fan module provides intermittent forced air cooling for the power amplifier, transceiver, site
controller, or RDM modules. The fan module houses two 119 mm axial fans which deliver a total of
approximately 160 cubic feet per minute of airflow. Nominal fan speed is 4100 revolutions per minute.
A thermostat behind the fan module controls each fan. If the fan speed for either fan falls below 30% of
the rated speed, a built-in speed sensor on each fan turns on the red Fan Alarm LED. In addition, the
power amplifiers always turn on the fan during any transmission.

If the fan module is used for the Power Efficiency Package, the fan holdover time (length of time the
base radio fan stays ON after transmission) can be configured in the CSS.

The fan module connects to the power amplifiers, transceivers, site controllers, or RDMs through a 4-
pin port.

NOTICE: The power supply module has its own fan which provides independent airflow.

Figure 25: Fan Module

Function of the Power Supply
The power supply operates from either an AC or DC input and provides the DC operating voltage for
the equipment in the cabinet/rack. However the power supply prioritizes an AC source (if present) over
a DC source.
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Figure 26: Power Supply

NOTICE: If the power supply module is used for the Power Efficiency Package, the power
supply must be used in DC only mode.

When operating from an AC source (90 to 264 VAC, 47-63 Hz), the supply generates two DC output
voltages of 29 V with respect to output ground. The power supply automatically adjusts to AC input
ranges and supplies a steady output.

In AC mode, the power supply provides a separate battery charger which can be used to maintain the
charge on a 48 VDC nominal system, positive or negative ground, if installed. The supply generates
two DC output voltages of 29 V with respect to output ground, when operating from a DC source (43.2
VDC to 60 VDC maximum, positive or negative ground. This voltage limit includes consideration of the
battery charging "float voltage" associated with the intended supply system, regardless of the marked
power rating of the equipment. Whether in AC, Battery Revert, or DC Only mode, at a voltage of 42 V
or lower, the power supply shuts down in order to not damage any connected battery bank. Once this
condition occurs, the power supply starts only after the applied voltage exceeds 45 V.

The battery charger is not usable when operating from a DC input power source. This DC source must
be located in the same building as the base radio / repeater, and it must meet the requirements of a
SELV circuit.

The power supply contains several switching-type power supply circuits as follows:

• Power factor correction circuitry

• Battery charging circuitry

• Diagnostics and monitoring circuitry

The battery charger outputs of the power supply are bussed together so that up to six power supplies
can provide charging services to a single battery bank.

The power supply controls its own continuously running fan, changing its speed to fast, or slow as
needed.

NOTICE: If the power supply module is used for the Power Efficiency Package, the power
supply fan does not run below a 40 °C air inlet temperature in DC mode with the transmitter in a
de-keyed state.
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AC/DC Power Distribution
As with the power supply, the power distribution prioritizes an AC source (if present) over a DC source.
The main DC output from each power supply feeds a power amplifier/transceiver (PA/transceiver)
combination. The Auxiliary outputs of up to three Power Supplies are bussed together to provide an
Aux DC bus, used as a redundant power source for site critical components (including site controllers).
This auxiliary power bus ensures that the site controllers can continue to operate if a power supply fails
or is removed and replaced.

Figure 27: AC and DC Power Distribution in the GTR 8000 Expandable Site Subsystem

For additional information about power distribution in the GTR 8000 Expandable Site Subsystem, see
the following sections:

• AC/DC Power Distribution Module on page 112

• Backplanes and Card Cages on page 115
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Power Supply Battery Charger
The power supply includes an integrated battery charger. The battery charger is controlled entirely
through software on the associated base radio. Software contains the information on supported battery
types and obtains user-specific information pertaining to the particular site. The base radio software
receives battery bus voltage and battery temperature information from the power supply and uses
these variables with supported battery charging profiles to return a signal which sets the charger output
voltage appropriately. The battery charge and temperature conditions may be viewed through
Configuration/Service Software (CSS) or through alarms to Unified Event Manager.

The maximum charging current available from the integrated charger is 3A (48 VDC nominal system).
Motorola recommends that a battery with a capacity of no larger than 60A-hr is connected to a single
charger to ensure that the charger maintains an adequate state-of-charge on the backup battery, and
that the backup battery is restored to full capacity within a reasonable amount of time following
operation on battery backup power.

In addition to standard sealed lead-acid batteries (valve-regulated lead acid or gel cells), the GTR 8000
Expandable Site Subsystem supports charging of vented lead-acid and NiCd batteries.

In the Expandable Site Subsystem, up to six power supplies operate from a single battery backup
system. The combined battery charger outputs enable the system to maintain the state of charge on a
larger battery bank than a single charger could maintain (300A-hr for five combined battery charger
outputs or 360A-hr for six combined battery charger outputs).

Battery Temperature Sensor Cable

The integrated charger in the power supply performs temperature compensated battery charging when
a temperature sensor is connected. If the sensor is disconnected, the charger continues to operate as
an uncompensated charger with the charging profile following the minimum charger voltage specified
by the battery manufacturer.

Included is a 40 ft battery temperature sensor cable, which attaches to a battery pack, supplied by your
organization, and to the backplane of the device. This three-wire cable carries a voltage signal to the
power supply from the sensor element, which must be mounted close to the storage battery. Voltage is
proportional to the battery temperature, and the diagnostic circuitry in the power supply module. This
cable is extended to a total length of 190 ft using 50 ft extensions. See Battery Temperature Sensor
Mounting on page 151.

IMPORTANT: Continuous operation with a disconnected sensor is not recommended.

ON/OFF Switch for Power Supply and Battery Charger

This table identifies the switch states for the power supply and battery charger.

Table 48: ON/OFF Switch - States for Power Supply and Battery Charger

Switch Position Power Supply State Battery Charger State

ON (1) • Power Factor Correction
(PFC) section is active (AC in-
put only)

• Main DC converter runs to
create the MAIN and AUX DC
outputs

Can be started if desired (AC
input only)

Table continued…
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Switch Position Power Supply State Battery Charger State

OFF (0) • Main DC converter is turned
OFF and the MAIN and AUX
DC outputs become 0.0 VDC

Disabled (AC input only)

Power Supply Module - Backplane Connections

Table 49: GTR 8000 Power Supply Module Backplane Connections

Port/Type Description

AC Input only

Battery / DC
Power and Con-
trol Signal

48 VDC:
• Provides the DC input to the power supply when operating from a DC source.

• Connects the charger output to the standby battery when operating from an AC in-
put with a standby DC battery.

29 VDC:
• Provides the Main outputs of the power supply for use by the power amplifier and

transceiver.

• Provides the Aux DC outputs of the power supply for use by site controller, XHub,
RDM, integrated site gateway, Rx multicoupler, power monitor unit (PMU), and hy-
brid combiner fan module.

Other signals handled by this connector include control interface and battery tempera-
ture interface.

Figure 28: Power Supply Connections (Rear)

Function of the GCP 8000 Site Controller
See “GCP 8000 Site Controller Functions” in the GCP 8000 Site Controller manual for functions of the
site controller used in a GTR 8000 Expandable Site Subsystem at an HPD, ASTRO® 25 repeater site,
or ASTRO® 25 Express site.
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Function of the GPB 8000 Reference Distribution Module (IP
Simulcast with High Availability)
Each GPB 8000 Reference Distribution Module (RDM) provides integrated Ethernet LAN switching and
integrated site reference distribution to the base radios, ensuring that a single point of failure in the
reference or switch does not cause the loss of any channels at the site.

Integrated Ethernet LAN Switches
Both RDMs maintain a built-in Ethernet LAN switch providing each base radio at the site with two
Ethernet LAN switch connections. The base radios determine which switch to use based on the
condition of the RDMs.

Network Time Protocol Sources
Network Time Protocol (NTP) provides a clock synchronization mechanism to the RDMs and other
NTP clients at the site. In a high-availability configuration, the NTP clients must use the TRAK 9100
Simulcast Site Reference (SSR), at the prime site, as the primary time source; and an ntp02.zoneN
device at a zone core as the secondary time source. The RDMs at the site also act as an NTP time
source. The base radios use RDM A as the primary NTP time source, and use RDM B as the
secondary NTP time source.

Dual GPS Unit Function
Each RDM has a connected GPS unit that provides the necessary references to either of the RDMs. A
high-stability ovenized crystal oscillator within the RDMs train to the GPS units. The RDMs then
generate the output time reference to the base radios. Both GPS units are active and provide
protection against a single GPS unit failure/interference at the site.

The CSS indicates whether the GPS capability is configured. The RDMs indicate the alarms for GPS
service to Unified Event Manager (UEM) and MOSCAD Network Fault Management (NFM).

Time Synchronization and Frequency Reference Function
The RDMs provide a 1PPS and 10 MHz reference signaling to the base radios. The time reference
synchronizes the transmissions from the base radios, and the high-stability frequency reference
provides a reference for both the transmit and receive frequency synthesizers in the base radios. The
time and frequency reference is supplied from a high-stability ovenized crystal oscillator within the
RDMs to the base radios through the backplanes of the GTR 8000 Expandable Site Subsystem.

Function of the GPB 8000 Reference Distribution Module (Trunked
3600 IntelliRepeater)
Each GPB 8000 Reference Distribution Module (RDM) provides integrated Ethernet LAN switching and
integrated site reference distribution to the base radios, ensuring that a single point of failure in the
reference or switch does not cause the loss of any channels at the site.

Integrated Ethernet LAN Switches
Both RDMs maintain a built-in Ethernet LAN switch providing each base radio at the site with two
Ethernet LAN switch connections. The base radios determine which switch to use based on the
condition of the RDMs.

Network Time Protocol (NTP) Sources
The RDMs at the site act as the Network Time Protocol (NTP) time source for time-stamping FM
events. The base radios use RDM A as the primary NTP time source, and use RDM B as the
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secondary NTP time source. The IP addresses of the RDMs are used as the primary and secondary
NTP server, and are configured into the base radios.

Time Synchronization and Frequency Reference Function
The RDMs provide a 1PPS and 10 MHz reference signaling to the base radios. The time reference
synchronizes the transmissions from the base radios, and the high stability frequency reference
provides a reference for both the transmit and receive frequency synthesizers in the base radios. The
time and frequency reference is supplied from a high-stability ovenized crystal oscillator within the
RDMs to the base radios through the backplanes of the GTR 8000 Expandable Site Subsystem.

Function of the Expansion Hubs
The XHub has three modes of operation:

Normal Mode
The XHub extends the switching and interface capabilities of the GCP 8000 Site Controllers or GPB
8000 Reference Distribution Modules (RDMs) in an expansion cabinet/rack. In normal mode, the
site controller or RDM configures the Ethernet switch.

Impaired Normal Mode
Occurs when one of the links between the site controller or RDM and the XHub is lost. The other
XHub remains active to pass the traffic.

Standalone Mode
Requires External 5 MHz and 1PPS, either as separate signals or as one combined 5 MHz/1PPS
signal. 1PPS generates the 5 MHz frequency reference for the base radios even if it is not used by
the base radio. For example: Analog Simulcast.

The XHubs at a repeater site are redundant and are required to support system expansion in
configurations with redundant site controllers. Redundant XHubs within each expansion cabinet/rack
share many common external interfaces. A hardware mechanism ensures that only one XHub drives
these interfaces at a given time.

The XHubs at a simulcast subsystem are both active and are required to support system expansion
with or without RDMs. Both XHubs within each expansion cabinet/rack drive the common external
interfaces.

The XHub supports these features:

• XHub Control circuitry:

- Six circuit links to base radios (backplane)

- One circuit link to the front panel of the site controller or RDM

- Power Supply monitoring and control through the remote SPI bus (backplane)

- Fan detection, control, and alarm

- Front-panel LEDs

• A 10/100/1000 Base-T Ethernet switch supporting the following LAN interfaces:

- Six 10/100Base-T Packet base radio interfaces (backplane)

- One 10/100Base-T Packet site controller or RDM interface (front panel)

- One 10/100/1000 Base-T interface (front panel)

- One 10/100Base-T interface for future use (backplane)

• Integrated Alarm Circuitry supports the following alarm interfaces:

- Fifteen Single-ended, opto-isolated, internal cabinet/rack alarm inputs

- Nine Single-ended, opto-isolated, external customer alarm inputs
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- Three Opto-isolated, external customer alarm inputs with isolated grounds

- One Opto-isolated, internal cabinet alarm input with isolated ground

- Four Analog inputs

- Two Relay outputs

Junction Panels
The junction panels for the GTR 8000 Expandable Site Subsystem provide locations for all the
connections to external devices. Locations for receive (Rx) and transmit (Tx) connectors are integrated
in the junction panel in the lower center position as shown in Figure 29: Junction Panel with Primary
Subpanel #1 on page 109.

Figure 29: Junction Panel with Primary Subpanel #1

All other connector locations are provided through additional subpanels. These subpanels include:

NOTICE: The following panels may not be included in your configuration. For details, see the
site manual for your site.

• Primary Subpanel #1, shown at the top right in Figure 29: Junction Panel with Primary Subpanel #1
on page 109. Included when site controllers or RDMs are installed in the cabinet/rack. Connections
are Internal Alarm, Gateway, Network AUX, Remote GPS A, Remote GPS B, Battery Temp,
External Frequency Reference, and 1PPS.

• Network Expansion Subpanel. Included when site controllers or RDMs are installed in the cabinet/
rack. Connections are two LAN links to each of five Expansion cabinets/racks and ten RJ-45
connections.
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Figure 30: Network Expansion Subpanel

• Primary Subpanel #2. Included when the cabinet has XHubs that are used in a trunked simulcast
standard configuration, trunked 3600 simulcast subsystem, or conventional system. Connections
are Internal Alarm, LAN, External Frequency Reference, 1 PPS, and Battery Temp.

Figure 31: Primary Subpanel #2

• Rx Expansion Subpanel. This subpanel is provided only if the GTR 8000 Expandable Site
Subsystem includes the CA00862AA (Site RMC) option. Connections are three RX branches to
three Expansion cabinets, and nine BNC connectors. See Site Receive Multicouplers/Low Noise
Amplifiers (Site RMCs/LNAs) on page 124.

Figure 32: Rx Expansion Subpanel

• Expansion Subpanel #1. This subpanel is provided only if the GTR 8000 Expandable Site
Subsystem includes the CA01536AA option when XHubs are installed in Expansion cabinets/racks
for a repeater site, trunked IP simulcast with high availability configuration, trunked 3600
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IntelliRepeater, or conventional overlay. Connections are Internal Alarm, LAN Input, Network AUX,
and Battery Temp.

Figure 33: Expansion Subpanel #1

• Circuit Audio Subpanel. Included to allow the connection of V.24, analog wireline, or optional
WildCard I/O when the cabinet/rack has conventional base radios or integrated CCGWs, or for a
trunked 3600 system for connection of circuit audio, ASYNC RS-232 and optional I/O. Connections
are thirteen RJ-45 connectors – six V.24, six wirelines, and one ASYNC.

Figure 34: Circuit Audio Subpanel

Circuit Audio

GTR8000_Circuit_Audio

ASYNC

V.24

WIRELINE

1 2 3 4 5 6

1 2 3 4 5 6

• Six Receiver Input Subpanel. The six receiver input subpanel is used on a VHF and UHF R1
cabinet/rack. VHF and UHF R1 use a Pass Through RMC module. Connections are six BNC female
connectors, one for each receiver input.

Figure 35: Six Receiver Input Subpanel

• Six Transmit Output Subpanel. The six transmit output subpanel is used on a VHF and UHF R1
cabinet/rack. Also used when a cavity combiner is not included in the cabinet/rack for an 800 MHz,
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900 MHz, and UHF R2 cabinet/rack. Connects from a PA output or to a Tx combiner. Connections
are six N-type connectors, one for each transmit output.

Figure 36: Six Transmit Output Subpanel

• 3600 Simulcast Subpanel. The 3600 simulcast subpanel is used for 3600 simulcast systems and
has six RJ-45 connections for analog voice to the DSM and six DB-25 connections to the remote
site controller.

Figure 37: 3600 Simulcast Subpanel

TRUNKING CONTROL

DSM

1 2 3 4 5 6

GTR8000_3600_simulcast_subpanel_A

Cables provided by Motorola include the specific connectors required by the junction panel on one end
and the subsystem equipment on the other end. For the types of connections at the junction panel, see 
Junction Panel Connections on page 181.

AC/DC Power Distribution Module
The power distribution module located with the junction panel provides connections for customer-
provided AC and DC inputs. One or two DC inputs can be connected to the DC section of the power
distribution module. For each power supply, there must be a single, separate AC source with the
proper power rating connected to the appropriate terminals in the AC section, where it is then fed to the
corresponding AC power supply input.

The number of outputs from the power distribution module depends on the configuration purchased:

• For HPD GTR 8000 Expandable Site Subsystems: Up to five AC outputs from the AC section of
the power distribution module are connected to the power supply through the power supply
backplane.

• For Trunked IV&D and Conventional GTR 8000 Expandable Site Subsystems: Up to six AC
outputs from the AC section of the power distribution module are connected to the power supply
through the power supply backplane.
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For additional information about power distribution in GTR 8000 Expandable Site Subsystem, see the
following sections:

• AC/DC Power Distribution on page 104

• Backplanes and Card Cages on page 115

Figure 38: AC/DC Power Distribution Module in GTR 8000 Expandable Site Subsystem (Cabinet
Version - Side View)

Figure 39: AC/DC Power Distribution Module in GTR 8000 Expandable Site Subsystem (Cabinet
Version - Top View)

Figure 40: AC/DC Power Distribution Module (Access Panel Removed)

In the AC distribution block of the power distribution module:
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• L indicates Line or Hot AC power feed.

• N indicates Neutral AC power feed.

• Input cable ground wires should be terminated to the ground bus bar.

Figure 41: Power Distribution Module–AC Distribution Block Diagram

Battery Pack Splitting
The GTR 8000 Expandable Site Subsystem is designed to receive DC power from a single DC source.
The power distribution module at the junction panel is shipped with the DC busses interconnected to
ensure that the single source is available for all power supplies contained within the subsystem. Two
sets of DC input terminals are provided to reduce the current supplied through any one set of DC input
cables to a value within the rating of the DC cables maximum size (2 AWG).

The jumpers can be removed if you are providing two DC inputs from separate sources.

NOTICE: Each DC input termination is rated for a maximum of 108A.

If only one DC power source is connected, the jumpers must be in place to provide DC power to the
entire subsystem. The power distribution module has six AC output cables, not the three as shown in
this figure).
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Figure 42: AC/DC Power Distribution Module with Jumper Bars in Place

Removing the DC Bus Bars in a Power Distribution Module
If operation with a split DC bus is desired, the DC jumpers can be easily removed from the bus bars by
performing the following procedure:

CAUTION: Potentially hazardous voltages are present in the power distribution panel. Input
power sources should be de-energized before removing access covers. If input power cannot
be de-energized at the source, this procedure should only be performed by properly trained
service personnel using appropriate safety precautions for working on energized equipment.

NOTICE: Your organization should consider the impacts on system availability when operating
with a split DC bus.

Prerequisites:
This procedure assumes the following service access clearances:

• At least 2 ft access at the rear of the cabinet or rack, or

• At least 2 ft access on one side of the cabinet or rack, and at least 6 inches at the rear of the
cabinet or rack

Procedure:
1 Locate the access cover on the junction panel power distribution module (accessible from the

rear of the cabinet or rack, immediately below the AC power output cables).

2 Remove the access cover by removing the two retaining screws.

3 Remove the two screws that secure each jumper to the bus bars.

4 Carefully remove each jumper from the assembly.

5 Retain the jumpers and screws in a secure location in case jumper reinstallation is needed at a
later date.

6 Reinstall the cover plate removed in step 1.

Backplanes and Card Cages
Card cages for the GTR 8000 Expandable Site Subsystem are created with a welded and riveted
design. Each card cage has a backplane. The GTR 8000 Expandable Site Subsystem backplane is
pre-cabled when the system is delivered. For connections, see the following:
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• GTR 8000 Expandable Site Subsystem Backplane Connections for HPD on page 155.

• GTR 8000 Expandable Site Subsystem Backplane Connections for an ASTRO 25 Repeater Site on
page 157.

• GTR 8000 Expandable Site Subsystem Backplane Connections for IP Simulcast Remote Sites on
page 159.

• GTR 8000 Expandable Site Subsystem Backplane Connections for ASTRO 25 Express System on
page 161

• GTR 8000 Expandable Site Subsystem Backplane Connections for a Trunked 3600 IntelliRepeater
Site on page 163

• GTR 8000 Expandable Site Subsystem Backplane Connections for Trunked 3600 Simulcast
Remote Sites on page 165

RFDS Modules
The Radio Frequency Distribution System (RFDS) equipment included in your subsystem depends on
what options were purchased from Motorola. The following lists all RFDS equipment available for the
GTR 8000 Expandable Site Subsystem.

RFDS - Duplexer (900 MHz)
The 900 MHz duplexer cleans up transmit signals (Tx) by removing any remaining noise in the receive
(Rx) sub-band between the hybrid combiner and the (Tx/Rx) antenna.

Figure 43: Duplexer (900 MHz) (Standalone Shown)

The duplexer also provides a first level of band pass filtering for inbound RF signals (Rx). It rejects
unwanted signals including the transmitter signals from over loading the receiver multi-coupler and
receivers.

6871022P87-C
Chapter 2:  GTR 8000 Expandable Site Subsystem Theory of Operations

116  Send Feedback

http://docsurvey.motorolasolutions.com


The duplexer is mounted on a tray which has an additional mounting location for dual duplexer
applications. Dual duplexer applications can include one or two transmit and/or receive paths. Two
transmit paths allow for greater outbound coverage by placing two or three hybrid-combined carriers on
each path instead of all carriers on one path. Two receive paths allow for improved receiver
performance via receiver diversity.

Table 50: 900 MHz Duplexer Module Descriptions

Duplexer Type Description

Duplexer Tray A single duplexer mounted on a tray. It is used for both Rx and Tx filtering in
concert with hybrid combining and single branch receive.

Dual Duplexer Two duplexers mounted on a tray. In some configurations, each duplexer
can be used for separate Rx and Tx filtering. Other configurations can be a
combination of two branch receive and/or two hybrid-combined transmit
paths.

Standalone Duplexer A single duplexer that can be used for site alterations such as the addition of
a second receive branch, splitting of Rx and Tx paths, or adding a second
transmit path.

RFDS - Hybrid Combiner (900 MHz)
The hybrid combiner prepares output signals from all the RF carriers in the GTR 8000 Expandable Site
Subsystem for transmission on a single antenna. The hybrid combiner can be set up in one of seven
combining configurations for two carriers through six carriers and/or one or two antennas. Three
unique combining modules are arranged in such a manner that provides optimal performance.

Table 51: Hybrid Combiner Module Descriptions

Module Description

Hybrid Module, 1/2 – 1/2 This symmetric module equally passes two RF inputs. It is used in all
combiner configurations from 2-way through 6-way combining.

Hybrid Module, 2/3 – 1/3 This asymmetric module passes two RF inputs with one input having two
times the insertion loss of the other input. It is used in 3-way, 5-way, and 6-
way combining.

Hybrid Module, 3/5 – 2/5 This asymmetric module also passes two RF inputs with one input having
50% more insertion loss than the other input. It is used only in 5-way com-
bining.

Blank Panel Blank panels are installed to properly cool the modules in 2-way, 3-way, 4-
way, and 5-way combining.

The hybrid combiner handles any permutation of valid 900 MHz transmitter frequencies. It has a
continuously running fan assembly, which is driven from the auxiliary odd/even bus of each power
system. Fan current draw is monitored within the assembly. If the fan current draw falls below a preset
threshold, an alarm signal is set and displays an alarm LED. Presence detect is also included with the
hybrid combiner fan assembly.

A blind-mate connector is installed within the hybrid combiner chassis. It is used to provide power and
signaling to the fan assembly. A female RJ-45 connector is also installed in the hybrid combiner
chassis and provides a fan alarm to the MOSCAD NFM.

6871022P87-C
Chapter 2:  GTR 8000 Expandable Site Subsystem Theory of Operations

Send Feedback   117

http://docsurvey.motorolasolutions.com


Figure 44: Hybrid Combiner Fan Module Connections
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Figure 45: Hybrid Combiner Modules

Figure 46: Single 6-Way Hybrid Combiner
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Figure 47: Single 5-Way Hybrid Combiner

Figure 48: Single 4-Way Hybrid Combiner

Figure 49: Single 3-Way Hybrid Combiner
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Figure 50: Single 2-Way Hybrid Combiner

Figure 51: Dual 3-Way Hybrid Combiner

Figure 52: Dual 2-Way Hybrid Combiner
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Figure 53: Hybrid Combiner Fan Module

RFDS - Site Preselector (700/800 MHz)
The site preselector provides a first level of band pass filtering for inbound RF signals. The site
preselector rejects unwanted signals including the transmitter signals from over loading the receiver
multicoupler and receivers. RF input and output connectors on the front of the device are cabled to the
junction panel and a receive multicoupler.

Figure 54: Site Preselector Filter (700/800 MHz)

The site preselector also has a built-in 30 dB coupler attached to a BNC connector on the front of the
filter. The coupler port can be used for diagnostics and test purposes. For instance, a test signal can
be injected on that port without having to disconnect the site from the antenna.

A single 700/800 MHz Site Preselector covers the 792-825 MHz frequency range.

RFDS - Site Preselector (UHF, 455–512 MHz)
The site preselector provides a first level of band pass filtering for inbound RF signals. The site
preselector rejects unwanted signals including the transmitter signals from over loading the receiver
multicoupler and receivers. RF input and output connectors on the front of the device are cabled to the
junction panel and a receive multicoupler.

The site preselector also has a built-in 30 dB coupler attached to a BNC connector on the front of the
filter. The coupler port can be used for diagnostics and test purposes. For instance, a test signal can
be injected on that port without having to disconnect the site from the antenna.

Site preselectors are pre-tuned to one of 18 subbands. The filters for the lower 4 subbands (below 470
MHz) have 3.5 MHz bandwidth. The remaining 14 filters (above 470 MHz) have 2 MHz bandwidth.
These filters cannot be retuned in the field. No other frequency subbands are available. If you need the
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filters to work on a different frequency, you must order a different filter. See Field Replaceable Units
(FRUs) and Parts on page 347 for a part number list for more information. Also see Motorola Solution
Support Center on page 344.

Figure 55: Site Preselector (UHF, 450–512 MHz)

RFDS - (RMCs/LNAs)
Depending on your RFDS configuration, you may have Site RMCs/LNAs or Cabinet RMCs/LNAs or
both. (RMC and LNA are used interchangeably in this documentation when referring to the receive
multicoupler/low noise amplifier modules.) Table 52: Receive Multicoupler (RMC) Internal Components
on page 123 describes components that are common to both Site RMCs/LNAs and Cabinet RMCs/
LNAs.

Table 52: Receive Multicoupler (RMC) Internal Components

Circuit Description

Balanced Amplifier A balanced amplifier design has been chosen, in order to achieve redundancy,
improved intercept point, and improved input matching. It splits the receive sig-
nal into two identical branches. Each branch contains a low noise amplifier, a
programmable attenuator, and a driver. At the output, the two branches are
combined.

Splitter The splitter provides multiple outputs. Each output is isolated from the others to
prevent unwanted interactions between the receivers. The programmable step
attenuator used to adjust output level is at the input of the splitter.

Alarm Circuit Measured current is compared to a threshold. If the threshold is exceeded an
alarm signal is set. The digital circuit block controls the status and alarm LED.

Power Supply Each amplifier branch has its own 5 V regulator for redundancy reasons. A
separate 5 V regulator feeds the alarm circuitry.

The following are additional features that are common to both Site RMCs/LNAs and Cabinet RMCs/
LNAs:

• Each RMC/LNA has a built-in 29 V to 7.5 V DC/DC converter.

• For HPD only, power sharing between the RMC/LNAs provides PSU redundancy.

• A green and a red LED visible from the front of the module indicate power supply and alarm states.
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Site Receive Multicouplers/Low Noise Amplifiers (Site RMCs/LNAs)
Each site RMC/LNA module serves as a balanced amplifier and a four-way splitter. It includes a built-in
adjustable 30 dB output attenuator, which is controlled through a DIP switch on the front of the module.
You can adjust overall RFDS receive (Rx) gain to the actual site configuration by selecting your
configuration on the RMC Attenuation tab of the Configuration Window in Configuration/Service
Software (CSS), then setting the DIP switches to the positions shown.

An RF input connector on the front of the RMC/LNA module is cabled to the preselector for the
associated Rx path. Four Rx output connectors are on the front of each Site RMC/LNA module. One
Rx output goes to the cabinet RMC/LNA module in the main card cage, and the other three can serve
as outputs to multiple expansion rack cabinet RMCs/LNAs in configurations with additional cabinets.

NOTICE: If your GTR 8000 Expandable Site Subsystem includes the CA00862AA (Site RMC)
option, it provides support for up to three colocated expansion RMCs.

Figure 56: Site RMC Tray With Two RMC/LNA Modules (Front View) on page 124 shows the two Site
RMC/LNA modules (A and B) on the RMC Tray for HPD or TDMA with dual diversity. For trunked
IV&D, only one Site RMC/LNA module is used. The connector ports are labeled for the module on the
left.

Figure 56: Site RMC Tray With Two RMC/LNA Modules (Front View)

The two Site RMC/LNA modules are connected to a backplane on a Site RMC tray. The backplane
includes an external connector labeled RMC that receives power from and sends alarm signals to the
site controller RFDS connection on the main backplane.

Figure 57: Site RMC Tray (Rear View)

Cabinet Receive Multicouplers/Low Noise Amplifiers (Cabinet RMCs/
LNAs)
The Cabinet RMC/LNA module employs a balanced amplifier, selectable attenuators, and a balanced
divider to route Rx signals to each of the base radios in the cabinet. The Cabinet RMC/LNA six-way
splitter sends output to up to five base radios (in the HPD GTR 8000 Expandable Site Subsystem) and
up to six base radios (in the GTR 8000 Expandable Site Subsystem for trunked IV&D).
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Figure 58: Cabinet RMC/LNA Module (Front View)

RFDS - RMC Pass Through Module
The RMC Pass Through module is in all VHF or UHF R1 applications on the GTR 8000 Expandable
Site Subsystem. It has six inputs, which correspond to the six receiver inputs. The RMC Pass Through
module has no active stages, no splitters, and no attenuators.

Figure 59: RMC Pass Through Module

RFDS - Cavity Combiner (700/800 MHz)
A six-way integrated ceramic cavity combiner prepares the output signals from all the RF carriers in the
GTR 8000 Expandable Site Subsystem for transmission on a single antenna. The cavity combiner has
built-in single stage circulator at each input. Each input to the combiner has a tuning and locking
mechanism for each cavity to provide on-site frequency selection / tuning and to prevent unintentional
detuning. Circulator loads are on the back of the combiner on a common heat sink. Figure 60: Cavity
Combiner (700/800 MHz) on page 126 shows the combiner set-up for six channels. The RF input
cable, built in circulator, and tuning knob have been identified for one of the six cavities. With the
optional phasing harness (700/800 MHz only), two combiners can provide 12-way combining on to a
single transmit antenna.
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Figure 60: Cavity Combiner (700/800 MHz)

RFDS - Cavity Combiner (UHF)
A six-way integrated ceramic cavity combiner prepares the output signals from all the RF carriers in the
GTR 8000 Expandable Site Subsystem for transmission on a single antenna. The cavity combiner has
built-in single stage circulators at each input. Each input to the combiner has a tuning and locking
mechanism for each cavity to provide on-site frequency selection / tuning and to prevent unintentional
detuning. Circulator loads are on the back of the combiner on a common heat sink. Minimum
transmitter frequency spacing is 150 kHz. The combiner is optional on the GTR 8000 Expandable Site
Subsystem. Frequency subbands for the UHF cavity combiners are 450–465 MHz, 470–491 MHz, and
494–509 MHz. 12-way combining is not available for UHF. The RF input cable, built in circulator, and
tuning knob have been identified for one of the cavities.
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Figure 61: Cavity Combiner (UHF)

RFDS - Transmit Filter (700/800/900 MHz)
The transmit filter removes any remaining noise in the receive sub-band between the combiner and the
transmit antenna. The output is sent to the transmit antenna port at the junction panel.

The transmit band pass filter has a built-in power monitor on the output for monitoring the antenna
system voltage standing wave ratio (VSWR). The power monitor converts the forward and reverse RF
signals to proportional 0-5 V analog signals. VSWR alarms are routed to the infrastructure as they
occur.

NOTICE: The integrated Power Monitor Unit (PMU) connector on the front of the filter that
routes analog signals received by the integrated alarm function in the site controller is not
supported and is reserved for future use.

The transmit filter is either 764–776 MHz, 851–870 MHz, or 935–941 MHz.

Figure 62: Transmit Filter (700/800/900 MHz)
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RFDS - Transmit Filter (UHF, 450–509 MHz)
The transmit filter removes any remaining noise in the receive sub-band between the combiner and the
transmit antenna. The output is sent to the transmit antenna port at the junction panel.

The transmit band pass filter has a built-in power monitor on the output for monitoring the antenna
system voltage standing wave ratio (VSWR). The power monitor converts the forward and reverse RF
signals to proportional 0-5 V analog signals. VSWR alarms are routed to the infrastructure as they
occur.

NOTICE: The integrated Power Monitor Unit (PMU) connector on the front of the filter that
routes analog signals received by the integrated alarm function in the site controller is not
supported and is reserved for future use.

The transmit filter is optional on the GTR 8000 Expandable Site Subsystem. The transmit filter is pre-
tuned to one of 18 subbands. The filters for the lower 4 subbands (below 470 MHz) have 3.5 MHz
bandwidth. The remaining 14 filters (above 470 MHz) have 2 MHz bandwidth. These filters cannot be
retuned in the field. No other frequency subbands are available. See Field Replaceable Units (FRUs)
and Parts on page 347 for a part number list for more information. Also see Motorola Solution Support
Center on page 344.

Figure 63: Transmit Filter (UHF, 450–509 MHz)

RFDS - Diplexer (700/800 MHz)
The diplexer is used to combine the outputs of a 700 MHz cavity combiner in one rack with the output
of an 800 MHz cavity combiner in another rack. The diplexer provides the same noise filtering function
as the Tx filter. The diplexer can be located either in the cabinet with the 700 MHz radios or the cabinet
with the 800 MHz radios. It is mounted on a tray with the preselector similar to the Tx filter. The cabinet
without the diplexer must be ordered with a diplexer extension cable.
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Figure 64: Diplexer (700/800 MHz)

Power Monitor Unit (UHF/VHF/900 MHz)
NOTICE: The Power Monitor Unit (PMU) is not supported and is reserved for future use.

The Power Monitor Unit (PMU) is used to monitor the combined transmitter forward and reflected
power. Analog voltages proportional to power are provided to the site controller.

The PMU circuitry is included in all transmit filters and diplexers. For sites without a transmit filter or
diplexer, a standalone PMU can be used.

Figure 65: Power Monitor Unit (PMU) (UHF/VHF/900 MHz)
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Chapter 3

GTR 8000 Expandable Site Subsystem
Installation
This chapter details installation procedures relating to the GTR 8000 Expandable Site Subsystem.

Pre-Installation Tasks
Follow this process to perform the installation tasks. Ensure that you have the following:

• Appropriate cables

• Access to Software Download (SWDL), Configuration/Service Software (CSS), and the Unified
Network Configurator (UNC)

• IP/DNS information

• Login and password information

Equipment Installation Process Overview
Process:

1 Prepare the site to comply with the Motorola requirements and specifications for the equipment,
as listed in the Motorola Standards and Guidelines for Communication Sites manual. The base
radio may be installed in a suitable, restricted access, indoor enclosure in any location suitable
for electronic communications equipment. Other codes and guidelines that may apply to the
location must also be met. See General Safety Precautions on page 132.

2 Inspect and inventory all racks, cabinets, cables, and other equipment with a Motorola
representative to ensure that the order is complete. See General Installation Standards and
Guidelines on page 137.

3 Various tools are used to install and service the equipment. If information is needed regarding
where to obtain any of the equipment and tools listed, contact the Motorola Solution Support
Center (SSC). See General Installation/Troubleshooting Tools on page 143 for a list of general
recommended tools for installing and servicing the hardware.

4 Install all equipment using the site drawings and other documents provided by the Field
Engineer. Use the installation standards and guidelines for placing and installing equipment.

5 Properly ground all the racks and cabinets to protect against ground faults, electrical surges, and
lightning. See GTR 8000 Expandable Site Subsystem Installation on page 145.

6 Connect all necessary cables within a rack and between the racks for system interconnection.
See Junction Panel Connections on page 181.

7 Run a preliminary check of a site before applying power.

8 See Installing Device Software Prerequisites on page 243 for a list of items you need access to
before installing the software.

9 See Installing Devices in the UNC on page 246 to discover the base radio and to load OS
software images from the UNC.

10 See Device Configuration in CSS on page 257 to program the configurations into the base radio
using CSS.
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11 See Configuring Centralized Authentication on Devices in VoyenceControl on page 287 to
program the base radio using UNC.

General Safety Precautions
WARNING: Compliance with FCC guidelines for human exposure to Electromagnetic Energy
(EME) at Transmitter Antenna sites generally requires that personnel working at a site must be
aware of the potential for exposure to EME, and can exercise control of exposure by
appropriate means, such as adhering to warning sign instructions, using standard operating
procedures (work practices), wearing personal protective equipment, or limiting the duration of
exposure. For more details and specific guidelines, see “Appendix A” of the Motorola Standards
and Guidelines for Communications Sites manual.

Observe the following general safety precautions during all phases of operation, service, and repair of
the equipment described in this manual. Follow the safety precautions listed and all other warnings and
cautions necessary for the safe operation of all equipment. See the appropriate section of the product
service manual for additional pertinent safety information. Due to the danger of introducing additional
hazards, do not install substitute parts or perform any unauthorized modifications of equipment.

NOTICE: The installation process requires preparation and knowledge of the site before
installation begins. Review installation procedures and precautions in the Motorola Standards
and Guidelines for Communications Sites manual before performing any site or component
installation.

Always follow all applicable safety procedures, such as Occupational Safety and Health Administration
(OSHA) requirements, National Electrical Code (NEC) requirements, local code requirements, and safe
working practices. Also, all personnel must practice good judgment. General safety precautions include
the following:

• Read and follow all warning notices and instructions marked on the product or included in this
manual before installing, servicing, or operating the equipment. Retain these safety instructions for
future reference.

• If troubleshooting the equipment while power is on, be aware of the live circuits.

• Do not operate the radio transmitters unless all RF connectors are secure and all connectors are
properly terminated.

• Ground all equipment properly in accordance with the Motorola Standards and Guidelines for
Communications Sites manual and specified installation instructions for safe operation.

• Slots and openings in the cabinet are provided for ventilation. Do not block or cover openings that
protect the devices from overheating.

• Only a qualified technician familiar with similar electronic equipment should service equipment.

• Some equipment components can become hot during operation. Turn off all power to the
equipment and wait until sufficiently cool before touching.

• Maintain emergency first aid kits at the site.

• Direct personnel to call in with their travel routes to help ensure their safety while traveling between
remote sites.

• Institute a communications routine during certain higher risk procedures where the on-site
technician continually updates management or safety personnel of the progress so that help can be
dispatched if needed.

• Never store combustible materials in or near equipment racks. The combination of combustible
material, heat, and electrical energy increases the risk of a fire safety hazard.

• Equipment installed at the site meeting the requirements of a "restricted access location," per
UL60950-1, is defined as follows: "Access can only be gained by service persons or by a user who
has been warned about the possible burn hazard on equipment metal housing. Access to the
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equipment is by using a tool or lock and key, or other means of security, and is controlled by the
authority responsible for the location."

WARNING: Burn hazard. The metal housing of the product may become extremely hot. Use
caution when working around the equipment.

Figure 66: Warning Label on Hot Modules

WARNING: DC input voltage must be no higher than 60 VDC. This maximum voltage includes
consideration of the battery charging "float voltage" associated with the intended supply system,
regardless of the marked power rating of the equipment. Failure to follow this guideline may
result in electric shock.
RF energy burn hazard: disconnect power in the cabinet to prevent injury while disconnecting
and connecting antennas.

CAUTION: All Tx and Rx RF cables outer shields must be grounded per Motorola Standards
and Guidelines for Communications Sites manual requirements.
All Tx and Rx RF cables must be connected to a surge protection device according to the
Motorola Standards and Guidelines for Communications Sites manual. Do not connect Tx and
Rx RF cables directly to an outside antenna.

IMPORTANT: All equipment must be serviced by Motorola-trained personnel.

GTR 8000 Base Radio Supplemental Safety Installation
Requirements
The Supplemental Safety and Installation Requirements include the following:

• The GTR 8000 Base Radio must be installed in a suitable, in-building enclosure. A restricted access
location is required when installing this equipment into the end system.

• The base radio contains a Class 1 built-in power supply component. This component is equipped
with an appliance inlet for connecting to an AC input, as well as DC input terminals which meet
SELV DC circuit requirements.

• When installing the equipment, all requirements of relevant standards and local electrical codes
must be fulfilled.

• The maximum operating ambient temperature of this equipment is 60 °C. The maximum operating
altitude is 3000 meters above sea level.

• The 28.6 VDC output from the power supply to the PA is at an energy hazard level (exceeds 240
VA). When installing into the end system, care must be taken so as not to touch the output wires.

• When the base radio is used in a DC reverting system, the DC power supply must be located in the
same building as the base radio, and it must meet the requirements of a SELV circuit.
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DC Mains Grounding Connections
CAUTION: This equipment is designed to permit the connection of the earthed conductor of the
DC supply circuit to the earthing conductor at the equipment. If this connection is made, you
must meet all following conditions:

• Connect this equipment directly to the DC supply system earthing electrode conductor or to a
bonding jumper from an earthing terminal bar or bus in which the DC supply system earthing
electrode conductor is connected.

• Locate this equipment in the same immediate area (such as adjacent cabinets) as any other
equipment that has a connection between the earthed conductor of the same DC supply circuit and
the earthing conductor (and also the point of earthing of the DC system). Do not earth the DC
system elsewhere.

• Locate the DC supply source within the same premises as the equipment.

• Do not install switching or disconnecting devices in the earthed circuit conductor between the DC
source and the point of connection of the earthing electrode conductor.

Disconnect Device Permanently Connected

Incorporate a readily accessible disconnect device (circuit breaker or switch) in the building installation
wiring.

Multiple Power Source

This product has multiple power sources. If service requires the removal of a power source, disconnect
all inputs (AC and DC powers) to remove power completely to the equipment before servicing.

Connection to Primary Power

For supply connections, use wires suitable for at least 75 °C.

Replaceable Batteries

WARNING: Risk of Explosion if you replace the battery with an incorrect type. Dispose of used
batteries according to the instructions.

Maintenance Requiring Two People
Identify maintenance actions that require two people to perform the repair. Two people are required
when:

• A repair has the risk of injury that would require one person to perform first aid or call for emergency
support. An example is work around high-voltage sources. If an accident occurs to one person,
another person may be required to remove power and call for emergency aid.

• Heavy lifting is involved. Use the National Institute of Occupational Safety and Health (NIOSH)
lifting equation to determine whether one or two persons are required to lift a system component
when it must be removed and replaced in its rack.

Equipment Racks
Lift equipment racks without the use of lifting equipment only when sufficient personnel are available to
ensure that regulations covering health and safety are not breached. Use an appropriately powered
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mechanical lifting apparatus for moving and lifting the equipment racks. In addition to these points,
comply with any local regulations that govern the use of lifting equipment.

WARNING: Crush Hazard could result in death, personal injury, or equipment damage.
Equipment racks can weigh up to 360 kg (800 lb). See the following instructions for proper
lifting procedures.

Lifting Equipment Racks Horizontally
In some cases, equipment racks are shipped in the horizontal position. Use the appropriate lifting
apparatus to lift the racks upright. Comply with all applicable health and safety regulations, and any
other regulations applicable to lifting heavy equipment.

WARNING: Crush Hazard could result in death, personal injury, or equipment damage.
Do not use the eyenuts mounted on the top of the rack to lift the rack upright from a horizontal
position. The eyenuts are not designed to lift horizontally and could fail resulting in damage to
the equipment or injury to personnel.

Lifting Equipment Racks Vertically
Some equipment racks have four M10 eyenuts mounted in the top of the rack. Use these eyenuts to lift
the equipment rack vertically. Before using these eyenuts, visually check them and the rack hardware
for any damage that may have occurred during shipping.

WARNING: Do not use the eyenuts if damage is apparent. Contact Motorola for replacements.

Use all four eyenuts when lifting the equipment rack. The minimum distance from each eyenut to the
lifting point is 1.2 meters (47.2 in). Using a shorter length than specified could cause the eyenuts to fail. 
Figure 67: Lengths and Angles for Lifting Using the Eyenuts on page 136 shows the minimum lengths
and proper lifting angles using the eyenuts.
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Figure 67: Lengths and Angles for Lifting Using the Eyenuts

If eyenuts are removed or become loose, install them properly before lifting the equipment rack.
Tighten the eyenuts and bolt assembly by hand. Correct eyenut tightness and alignment are crucial to
ensure that the eyenut assembly performs to its intended lifting capacity. Align the eyenuts to point
towards the center lifting point of the cabinet and tightened to between 90 to 120 in-lb torque.

Figure 68: Proper Alignment of the Eyenuts on page 137 shows the proper alignment of the eyenuts.

6871022P87-C
Chapter 3:  GTR 8000 Expandable Site Subsystem Installation

136  Send Feedback

http://docsurvey.motorolasolutions.com


Figure 68: Proper Alignment of the Eyenuts

General Installation Standards and Guidelines
This section provides several guidelines to ensure a quality install. Review these guidelines before
unpacking and installing the system. Additionally, review the installation information in the Motorola
Standards and Guidelines for Communication Sites manual for more details, including:

• Equipment installation

• Antenna installation

Review installation information specifically for the GTR 8000 Expandable Site Subsystem. See GTR
8000 Expandable Site Subsystem Installation on page 145.

General Site Preparation Overview
Perform the activities listed in this table to ensure proper site preparation. The table references specific
chapters in the Motorola Standards and Guidelines for Communication Sites manual for more
information.

Table 53: Activities for Site Preparation

Activity Description of Activity Chapter Reference

Review the site plan. • Prevents potential on-site and off-
site interference by local trunked
systems.

• Chapter 2 "Site Design and De-
velopment"

Table continued…
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Activity Description of Activity Chapter Reference

• Minimizes cable lengths.

• Determines the location of tele-
com equipment.

Determine site access
and security.

Outlines of site access and security
measures.

• Chapter 2 "Site Design and De-
velopment"

Review safety consid-
erations.

Outlines general, installation, and en-
vironmental safety guidelines and re-
quirements and OSHA-related con-
siderations.

• Chapter 3 "Communications Site
Building Design and Installation"

Schedule installation of
telephone service.

Ensures options and functions of on-
site, two-way communications for
personnel safety and maintenance.

• Chapter 3 "Communications Site
Building Design and Installation"

Review grounding
specifications.

Ensures that the site meets or ex-
ceeds the Quality Audit Checklist in
Appendix F as well as the Power and
Grounding Checklist in Appendix D.

• Appendix D. “Grounding (Earth-
ing) Electrode System Testing/
Verification”

• Appendix F. “R56 Compliance
Checklist”

Schedule installation of
site power.

Covers grounding, power sources,
and surge protection.

• Chapter 4 "External Grounding
(Earthing)"

• Chapter 5 "Internal Grounding
(Earthing)"

• Chapter 6 "Power Sources"

• Chapter 7 "Surge Protective Devi-
ces"

General Equipment Inspection and Inventory Recommendations
Take an inventory of all equipment with a Motorola representative to ensure that the order is complete.
Carefully inspect all equipment and accessories to verify that they are in good condition. Promptly
report any damaged or missing items to a Motorola representative.

CAUTION: Do not tamper with factory configuration settings for these devices. These settings
include software configuration, firmware release, password, and physical connections. Motorola
has configured and connected these devices to meet specific performance requirements.
Tampering with these devices may result in unpredictable system performance or catastrophic
failure.

General Placement and Spacing Recommendations
When placing equipment at a site, perform the following:

• Place each rack on a firm, level, and stable surface, and bolt the racks together.

• Use correct mounting hardware and shims to prevent rack movement.

• Use strain relief when installing and positioning cables and cords to help ensure that no interruption
of service occurs.
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• Provide an appropriate amount of space around all components to allow for proper air flow, cooling,
and safe access to equipment.

• Locate the site racks and other equipment with enough spacing to allow access for service.

NOTICE: Proper spacing of equipment is essential for ease of maintenance and safety of
personnel. Spacing requirements have been established to meet the National Fire Protection
Associations (NFPA) code, and the American Society of Heating, Refrigerating, and Air
Conditioning Engineers (ASHRAE) standards. Adhere to any local regulations that apply to
the installation.

• Locate the system in an area free of dust, smoke, and electrostatic discharge (ESD).

• See the Motorola Standards and Guidelines for Communication Sites manual for details on these
space requirements.

General Cabinet Bracing Recommendations
Use all supplied bracing hardware when installing a rack or cabinet, and secure all equipment within a
rack or cabinet.

If additional equipment is installed, see the system design document the field engineer provided, or
consult the Motorola Field Representative.

Subsystem cabinets are self-supporting structures. In areas subject to seismic activity, additional
bracing of the cabinet may be required to prevent it from tipping. However, the bracing hardware must
be locally procured. No specific procedures are provided within this manual for bracing cabinets in
active seismic areas. See the Motorola Standards and Guidelines for Communication Sites manual for
details on seismic conditions.

Mounting Cabinets or Racks to a Floor
When and where to use: Perform the following steps to properly install a cabinet or open rack within a
site building. Secure the cabinets and racks to the floor for optimum stability. This procedure is written
so that the cabinet or rack is moved only once.

Procedure:
1 Carefully mark the mounting holes with a pencil, as indicated on the appropriate cabinet or rack

footprint.

2 Drill the marked mounting holes to the appropriate depth of the mounting hardware with a
hammer drill and bit.

3 Insert an anchor into the drilled hole. If necessary, tap the anchor into place using a hammer.

4 For cabinets, remove the four screws securing the bottom kick panel to the front and back of the
cabinet. Remove the kick panel and set aside during installation.

5 Carefully move the cabinet or rack into the position indicated by the holes in the floor.

WARNING: Equipment cabinets and racks are heavy and may tip. Use extreme caution
when moving. Lift from top eyenuts with the appropriate apparatus, or secure the cabinet
or rack from tipping if lifting from the bottom. Failure to do so could result in death or
serious injury or equipment damage.

6 Adjust and level the cabinet or rack as necessary to position the cabinet mounting holes with the
pre-drilled holes.

7 Secure the cabinet or rack to the site floor with the locally procured mounting hardware.

IMPORTANT: If securing the cabinet or rack to a concrete floor, use 1/2-inch grade 8
bolts with anchors.
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General Bonding and Grounding Requirements
Cabinets and racks include a Rack Grounding Bar (RGB) with the capacity to terminate numerous
ground wires. Attach equipment added to the cabinet or rack to the ground bar using solid or stranded
6 AWG copper wire.

The RGB uses dual-hole lugs to terminate ground wires. The minimum number of dual-hole
attachments is system-dependent and specified by the customer. This bar provides electrical continuity
between all bonds and ground wire with a current-carrying capacity equal to or exceeding that of a 6
AWG copper wire.

See the Motorola Standards and Guidelines for Communication Sites manual for more information on
proper bonding and ground at a site.

General Cabling Requirements
Diagrams for cabling are typically included in the system-specific configuration documentation Motorola
provides. Also see the Motorola Standards and Guidelines for Communication Sites manual for cabling
standards.

IMPORTANT: System certification was completed using shielded cables. To prevent emission
problems, use only shielded cables. Do not substitute other cable types.

• Position the equipment to avoid excessive tension on cables and connectors. Cables must be loose
with absolutely no stress on the connectors. Careful cable routing and securing the cables with tie
wraps (or other devices) is one way to provide this protection. Set up preventive maintenance
loops .

• Dress the cables neatly using cable ties. Do not tighten the cable ties until you are sure that the
required service length and bend radius requirements are met. Leave cable ties loose enough to
allow adjustment.

• Verify that all cables are properly labeled to match System-specific configuration documentation
Motorola provided.

• Ensure that cables do not exceed the minimum bend radius as outlined in the Motorola Standards
and Guidelines for Communication Sites manual.

CAUTION: Use only Category 5 Shielded Twisted Pair (or higher) for cabling Ethernet
connections. Motorola has engineered this system to meet specific performance requirements.
Using other cabling and connectors may result in unpredictable system performance or
catastrophic failure.

NOTICE: For more information on cabling guidelines, see the documentation supplied with
components from each equipment manufacturer.

General Power Guidelines and Requirements
See the Motorola Standards and Guidelines for Communication Sites manual for information on
providing electrical service, power budgeting, selecting batteries, and other topics for supplying power
at the site.

Perform electrical installation work in accordance with the current edition of the NFPA 70 and local
building codes. Where required, use a qualified and licensed electrician for all electrical installations.
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General AC Power Guidelines and Requirements

The Motorola Standards and Guidelines for Communication Sites manual defines the guidelines and
requirements for cabinets and racks which house equipment that requires AC power input. Some of the
guidelines and requirements are as follows:

• The cabinet or rack is designed to accept 120/240 V, single-phase power with an amperage service
size as required by the electronic equipment.

• Cabinets and racks powered by commercial power must be equipped with a Nationally Recognized
Test Laboratory (NRTL) certified power distribution module that contains a main circuit breaker or
individual circuit breakers of the correct size as required for the electronic equipment or as the
customer specified.

• A decal showing an electrical schematic of the power wiring is affixed to the inside surface of the
cabinet.

• All AC power equipment and electrical components must conform to National Electrical
Manufacturers Association (NEMA) and National Electrical Code (NEC). The AC power equipment
must also be listed by an NRTL.

• A surge arrestor, designed to protect equipment systems from a 120/240 V service and load center,
is placed on the power feed ahead of all individual load center circuit breakers. This gapless
arrestor must be listed by an NRTL for the purpose intended.

• Selection of a surge arrestor is based on the susceptibility of the equipment powered by the
electrical service, with margin provided for locally generated disturbances. See ANSI/IEEE C62.41
(21) for more details.

• At least one 120 VAC, 15 A duplex convenience outlet equipped with Ground Fault Interrupter (GFI)
protection must be provided in the electronic equipment compartment.

CAUTION: Do not use surge/transient suppressors without careful and expert power system
analysis.

NOTICE: Redundant devices could be terminated on different AC main phases so that a single
phase failure does not result in a power loss for both devices.

General Breaker Recommendations

To ensure that a fault which causes the breaker to open does not result in the loss of multiple transmit
channels, each power supply should have its own supply breaker. The breaker recommendations for
AC and DC supply breakers are as follows:

• For a 120 VAC, 60 Hz application, the AC supply breaker must be rated for a continuous current of
20 A. For a 220 VAC, 50 Hz application, the AC supply breaker must be rated for a continuous
current of 10 A minimum, not to exceed 20 A.

• Individual DC breakers are not used. For information involving the sizing of cables and DC power
distribution, see the Standards and Guidelines for Communication Sites manual.

• Site installation must include a single current interrupting device on the DC input distribution (fuse or
circuit breaker) rated for the application loading, not to exceed 200 A. For each standalone device,
the DC supply breaker should be rated for a continuous current of 25 A.
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General Battery Installation Recommendations
The batteries and charger should be as close as possible to the rectifier system using the cables. A
heavy gauge stranded cable is advised to minimize voltage drop. Examples of the resistance of some
heavy gauge wire are:

Table 54: Heavy Gauge Wire Resistance Examples

Gauge Resistance

#6 gauge 0.3951 /1000 ft

#4 gauge 0.2485 /1000 ft

#2 gauge 0.1563 /1000 ft

The maximum voltage drop can be calculated by knowing the peak current drawn by the radio system.
Use the following formula:

Total Voltage drop = [Ώ/1000 ft] x [total loop length (ft)] x [Ipeak (A)] + [connector(s) voltage drop(s)]

See DC Power Connection Wire Gauge Calculations for Integrated Voice and Data on page 149 and 
DC Power Connection Wire Gauge Calculations for HPD on page 150 for additional guidelines on
cable sizing.

General Electrostatic Discharge Recommendations
Electronic components, such as circuit boards and memory modules, can be sensitive to Electrostatic
Discharge (ESD). Use an antistatic wrist strap and a conductive foam pad when installing or upgrading
the system.

If an ESD station is not available, wear an antistatic wrist strap. Wrap the strap around the wrist and
attach the ground end (usually a piece of copper foil or an alligator clip) to an electrical ground. An
electrical ground can be a piece of metal that literally runs into the ground (such as an unpainted metal
pipe), or the metal part of a grounded electrical appliance. An appliance is grounded if it has a three-
prong plug and is plugged into a three-prong grounded outlet.

NOTICE: Do not use a computer as a ground, because it is not plugged in during installation.

FCC Requirements
Radio frequency (RF) transmitters installed at sites within the US must be in compliance with the
following FCC regulations:

• The station licensee is responsible for the proper operation of the station at all times and is
expected to provide observations, servicing, and maintenance as often as may be necessary to
ensure proper operation.

• The transmitter ERP must not exceed the maximum power specified on the current station
authorization.

• The frequency of the transmitter must be checked during initial installation of the transmitter, when
replacing modules, or when making adjustments that affect the carrier frequency or modulation
characteristics.

This equipment has been tested and found to comply with the limits for a Class A digital device,
according to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference to radio communications when the equipment is operated in a commercial
environment.
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This equipment generates, uses, and can radiate radio frequency energy. If not installed properly and
used in accordance with the instruction manuals, the equipment may cause harmful interference to
radio communications. Operation of some compliant equipment in a residential area may cause
harmful interference to radio communications, in which case the interference must be corrected.

Networking Tools
Use the following networking tools for installing and servicing the network:

• Fluke® OneTouch Assistant LAN tester

• NiMH rechargeable battery for Fluke

• T1/E1 or E1 test set (such as the Hewlett-Packard® HP37702A)

• Serialtest® software with the ComProbe® and SerialBERT option

General Installation/Troubleshooting Tools
If information is needed regarding where to obtain any of the equipment and tools listed, contact the
Motorola Solution Support Center (SSC). See Motorola Solution Support Center on page 344.

General Tools

Use the following general tools to install, optimize, and service equipment in the system:

• 150 MHz 4 Channel Digital Storage Oscilloscope

• Transmission Test Set (TIMS Set)

• Aeroflex 3900 Series Service Monitor or equivalent

• 50 Ohm Terminated Load

• Digital Multimeter (DMM)

• Terminal Emulation Software

• DB-9 Straight through serial cable

• RS-232 Cables with Connectors

• Punch Block Impact Tool

• MODAPT – RJ-45 Breakout Box

• Remote RJ-11/ RJ-45 Cable Tester (1200 ft length maximum)

• PC Cable Tester (RG-58, 59, 62, BNC, RJ-45, RJ-11, DB-9, DB-15, DB-25, Centronics 36-pin
connectors)

• ESD field service kit

• Amprobe Instruments GP-1 Earth Tester

• AEMC 3730 Clamp-on Ground Resistance Tester

Rack Tools

Use the following tools to install, optimize, and service the equipment:

• Service Monitor: Aeroflex 3900 Series Service Monitor with P25 Options installed (plus High
Performance Data (HPD) and Time Division Multiple Access (TDMA) options as required)

• Personal Computer meeting the following specifications:
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- Operating Systems:

+ Windows XP Home Edition

+ Windows XP Professional

+ Windows Vista (all editions)

+ Windows 7 (all editions)

• Hardware Requirements:

- Processor:

+ 1 GHz or higher Pentium grade

- Processor Memory:

+ 1 GB RAM recommended for Windows XP

+ 2 GB RAM recommended for Windows Vista and Windows 7

- Hard Disk Space:

+ 300 MB minimum free space (for a Typical Installation, including Help Text and Software
Download) or 100 MB minimum free space (for a Compact Installation)

- Peripherals:

+ Microsoft Windows supported mouse or trackball

+ Microsoft Windows supported serial port for product communication

+ Microsoft Windows supported Ethernet port for product communication

+ Microsoft Windows supported printer port for report printing

+ CD-ROM for software installation

• Configuration/Service Software (CSS) DLN6455

• CSS serial programming cable

• Ethernet cable

• Antenna tester

• 50 Ohm terminated load

• Rohde & Schwarz NRT-Z14 Directional Power Sensor, 25-1000 GHz, 0.1-120 W. Recommended
for all uses when a service monitor is not available.

Technical Support for Installation
Technical support is available from the site-specific documents the Field Engineer or Motorola Field
Representative provided for the system, one of the Motorola Solution Support Centers (SSC), or
qualified subcontractors.

• SSC can help technicians and engineers resolve system problems and ensure that warranty
requirements are met. Check your contract for specific warranty information. See Motorola Solution
Support Center on page 344.

• The Motorola System Service Subcontractor Assessment program ensures that service people
contracted by Motorola meet strict minimum requirements before they can work on any system. For
more information on this program, contact the Motorola representative.
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Site-Specific Information

When the Motorola Center for Customer Solution Integration (CCSi) stages a system, the Field
Engineer assigned to the system creates all site-specific system documentation to document how the
system was staged. Site-specific information includes the following:

• Site design drawings showing the location of racks, cabinets, cable trays, and other components

• Rack drawings showing the location of the equipment in each rack

• Cable matrix in a table format that shows each cable and its connections

• Interconnect wiring diagrams to show the cable connections between devices

• Pre-programmed parameters of each site component

• Templates used to program each device

• All firmware and software revisions of each site component

• Test data from each device that requires operational verification

• Optimization requirements and settings of each electrical path

• Acceptance Test Plan for the site components

NOTICE: Maintain this site-specific information to reflect the current site configuration and
layout for the system.

GTR 8000 Expandable Site Subsystem Installation
The following is information specific to the GTR 8000 Expandable Site Subsystem.

Placement and Spacing
Expansion cabinets or racks allow equipment to be added to a site. Always consider room for
expansion when setting up a site. Cabinets or racks may be installed next to each other or to other
equipment. However, all cabinets and racks must have sufficient floor space to permit access for
installation and service.

For the GTR 8000 Expandable Site Subsystem, all service can be performed from the front of the
cabinet or rack except replacement of the power distribution module, the junction panel, eyenuts,
backplanes, and related cables. The following clearance is required to ensure complete service
access, including access for the power distribution module, junction panel, eyenut, backplane, and
related cable replacement.

Front access:
• At least 2 ft floor access in front of the cabinet or rack.

Side and rear access:
• At least 6 inches at the rear of the cabinet or rack for ventilation.

• No clearance is required on the sides of the cabinet or rack.

• No rear service access is required for the GTR 8000 Expandable Site Subsystem. Access is
required to the front and one side of cabinet to secure the GTR 8000 Expandable Site Subsystem
to the floor.
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Floor Mounting the Cabinet Version of the GTR 8000 Expandable
Site Subsystem 
Figure 69: GTR 8000 Expandable Site Subsystem (Cabinet Version) - Floor Mounting Detail
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Floor Mounting the Open Rack Version of the GTR 8000 Expandable
Site Subsystem
Figure 70: GTR 8000 Expandable Site Subsystem (Open Rack Version) - Floor Mounting Detail
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Figure 71: GTR 8000 Expandable Site Subsystem (7.5 Open Rack Shown) - Side View

Power Connections
This section covers topics on connecting power cables to the GTR 8000 Expandable Site Subsystem
and the power distribution module, calculating the length of wire for various gauges, and mounting the
battery temperature sensor.
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Power Distribution Module Power Connections
In GTR 8000 Expandable Site Subsystems, the AC/DC power distribution module located with the
junction panel provides connections for customer-provided AC and DC inputs. One or two DC inputs
can be connected to the DC section of the power distribution module. For each base radio, there must
be a single, separate AC source with the proper power rating connected to the appropriate terminals in
the AC section, where it is then fed to the corresponding AC power supply input.

NOTICE: Each DC input termination is rated for a maximum of 108A.

For additional information about power distribution in GTR 8000 Expandable Site Subsystems, see the
following:

• AC/DC Power Distribution on page 104

• AC/DC Power Distribution Module on page 112

DC Power Connection Wire Gauge Calculations for Integrated Voice and
Data
Since the power supply disconnects itself from the DC input when it senses that DC voltage has
dropped to 42 VDC, it is important to minimize the voltage drop in the DC power supply loop (the total
length of the 48 VDC hot wire and the DC return wire) to no more than 1 V total. Minimizing the voltage
drop ensures that the maximum energy is removed from the battery before disconnecting the power
supply from the DC input line.

A base radio transmitting at 100 W draws up to 10 A* current when operating from a 54 V source
(nominal 48 VDC system). As the voltage decreases (due to the standby battery discharging) the
current increases proportionally (since the base radio appears to be a constant power load). At the low
voltage disconnect point (42 V for a nominal 48 VDC system), the current is up to 13 A*. If a single pair
of 2 AWG wire is used to connect the battery to the junction panel, the maximum length of a single
conductor would be 75m (245 ft). Use of smaller gauge wire would reduce this length depending on the
resistance of the wire. To determine the maximum length of wire for wire other than 2 AWG, the
following relationship can be used:

* = The actual current value can be calculated from the power consumption value in the specifications
tables. See GTR 8000 Expandable Site Subsystem Specifications on page 67.

• Length (meter/feet) = V/I/R

where:

• V = voltage drop in one leg of the loop (max = 0.5 V)

• I = current drawn by the base radio during DC operation

• R = resistance of the wire being considered (in Ohms per meter/foot)

For common wire sizes for an IV&D site, the maximum distances apply.

Table 55: DC Power Connection Wire Gauge Maximum Distances for an IV&D Site

AWG Resistance (ohm/1000 ft) Maximum Distance (for 13 A)

2 0.1563 75m (245 ft)

3 0.1970 60m (195 ft)

4 0.2485 47m (155 ft)

5 0.3133 37m (120 ft)

6 0.3951 30m (95 ft)
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In some installations, local codes may require the installation of wire heavier than 2 AWG. In these
situations, a local splice box can be used to reduce the incoming wire to the 2 AWG needed for
connection to the input terminal box. The splice box should be as close as possible to the junction
panel.

If two pairs of 2 AWG wire are used to connect the GTR 8000 Expandable Site Subsystem to the
battery bank, the maximum distance from the battery to the junction panel would be 70 ft. If longer
distances are required, a splice box must be included in the DC distribution. In that event, the following
diagram provides guidance regarding the maximum distance permitted for various wire gages
available. These values are based on a splice box located 10 ft from the junction panel. If the splice
box is more than 10 ft from the junction panel, the allowable distance between the splice box and the
battery bank will be shorter.

NOTICE: Each DC input termination is rated for a maximum of 108 A.

Figure 72: Wire Gauge and Distance Guide

DC Power Connection Wire Gauge Calculations for HPD
Since the power supply disconnects itself from the DC input when it senses that DC voltage has
dropped to 42 VDC, it is important to minimize the voltage drop in the DC power supply loop (the total
length of the 48 VDC hot wire and the DC return wire) to no more than 1 V total. Minimizing the voltage
drop ensures that the maximum energy is removed from the battery before disconnecting the power
supply from the DC input line.

A base radio transmitting at 50 W draws up to 7.4 A current when operating from a 54 V source
(nominal 48 VDC system). As the voltage decreases (due to the standby battery discharging) the
current increases proportionally (since the base radio appears to be a constant power load). At the low
voltage disconnect point (42 V for a nominal 48 VDC system), the current is up to 9.5 A. Use of smaller
gauge wire would reduce this length depending on the resistance of the wire. To determine the
maximum length of wire for wire other than 2 AWG, the following relationship can be used:

• Length (ft) = V/I/R

where:

• V = voltage drop in one leg of the loop (max = 0.5 V)

• I = current drawn by the base radio during DC operation (9.5A)

• R = resistance of the wire being considered (in Ohms per ft)
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For common wire sizes, the maximum distances apply.

Table 56: Power Connection Wire Gauge Maximum Distances for HPD

AWG Resistance (ohm/1000 ft) Maximum Distance

2 0.1563 102m (335 ft)

3 0.1970 81m (265 ft)

4 0.2485 64m (210 ft)

5 0.3133 51m (165 ft)

6 0.3951 40m (130 ft)

Battery Temperature Sensor Mounting

A 40 ft battery temperature sensor cable is shipped with your device. This three-wire cable carries a
voltage signal to the power supply from a sensor element which must be mounted close to the storage
battery. Voltage is proportional to the battery temperature and the diagnostic circuitry in the power
supply module. The 40 ft cable can be extended to a total length of 190 ft using 50 ft extensions
(Motorola part number 3084827Y04. See Motorola Solution Support Center on page 344.

Mount the sensing element of the temperature sensor so that it detects the actual battery temperature
(or the ambient temperature as close as possible to the batteries being charged). The two examples of
mounting are as follows:

Example 1
Use cable ties to attach the sensing cable to the positive (or negative) power cable. A minimum of two
cable ties should be used (spaced 6 inches apart), with one of the cable ties not more than 2 inches
from the sensing element. Mount the sensing element not more than 2 inches from the battery post
where the power cable connects. See Figure 73: Battery Temperature Sensor Example 1 on page
152.
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Figure 73: Battery Temperature Sensor Example 1

Example 2
Attach the sensing cable to an existing battery tray support bracket using cable ties or nylon loop
straps of the proper size. Mount the sensing element not more than 2 inches from the surface of the
batteries being monitored. Use a minimum of two cable ties and/or loop straps to secure the sensing
cable to the bracket. Place the cable ties/ loop straps no more than 6 inches apart with one placed no
more than 2 inches from the sensing element. See Figure 74: Battery Temperature Sensor Example 2
on page 153.
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Figure 74: Battery Temperature Sensor Example 2

Grounding 
Detailed grounding information is beyond the scope of this manual. See the Motorola Standards and
Guidelines for Communication Sites manual for detailed information about grounding and lightning
protection.

IMPORTANT: Ground the battery system, either positive or negative, at the battery. The DC
input (battery charger output) of the power supply is floating with respect to earth ground. The
power supply can therefore be used in either positive ground or negative ground DC systems.
The appropriate terminal (+ or -) of the DC system should be connected to protective earth at
the battery.
These instructions assume that all telephone lines, antenna cables, and AC or DC power
cables have been properly grounded and lightning-protected.

When rack installations have a primary rack and one or more expansion racks, all these racks must be
connected to the same Sub System Ground Bus Bar (SSGB) (and no other rack connected to the
SSGB). Grounding ensures that surge events do not produce ground potential differences that affect
signals between the racks.
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Figure 75: Rack Grounding

GTR 8000 Expandable Site Subsystem Grounding
In the GTR 8000 Expandable Site Subsystem, devices connected to the backplanes (transceivers,
power amplifiers, fan modules, and power supplies) are grounded by contact with the card cage/
backplane. Each backplane has a double lug with two lock nuts on the rear panel where the ground
wire connects to the rack grounding bar.

In addition, there are grounding lugs on Radio Frequency Distribution System (RFDS) modules that
connect to the rack grounding bar.

The rack grounding bar must be connected to the master ground bus bar through the junction panel.

Backplanes and Card Cages
Card cages for the GTR 8000 Expandable Site Subsystem are created with a welded and riveted
design. Each card cage has a backplane. The GTR 8000 Expandable Site Subsystem backplane is
pre-cabled when the system is delivered. For connections, see the following:

• GTR 8000 Expandable Site Subsystem Backplane Connections for HPD on page 155.

• GTR 8000 Expandable Site Subsystem Backplane Connections for an ASTRO 25 Repeater Site on
page 157.

• GTR 8000 Expandable Site Subsystem Backplane Connections for IP Simulcast Remote Sites on
page 159.

• GTR 8000 Expandable Site Subsystem Backplane Connections for ASTRO 25 Express System on
page 161

• GTR 8000 Expandable Site Subsystem Backplane Connections for a Trunked 3600 IntelliRepeater
Site on page 163

• GTR 8000 Expandable Site Subsystem Backplane Connections for Trunked 3600 Simulcast
Remote Sites on page 165
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GTR 8000 Expandable Site Subsystem Backplane Connections for HPD
Figure 76: GTR 8000 Expandable Site Subsystem Backplane for HPD

IMPORTANT: It is not recommended that any external devices be connected to the ports
accessible on the GTR 8000 Expandable Site Subsystem backplane. Connections for external
equipment are on the junction panel.

Table 57: GTR 8000 Expandable Site Subsystem Rear Backplane Connections for HPD

Type of Connection Description

RFDS Supplies power to and receives status information signals from the re-
ceive multicouplers/low noise amplifiers (Site RMCs/LNAs) and the
Power Monitor in the Tx Filter.

Remote GPS A Connects Site Controller A to Remote GPS Unit A through the junction
panel.

Remote GPS B Connects Site Controller B to Remote GPS Unit B through the junction
panel.

DC Input #1 Connects to DC Output # 1 on the GTR 8000 Expandable Site Subsys-
tem Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 1, 2 and 3 to PAs/ transceivers
1, 2 and 3. Also carries power for the Odd Aux bus.

Table continued…
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Type of Connection Description

DC Input #2 Connects to DC Output # 2 on the GTR 8000 Expandable Site Subsys-
tems Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 4 and 5 to PAs/ transceivers 4
and 5. Also carries power for the Even Aux bus.

Even AUX PWR Output Auxiliary power output from the even-numbered power supplies. Re-
served for connection to other system components that require a redun-
dant AUX PWR input.

Odd AUX PWR Output Auxiliary power output from the odd-numbered power supplies. Re-
served for connection to other system components that require a redun-
dant AUX PWR input.

GND Two grounding lugs

Internal Alarm Not in use. However this port is cabled to the Internal Alarm port on the
junction panel.

External Alarm Not in use

EXT FREQ REF Not in use

1 PPS Not in use

Table 58: GTR 8000 Expandable Site Subsystem Backplane Internal Connections for HPD

Type of Connection Description

Internal (digital) Connection between Site Controller module A and base ra-
dios

Internal (digital) Connection between Site Controller module B and base ra-
dios

Internal (RF) Receive line A between Cabinet RMC A and up to 5 HPD
base radios

Internal (RF) Receive line B between Cabinet RMC B and up to 5 HPD
base radios

Internal (RF) Transmit line between transceivers and power amplifiers
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GTR 8000 Expandable Site Subsystem Backplane Connections for an
ASTRO 25 Repeater Site
Figure 77: GTR 8000 Expandable Site Subsystem Backplane for a Repeater Site

IMPORTANT: It is not recommended that any external devices be connected to the ports
accessible on the GTR 8000 Expandable Site Subsystem backplane. Connections for external
equipment are on the junction panel.

Table 59: GTR 8000 Expandable Site Subsystem Rear Backplane Connections for a Repeater Site

Type of Connection Description

RFDS Supplies power to and receives status information signals from the re-
ceive multicouplers/low noise amplifiers (Site RMCs/LNAs), the Tx Fil-
ter, the Power Monitor Unit, and the Hybrid Combiner Fan Module.

Remote GPS A Not in use

Remote GPS B Not in use

DC Input #1 Connects to DC Output # 1 on the GTR 8000 Expandable Site Subsys-
tem Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 1, 2 and 3 to PAs/ transceivers
1, 2 and 3. Also carries power for the Odd Aux bus.

Table continued…
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Type of Connection Description

DC Input #2 Connects to DC Output # 2 on the GTR 8000 Expandable Site Subsys-
tems Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 4, 5 and 6 to PAs/ transceivers
4, 5 and 6. Also carries power for the Even Aux bus.

Even AUX PWR Output Auxiliary power output from the even-numbered power supplies. Pro-
vides power to optional GGM 8000 Gateways colocated in the rack.

Odd AUX PWR Output Auxiliary power output from the odd-numbered power supplies. Pro-
vides power to optional GGM 8000 Gateways colocated in the rack.

GND Two grounding lugs.

Internal Alarm Not in use. However this port is cabled to the Internal Alarm port on the
junction panel.

External Alarm Not in use

EXT FREQ REF Not in use

1 PPS Not in use

Table 60: GTR 8000 Expandable Site Subsystem Backplane Internal Connections for an ASTRO 25
Repeater Site

Type of Connection Description

Internal (digital) Connection between site controller module A and base ra-
dios

Internal (digital) Connection between site controller module B and base ra-
dios

Internal (RF) Receive line A between cabinet RMC A and up to six base
radios

Internal (RF) Transmit line between transceiver modules and power am-
plifiers

6871022P87-C
Chapter 3:  GTR 8000 Expandable Site Subsystem Installation

158  Send Feedback

http://docsurvey.motorolasolutions.com


GTR 8000 Expandable Site Subsystem Backplane Connections for IP
Simulcast Remote Sites
Figure 78: GTR 8000 Expandable Site Subsystem Backplane for an IP Simulcast Remote Site

IMPORTANT: It is not recommended that any external devices be connected to the ports
accessible on the GTR 8000 Expandable Site Subsystem backplane. Connections for external
equipment are on the junction panel.

Table 61: GTR 8000 Expandable Site Subsystem Rear Backplane Connections for an IP Simulcast
Remote Site

Type of Connection Description

RFDS Supplies power to and receives status information signals from the re-
ceive multicouplers/low noise amplifiers (Site RMCs/LNAs), the Tx Fil-
ter, the Power Monitor Unit, and the Hybrid Combiner Fan Module.

Remote GPS A Used in a trunked IP simulcast high availability configuration. Connects
RDM A to Remote GPS Unit A through the junction panel.

Remote GPS B Used in a trunked IP simulcast high availability configuration. Connects
RDM B to Remote GPS Unit B through the junction panel.

DC Input #1 Connects to DC Output # 1 on the GTR 8000 Expandable Site Subsys-
tem Power Supply backplane. Provides the Main DC outputs and com-

Table continued…
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Type of Connection Description

munication signals from power supplies 1, 2 and 3 to PAs/ transceivers
1, 2 and 3. Also carries power for the Odd Aux bus.

DC Input #2 Connects to DC Output # 2 on the GTR 8000 Expandable Site Subsys-
tems Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 4, 5 and 6 to PAs/ transceivers
4, 5 and 6. Also carries power for the Even Aux bus.

Even AUX PWR Output Auxiliary power output from the even-numbered power supplies. Pro-
vides power to optional GGM 8000 Gateways colocated in the rack.

Odd AUX PWR Output Auxiliary power output from the odd-numbered power supplies. Pro-
vides power to optional GGM 8000 Gateways colocated in the rack.

GND Two grounding lugs

Internal Alarm Not in use. However this port is cabled to the Internal Alarm port on the
junction panel.

External Alarm Not in use

EXT FREQ REF Used when a TRAK is installed at the site. The EXT FREQ REF input
must have a BNC “T” connected to it. A 50 Ohm termination is on one
leg of the “T” and the cable to the junction panel is on the other side of
the “T”.

1PPS Used when a TRAK is installed at the site. The 1PPS input must have a
BNC “T” connected to it. A 50 Ohm termination is on one leg of the “T”
and the cable to the junction panel is on the other side of the “T”.

NOTICE: The EXT FREQ REF and 1PPS inputs on the backplane of the GTR 8000
Expandable Site Subsystem are high impedance. Use an external termination to properly
terminate the cable connected to the input. A BNC “T” and a 50 Ohm BNC termination is
provided.

Table 62: GTR 8000 Expandable Site Subsystem Backplane Internal Connections for an IP Simulcast
Remote Site (Standard Configuration)

Type of Connection Description

Internal (digital) Connection between XHub module A and base radios

Internal (digital) Connection between XHub module B and base radios

Internal (RF) Receive line A between Cabinet RMC A and up to six base
radios

Internal (RF) Transmit line between transceiver modules and power am-
plifiers

Table 63: GTR 8000 Expandable Site Subsystem Backplane Internal Connections for an IP Simulcast
Remote Site (High Availability Configuration)

Type of Connection Description

Internal (digital) Connection between RDM A and base radios

Internal (digital) Connection between RDM B and base radios

Internal (RF) Receive line A between Cabinet RMC A and up to 6 base
radios

Table continued…
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Type of Connection Description

Internal (RF) Transmit line between transceiver modules and power am-
plifiers

GTR 8000 Expandable Site Subsystem Backplane Connections for
ASTRO 25 Express System
Figure 79: GTR 8000 Expandable Site Subsystem Backplane for ASTRO 25 Express System

IMPORTANT: It is not recommended to connect any external devices to the ports accessible on
the GTR 8000 Expandable Site Subsystem backplane. Connections for external equipment are
on the junction panel.

Table 64: GTR 8000 Expandable Site Subsystem Rear Backplane Connections for ASTRO 25 Express
System

Type of Connection Description

RFDS Supplies power to and receives status information signals from the re-
ceive multicouplers/low noise amplifiers (Site RMCs/LNAs), and Hybrid
Combiner Fan Module.

Remote GPS A Not in use

Remote GPS B Not in use
Table continued…
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Type of Connection Description

DC Input #1 Connects to DC Output # 1 on the GTR 8000 Expandable Site Subsys-
tem Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 1, 2 and 3 to PAs/ XCVRs 1, 2
and 3; also carries power for the Odd Aux bus.

DC Input #2 Connects to DC Output # 2 on the GTR 8000 Expandable Site Subsys-
tems Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 4, 5 and 6 to PAs/ XCVRs 4, 5
and 6; also carries power for the Even Aux bus.

Even AUX PWR Output Auxiliary power output from the even-numbered power supplies. Re-
served for connection to other system components that require a redun-
dant AUX PWR input.

Odd AUX PWR Output Auxiliary power output from the odd-numbered power supplies. Re-
served for connection to other system components that require a redun-
dant AUX PWR input.

GND Two grounding lugs

Internal Alarm Not in use, however this port is cabled to the Internal Alarm port on the
junction panel.

External Alarm Not in use

EXT FREQ REF Not in use

1 PPS Not in use

Table 65: GTR 8000 Expandable Site Subsystem Backplane Internal Connections for an ASTRO 25
Express System

Type of Connection Description

Internal (digital) Connection between Site Controller module A and base radios

Internal (digital) Connection between Site Controller module B and base radios

Internal (RF) Receive line A between Cabinet RMC A and up to 6 base ra-
dios

Internal (RF) Transmit line between transceiver modules and power amplifi-
ers
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GTR 8000 Expandable Site Subsystem Backplane Connections for a
Trunked 3600 IntelliRepeater Site
Figure 80: GTR 8000 Expandable Site Subsystem Backplane for a Trunked 3600 IntelliRepeater
Site

IMPORTANT: It is not recommended that any external devices be connected to the ports
accessible on the GTR 8000 Expandable Site Subsystem backplane. Connections for external
equipment are on the junction panel.

Table 66: GTR 8000 Expandable Site Subsystem Rear Backplane Connections for a Trunked 3600
IntelliRepeater Site

Type of Connection Description

RFDS Supplies power to and receives status information signals from the re-
ceive multicouplers/low noise amplifiers (Site RMCs/LNAs), the Tx Fil-
ter, the Power Monitor Unit, and the Hybrid Combiner Fan Module.

Remote GPS A Not in use

Remote GPS B Not in use

DC Input #1 Connects to DC Output # 1 on the GTR 8000 Expandable Site Subsys-
tem Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 1, 2 and 3 to PAs/ transceivers
1, 2 and 3. Also carries power for the Odd Aux bus.

Table continued…
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Type of Connection Description

DC Input #2 Connects to DC Output # 2 on the GTR 8000 Expandable Site Subsys-
tems Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 4, 5 and 6 to PAs/ transceivers
4, 5 and 6. Also carries power for the Even Aux bus.

Even AUX PWR Output Auxiliary power output from the even-numbered power supplies. Pro-
vides power to optional GGM 8000 Gateways colocated in the rack.

Odd AUX PWR Output Auxiliary power output from the odd-numbered power supplies. Pro-
vides power to optional GGM 8000 Gateways colocated in the rack.

GND Two grounding lugs.

Internal Alarm Not in use. However this port is cabled to the Internal Alarm port on the
junction panel.

External Alarm Not in use

EXT FREQ REF Not in use

1 PPS Not in use

Table 67: GTR 8000 Expandable Site Subsystem Backplane Internal Connections for a Trunked 3600
IntelliRepeater Site

Type of Connection Description

Internal (digital) Connection between RDM A and base radios

Internal (digital) Connection between RDM B and base radios

Internal (RF) Receive line A between Cabinet RMC A and up to six base
radios

Internal (RF) Transmit line between transceiver modules and power am-
plifiers
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GTR 8000 Expandable Site Subsystem Backplane Connections for
Trunked 3600 Simulcast Remote Sites
Figure 81: GTR 8000 Expandable Site Subsystem Backplane for a Trunked 3600 Simulcast
Remote Site

IMPORTANT: It is not recommended that any external devices be connected to the ports
accessible on the GTR 8000 Expandable Site Subsystem backplane. Connections for external
equipment are on the junction panel.

Table 68: GTR 8000 Expandable Site Subsystem Rear Backplane Connections for a Trunked 3600
Simulcast Remote Site

Type of Connection Description

RFDS Supplies power to and receives status information signals from the re-
ceive multicouplers/low noise amplifiers (Site RMCs/LNAs), the Tx Fil-
ter, the Power Monitor Unit, and the Hybrid Combiner Fan Module.

Remote GPS A Not in use

Remote GPS B Not in use

DC Input #1 Connects to DC Output # 1 on the GTR 8000 Expandable Site Subsys-
tem Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 1, 2 and 3 to PAs/ transceivers
1, 2 and 3. Also carries power for the Odd Aux bus.

Table continued…
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Type of Connection Description

DC Input #2 Connects to DC Output # 2 on the GTR 8000 Expandable Site Subsys-
tems Power Supply backplane. Provides the Main DC outputs and com-
munication signals from power supplies 4, 5 and 6 to PAs/ transceivers
4, 5 and 6. Also carries power for the Even Aux bus.

Even AUX PWR Output Auxiliary power output from the even-numbered power supplies.

Odd AUX PWR Output Auxiliary power output from the odd-numbered power supplies.

GND Two grounding lugs.

Internal Alarm Not in use. However this port is cabled to the Internal Alarm port on the
junction panel.

External Alarm Not in use

EXT FREQ REF Used when a simulcast site reference is installed at the site. The EXT
FREQ REF input must have a BNC “T” connected to it. A 50 Ohm ter-
mination is on one leg of the “T” and the cable to the junction panel is on
the other side of the “T”.

1 PPS Used when a simulcast site reference is installed at the site. The 1 PPS
input must have a BNC “T” connected to it. A 50 Ohm termination is on
one leg of the “T” and the cable to the junction panel is on the other side
of the “T”.

NOTICE: The EXT FREQ REF and 1 PPS inputs on the backplane of the GTR 8000
Expandable Site Subsystem are high impedance. Use an external termination to properly
terminate the cable connected to the input. A BNC “T” and a 50 Ohm BNC termination is
provided.

Table 69: GTR 8000 Expandable Site Subsystem Backplane Internal Connections for a Trunked 3600
Simulcast Remote Site

Type of Connection Description

Internal (digital) Connection between XHub module A and base radios

Internal (digital) Connection between XHub module B and base radios

Internal (RF) Receive line A between Cabinet RMC A and up to six base
radios

Internal (RF) Transmit line between transceiver modules and power am-
plifiers
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GTR 8000 Expandable Site Subsystem Power Supply Backplane
Figure 82: GTR 8000 Expandable Site Subsystem Power Supply Backplane

Table 70: GTR 8000 Expandable Site Subsystem Power Supply Backplane Connections

Type of Connection Description

PS + Batt/DC - These ports connect to the positive and negative DC input cables at-
tached to the junction panel power distribution module. From these
ports, the DC power feeds through the backplane to the DC connector
on the associated power supply.

AC In These ports connect to the AC input cable attached to the junction panel
power distribution module. From these ports, AC power feeds through
the backplane to the AC input connector on the associated power sup-
ply.

Batt Temp Sensor, 6-pin For battery temperature sensor cable that can connect to a probe
through the junction panel. Used for temperature compensated battery
charging.

DC Output #1 Connects to DC Input # 1 on the GTR 8000 Expandable Site Subsys-
tem backplane. Provides the Main DC outputs and communication sig-
nals from power supplies 1, 2 and 3 to PAs/transceivers 1, 2 and 3. Also
carries power for the Odd Aux bus.

DC Output #2 Connects to DC Input # 2 on the GTR 8000 Expandable Site Subsys-
tem backplane. Provides the Main DC outputs and communication sig-
nals from power supplies 4, 5 and 6 to PAs/transceivers 4, 5 and 6. Also
carries power for the Even Aux bus.

NOTICE: Information about internal power connections for the GTR 8000 Expandable Site
Subsystem backplane and Power Supply backplane are provided in AC/DC Power Distribution
on page 104.

Front Transceiver Ports
Two service ports are accessible through a drop-down door to the top of the fans. The remaining ports
are behind the fan module.
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Figure 83: Transceiver Ports – Front

NOTICE: The optional Transceiver Option Card is a board that attaches to the control board.
The board provides an internal 10 MHz frequency reference. For conventional base radio
operation, it also provides the analog interfaces and WildCard I/Os.

Table 71: Transceiver Connections - Front

Transceiver Port / Type Connects to This De-
vice/Port Description

Ethernet service port, RJ-45 Service PC, LAN port Ethernet service port for local access using
Configuration/Service Software (CSS). Also
may be used for localized software down-
loads.

NOTICE: Supports only 10 Mb half
duplex operation.

Serial service port, DB-9 Service PC, RS-232
port

Serial service port for initial configuration of the
base radio IP address.

Microphone port, RJ-45 Microphone, RJ-45 Used to connect to a microphone with PTT
button.

NOTICE: Use microphone kit
GMM4063B.

Speaker port, RJ-9 External Speaker, RJ-9 Used to connect to an amplified (DC powered)
external speaker. Audio volume level is set
from the CSS.

CAUTION: To prevent damage to
the base radio, use speaker kit
HSN1006A and cable part no.
0185180U01.

Wireline port, RJ-45 Junction Panel, RJ-45 Connection between telephone lines or analog
site equipment and the analog base radio. The
wireline processes and routes all wireline au-
dio signals between the base radio and land-
line equipment (such as consoles or mo-
dems).

Table continued…
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Transceiver Port / Type Connects to This De-
vice/Port Description

System Connector, mini
SCSI

Junction Panel, RJ-45
or Punchblock 50-pin
Telco

Provides the WildCard I/Os and supplementa-
ry Analog I/Os for analog simulcast and spe-
cial applications. Editing of WildCard configu-
rations is permitted only through CSS.

Asynchronous port, RS232,
RJ-45

Junction Panel, RJ-45 Connection port when the base radio is part of
a trunked 3600 IntelliRepeater site.

V.24 port Junction Panel, RJ-45 Connection port when the base radio is part of
a conventional or trunking circuit-based site,
mixed mode or digital only.

Reference frequency input,
BNC*

Service monitor Connection port to service monitor for frequen-
cy calibration.

* See GTR 8000 Base Radio Time and Frequency Inputs on page 292.

System Connector Ports (Conventional)

The system connector, a 50-pin Mini SCSI connector, is used for the WildCard inputs, outputs, and the
analog audio paths not routed to their own connector.

Table 72: 50–Pin System Connector Pin-Outs (Conventional)

Pin No. Signal Type Function Note

1 Aux In 2 Input Main Standby - External hand-
shaking

Pull To Ground To Activate

2 Aux In 4 Input Main Standby- Status of other
side

Pull To Ground To Activate

3* Aux In 6 Input In-Cabinet Repeat Pull To Ground To Activate

4 Aux In 8 Input Main Standby - Connectivity
other Station

Pull To Ground To Activate

5 Aux In 9 – Input Phone Patch - PL Strip Opto-Isolated In - Current flow to Acti-
vate

6 Aux In 10 – Input Phone Patch - Monitor Opto-Isolated In - Current flow to Acti-
vate

7 Aux In 11 – Input Opto-Isolated In - Current flow to Acti-
vate

8 Aux In 12 – Input Opto-Isolated In - Current flow to Acti-
vate

9 Aux In 13 Input For future use Pull To Ground To Activate

10 Aux Out 12 Output Low Impedance to Ground When Ac-
tive

11 Aux Out 2 Output Phone Patch - Rx Carrier Low Impedance to Ground When Ac-
tive

12 Aux Out 4 Output Main Standby - Station Status Low Impedance to Ground When Ac-
tive

Table continued…
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Pin No. Signal Type Function Note

13 Aux Out 6 Output Low Impedance to Ground When Ac-
tive

14 Aux Out Relay 7
Com

Output RD STAT - Receiver Active Form Relay A Closed When Active

15 Aux Out Relay 8
Com

Output Main Standby - Antenna Relay Form Relay A Closed When Active

16 Aux Out Relay 9
Com

Output Form Relay A Closed When Active

17 Aux Out Relay 10
Com

Output Form Relay A Closed When Active

18 Aux Out 11 Output Low Impedance to Ground When Ac-
tive

19 External_Reset Input Reset Buffered Input Pull To Ground To Acti-
vate

20 TSTAT Output For future use 0 Volts When Inactive / +5 Volts when
Active

21 AUX RX Output Aux Rx Analog Signal – Unbalanced

22 GND GND

23** AUX TX Input/Out-
put

Aux Tx Analog Signal – 600 Ohm Unbalanced

24 PL - Input PL(-) In Analog Signal – 600 Ohm Balanced

25** Gen TX – Input Gen TX Data- Analog Signal – 600 Ohm Balanced

26 Aux In 1 Input Phone Patch - Call Request Pull To Ground To Activate

27 Aux In 3 Input Tx Inhibit Pull To Ground To Activate

28 Aux In 5 Input External PTT Pull To Ground To Activate

29 Aux In 7 Input Rx Inhibit Pull To Ground To Activate

30 Aux In 9 + Input Phone Patch - PL Strip Opto-Isolated In - Current flow to Acti-
vate

31 Aux In 10 + Input Phone Patch - Monitor Opto-Isolated In - Current flow to Acti-
vate

32 Aux In 11 + Input Opto-Isolated In - Current flow to Acti-
vate

33 Aux In 12 + Input Opto-Isolated In - Current flow to Acti-
vate

34 GND GND

35 Aux In 14 Input For future use Pull To Ground To Activate

36 Aux Out 1 Output Phone Patch - Inhibit / Enable Low Impedance to Ground When Ac-
tive

37 Aux Out 3 Output Low Impedance to Ground When Ac-
tive

Table continued…
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Pin No. Signal Type Function Note

38 Aux Out 5 Output Low Impedance to Ground When Ac-
tive

39 Aux Out Relay 7
N.O.

Output RD STAT - Receiver Active Form Relay A Closed When Active

40 Aux Out Relay 8
N.O.

Output Main Standby - Antenna Relay Form Relay A Closed When Active

41 Aux Out Relay 9
N.O.

Output Form Relay A Closed When Active

42 Aux Out Relay 10
N.O.

Output Form Relay A Closed When Active

43 GND GND

44 GND GND

45 RSTAT Output For future use 0 Volts When Inactive / +5 Volts when
Active

46 GND GND

47 TX DATA +

48 GND GND

49 PL + Input PL(+ ) In Analog Signal – 600 Ohm Balanced

50** Gen TX + Input Gen TX DATA + Analog Signal – 600 Ohm Balanced

* For detailed information on the differences between the automatic Fallback In-Cabinet Repeat and
the externally-wired In-Cabinet Repeat functions, see the Conventional Operations manual.

** It is the responsibility of the third-party vendor to ensure that the signal generated by their device is
compliant with any regulatory agency limitation imposed on the channel. This signal is not filtered or
limited by the GTR 8000 Base Radio.

Figure 84: 50–Pin System Connector Pin-Outs (Conventional)
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System Connector Ports (Trunked 3600)

The system connector is a 50-pin Mini SCSI connector. It is used for the WildCard inputs, outputs, and
the analog audio paths not routed to their own connector.

Table 73: 50–Pin System Connector Pin-Outs (Trunked 3600)

Pin # Signal Type Function Note

1 Aux In 2 Input CCI Pull To Ground To Activate

2 Aux In 4 Input TPTT Pull To Ground To Activate

3* Aux In 6 Input In-Cabinet Repeat Pull To Ground To Activate

4 Aux In 8 Input Pull To Ground To Activate

5 Aux In 9 – Input Opto-Isolated In - Current flow to Acti-
vate

6 Aux In 10 – Input Opto-Isolated In - Current flow to Acti-
vate

7 Aux In 11 – Input Opto-Isolated In - Current flow to Acti-
vate

8 Aux In 12 – Input Opto-Isolated In - Current flow to Acti-
vate

9 Aux In 13 Input Trunking Mute Pull To Ground To Activate

10 Aux Out 12 Output Low Impedance to Ground When Ac-
tive

11 Aux Out 2 Output Low Impedance to Ground When Ac-
tive

12 Aux Out 4 Output Low Impedance to Ground When Ac-
tive

13 Aux Out 6 Output Low Impedance to Ground When Ac-
tive

14 Aux Out Relay 7
Com

Output RD STAT - Receiver Active Form Relay A Closed When Active

15 Aux Out Relay 8
Com

Output Form Relay A Closed When Active

16 Aux Out Relay 9
Com

Output Form Relay A Closed When Active

17 Aux Out Relay 10
Com

Output Form Relay A Closed When Active

18 Aux Out 11 Output Low Impedance to Ground When Ac-
tive

19 External_Reset Input Reset Buffered Input Pull To Ground To Acti-
vate

20 TSTAT Output TSTAT 0 Volts When Inactive / +5 Volts when
Active

Table continued…
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Pin # Signal Type Function Note

21 AUX RX Output Aux Rx Analog Signal – Unbalanced

22 GND GND

23** AUX TX Input/Out-
put

Aux Tx Analog Signal – 600 Ohm Unbalanced

24 PL - Input n/a Analog Signal – 600 Ohm Balanced

25** Gen TX – Input Gen TX Data- Analog Signal – 600 Ohm Balanced

26 Aux In 1 Input Ext Failsoft Pull To Ground To Activate

27 Aux In 3 Input Tx Inhibit Pull To Ground To Activate

28 Aux In 5 Input External PTT Pull To Ground To Activate

29 Aux In 7 Input Rx Inhibit Pull To Ground To Activate

30 Aux In 9 + Input Opto-Isolated In - Current flow to Acti-
vate

31 Aux In 10 + Input Opto-Isolated In - Current flow to Acti-
vate

32 Aux In 11 + Input Opto-Isolated In - Current flow to Acti-
vate

33 Aux In 12 + Input Opto-Isolated In - Current flow to Acti-
vate

34 GND GND

35 Aux In 14 Input For future use Pull To Ground To Activate

36 Aux Out 1 Output Failsoft Indicate Low Impedance to Ground When Ac-
tive

37 Aux Out 3 Output Low Impedance to Ground When Ac-
tive

38 Aux Out 5 Output Low Impedance to Ground When Ac-
tive

39 Aux Out Relay 7
N.O.

Output RD STAT - Receiver Active Form Relay A Closed When Active

40 Aux Out Relay 8
N.O.

Output Form Relay A Closed When Active

41 Aux Out Relay 9
N.O.

Output Form Relay A Closed When Active

42 Aux Out Relay 10
N.O.

Output Form Relay A Closed When Active

43 GND GND

44 GND GND

45 RSTAT Output RSTAT 0 Volts When Inactive / +5 Volts when
Active

46 GND GND

47 TX DATA +
Table continued…
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Pin # Signal Type Function Note

48 GND GND

49 PL + Input n/a Analog Signal – 600 Ohm Balanced

50** Gen TX + Input Gen TX DATA + Analog Signal – 600 Ohm Balanced

* For detailed information on the differences between the automatic Fallback In-Cabinet Repeat and
the externally-wired In-Cabinet Repeat functions, see the Conventional Operations manual.

** It is the responsibility of the third-party vendor to ensure that the signal generated by their device is
compliant with any regulatory agency limitation imposed on the channel. This signal is not filtered or
limited by the GTR 8000 Base Radio.

Figure 85: 50–Pin System Connector Pin-Outs (Trunked 3600)

Wireline Port Pin-Outs

The Wireline port, an RJ-45 connector, can accommodate up to eight pins.

Table 74: Wireline Port Pin-Outs

Signal Name Pin No.
2-Wire Con-

nection
4-Wire Con-

nection

Auxiliary 4-
Wire Connec-

tion

Line2_+ 1 Input/Output Output

Line2_– 2 Input/Output Output

Line3_+ 3 Input

Line1_– 4 Input

Line1_+ 5 Input

Line3_– 6 Input

Line4_+ 7 Output

Line4_– 8 Output
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Figure 86: Wireline Port Pin-Outs

Microphone Port Pin-Outs

The Microphone port is an RJ-45 connector that provides the interface for a microphone.

Table 75: Microphone Port Pin-Outs

Signal Name Pin No.

Reserved 1

Reserved 2

MIC_PTT 3

MIC_AUDIO 4

GND 5

Reserved 6

Reserved 7

Reserved 8

Figure 87: Microphone Port Pin-Outs

Speaker Port Pin-Outs

The Speaker port is an RJ-9 connector that provides the interface to an external speaker.
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CAUTION: To prevent damage to the base radio, use the HSN1006A speaker with the
0185180U01 cable.

Table 76: Speaker Port Pin-Outs

Signal Name Pin No.

GND 1

+12 V 2

GND 3

Speaker Out 4

Figure 88: Speaker Port Pin-Outs

V.24 Port Pin-Outs

The V.24 port is an RJ-45 connector that provides the interface to a Digital Interface Unit, Conventional
Channel Interface, Conventional Channel Gateway (CCGW), ASTRO-TAC® 3000 Comparator, or
Channel Bank.

Table 77: V.24 Port Pin-Outs

Signal Name Pin No. Type

RCLK 1 Input

Rx Line Det 2 Input

TCLK 3 Input/Output

GND 4 GND

Data Rx 5 Input

Data Tx 6 Output

CTS 7 Input

RTS 8 Output

ASYNC RS-232 Cable Pin-Outs

The ASYNC RS-232 port is an RJ-45 connector that provides the interface to the Channel Bank for
connection to the zone controller.
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NOTICE: The ASYNC connection is only supported for a GTR 8000 Expandable Site
Subsystem used in a trunked 3600 IntelliRepeater site.

Table 78: ASYNC RS-232 Port Pin-Outs

XCVR Pin-Outs Junction Panel Pin-Outs

Function RJ-45 ASYNC Pin # Channel Bank RJ-45 Pin #

RTS 1 8

DCD/DSR 2 2

RXD 3 5

— 4 —

GND 5 4

TXD 6 6

— 7 —

CTS 8 7

GTR 8000 Base Radio Part 68 Information

This section applies when the base radio is equipped with the optional wireline interface circuitry
contained on the Oven Controlled Crystal Oscillator (OCXO) Transceiver Option Card (Option
CA01506AA) or Temperature Compensated Crystal Oscillator (TCXO) Transceiver Option Card
(Option CA01953).

NOTICE: The TCXO Transceiver Option Card is used for the Power Efficiency Package option.

This equipment complies with Part 68 of the FCC rules and the requirements of the Administrative
Counsel for Terminal Attachments (ACTA). On the rear of this equipment is a label that contains,
among other information, the registration number:

• US: ABZNINANT7039

If requested, this number must be provided to the telephone company.

The connector used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements of the ACTA. A compliant connector is
provided with this product. See installation instructions for details.

REN: N/A
Connector: RJ-48
Authorized Network Port: 04NO2
Service Order Code: 7.0Y

If the equipment causes harm to the telephone network, the telephone company notifies your
organization in advance that temporary discontinuance of service may be required. If advance notice is
not practical, the telephone company notifies your organization as soon as possible. Also, your
organization is advised of the right to file a complaint with the FCC if it is necessary.

The telephone company may change its facilities, equipment, operations, or procedures that could
affect the operation of the equipment. If changes happen, the telephone company provides advance
notice so your organization can make necessary modifications to maintain uninterrupted service.

If your organization experiences trouble with this equipment, see Motorola Solution Support Center on
page 344 for repair and warranty information. If the equipment is causing harm to the telephone
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network, the telephone company may request that you disconnect the equipment until the problem is
resolved.

None of the circuit boards in this equipment are field repairable. For assistance in sending the boards
back for repair, see Motorola Solution Support Center on page 344.

This equipment cannot be used on telephone company public coin phone service. Connection to party
line service is subject to state tariffs. Contact the state public utility commission, public service
commission, or corporation commission for information.

GCP 8000 Site Controller and GPB 8000 Reference Distribution
Module Ports (Front)
The GCP 8000 Site Controller and GPB 8000 Reference Distribution Module (RDM) has ports on both
the front and the back that allow it to connect to various devices, including base radios, expansion
ports, and other site equipment. In a GTR 8000 Expandable Site Subsystem configuration, the
Ethernet connections from the individual base radios run on the backplane and connect to the switch
on the site controller or RDM. This configuration minimizes the need for Ethernet cables.

Two service ports are accessible through a drop-down door to the top of the fans. The remaining ports
are behind the fan module.
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Figure 89: Site Controller and RDM Ports – Front

Table 79: Site Controller and RDM Connections – Front

Port / Type Device it connec-
tions to: Port / Type Description

Ethernet serv-
ice port,
RJ-45

Service PC LAN port Ethernet service port for lo-
cal access using Configura-
tion/Service Software (CSS).
Also may be used for local-
ized software downloads.

Table continued…
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Port / Type Device it connec-
tions to: Port / Type Description

NOTICE: Sup-
ports only 10 Mb
half duplex opera-
tion.

Serial service
port, DB-9

Service PC RS-232 port Serial service port for initial
configuration of the IP ad-
dress.

Net AUX,
RJ-45

Not in use

Gateway,
RJ-45

Site router or site gate-
way

RJ-45 Connection to Gateway port
on junction panel.

Expansion
1-5, RJ-45

Junction panel Cab #1-5 A and Cab #1-5 B
ports, RJ-45

Connects the site controllers
or RDMs to the XHubs in the
expansion cabinets.

Reference fre-
quency input,
BNC

Service monitor BNC Connection port to service
monitor for frequency cali-
bration.

Expansion Hub Connections
Each Expansion Hub (XHub) is connected to its corresponding site controller or GPB 8000 Reference
Distribution Module (RDM) through the sub-panels on the junction panel.
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Figure 90: Expansion Hub Connections

Table 80: Expansion Hub Connections (Front View)

Port Connects to Port Type Description

NET AUX Junction panel, NET AUX
port

RJ-45 Provides connection to auxiliary de-
vices to the LAN.

EXPSN In-
put (CP3)

Network Expansion sub-pan-
el on junction panel

RJ-45 Provides connection between
XHubs and junction panel. Also pro-
vides connections between site con-
trollers or RDMs in Cabinet #1.

Junction Panel Connections
The junction panel for the GTR 8000 Expandable Site Subsystem provides locations for all the
connections to external devices. Cables provided by Motorola include the specific connectors for the
junction panel on one end and the subsystem equipment on the other end.

IMPORTANT: Do not remove the label from a connector location until you insert the connector.

NOTICE: For an overview of connecting to an ASTRO® 3.1 Conventional System (ASTRO-TAC
3000 Comparator or DIU), see the Conventional Operations manual. The base radio can be IP
managed while using the 4-wire/V.24 interface for channel traffic.

Junction Panel Connections for an ASTRO 25 Repeater Site (700/800/900
MHz and UHF R2 435–524 MHz)
In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
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Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 91: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for an
ASTRO 25 Repeater Site (700/800/900 MHz and UHF R2 435–524 MHz)

Receive Input
Branch 'A' Branch 'B' Branch 'C'

TX '1' TX '2'

TX

To Receiver Antenna

To Transmit Antenna

To Moscad

To Site Gateway
or Link

A25_GTR8000_JP_ESS_Prime_Conv_700_800_900_UHFR2E

Optional
Network Expansion
Subpanel 

Optional
Receiver Expansion

Subpanel

To Channel Bank or CCGW

Network
AUX

Gateway Internal
Alarm

Remote
GPS 'B'

Remote
GPS 'A'

Battery
Temp

A

B

A

B

Ext
Freq Ref

1 PPS

To Remote GPS Units

To Transmit AntennaTo Transmit Antenna

Circuit Audio
ASYNC

V.24

WIRELINE

1 2 3 4 5 6

1 2 3 4 5 6

NOTICE: For HPD Overlay sites, the Gateway A and B connections link directly to Site
Switches A and B instead of gateways. The site switches may be inside the site controller
modules if HPD is overlaid on a GTR 8000 Expandable Site Subsystem.

Table 81: GTR 8000 Expandable Site Subsystem Prime Cabinet Junction Panel Connections for an
ASTRO 25 Repeater Site (700/800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type Description

Gateway
A port,
RJ-45

Primary Site Gateway LAN 1, RJ-45 Ethernet link between site controller A and
the primary site gateway or primary site
gateway to site link

Gateway
B port,
RJ-45

Secondary Site Gateway
(optional)

LAN 1, RJ-45 Ethernet link between site controller B and
secondary site gateway or secondary site
gateway to site link (if installed).

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type Description

Network
AUX A,
RJ-45

MOSCAD NFM or exter-
nal trunked base radio

LAN Port 1,
RJ-45
SC-A, RJ-45

Ethernet link for MOSCAD NFM or con-
nection to external trunked base radio.

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.
If a site gateway (CCGW) is integrated into
the prime cabinet, it connects directly to the
Net AUX port on SC B.

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

Remote
GPS A,
DB-15

Not in use

Remote
GPS B,
DB-15

Not in use

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device, or
channel bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the prime cabinet. This port
is used to connect them when one is inte-
grated and the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the prime cabinet. This
port is used to connect them when one is
integrated and the other is not.

ASYNC,
RJ-45

Not in use

Rx-A, N-
type

Receive antenna A / tow-
er top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tow-
er top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity option for Phase 2 TDMA is needed.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type Description

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner (optional)

Tx output port RF coax to transmit antenna.

Cab #1-5,
A, RJ-45

Site Controller 1 Expansion
Ports 1-5,
RJ-45

Connection of site controller 1 to XHub A in
expansion cabinets #1-5.

Cab #1-5,
B, RJ-45

Site Controller 2 Expansion
Ports 1-5,
RJ-45

Connection of site controller 2 to XHub B in
expansion cabinets #1-5.

Cab #1-3,
Branch A,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘A’.

Rx A, N Receive path connection from the primary
cabinet to the Rx Branch ‘A’ connector of
expansion cabinets #1-3.

Cab #1-3,
Branch B,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘B’.

Rx B, N Receive path connection from the primary
cabinet to the Rx Branch ‘B’ connector of
expansion cabinets #1-3.

Internal
Alarm,
DB-25

Not in use

Ext. Freq.
Ref.

Not in use

1 PPS Not in use
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Figure 92: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
an ASTRO 25 Repeater Site (700/800/900/UHF R2 435–524 MHz)
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Table 82: GTR 8000 Expandable Site Subsystem Expansion Junction Panel Connections for an
ASTRO 25 Repeater Site (700/800/900/UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type
Description

Expansion
Input A
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1-5, A

LAN 1, RJ-45 Expansion link between site controller A and
XHub A in expansion cabinet (N) where N is
the number of the cabinet.

Expansion
Input B
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1-5, B

LAN 1, RJ-45 Expansion link between site controller B and
XHub B in expansion cabinet (N) where N is
the number of the cabinet.

Network
AUX A,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type
Description

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Battery
Temp, 6-
pin

Backup Battery Tem-
perature Sensor

See battery temperature sensor instructions
for connection requirements.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU, site
gateway (digital CCGW) device, or channel
bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the cabinet. This port is used
to connect them when one is integrated and
the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external or
integrated into the cabinet. This port is used
to connect them when one is integrated and
the other is not.

ASYNC,
RJ-45

Not in use

Rx-A, N-
type

Receive antenna A/tow-
er top amplifier or Re-
ceive expansion

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B /
tower top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity option for Phase 2 TDMA is needed.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for
hybrid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for
hybrid combiner (op-
tional)

Tx output port RF coax to transmit antenna.

Internal
Alarm,
DB-25

Not in use
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Junction Panel Connections for an ASTRO 25 Repeater Site (UHF R1 380–
435 MHz and VHF 136–174 MHz)
In a GTR 8000 Expandable Site Subsystem operating in the UHF R1 and VHF bands, most external
equipment is connected through the junction panel. Each of the six Tx outputs is connected with a
cable from a power amplifier in the GTR 8000 Expandable Site Subsystem to the junction panel that
connects to the Tx RFDS. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 93: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for an
ASTRO 25 Repeater Site (UHF R1 380–435 MHz and VHF 136–174 MHz)
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NOTICE: For HPD Overlay sites, the Gateway A and B connections link directly to Site
Switches A and B instead of gateways. The site switches may be inside the site controller
modules if HPD is overlaid on a GTR 8000 Expandable Site Subsystem.

Table 83: GTR 8000 Expandable Site Subsystem Prime Cabinet Junction Panel Connections for an
ASTRO 25 Repeater Site (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type Description

Gateway
A port,
RJ-45

Primary Site Gateway LAN 1, RJ-45 Ethernet link between site controller A and
the primary site gateway or primary site
gateway to site link.

Gateway
B port,
RJ-45

Secondary Site Gateway
(optional)

LAN 1, RJ-45 Ethernet link between site controller B and
secondary site gateway or secondary site
gateway to site link (if installed).

Network
AUX A,
RJ-45

MOSCAD NFM or exter-
nal trunked base radio

LAN 1, RJ-45
SC-A, RJ-45

Ethernet link for MOSCAD NFM or con-
nection to external trunked base radio.

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.
If a site gateway is integrated into the
prime cabinet, it connects directly to the
Net AUX port on SC B.

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

Remote
GPS A,
DB-15

Not in use

Remote
GPS B,
DB-15

Not in use

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device, or
channel bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the prime cabinet. This port
is used to connect them when one is inte-
grated and the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the prime cabinet. This

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type Description

port is used to connect them when one is
integrated and the other is not.

ASYNC Not in use

RX 1
through 6,
BNC

External Receive Multi-
coupler

RMC output
Port

RF coax to receive input for each BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU option
is included. Tx output from external
combiner must be routed directly to PMU
input.

Cab #1-5,
A, RJ-5

Site Controller 1 Expansion
Ports 1-5,
RJ-45

Connection of site controller 1 to XHub A in
expansion cabinets #1-5.

Cab #1-5,
B, RJ-45

Site Controller 2 Expansion
Ports 1-5,
RJ-45

Connection of site controller 2 to XHub B in
expansion cabinets #1-5.

Internal
Alarm,
DB-25

Not in use

Ext. Freq.
Ref.

Not in use

1 PPS Not in use
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Figure 94: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
an ASTRO 25 Repeater Site (UHF R1 380–435 MHz and VHF 136–174 MHz)
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Table 84: GTR 8000 Expandable Site Subsystem Expansion Junction Panel Connections for a
Repeater Site (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Expansion
Input A
port, RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1-5, A

LAN 1, RJ-45 Expansion link between site controller A
and Expansion Hub A in expansion cabinet
(N) where N is the number of the cabinet.

Expansion
Input B
port, RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1-5, B

LAN 1, RJ-45 Expansion link between site controller B
and Expansion Hub B in expansion cabinet
(N) where N is the number of the cabinet.

Network
AUX A,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Battery
Temp, 6-
pin

Backup Battery Tem-
perature Sensor

See battery temperature sensor instructions
for connection requirements.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU, site
gateway (digital CCGW) device, or channel
bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the cabinet. This port is used
to connect them when one is integrated and
the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW),
or analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the cabinet. This port is
used to connect them when one is integrat-
ed and the other is not.

ASYNC Not in use

RX ‘1’
through 6
BNC

External Receive Multi-
coupler

RMC output
Port

RF coax to receive input for each BR.

TX 1
through 6
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU option
is included. Tx output from external combin-
er must be routed directly to PMU input.

Internal
Alarm,
DB-25

Not in use

Junction Panel Connections for a Trunked IP Simulcast Site (700/800/900
MHz and UHF R2 435–524 MHz) (Standard Configuration)
In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.
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Figure 95: Junction Panel for the GTR 8000 Expandable Site Subsystem for a Trunked IP
Simulcast Site Standard Configuration (700/800/900 MHz and UHF R2 435–524 MHz)
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Table 85: GTR 8000 Expandable Site Subsystem Junction Panel Connections for Trunked IP
Simulcast Sites Standard Configuration (700/800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

LAN A
port,
RJ-45

Switch LAN 1, RJ-45 Ethernet link to the LAN switch to remote
site gateway.

LAN B
port,
RJ-45

Not in use

1PPS,
BNC*

TRAK 9100 Timing, BNC Connect external Site Timing Reference

Ext Freq
Ref, BNC*

TRAK 9100 5 MHz fre-
quency reference

RF, BNC Connect external Site Frequency Refer-
ence

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device, or
channel bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the cabinet. This port is
used to connect them when one is inte-
grated and the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the cabinet. This port is
used to connect them when one is inte-
grated and the other is not.

ASYNC Not in use

Rx-A, N-
type

Receive antenna A / tow-
er top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tow-
er top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity option for Phase 2 TDMA is required.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner (optional)

Tx output port RF coax to transmit antenna.

Cab #1-3,
Branch A,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘A’.

Rx A, N Receive path connection from the primary
cabinet to the Rx Branch ‘A’ connector of
expansion cabinets #1-3.

Cab #1-3,
Branch B,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘B’.

Rx B, N Receive path connection from the primary
cabinet to the Rx Branch ‘B’ connector of
expansion cabinets #1-3.

Internal
Alarm,
DB-25

May connect MOSCAD NFM to pin-22 and
23 for contact closure. Indicates RMC fail-
ure.

* See GTR 8000 Base Radio Time and Frequency Inputs on page 292 The XHubs need both Time
and Frequency references that are provided with either a Composite (5 MHz +1PPS) or separate 5
MHz and 1PPS sources. For a separate 5 MHz reference, connect to the Ext Freq Ref port on each
cabinet/rack. For a separate 1PPS reference, connect to the 1PPS port on each cabinet/rack. For a
Composite reference, connect to the Ext Freq Ref port only on each cabinet/rack.

Both Ext Freq Ref and 1PPS inputs must have a BNC “T” connected. A 50 Ohm termination is on one
leg of the “T” and the cable to the junction panel is on the other side of the “T”.
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Junction Panel Connections for a Trunked IP Simulcast Site (UHF R1
380–435 MHz and VHF 136–174 MHz) (Standard Configuration)
In a GTR 8000 Expandable Site Subsystem operating in the UHF R1 and VHF bands, most external
equipment is connected through the junction panel. Each of the six Tx outputs is connected with a
cable from a power amplifier in the GTR 8000 Expandable Site Subsystem to a jumper cable that
connects to the Tx RFDS. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 96: Junction Panel for the GTR 8000 Expandable Site Subsystem for a Trunked IP
Simulcast Site Standard Configuration (UHF R1 380–435 MHz and VHF 136–174 MHz)
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Table 86: GTR 8000 Expandable Site Subsystem Junction Panel Connections for a Trunked IP
Simulcast Site Standard Configuration (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

LAN A
port,
RJ-45

Switch LAN 1, RJ-45 Ethernet link to the LAN switch to remote
site gateway.

LAN B
port,
RJ-45

Not in use

1PPS,
BNC*

TRAK 9100 Timing Connect external Site Timing Reference

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Freq Ref,
BNC*

TRAK 9100 5 MHz fre-
quency reference

RF, BNC Connect external Site Frequency Refer-
ence

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device, or
channel bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the cabinet. This port is
used to connect them when one is inte-
grated and the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the cabinet. This port is
used to connect them when one is inte-
grated and the other is not.

ASYNC Not in use

RX 1
through 6,
BNC

External Receive Multi-
coupler

RMC output
Port

RF coax to receive input for each BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.

Tx, 7/16 Not in use

Internal
Alarm,
DB-25

May connect MOSCAD NFM to pin-22 and
23 for contact closure. Indicates RMC fail-
ure.

* See GTR 8000 Base Radio Time and Frequency Inputs on page 292. The XHubs need both Time
and Frequency references that are provided with either a Composite (5 MHz + 1PPS) or separate 5
MHz and 1PPS sources. For a separate 5 MHz reference, connect to the Ext Freq Ref port on each
cabinet/rack. For a separate 1PPS reference, connect to the 1PPS port on each cabinet/rack. For a
Composite reference, connect to the Ext Freq Ref port only on each cabinet/rack.

Both Ext Freq Ref and 1PPS inputs must have a BNC “T” connected. A 50 Ohm termination is on one
leg of the “T” and the cable to the junction panel is on the other side of the “T”.

Junction Panel Connections for HPD (700/800 MHz)
In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.
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Figure 97: Junction Panel for the GTR 8000 Expandable Site Subsystem for HPD (700/800 MHz)
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NOTICE: For HPD Overlay sites, the Gateway A and B connections link directly to Site
Switches A and B instead of gateways.

Table 87: GTR 8000 Expandable Site Subsystem Junction Panel Connections for HPD (700/800 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Gateway
A port,
RJ-45

Primary Site Gateway LAN 1, RJ-45 Ethernet link between site controller A and
the primary site gateway or primary site
gateway to site link.

Gateway
B port,
RJ-45

Secondary Site Gateway
(optional)

LAN 1, RJ-45 Ethernet link between site controller B and
secondary site gateway or secondary site
gateway to site link (if installed).

Network
AUX A,
RJ-45

MOSCAD NFM LAN Port 1,
RJ-45

Ethernet link for MOSCAD NFM.

Network
AUX B,
RJ-45

Auxiliary site equipment
such as a site gateway

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
site gateway if it is included at the site.
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

If a site gateway is integrated into the
prime cabinet, it connects directly to the
Net AUX port on SC B.

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

V7.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device, or
channel bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the cabinet. This port is
used to connect them when one is inte-
grated and the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the cabinet. This port is
used to connect them when one is inte-
grated and the other is not.

ASYNC

Remote
GPS A,
DB-15

Lightning Arrestor /
RGPS Unit A

Line terminals See GPS Lightning Arrestor for terminal
connection details on the lightning arrestor.

Remote
GPS B,
DB-15

Lightning Arrestor /
RGPS Unit B

Line terminals See GPS Lightening Arrestor for terminal
connection details on the lightning arrestor.

Rx-A, N-
type

Receive antenna A / tow-
er top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tow-
er top amplifier

TTA input port RF coax to receive branch B.

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna.

Ext. Freq.
Ref.

Not in use

1PPS Not in use

Internal
Alarm,
DB-25

Not in use
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Junction Panel Connections for an ASTRO 25 Express System
(700/800/900 MHz and UHF R2 435–524 MHz)
In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 98: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for an
ASTRO 25 Express System (700/800/900 MHz and UHF R2 435–524 MHz)

Table 88: GTR 8000 Expandable Site Subsystem Prime Cabinet Junction Panel Connections for an
ASTRO 25 Express System (700/800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Gateway
A port,
RJ-45

Not in use

Gateway
B port,
RJ-45

Not in use

Network
AUX A,
RJ-45

not in use

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Network
AUX B,
RJ-45

Not in use

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

Remote
GPS A,
DB-15

Not in use

Remote
GPS B,
DB-15

Not in use

Rx-A, N-
type

Receive antenna A / tow-
er top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tow-
er top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity operation for Phase 2 TDMA is re-
quired.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner (optional)

Tx output port RF coax to transmit antenna.

Internal
Alarm,
DB-25

Not in use

Cab #1-5,
A, RJ-45

Site Controller 1 Expansion
Ports 1–5,
RJ-45

Connection of site controller 1 to XHub A in
expansion cabinets #1-5.

Cab #1-5,
B, RJ-45

Site Controller 2 Expansion
Ports 1–5,
RJ-45

Connection of site controller 2 to XHub B in
expansion cabinets #1-5.

Cab #1-3,
Branch A,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘A’.

Rx A, N Receive path connection from the primary
cabinet to the Rx Branch ‘A’ connector of
expansion cabinets #1-3.

Cab #1-3,
Branch B,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘B’.

Rx B, N Receive path connection from the primary
cabinet to the Rx Branch ‘B’ connector of
expansion cabinets #1-3.

Ext. Freq.
Ref.

Not in use

1PPS Not in use
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Figure 99: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
an ASTRO 25 Express System (700/800/900 MHz and UHF R2 435–524 MHz)

NOTICE: For an ASTRO® 25 Express System using Phase 2 TDMA operation, a second
antenna branch may be required, see “Appendix B” in the Dynamic Dual Mode for TDMA
Operation manual for details.

Table 89: GTR 8000 Expandable Site Subsystem Expansion Cabinet Junction Panel Connections for
an ASTRO 25 Express System (700/800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Expan-
sion Input
A port,
RJ-45

Primary cabinet, network
expansion sub-panel
Cab #(N) A

LAN 1, RJ-45 Expansion link between site controller 1 and
Expansion Hub A in expansion cabinet (N)
where N is the number of the cabinet.

Expan-
sion Input
B port,
RJ-45

Primary cabinet, network
expansion sub-panel
Cab #(N) B

LAN 1, RJ-45 Expansion link between site controller 2 and
Expansion Hub B in expansion cabinet (N)
where N is the number of the cabinet.

Network
AUX A,
RJ-45

Not in use

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Network
AUX B,
RJ-45

Not in use

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instructions
for connection requirements.

Rx-A, N-
type

Receive antenna A / tow-
er top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tow-
er top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity operation for Phase 2 TDMA is re-
quired.

Tx 1, N
female

Not in use Tx output port Not in use

Tx 2, N
female

Not in use Tx output port Not in use

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna.

Internal
Alarm,
DB-25

Not in use

Junction Panel Connections for an ASTRO 25 Express System (UHF R1
380–435 MHz and VHF 136–174 MHz)
In a GTR 8000 Expandable Site Subsystem operating in the UHF R1 and VHF bands, most external
equipment is connected through the junction panel. Each of the six Tx outputs is connected with a
cable from a power amplifier in the GTR 8000 Expandable Site Subsystem to the junction panel. The
RF connections are also illustrated in GTR 8000 Expandable Site Subsystem RFDS Transmit Path on
page 61 and GTR 8000 Expandable Site Subsystem RFDS Receive Path on page 62.
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Figure 100: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for an
ASTRO 25 Express System (UHF R1 380–435 MHz and VHF 136–174 MHz)

Table 90: GTR 8000 Expandable Site Subsystem Prime Cabinet Junction Panel Connections for an
ASTRO 25 Express System (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel Port /

Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Gateway A
port, RJ-45

Not in use

Gateway B
port, RJ-45

Not in use

Network
AUX A,
RJ-45

No in use

Network
AUX B,
RJ-45

Not in use

Battery
Temp, 6-pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

Remote
GPS A,
DB-15

Not in use

Table continued…
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Junction
Panel Port /

Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Remote
GPS B,
DB-15

Not in use

RX 1
through 6,
BNC

External Receive Multi-
coupler

RMC Output
Port

RF coax to receive input for each BR.

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU op-
tion is included. Tx output from external
combiner must be routed directly to PMU
input.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner

Cab #1-5,
A, RJ–45

Site Controller 1 Expansion
Ports 1–5,
RJ-45

Connection of site controller 1 to XHub A
in expansion cabinets #1-5.

Cab #1-5,
B, RJ-45

Site Controller 2 Expansion
Ports 1–5,
RJ-45

Connection of site controller 2 to XHub B
in expansion cabinets #1-5.

Internal
Alarm,
DB-25

Not in use

Ext Freq
Ref

Not in use

1PPS Not in use
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Figure 101: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
an ASTRO 25 Express System (UHF R1 380–435 MHz and VHF 136–174 MHz)

Table 91: GTR 8000 Expandable Site Subsystem Expansion Cabinet Junction Panel Connections for
an ASTRO 25 Express System (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Expansion
Input A
port,
RJ-45

Primary cabinet, network
expansion sub-panel
Cab #(N) A

LAN 1, RJ-45 Expansion link between site controller 1
and expansion Hub A in expansion cabinet
(N) where N is the number of the cabinet.

Expansion
Input B
port,
RJ-45

Primary cabinet, network
expansion sub-panel
Cab #(N) B

LAN 1, RJ-45 Expansion link between site controller 2
and expansion Hub B in expansion cabinet
(N) where N is the number of the cabinet.

Network
AUX A,
RJ-45

Not in use

Network
AUX B,
RJ-45

Not in use

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

RX 1
through 6,
BNC

External Receive Multi-
coupler

RMC output
Port

RF coax to receive input for each BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU option
is included. Tx output from external
combiner must be routed directly to PMU
input.

Internal
Alarm,
DB-25

Not in use

Junction Panel Connections for a Trunked IP Simulcast (High
Availability Configuration)
A high availability configuration at a trunked IP simulcast remote site uses GPB 8000 Reference
Distribution Modules (RDMs) instead of XHubs in the first cabinet/rack. The RDM provides integrated
Ethernet LAN switching, eliminating the external HP LAN switches at the remote site. The RDM also
provides redundant integrated site reference distribution through two GPS units as timing reference
sources to all the base radios at the remote site, eliminating the need for the TRAK 9100 Simulcast
Site Reference at the remote site.

The junction panel for the GTR 8000 Expandable Site Subsystem provides locations for all the
connections to external devices. Cables provided by Motorola include the specific connectors for the
junction panel on one end and the subsystem equipment on the other end.

IMPORTANT: Do not remove the label from a connector location until you insert the connector.

NOTICE: For an overview of connecting to an ASTRO® 3.1 Conventional System (ASTRO-TAC
3000 Comparator or DIU), see the Conventional Operations manual. The base radio can be IP
managed while using the 2- or 4-wire E&M, or V.24 interface for channel traffic.

Junction Panel Connections for a Trunked IP Simulcast Site (700/800/900
MHz and UHF R2 435–524 MHz) (High Availability)
In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.
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Figure 102: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for a
Trunked IP Simulcast Site High Availability (700/800/900 MHz and UHF R2 435–524 MHz)
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AUX

Gateway Internal
Alarm
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Circuit Audio
ASYNC
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WIRELINE
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NOTICE: For HPD Overlay sites, the Gateway A and B ports in the HPD rack/cabinet connect
to the LAN via Network AUX ports in the trunked simulcast site and not to a Gateway directly.

Table 92: GTR 8000 Expandable Site Subsystem Prime Cabinet Junction Panel Connections for
Trunked IP Simulcast Site High Availability (700/800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Gateway
A port,
RJ-45

Primary Site Gateway LAN 1, RJ-45 Ethernet link between RDM A and the pri-
mary site gateway or primary site gateway
to site link.

Gateway
B port,
RJ-45

Secondary Site Gateway
(optional)

LAN 1, RJ-45 Ethernet link between RDM B and secon-
dary site gateway or secondary site gate-
way to site link (if installed).

Network
AUX A,
RJ-45

MOSCAD NFM LAN Port 1,
RJ-45

Ethernet link for MOSCAD NFM.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.
If a site gateway (CCGW) is integrated into
the prime cabinet, it connects directly to
the Net AUX port on RDM B.

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

Remote
GPS A,
DB-15

Lightning Arrestor / GPS
Unit A

Line terminals See GPS Lightning Arrestor for terminal
connection details on the lightning arrestor.

Remote
GPS B,
DB-15

Lightning Arrestor / GPS
Unit B

Line terminals See GPS Lightning Arrestor for terminal
connection details on the lightning arrestor.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device, or
channel bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the prime cabinet. This port
is used to connect them when one is inte-
grated and the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the prime cabinet. This
port is used to connect them when one is
integrated and the other is not.

ASYNC Not in use

Rx-A, N-
type

Receive antenna A / tow-
er top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tow-
er top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity operation for Phase 2 TDMA is re-
quired.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner

Tx output port RF coax to transmit antenna.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner (optional)

Tx output port RF coax to transmit antenna.

Cab #1-5,
A, RJ-45

RDM A Expansion
Ports 1–5,
RJ-45

Connection of RDM A to XHub A in expan-
sion cabinets #1-5.

Cab #1-5,
B, RJ-45

RDM B Expansion
Ports 1–5,
RJ-45

Connection of RDM B to XHub B in expan-
sion cabinets #1-5.

Cab #1-3,
Branch A,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘A’.

Rx A, N Receive path connection from the primary
cabinet to the Rx Branch ‘A’ connector of
expansion cabinets #1-3.

Cab #1-3,
Branch B,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘B’.

Rx B, N Receive path connection from the primary
cabinet to the Rx Branch ‘B’ connector of
expansion cabinets #1-3.

Internal
Alarm,
DB-25

Not in use

Ext. Freq.
Reference

Not in use

1PPS Not in use

*See GTR 8000 Base Radio Time and Frequency Inputs on page 292.
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Figure 103: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
a Trunked IP Simulcast Site High Availability (700/800/900 MHz and UHF R2 435–524 MHz)
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Table 93: GTR 8000 Expandable Site Subsystem Expansion Cabinet Junction Panel Connections for
Trunked IP Simulcast Site High Availability (700/800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Expansion
Input A
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1–5, A

LAN 1, RJ-45 Expansion link between RDM A and XHub
A in expansion cabinet (N) where N is the
number of the cabinet.

Expansion
Input B
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1–5, B

LAN 1, RJ-45 Expansion link between RDM B and XHub
B in expansion cabinet (N) where N is the
number of the cabinet.

Network
AUX A,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Battery
Temp, 6-
pin

Backup Battery Tem-
perature Sensor

See battery temperature sensor instructions
for connection requirements.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU, site
gateway (digital CCGW) device, or channel
bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the cabinet. This port is used
to connect them when one is integrated and
the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external or
integrated into the cabinet. This port is used
to connect them when one is integrated and
the other is not.

ASYNC Not in use

Rx-A, N-
type

Receive antenna A/tow-
er top amplifier or Re-
ceive expansion

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B /
tower top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity operation for Phase 2 TDMA is re-
quired.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for
hybrid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for
hybrid combiner (op-
tional)

Tx output port RF coax to transmit antenna.

Internal
Alarm,
DB-25

Not in use
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Junction Panel Connections for a Trunked IP Simulcast Site (UHF R1
380–435 MHz and VHF 136–174 MHz) (High Availability)
In a GTR 8000 Expandable Site Subsystem operating in the UHF R1 and VHF bands, most external
equipment is connected through the junction panel. Each of the six Tx outputs is connected with a
cable from a power amplifier in the GTR 8000 Expandable Site Subsystem to a jumper cable that
connects to the Tx RFDS. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 104: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for
Trunked IP Simulcast Site High Availability (UHF R1 380–435 MHz and VHF 136–174 MHz)
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NOTICE: For HPD Overlay sites, the Gateway A and B ports in the HPD rack/cabinet connect
to the LAN via Network AUX ports in the trunked simulcast site and not to a Gateway directly.

Table 94: GTR 8000 Expandable Site Subsystem Prime Cabinet Junction Panel Connections for
Trunked IP Simulcast Site High Availability (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Gateway
A port,
RJ-45

Primary Site Gateway LAN 1, RJ-45 Ethernet link between RDM A and the pri-
mary site gateway or primary site gateway
to link.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Gateway
B port,
RJ-45

Secondary Site Gateway
(optional)

LAN 1, RJ-45 Ethernet link between RDM B and secon-
dary site gateway or secondary site gate-
way to link (if installed).

Network
AUX A,
RJ-45

MOSCAD NFM LAN Port 1,
RJ-45

Ethernet link for MOSCAD NFM.

Network
AUX B,
RJ-45

Auxiliary site equipment
such as a site gateway

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
site gateway if it is included at the site.
If a site gateway is integrated into the
prime cabinet, it connects directly to the
Net AUX port on RDM B.

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

Remote
GPS A,
DB-15

Lightning Arrestor / GPS
Unit A

Line terminals See GPS Lightning Arrestor for terminal
connection details on the lightning arrestor.

Remote
GPS B,
DB-15

Lightning Arrestor / GPS
Unit B

Line terminals See GPS Lightning Arrestor for terminal
connection details on the lightning arrestor.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device, or
channel bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the prime cabinet. This port
is used to connect them when one is inte-
grated and the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the prime cabinet. This
port is used to connect them when one is
integrated and the other is not.

ASYNC Not in use

RX 1
through 6,
BNC

External Receive Multi-
coupler

RMC output
Port

RF coax to receive input for each BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU option
is included. Tx output from external
combiner must be routed directly to PMU
input.

Cab #1-5,
A, RJ-45

RDM A Expansion
Ports 1-5,
RJ-45

Connection of RDM A to XHub A in expan-
sion cabinets #1-5.

Cab #1-5,
B, RJ-45

RDM B Expansion
Ports 1-5,
RJ-45

Connection of RDM B to XHub B in expan-
sion cabinets #1-5.

Internal
Alarm,
DB-25

Not in use

Ext. Freq.
Reference

Not in use

1PPS Not in use

*See GTR 8000 Base Radio Time and Frequency Inputs on page 292.

Figure 105: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
Trunked IP Simulcast Site High Availability (UHF R1 380–435 MHz and VHF 136–174 MHz)
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Table 95: GTR 8000 Expandable Site Subsystem Expansion Cabinet Junction Panel Connections for
Trunked IP Simulcast Site High Availability (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Expansion
Input A
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab #1-5, A

LAN 1, RJ-45 Expansion link between RDM A and XHub
A in expansion cabinet (N) where N is the
number of the cabinet.

Expansion
Input B
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab #1-5, B

LAN 1, RJ-45 Expansion link between RDM B and XHub
B in expansion cabinet (N) where N is the
number of the cabinet.

Network
AUX A,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW),
channel bank, or base
radio (for conventional
channels)

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device or
channel bank.
The conventional base radio and/or site
gateway (digital CCGW) can be external or
integrated into the cabinet. This port is used
to connect them when one is integrated
and the other is not.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog conventional
base radio

RJ-45 Connection of Wireline link from BR to DIU
or site gateway (analog CCGW) device.
The conventional base radio and/or site
gateway (analog CCGW) can be external
or integrated into the cabinet. This port is
used to connect them when one is integrat-
ed and the other is not.

ASYNC Not in use

RX ‘1’
through 6,
BNC

External Receive Multi-
coupler

RMC output
port

RF coax to receive input for each BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU option
is included. Tx output from external
combiner must be routed directly to PMU
input.

Internal
Alarm,
DB-25

Not in use

Junction Panel Connections for a Conventional Simulcast Cabinet
Within a Trunked IP Simulcast High Availability Site
The junction panel for the GTR 8000 Expandable Site Subsystem provides locations for many of the
connections to external devices when a conventional GTR 8000 Expandable Site Subsystem cabinet
resides within a trunked IP simulcast high availability site. Cables provided by Motorola include the
specific connectors for the junction panel on one end and the subsystem equipment on the other end.

IMPORTANT: Do not remove the label from a connector location until you insert the connector.

NOTICE: For an overview of connecting to an ASTRO® 3.1 Conventional System (ASTRO-TAC
3000 Comparator or DIU), see the Conventional Operations manual. The base radio can be IP
managed while using the 4-wire/V.24 interface for channel traffic.

Junction Panel Connections for a Conventional Simulcast Cabinet within
a Trunked IP Simulcast High Availability Site (700/800/900 MHz and UHF
R2 435–524 MHz)
In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.
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Figure 106: Junction Panel for a Simulcast Conventional GTR 8000 Expandable Site Subsystem
Cabinet within a Trunked IP Simulcast High Availability Site (700/800/900/UHF R2 435–524 MHz)

Expansion
Input

Network
AUX

Internal
Alarm

Battery
Temp

Receive Input
Branch 'A' Branch 'B' Branch 'C'

TX '1' TX '2'

TX

A

B

A

B

To Receiver Antenna or Receiver Expansion

A25_GTR_8000_JP_ESS_Expansion_700_800_900_UHFR2E

To Channel Bank or CCGW

To Transmit Antenna

To Transmit AntennaTo Transmit Antenna

Circuit Audio
ASYNC

V.24

WIRELINE

1 2 3 4 5 6

1 2 3 4 5 6

Table 96: Simulcast Conventional GTR 8000 Expandable Site Subsystem Junction Panel Connections
within a Trunked IP Simulcast High Availability Site (700/800/900/UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type
Description

Expansion
Input A
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1-5, A

LAN 1, RJ-45 Expansion link between RDM A and XHub
A in expansion cabinet (N) where N is the
number of the cabinet.

Expansion
Input B
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1-5, B

LAN 1, RJ-45 Expansion link between RDM B and XHub
B in expansion cabinet (N) where N is the
number of the cabinet.

Network
AUX A,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type
Description

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Battery
Temp, 6-
pin

Backup Battery Tem-
perature Sensor

See battery temperature sensor instructions
for connection requirements.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW), or
channel bank

RJ-45 Connection of V.24 link from BR to DIU, site
gateway (digital CCGW) device, or channel
bank.
If more than six connections are required,
then cables may need to be run through the
access hole provided.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog comparator

RJ-45 Connection of Wireline link from BR to DIU,
site gateway (analog CCGW) device, or an-
alog comparator.
If more than six connections are required,
then cables may need to be run through the
access hole provided.

ASYNC,
RJ-45

Not in use

Rx-A, N-
type

Receive antenna A/tow-
er top amplifier or Re-
ceive expansion

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B /
tower top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity option for Phase 2 TDMA is needed.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for
hybrid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for
hybrid combiner (op-
tional)

Tx output port RF coax to transmit antenna.

Internal
Alarm,
DB-25

Not in use

Junction Panel Connections for a Conventional Simulcast Cabinet within
a Trunked IP Simulcast High Availability Site (UHF R1 380–435 MHz and
VHF 136–174 MHz)
In a GTR 8000 Expandable Site Subsystem operating in the UHF R1 and VHF bands, most external
equipment is connected through the junction panel. Each of the six Tx outputs is connected with a
cable from a power amplifier in the GTR 8000 Expandable Site Subsystem to the junction panel that
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connects to the Tx RFDS. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 107: Junction Panel for a Conventional Simulcast GTR 8000 Expandable Site Subsystem
Cabinet within a Trunked IP Simulcast High Availability Site (UHF R1 380–435 MHz and VHF
136–174 MHz)
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Table 97: Conventional Simulcast GTR 8000 Expandable Site Subsystem Junction Panel Connections
within a Trunked IP Simulcast High Availability Site (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Expansion
Input A
port, RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1-5, A

LAN 1, RJ-45 Expansion link between RDM A and Ex-
pansion Hub A in expansion cabinet (N)
where N is the number of the cabinet.

Expansion
Input B
port, RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1-5, B

LAN 1, RJ-45 Expansion link between RDM B and Ex-
pansion Hub B in expansion cabinet (N)
where N is the number of the cabinet.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW), or
channel bank

RJ-45 Connection of V.24 link from BR to DIU, site
gateway (digital CCGW) device, or channel
bank.
If more than six connections are required,
then cables may need to be run through the
access hole provided.
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW),
or analog comparator

RJ-45 Connection of Wireline link from BR to DIU,
site gateway (analog CCGW) device, or an-
alog comparator.
If more than six connections are required,
then cables may need to be run through the
access hole provided.

ASYNC Not in use

Network
AUX A,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Battery
Temp, 6-
pin

Backup Battery Tem-
perature Sensor

See battery temperature sensor instructions
for connection requirements.

RX ‘1’
through 6
BNC

External Receive Multi-
coupler

RMC output
Port

RF coax to receive input for each BR.

TX 1
through 6
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU option
is included. Tx output from external combin-
er must be routed directly to PMU input.

Internal
Alarm,
DB-25

Not in use

Junction Panel Connections for a Conventional Cabinet Within a
Conventional Site
The junction panel for the GTR 8000 Expandable Site Subsystem provides locations for all the
connections to external devices when a conventional GTR 8000 Expandable Site Subsystem cabinet
resides within a conventional site. Cables provided by Motorola include the specific connectors for the
junction panel on one end and the subsystem equipment on the other end.

IMPORTANT: Do not remove the label from a connector location until you insert the connector.

NOTICE: For an overview of connecting to an ASTRO® 3.1 Conventional System (ASTRO-TAC
3000 Comparator or DIU), see the Conventional Operations manual. The base radio can be IP
managed while using the 4-wire/V.24 interface for channel traffic.
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Junction Panel Connections for a Conventional Cabinet within a
Conventional Site (700/800/900 MHz and UHF R2 435–524 MHz)
In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 108: Junction Panel for a Conventional GTR 8000 Expandable Site Subsystem Cabinet
within a Conventional Site (700/800/900 MHz and UHF R2 435–524 MHz)
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Table 98: Conventional GTR 8000 Expandable Site Subsystem Junction Panel Connections within a
Conventional Site (700/800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

LAN A
port,
RJ-45

Switch LAN 1, RJ-45 Ethernet link to the LAN switch to remote
site gateway.

LAN B
port,
RJ-45

Not in use
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

1PPS,
BNC*

TRAK 9100 Timing, BNC Connect external Site Timing Reference
Required for simulcast

Freq Ref,
BNC*

TRAK 9100 5 MHz fre-
quency reference

RF, BNC Connect external Site Frequency Refer-
ence
Required for simulcast

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW), or
channel bank

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device, or
channel bank.
If more than six connections are required,
then cables may need to be run through
the access hole provided.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog comparator

RJ-45 Connection of Wireline link from BR to
DIU, site gateway (analog CCGW) device,
or analog comparator.
If more than six connections are required,
then cables may need to be run through
the access hole provided.

ASYNC Not in use

Rx-A, N-
type

Receive antenna A / tow-
er top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tow-
er top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity option for Phase 2 TDMA is required.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner (optional)

Tx output port RF coax to transmit antenna.

Cab #1-3,
Branch A,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘A’.

Rx A, N Receive path connection from the primary
cabinet to the Rx Branch ‘A’ connector of
expansion cabinets #1-3.

Cab #1-3,
Branch B,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘B’.

Rx B, N Receive path connection from the primary
cabinet to the Rx Branch ‘B’ connector of
expansion cabinets #1-3.

Internal
Alarm,
DB-25

May connect MOSCAD NFM to pin-22 and
23 for contact closure. Indicates RMC fail-
ure.
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* See GTR 8000 Base Radio Time and Frequency Inputs on page 292. The XHubs need both Time
and Frequency references that are provided with either a Composite (5 MHz + 1PPS) or separate 5
MHz and 1PPS sources. For a separate 5 MHz reference, connect to the Ext Freq Ref port on each
cabinet/rack. For a separate 1PPS reference, connect to the 1PPS port on each cabinet/rack. For a
Composite reference, connect to the Ext Freq Ref port only on each cabinet/rack.

Both Ext Freq Ref and 1PPS inputs must have a BNC “T” connected. A 50 Ohm termination is on one
leg of the “T” and the cable to the junction panel is on the other side of the “T”.

Junction Panel Connections for a Conventional Cabinet within a
Conventional Site (UHF R1 380–435 MHz and VHF 136–174 MHz)
In a GTR 8000 Expandable Site Subsystem operating in the UHF R1 and VHF bands, most external
equipment is connected through the junction panel. Each of the six Tx outputs is connected with a
cable from a power amplifier in the GTR 8000 Expandable Site Subsystem to a jumper cable that
connects to the Tx RFDS. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.
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Figure 109: Junction Panel for a Conventional GTR 8000 Expandable Site Subsystem Cabinet
within a Conventional Site (UHF R1 380–435 MHz and VHF 136–174 MHz)
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Table 99: Conventional GTR 8000 Expandable Site Subsystem Junction Panel Connections within a
Conventional Site (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

LAN A
port,
RJ-45

Switch LAN 1, RJ-45 Ethernet link to the LAN switch to remote
site gateway.

LAN B
port,
RJ-45

Not in use

1PPS,
BNC*

TRAK 9100 Timing Connect external Site Timing Reference
Required for simulcast

Freq Ref,
BNC*

TRAK 9100 5 MHz fre-
quency reference

RF, BNC Connect external Site Frequency Refer-
ence
Required for simulcast

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

V.24-1
through 6,
RJ-45

External DIU, site gate-
way (digital CCGW), or
channel bank

RJ-45 Connection of V.24 link from BR to DIU,
site gateway (digital CCGW) device or
channel bank.
If more than six connections are required,
then cables may need to be run through
the access hole provided.

Wireline-1
through 6,
RJ-45

External DIU, site gate-
way (analog CCGW), or
analog comparator

RJ-45 Connection of Wireline link from BR to
DIU, site gateway (analog CCGW) device
or analog comparator.
If more than six connections are required,
then cables may need to be run through
the access hole provided.

ASYNC Not in use

RX 1
through 6,
BNC

External Receive Multi-
coupler

RMC output
Port

RF coax to receive input for each BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.

Tx, 7/16 Not in use

Internal
Alarm,
DB-25

May connect MOSCAD NFM to pin-22 and
23 for contact closure. Indicates RMC fail-
ure.

* See GTR 8000 Base Radio Time and Frequency Inputs on page 292. The XHubs need both Time
and Frequency references that are provided with either a Composite (5 MHz + 1PPS) or separate 5
MHz and 1PPS sources. For a separate 5 MHz reference, connect to the Ext Freq Ref port on each
cabinet/rack. For a separate 1PPS reference, connect to the 1PPS port on each cabinet/rack. For a
Composite reference, connect to the Ext Freq Ref port only on each cabinet/rack.

Both Ext Freq Ref and 1PPS inputs must have a BNC “T” connected. A 50 Ohm termination is on one
leg of the “T” and the cable to the junction panel is on the other side of the “T”.

Junction Panel Connections for a Trunked 3600 IntelliRepeater Site
A trunked 3600 IntelliRepeater site uses GPB 8000 Reference Distribution Modules (RDMs) instead of
XHubs in the first cabinet/rack. The RDM provides integrated Ethernet LAN switching and redundant
integrated time and frequency reference sources to all the base radios at the site.

The junction panel for the GTR 8000 Expandable Site Subsystem provides locations for all the
connections to external devices. Cables provided by Motorola include the specific connectors for the
junction panel on one end and the subsystem equipment on the other end.

IMPORTANT: Do not remove the label from a connector location until you insert the connector.
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Junction Panel Connections for a Trunked 3600 IntelliRepeater Site
(800/900 MHz and UHF R2 435–524 MHz)

In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 110: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for a
Trunked 3600 IntelliRepeater Site (800/900 MHz and UHF R2 435–524 MHz)
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Table 100: GTR 8000 Expandable Site Subsystem Prime Cabinet Junction Panel Connections for a
Trunked 3600 IntelliRepeater Site (800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Gateway
A port,
RJ-45

Primary Site Gateway LAN 1, RJ-45 Ethernet link between RDM A and the pri-
mary site gateway or primary site gateway
to site link.

Gateway
B port,
RJ-45

Secondary Site Gateway
(optional)

LAN 1, RJ-45 Ethernet link between RDM B and secon-
dary site gateway or secondary site gate-
way to site link (if installed).

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Network
AUX A,
RJ-45

Not in use

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.
If a site gateway (CCGW) is integrated into
the prime cabinet, it connects directly to
the Net AUX port on RDM B.

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

Remote
GPS A,
DB-15

Not in use

Remote
GPS B,
DB-15

Not in use

V.24-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of V.24 link from base radio to
channel bank.

Wireline-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of Wireline link from BR to
channel bank.

ASYNC,
RS-232,
RJ-45

Channel Bank RJ-45 ASYNC RS-232 connection to the zone
controller.

Rx-A, N-
type

Receive antenna A / tow-
er top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tow-
er top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity operation for Phase 2 TDMA is re-
quired.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for hy-
brid combiner (optional)

Tx output port RF coax to transmit antenna.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Cab #1-5,
A, RJ-45

RDM A Expansion
Ports 1–5,
RJ-45

Connection of RDM A to XHub A in expan-
sion cabinets #1-5.

Cab #1-5,
B, RJ-45

RDM B Expansion
Ports 1–5,
RJ-45

Connection of RDM B to XHub B in expan-
sion cabinets #1-5.

Cab #1-3,
Branch A,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘A’.

Rx A, N Receive path connection from the primary
cabinet to the Rx Branch ‘A’ connector of
expansion cabinets #1-3.

Cab #1-3,
Branch B,
BNC

Expansion cabinet #1-3
Receive Input Branch
‘B’.

Rx B, N Receive path connection from the primary
cabinet to the Rx Branch ‘B’ connector of
expansion cabinets #1-3.

Internal
Alarm,
DB-25

Not in use

Ext. Freq.
Reference

Not in use

1PPS Not in use
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Figure 111: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
a Trunked 3600 IntelliRepeater Site (800/900 MHz and UHF R2 435–524 MHz)
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Table 101: GTR 8000 Expandable Site Subsystem Expansion Cabinet Junction Panel Connections for
a Trunked 3600 IntelliRepeater Site (800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Expansion
Input A
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1–5, A

LAN 1, RJ-45 Expansion link between RDM A and XHub
A in expansion cabinet (N) where N is the
number of the cabinet.

Expansion
Input B
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab # 1–5, B

LAN 1, RJ-45 Expansion link between RDM B and XHub
B in expansion cabinet (N) where N is the
number of the cabinet.

Network
AUX A,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Table continued…

6871022P87-C
Chapter 3:  GTR 8000 Expandable Site Subsystem Installation

228  Send Feedback

http://docsurvey.motorolasolutions.com


Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Battery
Temp, 6-
pin

Backup Battery Tem-
perature Sensor

See battery temperature sensor instructions
for connection requirements.

V.24-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of V.24 link from base radio to
channel bank.

Wireline-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of Wireline link from base radio
to channel bank.

ASYNC,
RS-232,
RJ-45

Not in use

Rx-A, N-
type

Receive antenna A/tow-
er top amplifier or Re-
ceive expansion

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B /
tower top amplifier

TTA input port RF coax to receive branch B. Used if diver-
sity operation for Phase 2 TDMA is re-
quired.

Tx, 7/16 Transmit antenna for
cavity combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for
hybrid combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for
hybrid combiner (op-
tional)

Tx output port RF coax to transmit antenna.

Internal
Alarm,
DB-25

Not in use

Junction Panel Connections for a Trunked 3600 IntelliRepeater Site (UHF
R1 380–435 MHz and VHF 136–174 MHz)

In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.
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Figure 112: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for a
Trunked 3600 IntelliRepeater Site (UHF R1 380–435 MHz and VHF 136–174 MHz)
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Table 102: GTR 8000 Expandable Site Subsystem Prime Cabinet Junction Panel Connections for a
Trunked 3600 IntelliRepeater Site (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Gateway
A port,
RJ-45

Primary Site Gateway LAN 1, RJ-45 Ethernet link between RDM A and the pri-
mary site gateway or primary site gateway
to link.

Gateway
B port,
RJ-45

Secondary Site Gateway
(optional)

LAN 1, RJ-45 Ethernet link between RDM B and secon-
dary site gateway or secondary site gate-
way to link (if installed).

Network
AUX A,
RJ-45

Not in use

Network
AUX B,
RJ-45

Auxiliary site equipment
such as a site gateway

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
site gateway if it is included at the site.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

If a site gateway is integrated into the
prime cabinet, it connects directly to the
Net AUX port on RDM B.

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

Remote
GPS A,
DB-15

Not in use

Remote
GPS B,
DB-15

Not in use

V.24-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of V.24 link from base radio to
channel bank.

Wireline-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of Wireline link from base radio
to channel bank.

ASYNC,
RS-232,
RJ-45

Channel Bank RJ-45 ASYNC RS-232 connection to the zone
controller.

RX 1
through 6,
BNC

External Receive Multi-
coupler

RMC output
Port

RF coax to receive input for each BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU option
is included. Tx output from external
combiner must be routed directly to PMU
input.

Cab #1-5,
A, RJ-45

RDM A Expansion
Ports 1-5,
RJ-45

Connection of RDM A to XHub A in expan-
sion cabinets #1-5.

Cab #1-5,
B, RJ-45

RDM B Expansion
Ports 1-5,
RJ-45

Connection of RDM B to XHub B in expan-
sion cabinets #1-5.

Internal
Alarm,
DB-25

Not in use

Ext. Freq.
Ref.

Not in use

1PPS Not in use
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Figure 113: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
a Trunked 3600 IntelliRepeater Site (UHF R1 380–435 MHz and VHF 136–174 MHz)
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Table 103: GTR 8000 Expandable Site Subsystem Expansion Cabinet Junction Panel Connections for
a Trunked 3600 IntelliRepeater Site (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Expansion
Input A
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab #1-5, A

LAN 1, RJ-45 Expansion link between RDM A and XHub
A in expansion cabinet (N) where N is the
number of the cabinet.

Expansion
Input B
port,
RJ-45

Primary cabinet, net-
work expansion sub-
panel Cab #1-5, B

LAN 1, RJ-45 Expansion link between RDM B and XHub
B in expansion cabinet (N) where N is the
number of the cabinet.

Network
AUX A,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Network
AUX B,
RJ-45

Auxiliary site equipment
such as an external site
gateway (CCGW)

LAN 1, RJ-45 This port is available for devices that need
to be connected to the network, including a
standalone site gateway (CCGW) if it is in-
cluded at the site.

Table continued…
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Junction
Panel
Port /
Type

External Device This
Connects To:

External De-
vice Port /

Type

Description

Battery
Temp, 6-
pin

Backup Battery Temper-
ature Sensor

See battery temperature sensor instruc-
tions for connection requirements.

V.24-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of V.24 link from base radio to
channel bank.

Wireline-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of Wireline link from base radio
channel bank.

ASYNC,
RS-232,
RJ-45

Not in use

RX ‘1’
through 6,
BNC

External Receive Multi-
coupler

RMC output
port

RF coax to receive input for each BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.

Tx, 7/16 Transmit antenna Tx output port RF coax to transmit antenna if PMU option
is included. Tx output from external
combiner must be routed directly to PMU
input.

Internal
Alarm,
DB-25

Not in use

Junction Panel Connections for a Trunked 3600 Simulcast
Subsystem
The junction panel for the GTR 8000 Expandable Site Subsystem provides locations for all the
connections to external devices when a GTR 8000 Expandable Site Subsystem cabinet resides within
a trunked 3600 simulcast subsystem. Cables provided by Motorola include the specific connectors for
the junction panel on one end and the subsystem equipment on the other end.

IMPORTANT: Do not remove the label from a connector location until you insert the connector.

Junction Panel Connections – GTR 8000 Expandable Site Subsystem for
a Trunked 3600 Simulcast Subsystem (800/900 MHz and UHF R2 435–524
MHz)

In the GTR 8000 Expandable Site Subsystem, the junction panel is the primary location of connections
to external equipment. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.
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Figure 114: Junction Panel for the GTR 8000 Expandable Site Subsystem for a Trunked 3600
Simulcast Subsystem (800/900 MHz and UHF R2 435–524 MHz)
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Table 104: GTR 8000 Expandable Site Subsystem Junction Panel Connections for a Trunked 3600
Simulcast Subsystem (800/900 MHz and UHF R2 435–524 MHz)

Junction
Panel

Port / Type

External Device This
Connects To:

External Device
Port / Type

Description

LAN A port,
RJ-45

Switch LAN 1, RJ-45 Ethernet link to the LAN switch to re-
mote site gateway.

LAN B port,
RJ-45

Not in use

1PPS,
BNC*

Simulcast Site Reference Timing, BNC Connect external Site Timing Refer-
ence

Freq Ref,
BNC*

Simulcast Site Reference, 5
MHz frequency reference

RF, BNC Connect external Site Frequency
Reference

Battery
Temp, 6-pin

Backup Battery Tempera-
ture Sensor

See battery temperature sensor in-
structions for connection require-
ments.

V.24-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of V.24 link from base ra-
dio to channel bank for mixed mode
or digital systems.
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Junction
Panel

Port / Type

External Device This
Connects To:

External Device
Port / Type

Description

Wireline-1
through 6,
RJ-45

Not in use
Optional connection from Wireline
port on XCVR for colocated compa-
rator sites.

ASYNC Not in use

Rx-A, N-
type

Receive antenna A / tower
top amplifier

TTA input port RF coax to receive branch A.

Rx-B, N-
type

Receive antenna B / tower
top amplifier

TTA input port RF coax to receive branch B. Used if
diversity option for Phase 2 TDMA is
required.

Tx, 7/16 Transmit antenna for cavity
combiner

Tx output port RF coax to transmit antenna.

Tx 1, N fe-
male (900
MHz only)

Transmit antenna for hybrid
combiner

Tx output port RF coax to transmit antenna.

Tx 2, N fe-
male (900
MHz only)

Transmit antenna for hybrid
combiner (optional)

Tx output port RF coax to transmit antenna.

Cab #1-3,
Branch A,
BNC

Expansion cabinet #1-3
Receive Input Branch ‘A’.

Rx A, N Receive path connection from the
primary cabinet to the Rx Branch ‘A’
connector of expansion cabinets
#1-3.

Cab #1-3,
Branch B,
BNC

Expansion cabinet #1-3
Receive Input Branch ‘B’.

Rx B, N Receive path connection from the
primary cabinet to the Rx Branch ‘B’
connector of expansion cabinets
#1-3.

Trunking
Control-1
through 6

Remote Trunking Controller
(6809 or MTC 3600)

DB-25 Control signals from base radio to ex-
ternal trunking controller.

DSM-1
through 6

Channel Bank RJ-45 DSM analog audio path connection
to channel bank for trunked 3600 si-
mulcast sites.

Internal
Alarm,
DB-25

Not in use

* See GTR 8000 Base Radio Time and Frequency Inputs on page 292.

The XHubs need both Time and Frequency references that are provided with either a Composite (5
MHz + 1PPS) or separate 5 MHz and 1PPS sources. For a separate 5 MHz reference, connect to the
Ext Freq Ref port on each cabinet/rack. For a separate 1PPS reference, connect to the 1PPS port on
each cabinet/rack. For a Composite reference, connect to the Ext Freq Ref port only on each cabinet/
rack.

Both Ext Freq Ref and 1PPS inputs must have a BNC “T” connected. A 50 Ohm termination is on one
leg of the “T” and the cable to the junction panel is on the other side of the “T”.
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Junction Panel Connections – GTR 8000 Expandable Site Subsystem for
a Trunked 3600 Simulcast Subsystem (UHF R1 380–435 MHz and VHF
136–174 MHz)

In a GTR 8000 Expandable Site Subsystem operating in the UHF R1 and VHF bands, most external
equipment is connected through the junction panel. Each of the six Tx outputs is connected with a
cable from a power amplifier in the GTR 8000 Expandable Site Subsystem to a jumper cable that
connects to the Tx RFDS. The RF connections are also illustrated in GTR 8000 Expandable Site
Subsystem RFDS Transmit Path on page 61 and GTR 8000 Expandable Site Subsystem RFDS
Receive Path on page 62.

Figure 115: Junction Panel for the GTR 8000 Expandable Site Subsystem for a Trunked 3600
Simulcast Subsystem (UHF R1 380–435 MHz and VHF 136–174 MHz)
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Table 105: GTR 8000 Expandable Site Subsystem Junction Panel Connections for a Trunked 3600
Simulcast Subsystem (UHF R1 380–435 MHz and VHF 136–174 MHz)

Junction
Panel

Port / Type

External Device This
Connects To:

External Device
Port / Type

Description

LAN A port,
RJ-45

Switch LAN 1, RJ-45 Ethernet link to the LAN switch to re-
mote site gateway.

LAN B port,
RJ-45

Not in use

1PPS,
BNC*

Simulcast Site Reference Timing Connect external Site Timing Refer-
ence

Table continued…
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Junction
Panel

Port / Type

External Device This
Connects To:

External Device
Port / Type

Description

Freq Ref,
BNC*

Simulcast Site Reference, 5
MHz frequency reference

RF, BNC Connect external Site Frequency
Reference

Battery
Temp, 6-pin

Backup Battery Tempera-
ture Sensor

See battery temperature sensor in-
structions for connection require-
ments.

V.24-1
through 6,
RJ-45

Channel Bank RJ-45 Connection of V.24 link from base ra-
dio to channel bank.

Wireline-1
through 6,
RJ-45

Not in use
Optional connection from Wireline
port on XCVR for colocated compa-
rator sites.

ASYNC Not in use

RX 1
through 6,
BNC

External Receive Multicou-
pler

RMC output Port RF coax to receive input for each
BR.

TX 1
through 6,
N-type

Tx combiner Tx input port RF coax output from each BR to Tx
combiner.

Trunking
Control-1
through 6

Remote Trunking Controller
(6809 or MTC 3600)

DB-25 Control signals from base radio to ex-
ternal trunking controller.

DSM-1
through 6

Channel Bank RJ-45 DSM analog audio path connection
to channel bank for trunked 3600 si-
mulcast sites.

Tx, 7/16 Not in use

Internal
Alarm,
DB-25

Not in use

* See GTR 8000 Base Radio Time and Frequency Inputs on page 292.

The XHubs need both Time and Frequency references that are provided with either a Composite (5
MHz + 1PPS) or separate 5 MHz and 1PPS sources. For a separate 5 MHz reference, connect to the
Ext Freq Ref port on each cabinet/rack. For a separate 1PPS reference, connect to the 1PPS port on
each cabinet/rack. For a Composite reference, connect to the Ext Freq Ref port only on each cabinet/
rack.

Both Ext Freq Ref and 1PPS inputs must have a BNC “T” connected. A 50 Ohm termination is on one
leg of the “T” and the cable to the junction panel is on the other side of the “T”.

Expansion to Net AUX Conversion Cables
To improve integration and reduce equipment at the site, the GTR 8000 Expandable Site Subsystem
provides additional auxiliary network LAN ports to connect peripheral Ethernet capable devices at the
site. These ports are labeled Network AUX or Net AUX at the junction panel. Examples of devices
which can be connected to these Network AUX ports include: MOSCAD NFM, CCGWs, IP capable
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standalone conventional radios, or connecting an HPD GTR 8000 Expandable Site Subsystem when
overlaid with a repeater site or a trunked IP simulcast subsystem with high availability.

Network AUX ports are provided in cabinets/racks only for HPD, repeater, and trunked IP simulcast
with high availability configurations. Two Network AUX ports are provided in the Primary Subpanel #1
contained in the prime cabinet (housing the GCP 8000 Site Controllers or GPB 8000 Reference
Distribution Modules (RDM)) for each of these configuration types. In addition, two additional Network
AUX ports are provided in the Expansion Subpanel #1 in each expansion cabinet added at a repeater
site and a trunked IP simulcast high availability subsystem.

For systems where the quantity of peripheral devices exceeds the number of available Network AUX
ports (due to no or low expansion cabinet quantities), a cable conversion kit has been created to
convert the expansion link ports of the prime cabinet to standard Ethernet compliant Network AUX LAN
ports. The expansion link ports in the Network Expansion subpanel, and connected to the Expansion
Ports on the site controller or RDM, contain Frequency Reference and Timing Signaling in addition to
LAN connectivity. These additional signals could cause adverse affects to peripheral devices
connected to an expansion port. The Expansion to Net AUX conversion cable kit (CA01806AA)
removes the extra signaling and provides the same 10/100 Mb Ethernet compliant interface found in
other Network AUX connections. The expansion cable is blue, to differentiate it from the standard
networking cables in the rack/cabinet. In addition, a blue “Net AUX” label is provided to add to the
expansion panel labeling to indicate that a particular port has been converted. It is important to note
that an expansion cabinet cannot be connected to a converted port. If site expansion requires the use
of a converted Network AUX port, the conversion cable and label must be removed and the LAN
cables provided with the expansion cabinet should be installed in their place.

Up to ten of the conversion cable kits can be added to the prime rack, though the amount is reduced by
two for each expansion cabinet added to the site (the expansion cabinet has two Network AUX ports in
its junction panel). These conversion cable kits are shipped bagged for installation at the site. If
replacement or additional conversion kits are required they may be ordered through Motorola parts.
See GTR 8000 Expandable Site Subsystem FRU Procedures on page 347 for details on ordering.

GPS Unit Installation for a High Availability Configuration
Remote sites with GPB 8000 Reference Distribution Modules (RDMs) use GPS units that lock onto a
GPS satellite system. The RDMs use the signals from the GPS unit to generate the time and frequency
reference for the remote site. Alignment of timing is handled by each remote site independently locking
to the GPS satellite system.

This section provides an overview and procedures for installing the GPS unit. In a trunked simulcast
subsystem, the TRAK 9100 Simulcast Site Reference (SSR) at the prime site provides 1PPS and 5
MPPS signals to the RDMs from the GPS unit. This signal establishes timing functions for transmit and
receive frequencies to the base radios.

IMPORTANT:
• Improper installation of the GPS unit (mainly reflection issues) can lead to improper position

information, and is reported by the GPS unit.

• During initial startup, if the GPS unit is not locked onto at least four GPS satellites the
simulcast system may not operate properly. These satellites are used to establish a three-
dimensional fix (latitude, longitude, and altitude) for the site. Once the three-dimensional fix
has been determined, only one GPS satellite is required to maintain proper operation.

• The RDMs can free-run for approximately four hours. However, after that period, the
simulcast system will not operate properly without the GPS satellite signals. The GPS units
must be properly positioned, and the cables and connectors must be properly maintained to
ensure the operation of the simulcast system.

• Wait until the GPS units have locked onto the GPS satellites before verifying proper
operation.
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Installing the GPS Units
Follow this process to install the GPS units for a high-availability configuration.

Process:
1 Mount the GPS units with an unrestricted aerial down view to within ten degrees of the horizon

in all directions.

2 Mount the GPS units high enough so they have an un-obstructed view of the sky. Adjacent
structures (such as trees, buildings, and antenna towers) are considered obstructions. If an un-
obstructed view is not possible, install the GPS units so they have a clear view of the
appropriate sky region. Adjacent antenna towers at the RF site which protrude into the required
region have a minimal effect on GPS unit reception due to their narrow, largely open profiles and
are not considered obstructions.

• For northern hemisphere installations, ensure that an un-obstructed view of the southern sky
is maintained.

• For southern hemisphere installations, ensure that an un-obstructed view of the northern sky
is maintained.

3 Isolate the GPS units from RF interference by mounting the units at a distance of at least 3.66 m
(12 ft) horizontally from the other units.

4 Validate the correctness of the position information (latitude, longitude, elevation) reported by
the GPS unit. Proper timing operation is dependent on proper position identification.

5 Validate both GPB 8000 Reference Distribution Modules (RDMs) in the CSS Reference Service
Screen and are within 250 nsec of each other. If not, verify the position information (latitude,
longitude, elevation) reported by the GPS units on both RDMs.

GPS Equipment

The following equipment is required for an IP simulcast remote site configured for high availability. The
GPS equipment should equal the number of GPB 8000 Reference Distribution Modules (RDMs) at the
site with each item ordered in a quantity of two.

The following lists the equipment to install the GPS unit:

• GPS Antenna/Receiver: DS0900382701

• Mounting Kit for GPS Timing Unit: DS0900382701

• GPS Primary Surge Protector: DS0971017AA1

• GPS Antenna/Receiver to RDM Cable (125 FT): DS30C87465CO1

• GPS Antenna/Receiver to RDM Cable (350 FT): DS30C87465CO2

• GPS Antenna/Receiver to RDM Cable (500 FT): DS30C87465CO3

• GPS Antenna/Receiver to RDM Cable (1,000 FT): DS30C87465CO4

GPS Unit

The GPS unit includes the antenna and the receiver/modem. Because the actual receiver is integrated
with the antenna, the connection between the GPS unit and the GPB 8000 Reference Distribution
Module (RDM) is digital using a 6-pair twisted pair cable.

GPS Mounting Kit

This kit is required to mount the GPS unit. There should be one mounting kit for each GPB 8000
Reference Distribution Module (RDM) at the site.
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Surge Suppression

This primary surge suppression is used at the point where the cable enters the site building. There
should be one surge suppression for each GPB 8000 Reference Distribution Module (RDM) at the site.
The surge suppression is installed by cutting the cable at the point where the cable enters the site
building and connecting both ends to the surge suppressor.

GPS Cables

Choose the cable length required for the site configuration. One cable is required for each GPB 8000
Reference Distribution Module (RDM) at the site. These cables have a Deutsch connector at one end
that connects to the GPS unit and a DB15 connector that connects to the RDM.

In a typical installation using 6-pair twisted pair cable, the recommended cable length should be 106.7
m (350 ft) or less. This cable length is sufficient for most installations. For cable lengths greater than
106.7 m (350 ft), contact Motorola Solution Support Center (SSC) for guidance on the installation and
configuration.

Alarm Indication (No Lock on GPS Signal)

A system alarm indicates when the GPS signal cannot be located and that the GPS unit must be
repositioned.

GPS Lightning Arrestor
A lightning arrestor must be installed between a GCP 8000 Site Controller or GPB 8000 Reference
Distribution Module (RDM) and the GPS unit. One GPS unit is connected to each of the site controllers
or RDMs. Each GPS unit requires its own arrestor. The lightning arrestor can be installed in an HPD or
trunked IP simulcast remote site supporting a high availability configuration.

Figure 116: Lightning Arrestor – System Connections on page 240 shows the connections between
the lightning arrestor and the GCP 8000 Site Controller or RDM.

Figure 116: Lightning Arrestor – System Connections
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Figure 117: GPS Lightning Arrestor DS109–0129H-A Model Wiring on page 241 shows one possible
configuration of the connections and terminal assignments for installing the DS109–0129H-A model
lightning arrestor.

Figure 117: GPS Lightning Arrestor DS109–0129H-A Model Wiring

Figure 118: GPS Lightning Arrestor DS-IX-2L1M1DC48–IG Model Wiring on page 242 shows one
possible configuration of the connections and terminal assignments for installing the DS-
IX-2L1M1DC48–IG model lightning arrestor.

6871022P87-C
Chapter 3:  GTR 8000 Expandable Site Subsystem Installation

Send Feedback   241

http://docsurvey.motorolasolutions.com


Figure 118: GPS Lightning Arrestor DS-IX-2L1M1DC48–IG Model Wiring

Installation/Troubleshooting Tools
In addition to the general tools needed for site installation activities, a service monitor is used
specifically for testing the equipment.

To place an order, contact Motorola at:
Phone: 1-800-422-4210 ext. 6883
TTY Phone: 1-866-522-5210
Motorola Online users: Web: https://businessonline.motorolasolutions.com
Fax: 1-800-622-6210
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Quick Connect RF Coaxial Adapters for GTR 8000 Base Radio
Support
The GTR 8000 Base Radio employs a number of "QN" and "QMA" Quick-Connect RF connectors in its
design. The following RF adapters are available from Motorola and can be used to connect test
equipment to the various station devices for troubleshooting purposes.

Table 106: Quick-Connect RF Coaxial Adapters for GTR 8000 Base Radio Support

Type Adapter / Connector description Motorola Part Number

"N"/QN Female "N" to Male QN 5886055Y01

"N"/QN Female "N" to Female QN 5886055Y10

"N"/QN Male "N" to Male "QN" 5886055Y05

QN Right Angle Male QN cable plug for RG-400
coax

2871002H01

QN Right Angle Male QN cable plug for RG-213
coax

2886067Y01

N/QMA Female "N" to Male QMA 5886055Y06

N/QMA Female "N" to Female QMA 5886055Y07

QMA/QMA Female QMA to Female QMA 5886055Y08

QMA/QMA Male QMA to Male QMA 5886055Y09

7/16/QN Female 7/16 to male QN 5886055Y03

7/16/QN Male 7/16 to Male QN 5886055Y02

7/16/QN "Female 7/16 to female QN Intermod test
adaptor"

5886055Y04

7/16/QN "Male 7/16 to female QN Intermod test
adaptor"

5886055Y11

Installing Device Software Prerequisites
When and where to use: The following tasks are required before you can complete the device
software installation and begin the configuration procedures in the “Configuration” chapter.

Process:
1 Transfer and install new software to a device using the Software Download. See Software

Download on page 245.

2 Obtain the ASTRO® 25 system CDs and DVDs. Specifically, you need the Motorola Device OS
Image CDs. See Loading Device OS Images to the UNC on page 248.

3 Obtain user names, passwords, and procedures required to access the devices on the network.
For specific user names and passwords to access devices on the network, contact your system
administrator.

4 Set up the users in the IT Admin group in Active Directory Users and Computers. See the
Authentication Services manual.

5 Obtain the following values from the system administrator:

• Line interface number
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• Zone Controller (ZC) site link path 1 IP address

• ZC site link path 2 IP address

• Host name to access the Unified Network Configurator (UNC) server application using
Secure SHell (SSH) (<username> @IP address format)

• Site ID number

• IP address 1 and 2

• Primary and secondary NTP IP addresses

NOTICE: The following are applicable to systems with Authentication, Authorization,
and Accounting (AAA) Servers, Domain Controllers, or Syslog Servers.

• Primary, secondary, and tertiary Domain Name Services (DNS) IP addresses

• Requested DNS Domain Name

• Requested DNS Host Name

• System Name

• Primary SYSLOG Service Name Fully Qualified Domain Name (FQDN)

• Backup SYSLOG Service Name Fully Qualified Domain Name (FQDN)

• Remote Authentication Dial-In User Service (RADIUS) FQDN parameter value

• RADIUS Row Status parameter value

• RADIUS Service Time Out (seconds) parameter value

• RADIUS Service Retransmits Attempts parameter value

• RADIUS Service Dead Timer (min) parameter value

• RADIUS Specific Key parameter value

• RADIUS Service Global Key parameter value

6 Obtain the default credentials (local accounts, central authentication, and SNMPv3) for the
device being installed, as well as the updated passwords for those types of accounts (so that
you can change the password after you install the device). Contact your system administrator, if
you do not have this information. See the SNMPv3 manual or see Local Password and SNMPv3
Passphrase Troubleshooting on page 343 for more information.

7 Configure the device as a RADIUS client on the RADIUS server. When these devices are
configured with a RADIUS key that matches a shared secret for that device in Microsoft
Windows Internet Authentication Service (IAS), they become RADIUS clients. They do not join
the Active Directory domain. See the Authentication Services manual for more information.

8 NOTICE: This step is applicable to systems with AAA Servers, Domain Controllers, or
Syslog Servers.

To use the VoyenceControl component of the Motorola centralized configuration application for
any of the site device procedures, set up the UNC. Depending on your organizational policies,
you may also need to implement a secure protocol between the UNC and the site device. Before
performing any procedures using VoyenceControl, the device must be discovered in
VoyenceControl, and the device configurations must be recently pulled to the UNC database.
See the following ASTRO® 25 system documentation: Unified Network Configurator manual and
Securing Protocols with SSH manual.
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Software Download
The Software Download (SWDL) is an application that can transfer only, install only, or transfer and
install new software to devices. The new software can be installed either locally at a site or on the
Network Management subsystem. Individual devices not connected to the system can be downloaded
using single device mode.

Software Download Security Transfer Modes
A software download can be performed using the following security transfer modes:

Clear SWDL
Transfers the software without security, based on the File-Transfer Protocol (FTP)

Secure SWDL
Transfers the software as encrypted, based on the Secure File-Transfer Protocol (SFTP)

Before initiating transfer, SWDL connects to the site in the zone to discover all devices. The transfer
mode of all devices is displayed in the SWDL window. It is important that all devices have the same
SWDL transfer mode. Otherwise, SWDL flags a mismatch of the SWDL transfer modes across site
devices.

SWDL provisions the credentials for Secure SWDL as part of initiating the SWDL operation. No user
intervention is required. For a single device, Secure or Clear SWDL is configured based on the SWDL
Transfer Mode configuration within the Configuration/Service Software (CSS). The Unified Network
Configurator (UNC) can be used to schedule and configure all devices in the system at once.

For information on how to configure the secure or clear SWDL transfer mode, see the Unified Network
Configurator manual and “Device Security Configuration” in the CSS Online Help.

Software Download Transfer Methods
A software download can be accomplished in two ways:

Site Software Download
Allows you to transfer and install application software from any location within a network. The
Software Download resides on the Network Management Client computer and a computer loaded
with the CSS application. From either of the computers, you can select device types to download
software. Site Software Download allows you to select the zone, site, device types, and software
download operation to perform. When performing a site software download, the site controller
coordinates the software transfer for all trunked base radios, receivers and/or comparators installed
at the site. A site software download can only be performed on a trunked ASTRO® 25 system.

Single Device Software Download
Allows you to transfer and install software to a single instance of a device (such as one base radio).
This feature gives the technician the ability to install different versions of software. Single device
software download is done from a computer loaded with the CSS application either connected
directly to the device or connected to the network.

NOTICE: Conventional devices, GPB 8000 Reference Distribution Modules, and 3600 base
radios are supported only in single device software download.

Site Software Download Functionality
When SWDL is connected from a central remote location, SWDL performs a site software download to
the site controllers, then to the comparators and base radios or receivers installed at the site. Both
active and standby site controller modules have two flash memory banks for storing software. The
device application is run from RAM, and is loaded from the active flash memory bank after a reset. One
bank is active while the other bank is inactive. The transfer of the software using SWDL is a
background process, without interruption of services at the site, that loads the software into the inactive
bank. The site controller executes the software from one bank, while software is simultaneously
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downloaded to the inactive bank. The transfer and install are done in the background. An install causes
the site controller to reset and load the RAM from the bank that was installed with the new software.

SWDL communicates with the site controllers to determine the number of existing remote sites and the
number of channels. SWDL considers a channel or remote site to be accessible if its status is “Not
Unconfigured.” This term means that the site must be set up with a computer with CSS or a network
management client before software download is performed on the site.

The system downloads software to the site controllers, comparators, base radios, or receivers as a
unit. Use SWDL to transfer software to each device type, then perform an install operation. During the
transfer, the operation designates a proxy for each device type at each LAN. Site controllers proxy for
comparators, and base radios or receivers proxy for each other. The proxy cross-transfers the software
to other devices on the LAN. Using proxies minimizes system downtime. Transfers to the LAN are
done simultaneously except for the site controller and comparators.

Software installation is done on a channel-by-channel basis, starting with the highest number channel.
When a channel software download occurs, the base radio or receiver which incorporates that channel
is processed along with the comparator for that channel. For example, if channel 3 was being
downloaded, comparator 3 and the base radios or receivers for channel 3 at each of the remote sites
would be installed simultaneously.

SWDL operation can be fault managed through Unified Event Manager (UEM), syslog, local SWDL log
files, user messages, and device reports.

For further information on SWDL, see the Software Download manual.

The operating software can also be loaded using the UNC. See the Unified Network Configurator
manual to perform single device software downloads (ruthless download) to the devices.

See the G-Series Equipment - System Release Configuration manual for SWDL instructions specific to
the operating characteristics of your existing system release.

Installing Devices in the UNC
When and where to use: The Unified Network Configurator (UNC) is the Network Manager used to
discover a device and load Operating System images. This process lists the basic steps involved using
the UNC on a device.

NOTICE: The UNC is not applicable for K core or non-networked sites.

Process:
1 Discover the device in the UNC. See Discovering a Device in the UNC on page 247.

2 Log in to the UNC server application using PuTTY. See the Securing Protocols with SSH
manual.

3 Load the operating system images to the UNC. See Loading Device OS Images to the UNC on
page 248.

4 Enable FTP services on the UNC. See Enabling FTP Service on page 249.

5 Transfer and install the OS image to the device. See Transferring and Installing the OS Image
on page 249.

6 Inspect the device properties for the transferred and installed software. See Inspecting Device
Properties for Transferred and Installed Software on page 252.

7 Disable FTP services for the UNC. See Disabling FTP Service on page 253.
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Discovering a Device in the UNC
When and where to use:
The discovery process allows the Unified Network Configurator (UNC) to manage the site devices.
Once the device is installed, configured through the Configuration/Service Software (CSS), and
security parameters are enabled, follow this procedure to discover the device. The configuration
information can then be updated using this configuration management application.

The UNC network management solution consists of two applications. Both the UNC Wizard and the
VoyenceControl applications are used in this procedure.

NOTICE: The names EMC Smarts™ Network Configuration Manager and VoyenceControl are
used interchangeably for this product.

Once the device is discovered in the UNC, the OS images and CSS configuration files can be loaded
to add a device to a site, which then connects the site to the current ASTRO® 25 zone core.

Procedure:
1 Ensure that Domain Name Services (DNS) is functional on your system. DNS is supplied by a

specific server application, which must be operational before you can discover the device.

2 Log on to the UNC Wizard from the Network Management (NM) client, by double-clicking the
Internet Explorer icon on the desktop.

The Internet Explorer browser opens.

3 In the Address field, enter: http://ucs-unc0<Y>.ucs:9443/UNCW
where <Y> is the number of the UNC server (01 for primary core UNC server, and 02 for backup
core UNC server).

The UNC Wizard launches and a login dialog box appears.

4 Type the administrative user name and password. Click OK.

The UNC Wizard appears.

5 From the list of available wizards on the left side, select Subnet Discovery.

The right side of the window is updated with the Subnet Discovery form.

6 Select RF Site by clicking the Discovery Type drop-down list.

7 Enter the Zone ID and the Site ID. Click Submit.
An auto-discovery job is created in the UNC Schedule Manager.

8 Log on to the UNC from the NM client by entering:
http://ucs-unc0<Y>.ucs
where <Y> is the number of the UNC server (01 for primary core UNC server, and 02 for backup
core UNC server).

The UNC client launches and a login dialog box appears.

9 Type the administrative user name and password. Click OK.

VoyenceControl launches.

NOTICE: The names EMC Smarts™ Network Configuration Manager and
VoyenceControl are used interchangeably for this product.
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10 Press F7 (Schedule Manager).

The Schedule Manager window appears in the UNC with the discovery jobs.

11 Verify that the Zone and Site containers include any devices discovered.

IMPORTANT: No site devices should be in the Lost and Found folder. If any devices
are in the folder, see the Unified Network Configurator manual for troubleshooting
guidance.

12 In the UNC Wizard, verify the devices by selecting Channel under RF Site Level
Configuration. If multiple zones exist, choose Zone.

The device sites are listed, which means they are available for channel configuration.

Loading Device OS Images to the UNC
Prerequisites: This procedure requires the Motorola device Operating System (OS) Image CDs.
Locate the Transport OS Image media packaged with the Network Management DVDs.

When and where to use: This procedure loads the OS images for the devices for distribution through
the Unified Network Configurator (UNC). Once OS images are distributed to the UNC, you can update
the device Configuration/Service Software (CSS) configuration files to the UNC.

Procedure:
1 Launch a Secure SHell (SSH) terminal server session in PuTTY to access the UNC Server

Administration menu. See the Securing Protocols with SSH manual.

2 From the UNC Server Administration menu, select OS Images Administration. Press ENTER.

3 From the OS Images Administration menu, select Load new OS images. Press ENTER.

A message appears indicating there are two methods for loading OS Images.

4 Insert the Motorola Device OS Images CD into the CD/DVD-ROM drive of the server.

The drive light starts blinking on the server.

5 When the drive light stops blinking, press ENTER.

The OS images load on the UNC.

6 From the menu, select View OS Images. Press ENTER.

The device software image appears.

7 From the menu, select Eject CD. Press ENTER.

The media ejects from the drive on the server.

8 Remove the Motorola Device OS Images CD from the CD/DVD-ROM drive of the server.

9 To log out of the server, press ENTER.

The User Configuration Server Administration menu appears.

10 Press ENTER again.

The prompt appears.
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Loading Software to a Device
NOTICE: These procedures are for a single device download. For a site download, see 
Software Download on page 245.

The following procedures describe how to load software images onto Unified Network Configurator
(UNC) and download and install this software to the device. Secure protocols for software download is
the preferred approach to transfer operations. However, as a backup option, FTP service can be
enabled before installing the software.

Enabling FTP Service

When and where to use: Follow this procedure to enable FTP service before installing the OS
software.

Procedure:
1 Launch a Secure SHell (SSH) terminal server session in PuTTY to access the Unified Network

Configurator (UNC) Server Administration menu. See the Securing Protocols with SSH
manual.

2 From the Server Administration menu, select Unix Administration. Press ENTER.

3 From the Unix Administration menu, select FTP Services. Press ENTER.

4 From the FTP Services menu, select Enable FTP service. Press ENTER.

The FTP Services are enabled and available for software transfer and install operations.

Transferring and Installing the OS Image

When and where to use: Use this procedure to download the OS from the Unified Network
Configurator (UNC) to the device.

Procedure:
1 On the Private Network Management (PNM) client where you set up VoyenceControl, double-

click the UNC shortcut on the desktop.

You can also paste the following address into an IE web browser: http://ucs-unc0<Y>.ucs,
where <Y> is the number of the UNC server (01 for primary core UNC server, and 02 for backup
core UNC server).

Internet Explorer opens to the URL of the application server, and a VoyenceControl client
session launches with the welcome page.
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Figure 119: VoyenceControl Welcome Page

NOTICE: The names EMC Smarts™ Network Configuration Manager and
VoyenceControl are used interchangeably for this product.

2 Click the launch VoyenceControl™ link.

A VoyenceControl client session launches with the login window.

Figure 120: VoyenceControl Login Window

3 Enter the User ID and Password. Click OK.

The VoyenceControl Dashboard appears.
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Figure 121: VoyenceControl Dashboard

4 In the left navigation pane, expand Networks, then select ASTRO 25 Radio Network, then
Views.

The list of options expands.

5 From the navigation pane, double-click Motorola <device>.

The view opens and all currently discovered devices appear.

6 From the menu, select Tools → OS Inventory.

A list of the OS images appears.

7 Verify OS images loaded on the UNC server appear in the OS inventory.

NOTICE: These images were automatically created during the Loading Device OS
Images to the UNC on page 248 procedure.

8 Under Networks in the navigation pane, select one or more devices from the same device class
by right-clicking the selections.

9 From the menu, select Update OS Image.

10 From the Select OS Image window, select Software Image. Click Next.
11 From the Update OS Image window, select each device that appears in the Selected Devices

section.

This action associates a version to a device instance.

NOTICE: In most cases, the “summary of device partitions” are already set up and the
values in step 11 through step 14 must be verified.

12 Select nvm partition from the Manage Partition for Device section.
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NOTICE: Selecting nvm partition defines where the OS image is transferred and is the
only choice for the device.

13 From the Selected Image section, select the image for this device.

NOTICE: Ignore the Install and Copy check boxes.

The Image Info tab is populated and informs the application which image to use.

14 Click Add.

The Summary of Device Partitions for Device populates and confirms the proper setup.

15 Select the Device Options section, Software Operations, then choose transfer, install, or
both.

These selections indicate which operations occur when the job is executed.

NOTICE: If transfer is chosen, select the install option later to complete the installation.
If both is chosen, the software is transferred and installed. There are up to two resets of
the device during installation.

16 Click Schedule.

17 From the Schedule Push Job window, configure the schedule information. Click Approve and
Submit.
The job is approved and can be viewed in the Schedule Manager window.

NOTICE: If only Submit is chosen, the job must be approved later.

18 Verify the job status by pressing F7 (Schedule Manager).

The Schedule Manager window appears in the UNC with the discovery jobs.

Inspecting Device Properties for Transferred and Installed Software

When and where to use: When the software has been transferred and installed, follow this procedure
to inspect the device properties before assuming the installation was a success and disabling FTP
service

Procedure:
1 From the Device view, right-click the device, select Pull, and then Pull Hardware Spec.

The current software version information is updated in the Unified Network Configurator (UNC).

NOTICE: Skip this step if a Pull All or Pull Hardware Spec has already occurred.

2 From the Device view, right-click on the device, and then choose Properties.

The Device Properties window appears.

NOTICE: Select the Properties icon to view the device properties appear directly within
the Device view.

3 Choose the Configuration tab, and then the Hardware tab.

4 Double-click the Chassis object from the Physical Hardware properties.

5 From the Chassis property tree, view the following properties and their values:
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• Bnk1:<device>: Transferred software in bank 1.

• Bnk2:<device>: Transferred software in bank 2.

• <device>: Installed and Running Software.

NOTICE: The Table format can be used (instead of the Diagram format) to view the
Installed and Running Software in the Device view.

Disabling FTP Service

When and where to use: Follow this procedure to disable the FTP service after the transfer and
installation of the software is completed.

Procedure:
1 Launch a Secure SHell (SSH) terminal server session in PuTTY to access the Unified Network

Configurator (UNC) UNC Server Administration menu. See the Securing Protocols with SSH
manual.

2 From the UNC Server Administration menu, select Unix Administration. Press ENTER.

3 From the Unix Administration menu, select FTP Services. Press ENTER.

4 From the FTP Services menu, select Disable FTP service. Press ENTER.

The FTP services are disabled and unavailable for software transfer and install operations.

5 To back out of the menus, press Q three times.

6 At the prompt, enter: exit to return to the previous menu.

7 To log out of the application, enter: exit.

8 Close the PuTTY connection.
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Chapter 4

GTR 8000 Expandable Site Subsystem
Configuration
This chapter details configuration procedures relating to the GTR 8000 Expandable Site Subsystem.

Proper software/hardware configuration for the GTR 8000 Expandable Site Subsystem requires the
following activities:

• Updating factory-installed GTR 8000 Base Radio, GCP 8000 Site Controller, and GPB 8000
Reference Distribution Module application software

• Setting parameters in a configuration file stored on the devices impact both the devices and RF
Distribution System (RFDS) functionality

• Setting DIP switches on RFDS receive multicoupler/low noise amplifier (RMC/LNA) modules

Configuration Software
Configuring a device requires loading two software applications on the service computer:
Configuration/Service Software (CSS) and Unified Network Configurator (UNC).

CSS
is used to configure the parameters on the device. CSS can access devices remotely over the
network, or locally through an Ethernet/serial connection to the service port on the device or
through a LAN switch. CSS also can be used to view status information, equalize batteries, and
check internal logs of the equipment at the site. See the CSS Online Help for configuration details.

UNC Wizard
is a component of UNC used to configure the parameters of a site, subsite, and channel. See the
UNC Wizard Online Help for configuration details.

VoyenceControl
is a component of UNC used to pull and push configurations and configure the parameters of the
device. See the Unified Network Configurator manual for general information about using
VoyenceControl functions.

NOTICE: While it is possible to configure a conventional device using the UNC, it is preferable
to use CSS because configuration dependencies are enforced.
The UNC is not applicable for K core or non-networked sites.

All parameters are programmed locally when the site is installed but not linked to a network. Test all
parameters before making the site available. The ability to locally program provides the means to test
the site before making it available for system operation.

Discovering a Device in the UNC
When and where to use: Use these high-level steps to discover the devices in the Unified Network
Configurator (UNC). See the Unified Network Configurator manual for details on discovering devices.

Process:
1 Use the UNC Discovery Wizard to:

• Discover the devices.
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• Upload configurations for the devices.

• Generate changes for non-compliant devices.

2 Approve jobs (if any).

Security/Authentication Services
If the device supports SNMPv3 protocol, a pop-up dialog box appears displaying the SNMPv3
Password Prompt when logging in to a device through Configuration/Service Software (CSS) using an
Ethernet connection. For configuration details, see the Information Assurance Features Overview,
Software Download, and SNMPv3 manuals. See Figure 122: SNMPv3 Security Level Option Prompt
on page 256.

Figure 122: SNMPv3 Security Level Option Prompt

A pop-up window appears displaying the File Transfer Access Services for CSS. Use this logon when
communicating to a device through CSS using either an Ethernet or DB-9 Serial Port connection. See 
Figure 123: CSS Login Banner on page 257.
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Figure 123: CSS Login Banner

Device Configuration in CSS
This section covers configuration of a device using the Configuration/Service Software (CSS).

NOTICE: The IP address for the device is available through a serial port connection in the
Tools → Set IP Address from the CSS menu.

Initially Configuring a Device in CSS
When and where to use: Use this process to initially configure a device in CSS

Process:
1 Perform the following configuration steps that require a serial connection. See Connecting

Through a Serial Port Link on page 258.

a Set the IP address and pairing number of the device. See Setting the Device IP Address and
Pairing Number in CSS on page 260.

b Set the serial security services. See Setting the Serial Security Services in CSS on page
261.

2 Perform the following configuration steps that require an Ethernet connection. See Connecting
Through an Ethernet Port Link on page 262.

a Set the pairing number of the device. See Setting the BR/CM Pairing Number in CSS on
page 265.

b Set the current date and time of the device. See Setting the Date and Time in CSS on page
265.

c Change the SNMPv3 configuration and user credentials of a device in the site. See Changing
SNMPv3 Configuration and User Credentials in CSS on page 265.

d Create, update, or delete an SNMPv3 user on a device. See Adding or Modifying an
SNMPv3 User in CSS on page 268.

e Verify the SNMPv3 credentials on a device. See Performing an SNMPv3 Connection
Verification in CSS on page 268.

f Configure DNS using the CSS. See Chapter 7, “Configuring DNS in CSS” in the
Authentication Services manual.
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g Set the SWDL transfer mode. See Setting the SWDL Transfer Mode in CSS on page 269.

h Configure for SSH. See the Securing Protocols with SSH manual, "Configuring SSH for RF
Site Devices and VPMs in CSS" section in Chapter 4.

i Enable RADIUS Authentication on a device. See Chapter 7, “Configuring RADIUS Sources
and Parameters in CSS” in the Authentication Services manual. Make sure that the devices
have been added to the RADIUS servers on the domain controllers as RADIUS clients.

j Enable Centralized Authentication on a device. See Chapter 7, “Enabling/Disabling
Centralized Authentication in CSS” in the Authentication Services manual.

k Set the Local Cache Size for Centralized Authentication on a device. See Chapter 7, “Setting
the Local Cache Size for Central Authentication in CSS” in the Authentication Services
manual.

l Customize the login banner text in CSS (optional). See Customizing the Login Banner in
CSS on page 269.

m Enable Centralized Event Logging on a device (optional). See Chapter 6, “Enabling/Disabling
Centralized Event Logging on Devices in CSS” in theCentralized Event Logging manual.

n Set the NTP Server Settings on a device. See NTP Server Settings in CSS on page 270.

3 Set up the local Password Configuration in the CSS (optional). See Setting the Local Password
Configuration in CSS on page 271.

4 Continue to one of the following depending on the type of device you are configuring:

• Configuring the Parameters for the GTR 8000 Base Radio (Trunked Simulcast) on page
272.

• Configuring the Parameters for the GTR 8000 Base Radio (Trunked Repeater) on page 273.

• Configuring the Parameters for the GTR 8000 Base Radio (HPD) on page 274.

• Configuring the Parameters for a GTR 8000 Base Radio (Conventional) on page 274.

• Configuring the Parameters for a GTR 8000 Base Radio (Express) on page 275

• Configuring the Parameters for a GPB 8000 Reference Distribution Module on page 276.

Connecting Through a Serial Port Link
Prerequisites: This procedure assumes that the Configuration/Service Software (CSS) application is
loaded on your computer. See the Private Network Management Client manual.

When and where to use: This procedure describes the steps required to connect through a serial port
link to set the IP address of the device and to set the serial security services. Perform all other device
function and feature configurations through an Ethernet port connection in the CSS.

Procedure:
1 Connect a serial cable to a laptop or computer running CSS, and the serial connector on the

device module. The serial cable is an RS232, female DB-9 to male DB-9 straight through cable.
If the laptop does not have a serial port, use a USB-to-serial converter external device.

2 Open the CSS application.

3 From the menu, select Tools → Connection Configuration.

The Connection Screen dialog box appears.

4 In the Connection Type area, select Serial.
The Serial Settings area on the dialog box becomes enabled.
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5 In the Serial Port field, select the communication port that matches the one selected on the
computer.

6 In the Baud Rate field, select the baud rate with which you want to communicate with the
device.

• Baud Rate 19200

7 Click Connect.
A login/password prompt screen appears.

Figure 124: CSS Login Banner

8 Provide the required credentials. Perform one of the following actions:

• If a domain controller is available on the network, enter the Username and Password for the
RADIUS service user account assigned to the netwadm group in the Active Directory. (The
default service user is serviceuser.)

• If a domain controller is not available on the network, enter the Username and Password for
the local bts_service account.

• If the Elevated Privileges Password field is active, enter the Elevated Privileges
Password that was set up for this device.

When accessing the device, if the default passwords do not work, the passwords may have
been set to default values by a different system release of software. See "Resetting Device
Passwords" in the CSS Online Help to reset the passwords to the current software release
defaults. If Authentication Services are not enabled on a device, type any alphanumeric
characters to populate the [Username, Password, and Elevated Privileges Password] fields,
as they cannot be left blank.

9 To access the device and close the dialog box, click OK.

The blank CSS main window appears.

NOTICE: The Service menu is not available until you read the configuration file from the
device using an Ethernet connection.

Serial Connection Configurations
The following procedures set configuration parameters in the Configuration/Service Software (CSS)
using a serial connection.
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Setting the Device IP Address and Pairing Number in CSS

Prerequisites: Obtain the required credentials information (local service account password and
elevated privileges password) to configure the site devices before proceeding. The user credentials
information includes both the current and new credentials. Without the current credentials, access to
the device or to the user credentials is denied. See Local Password and SNMPv3 Passphrase
Troubleshooting on page 343.

NOTICE: Setting or changing the device IP Address causes the SNMPv3 configuration and
user credentials to automatically reset.

Procedure:
1 Connect to the device using Configuration/Service Software (CSS) through a serial port link. See 

Connecting Through a Serial Port Link on page 258.

2 From the menu, select Tools → Set IP Address/BR_CM Pairing Number.
NOTICE: If the device is not in a voting or simulcast IP only topology, the menu item is
shown as Set IP Address/Box Number.

The Set IP Address and Base Radio/Comparator Pairing Number dialog box appears or the
Set IP Address and Box Number dialog box appears.

3 In the Device IP Address field, enter the device IP address. Click Set Device IP Address.

4 In a voting or simulcast IP only topology, enter the device pairing number. Click Set BR/CM
Pairing Number.

5 Click OK to close the dialog box.

6 Click Reset to initiate a hardware restart.

SNMPv3 user credentials reset to their factory default values.

7 Click Close to close the dialog box.

8 To reconfigure the SNMPv3 user credentials, see Changing SNMPv3 Configuration and User
Credentials in CSS on page 265.

Pairing To a Comparator

When operating in a voting, multicast, or IP simulcast configuration, base radios must be paired to
comparators using the BR/CM Pairing Number. The BR/CM Pairing Number for the base radio and
comparator is used to create an IP multicast group that allows the base radio and comparator to talk to
each other. The base radio listens for messages that the comparator sends to establish an IP
connection with all the paired base radios. When the base radio receives the message from the
comparator, it extracts the comparator IP address from the message and uses it to send received voice
and data back to the comparator.

Communication from the comparator to the paired base radio always uses a multicast IP address.
Communication between the paired base radio to the comparator always uses a unicast IP address.

The multicast IP address is calculated based on the base radio and comparator pairing number and
the formula as follows:

For Conventional Systems:
224.10.100.nnn, where nnn is: (2 * channel number) - 1 for channel number between [1, 127]
224.10.101.nnn, where nnn is: (2 * (channel number – 127) - 1) for a channel number between [128,
200]

For Trunked Multi-Site Systems:
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224.100.102.nnn, where nnn is: 100 + (2 * channel number) - 1

NOTICE: The BR/CM Pairing Number is not used for circuit (V.24 or 4-wire/V.24 hybrid link)
configurations.

See Setting the Device IP Address and Pairing Number in CSS on page 260 to set the pairing number.
The pairing number can also be set using an Ethernet connection. See Setting the BR/CM Pairing
Number in CSS on page 265.

Serial Security Services in CSS

The Serial Security Services in Configuration/Service Software (CSS) enables the secure services and
changes the device password.

NOTICE: The Serial Security Services must be set before changing the SNMPv3 configuration
and user credentials on a selected device in the site.

Before enabling this parameter, any login and password may be used on the File Transfer Access
Services login window to access a device. After Authentication Services are enabled, the login and
password provided is checked against the following authentication sources:

Stored password
RF site devices support a configurable password for the Local Service and Elevated Privileges
accounts. The password is verified against the stored password for these accounts.

Built-in logins and passwords
RF site devices support built-in login/password combinations for a login by services such as the
software downloads. Only certain software download login names are authenticated in this way.

Centralized Authentication
For authentication through centralized accounts instead of Local Service, Elevated Privileges, and
built-in user accounts, use the Configure the Centralized Authentication parameter in CSS for
the Challenge Handshake Authentication Protocol (CHAP). See Chapter 7, “Enabling/Disabling
Centralized Authentication in CSS” in the Authentication Services manual. This procedure requires
an Ethernet connection to the device being configured.

Setting the Serial Security Services in CSS

Prerequisites: Obtain the required credentials information (local service account password and
elevated privileges password) to configure the site devices before proceeding. The user credentials
information includes both the current and new credentials. Without the current credentials, you cannot
access the device and cannot change the user credentials. See Local Password and SNMPv3
Passphrase Troubleshooting on page 343. Changing to the incorrect user credentials may lead to not
being able to access the device through Configuration/Service Software (CSS) or Secure SHell (SSH).

Procedure:
1 Connect to the device using CSS through a serial port link. See Connecting Through a Serial

Port Link on page 258.

2 From the menu, select Security → Device Security Configuration → Security Services
(Serial).

3 From the Security Services Configuration dialog box, set the Test Application
Configuration field according to your organizational policies. The recommended secure
configuration is Disabled.

4 Set the Authentication Services field to Enabled. This field enables local authentication
services and must be enabled as a prerequisite for centralized authentication.
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5 Set the Password Reset Mechanism field. This field allows a reset of the passwords for two
built-in device accounts to their default values.

6 To update the password for the device, select either Service Account or Elevated Privilege
from the drop-down list. Click Update password.

7 In the Change Account Password dialog box, enter the old password, then enter a new
password, and confirm the new password before clicking Change Password.

8 To save the new password, click OK.

The Change Account Password dialog box closes.

Resetting SNMPv3 User Credentials to Factory Defaults in CSS

Prerequisites: Obtain the required credentials information (local service account password and
elevated privileges password) to configure the site devices before proceeding. The user credentials
information includes both the current and new credentials. Without the current credentials, you cannot
access the device and cannot change the user credentials. To obtain the keys for resetting either
password or SNMPv3 passphrases for the device, contact Motorola Solution Support Center (SSC).
Changing to the incorrect user credentials may lead to not being able to access the device through
Configuration/Service Software (CSS) or Secure SHell (SSH).

Procedure:
1 Connect to the device using CSS through a serial port link. See Connecting Through a Serial

Port Link on page 258.

2 From the menu, select Security → SNMPv3 Configuration → Reset SNMPv3 Configuration
(Serial).
The Reset SNMPv3 Configuration dialog box opens.

3 Click Reset SMPv3 Configuration.

The SNMPv3 configuration is reset to factory defaults in the device.

4 Click Exit.
The Reset SNMPv3 Configuration dialog box closes.

5 To reboot the device for the SNMPv3 user credentials to take effect, perform the following
actions:

a From the menu, select Tools → Set IP Address/Box Number or Set IP Address/BR_CM
Pairing Number.

b In the dialog box, click Reset.
The device reboots.

6 Proceed to Changing SNMPv3 Configuration and User Credentials in CSS on page 265.

Connecting Through an Ethernet Port Link
Prerequisites: Load Configuration/Service Software (CSS) on the computer. See the Private Network
Management Client manual if necessary or see the instructions in the CSS CD-ROM jewel box for
instructions on loading the CSS on the laptop or computer.
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When and where to use: Use the Ethernet port link to configure all CSS parameters for the device.
For a base radio, receiver, or comparator, the 10/100Base-T LAN is not the default Ethernet port
setting. To set the correct port speed and duplex, see the CSS Online Help.

Procedure:
1 Connect a computer (either laptop or desktop) to a device.

a Connect an Ethernet straight through cable between the Ethernet port on the computer and
the appropriate LAN switch either locally at a site or remotely through the network.

• If connecting to a base radio or receiver, set the IP address of the laptop to the
192.168.1.x subnet (where x is any number between 2 and 253).

• If connecting to a site controller or comparator, set the IP address of the laptop to an
address on the subnet of the local site, which varies depending on the site and zone
numbers.

NOTICE: Normally the computer is connected to the appropriate LAN switch either
locally or remotely through the network. Do not connect directly to a device unless
downloading the software or configuring individually to that device.

b Start the computer.

2 Open the CSS application.

3 From the menu, select Tools → Connection Configuration.

4 From the Connection Screen, in the Connection Type area, select Ethernet.
5 If connected through the LAN switch, specify the IP address for the device in the Ethernet

Settings area. Perform one of the following actions:

If… Then…

If you know the IP ad-
dress for the device,

perform the following actions:

a In the Device IP Address field, enter the IP address for the de-
vice.

b Go to step 7.

Trunked Device: If you do
not know the IP address,
but know the system
identification of the device
(the zone, site, subsite,
and device ID of the de-
vice),

perform the following actions:

a To open the DNS IP Address Calculation Screen dialog box,
click Fetch DNS Entry.

b From the Device list box, select the desired device type.

c In the Zone, Site, Subsite, and Device ID fields, enter the
proper values .

NOTICE: Some fields, such as Subsite, do not allow
entries for some devices. Therefore, select the de-
vice first.

d Click OK.
The Domain Name Services (DNS) information of the device
automatically appears in the Device IP Address field.

e Go to step 7.

Conventional Device: If
you do not know the IP
address,

perform the following actions:

a Establish a serial connection to the device. See Connecting
Through a Serial Port Link on page 258.

6871022P87-C
Chapter 4:  GTR 8000 Expandable Site Subsystem Configuration

Send Feedback   263

http://docsurvey.motorolasolutions.com


If… Then…

b For a base radio, receiver or comparator, from the menu, select
Tools → Set IP Address/BR_CM Pairing Number. For a site
controller or Reference Distribution Module (RDM), select Set
IP Address/Box Number.

c In the Device IP Address field, read the IP address.

d Re-establish an Ethernet connection and repeat steps 1
through 4.

e In the Device IP Address field, enter the IP address for the de-
vice.

f Go to step 7.

6 If connected directly to the Ethernet service port of the device, click Front Panel Ethernet.
7 To make the connection, click Connect.

If this device is SNMPv3-capable, an SNMPv3 Passphrase Prompt dialog box appears.

Figure 125: SNMPv3 Passphrase Prompt

8 In the SNMPv3 Passphrase Prompt dialog box, enter the User Information and Passphrase
Information. Click OK. If Authentication Services are not enabled on a device, click OK when
the dialog box appears.

9 From the menu, select File → Read Configuration From Device.

The parameters download from the device to the computer. When the download is complete, the
CSS main window opens. Use the map on the left side of the screen to view configuration
information for the device.
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Ethernet Connection Configurations
The following procedures set configuration parameters in the Configuration/Service Software (CSS)
using an Ethernet connection.

Setting the BR/CM Pairing Number in CSS

When and where to use:
Set the pairing number for the base radio, receiver, and comparator using Configuration/Service
Software (CSS) when operating in a voting, multicast, or simulcast IP configuration using an Ethernet
connection.

Procedure:
1 Connect to the device using Configuration/Service Software (CSS) through an Ethernet port link.

See Connecting Through an Ethernet Port Link on page 262.

2 From the menu, select Service → BR/CM Pairing Number.
3 Enter the pairing number. Click OK.

The pairing number is set.

Setting the Date and Time in CSS
This procedure provides the date and time to the device.

When and where to use: During installation, the date and time is set through an Ethernet cable
connected directly to the Ethernet port of the device. After installation, this procedure may be
performed remotely.

NOTICE: If a power outage occurs, the device does not retain the date and time settings.

Procedure:
1 Connect to the device using CSS through an Ethernet port link. See Connecting Through an

Ethernet Port Link on page 262.

2 From the menu, select Tools → Set Device Date and Time.

3 Enter the current date and time. Click OK.

The date and time are set.

Changing SNMPv3 Configuration and User Credentials in CSS

Prerequisites: Obtain the required SNMPv3 credentials information (Authentication passphrase,
Encryption passphrase, and Authoritative Engine ID) to configure the device before proceeding. The
user credentials information includes both the current and new credentials. Without the current
credentials, you cannot access the device and cannot change the user credentials. See Local
Password and SNMPv3 Passphrase Troubleshooting on page 343. Changing to the incorrect user
credentials may lead to not being able to access the device from the Unified Network Configurator
(UNC), or for the device to be unable to send alarms to the Unified Event Manager (UEM) (for fault
management).

When and where to use: This procedure changes the SNMPv3 configuration and user credentials
from Configuration/Service Software (CSS) on a selected device in the site. For more information on
this feature, see the SNMPv3 manual.
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NOTICE: During installation, perform this procedure through an Ethernet cable connected
directly to the Ethernet port of the device. After installation, this procedure may be performed
remotely from CSS.

Procedure:
1 Connect to the device using CSS through an Ethernet port link. See Connecting Through an

Ethernet Port Link on page 262.

2 From the menu, select Security → SNMPv3 Configuration → Configure SNMPv3 Users
(Ethernet).
The SNMPv3 Passphrase Prompt dialog box appears with MotoAdmin as the selected
SNMPv3 user.

3 In the SNMPv3 Passphrase Prompt, enter the appropriate Authentication and Encryption
Passphrases in the text fields.

NOTICE: When accessing the device for the first time, if the default passphrases do not
work, the passphrases may have been set to default values by a different system release
of software. See “Reset SNMPv3 Configuration (Serial)” in the CSS Online Help to reset
the passphrases to the current software release defaults.

4 If connecting remotely through the network to a different device, perform one of the following
actions. Otherwise, go to step 5.

If… Then…

If you know the IP address
for the device,

perform the following actions:

a In the Device IP Address field, enter the IP address for the
device.

b Go to step 5.

If you do not know the IP ad-
dress, but know the system
identification of the device
(the zone, site, subsite, and
device ID of the device),

perform the following actions:

a To open the DNS IP Address Calculation Screen dialog
box, click Fetch DNS Entry.

b From the Device list box, select the desired device type.

c In the Zone, Site, Subsite, and Device ID fields, enter the
proper values.

NOTICE: Some fields, such as Subsite, do not al-
low entries for some devices. Therefore, select the
device first.

d Click OK.
The Domain Name Services (DNS) information of the device
automatically appears in the Device IP Address field.

e Go to step 5.

5 Click OK.

If the passphrases are authenticated, the Configure SNMPv3 Users window appears. If the
connection fails, a message appears.

6 To update the SNMPv3 credentials for a selected user, from the User Information section,
select a Username in the Username drop-down list.

The CSS retrieves the current credentials from the device for a selected user.
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NOTICE: Depending on the user selected, some fields on this dialog box become read-
only or disabled. Click Cancel at any time to discard changes made to a selected user.

7 To change or update the SNMPv3 security level for a selected user, from the User Information
section, select the security level in the Security Level drop-down list.

The security level options are:
NoAuthNoPriv

Neither the Authentication Passphrase nor Encryption Passphrase are needed for
communicating with the device.

AuthNoPriv
Authentication Passphrase is needed; but no Encryption Passphraseis needed for
communicating with the device.

AuthPriv
Both Authentication Passphraseand Encryption Passphrase are needed for communicating
with the device.

The User Status field reflects the current operational status of the selected SNMPv3 User. The
Status Types include:
Active

User configured on the device; the Update and Delete options are enabled.

Not in service
User configured on the device; the Update and Delete options are enabled.

Not ready
User configured on the device; the Update and Delete options are enabled.

Not present
Not present on the device; the Create option is enabled.

The security level of the selected user is set.

8 To change the Authentication Passphrase for the selected SNMPv3 user, if applicable to the
selected security level, perform the following actions:

a From the Authentication Passphrase section, enter the passphrase into the Old
Passphrase field.

NOTICE: If you do not know the passphrase, select the I do not remember old
passphrase check box.

b Enter the new passphrase into the New Passphrase field.

NOTICE: The passphrase must be between 8 and 64 characters in length and consist
of upper or lowercase alphanumeric characters (excluding the @ # $ ^ or _
characters).

c Enter the same new passphrase into the Confirm New Passphrase field.

9 To change the encryption passphrase for the selected SNMPv3 user, if applicable to the
selected security level, perform the following actions:

a From the Encryption Passphrase section, enter the old passphrase into the Old
Passphrase field.

NOTICE: If you do not know the passphrase, select the I do not remember old
passphrase check box.

b Enter the new passphrase into the New Passphrase field.

c Enter the same new passphrase into the Confirm New Passphrase field.
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10 To change the Authoritative Engine Identifier, applicable to MotoInformA and MotorInformB
users only, perform the following actions:

a From the Authoritative Engine ID section, select the desired current engine ID from the
Current Engine ID drop-down list.

b In the New Engine ID field, enter the new engine ID.

NOTICE: The new engine ID must be between 1 and 27 characters and comply with
the Engine ID Domain Name Syntax.

11 To create, update, or delete SNMPv3 users, go to Adding or Modifying an SNMPv3 User in CSS
on page 268.

Adding or Modifying an SNMPv3 User in CSS

When and where to use: Use this procedure to create, update, or delete an SNMPv3 user from the
Configure SNMPv3 Users window.

Procedure:
1 From the Configure SNMPv3 Users window, to add or modify the selected SNMPv3 user, click

one of the following:

• Create: Creates a user when the status is Not Present.

• Update: Updates an existing user.

• Delete: Removes an existing user.

A Confirmation dialog box appears and prompts if you want to continue.

2 Click Yes.

The Processing Requests dialog box appears and processes the request. A green square X
indicates OK and a red square X indicates failure.

3 After reviewing the processing status, click OK.

NOTICE: If you encounter any errors, go back to the appropriate step and correct the
information entered.

4 Repeat these steps for any SNMPv3 users you wish to create, update, or delete.

5 Click Cancel to exit the Configure SNMPv3 Users window.

The Configure SNMPv3 Users window closes, and the CSS main window returns.

Performing an SNMPv3 Connection Verification in CSS

When and where to use: When the SNMPv3 user credentials have been created, modified, or
deleted, ensure that the device is properly configured for SNMPv3. Follow this procedure to verify the
SNMPv3 connection.

Procedure:
1 Connect to the device using Configuration/Service Software (CSS) through an Ethernet port link.

See Connecting Through an Ethernet Port Link on page 262.

2 When the passphrase prompt screen opens, select the configured security level and enter the
required passphrases.

3 If the connection was successful, click OK.
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Customizing the Login Banner in CSS
This procedure describes how to edit the login banner security notice.

Procedure:
1 Connect to the device using Configuration/Service Software (CSS) through an Ethernet port link.

See Connecting Through an Ethernet Port Link on page 262.

2 From the menu, select Security → Device Security Configuration → Remote Access/Login
Banner (Ethernet).

3 From the Remote Access/Login Banner screen, Remote Access Configuration tab, click the
Login Banner tab.

4 Edit the text of the banner.

5 Click one of the following:

• Refresh: re-reads the original Login Banner text.

• Apply: saves the changes and keep the screen open.

• OK: saves the changes and close the screen.

• Cancel: closes the screen without saving the changes.

Setting the SWDL Transfer Mode in CSS
This procedure sets the Software Download (SWDL) transfer mode.

When and where to use: Follow this procedure to set the SWDL transfer mode to Ftp (clear) or Sftp
(secure) before performing a software download on the device.

Procedure:
1 Connect to the device using Configuration/Service Software (CSS) through an Ethernet port link.

See Connecting Through an Ethernet Port Link on page 262.

2 From the menu, select Security → Device Security Configuration → Remote Access/Login
Banner (Ethernet).
The Remote Access/Login Banner screen appears displaying the Remote Access
Configuration tab.
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Figure 126: Remote Access Configuration Tab

3 In the Software Download Transfer Mode (Requested) field, choose either Ftp (clear) or Sftp
(secure). Click OK.

NOTICE: Secure Shell Service (Requested) and Secure FTP (Requested) are
automatically set to Enabled and grayed out when you choose Sftp.

Manager IP Address Settings in CSS

When IP addresses exceed the allowed total, remove the IP addresses that are no longer used at the
site. This removal allows the Unified Event Manager (UEM) to be identified as the current manager and
handles traps for the device.

See “Clearing Manager IP Address” in the CSS On-line Help for removing these IP addresses.

NTP Server Settings in CSS

Network Time Protocol (NTP) provides a clock synchronization mechanism for various Network
devices and computers, and allows the NTP server to provide the date and time synchronization for a
particular device. The NTP server IP address must be entered on the Manager / NTP Definition
Screen.

Trunked ASTRO® 25 systems: For security purposes, the base radio can restrict NTP messages from
only the site controller. This restriction can be accomplished by configuring two site controller IP
addresses into the NTP Server IP Address fields on the base radio.

Trunked 3600 IntelliRepeater systems: For security purposes, the base radio can restrict NTP
messages from only the GPB 8000 Reference Distribution Modules (RDMs). This restriction can be
accomplished by configuring two RDM IP addresses into the NTP Server IP Address fields on the
base radio.
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For a base radio, see “Configuring the NTP Servers” or for RDMs in a trunked 3600 IntelliRepeater
system, see “Configuring NTP Servers for an RDM in a Trucked 3600 IntelliRepeater Site” in the CSS
On-line Help for defining, editing, and removing these settings.

Setting the Local Password Configuration in CSS

When and where to use: Use this procedure to set the complexity requirements and controls for the
local service account password. The updated password criteria is enforced on the next password
change for the device local service account. Password Configuration is an optional feature. For
information, see “Password Configuration" in the CSS Online Help.

Procedure:
1 Connect to the device using Configuration/Service Software (CSS) through an Ethernet port link.

See Connecting Through an Ethernet Port Link on page 262.

2 In the navigation pane, click the Password Configuration element.

The Password Configuration window appears.

Figure 127: Password Configuration Window

3 Complete the following fields:

Minimum Password Length
This field allows you to enter a value as the minimum length for the password. The minimum can be
between 8 and 255 characters, with a default of 10 characters.

Number of Required Special Characters
This field allows you to enter a value for the required number of special characters which must be
included in the password. The value can be between 0 and 255, with a default of 1.

Number of Required Numeric Characters
This field allows you to enter a value for the required number of numeric characters which must be
included in the password. The value can be between 0 and 255, with a default of 2.

Number of Required Uppercase Characters
This field allows you to enter a value for the required number of uppercase alphabetic characters
which must be included in the password. The value can be between 0 and 255, with a default of 2.

Number of Required Lowercase Characters
This field allows you to enter a value for the required number of lowercase alphabetic characters
which must be included in the password. The value can be between 0 and 255, with a default of 2.

Number of Consecutive Characters
This field allows you to enter the maximum number of consecutive repeated characters permitted in
the password.
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Set Values to Default
This field returns all fields to their system default values.

Password Aging Time [days]
This field allows you to enter a value between 0 and 65535 for the maximum number of days a local
password is valid. After the Password Aging Time has elapsed, the password must be changed.
The default value is 0.

Change Interval Limit [days]
This field allows you to enter a value between 0 and 65535 for the number of days which must
elapse before a local password can be changed. The default value is 1.

Configuring the Parameters for the GTR 8000 Base Radio (Trunked
Simulcast)
When and where to use:
Before proceeding with this process, complete the initial configuration of the device in Initially
Configuring a Device in CSS on page 257.

For configuration parameters for a trunked simulcast GTR 8000 Expandable Site Subsystem, see the
following in the CSS Online Help:

• GTR 8000 Base Radios: Multi-Site or Simulcast Subsystem

• GCP 8000 Site Controllers: Site Controller Configuration & Service Help > Multi-Site Controller

• GPB 8000 Reference Distribution Modules: Site Controller Configuration & Service Help > GPB
8000 Reference Distribution Module

Process:
1 Connect to the base radio through an Ethernet port link and then read the configuration file from

the base radio. See Connecting Through an Ethernet Port Link on page 262.

2 Click System in the System tree and enter a hexadecimal value (between 001 and FFE) in the
System Id field.

3 Click Site in the System tree and complete the fields.

4 Click Channel in the System tree and complete the fields.

5 Click Subsite in the System tree and complete the fields.

6 Click Configuration in the System tree and complete the fields on all four tabs.

NOTICE: As part of RMC configuration, the DIP switches on the RMC/LNA modules
must be set. See RMC Attenuation on page 278.

7 Click Network Services Configuration in the System tree and complete the fields on the three
tabs.

NOTICE: For configuration details for DNS and RADIUS Services, see the Authentication
Services manual. For configuration details for SYSLOG Services, see the Centralized
Event Logging manual.

8 Click Password Configuration in the System tree and complete the fields.

NOTICE: Password Configuration is only required if you have passwords entered for
local accounts. Password Configuration sets the password complexity and controls. For
details on password complexity and controls, see “Password Configuration” in CSS
Online Help.

9 From the menu, select File → Save As to save the configuration data to a new archive file, or
select File → Save to overwrite the existing archive file.
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IMPORTANT: Save any configuration changes to a local or network drive in case the
base radio transceiver module fails you can load the settings to a replacement base radio
transceiver. If the configuration file is not saved to a local or network drive, repeat the
set-up steps after replacing a transceiver module.

10 From the menu, select File → Write Configuration to Device to write the configuration data to
the base radio.

Configuring the Parameters for the GTR 8000 Base Radio (Trunked
Repeater)
When and where to use:
Before proceeding with this process, complete the initial configuration of the device in Initially
Configuring a Device in CSS on page 257.

For configuration parameters for a trunked repeater GTR 8000 Expandable Site Subsystem, see the
following in the CSS Online Help:

• GTR 8000 Base Radios: Repeater Site Subsystem

• GCP 8000 Site Controllers: Site Controller Configuration & Service Help > Repeater Site
Controller > GCP 8000

Process:
1 Connect to the base radio through an Ethernet port link and read the configuration file from the

base radio. See Connecting Through an Ethernet Port Link on page 262.

2 Click System in the System tree and enter a hexadecimal value (between 001 and FFE) in the
System Id field.

3 Click Zone in the System tree and complete the fields.

4 Click Site in the System tree and complete the fields.

5 Click Channel in the System tree and complete the fields.

6 Click Configuration in the System tree and complete the fields on all four tabs.

NOTICE: As part of RMC configuration, the DIP switches on the RMC/LNA modules
must be set. See RMC Attenuation on page 278.

7 Click Network Services Configuration in the System tree and complete the fields on the three
tabs.

NOTICE: For configuration details for DNS and RADIUS Services, see the Authentication
Services manual. For configuration details for SYSLOG Services, see the Centralized
Event Logging manual.

8 Click Password Configuration in the System tree and complete the fields.

NOTICE: Password Configuration is only required if you have passwords entered for
local accounts. Password Configuration sets the password complexity and controls. For
details on password complexity and controls, see “Password Configuration” in CSS
Online Help.

9 From the menu, select File → Save As to save the configuration data to a new archive file, or
select File → Save to overwrite the existing archive file.

IMPORTANT: Save any configuration changes to a local or network drive in case the
base radio transceiver module fails you can load the settings to a replacement
transceiver module. If the configuration file is not saved to a local or network drive, repeat
the set-up steps after replacing a transceiver module.
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10 From the menu, select File → Write Configuration to Device to write the configuration data to
the base radio.

Configuring the Parameters for the GTR 8000 Base Radio (HPD)
When and where to use:
Before proceeding with this process, complete the initial configuration of the device in Initially
Configuring a Device in CSS on page 257.

For configuration parameters for an HPD GTR 8000 Expandable Site Subsystem, see the following in
the CSS Online Help:

• GTR 8000 Base Radios: HPD Remote/Expandable Site

• GCP 8000 Site Controllers: Site Controller Configuration & Service Help > HPD Site Controller

Process:
1 Connect to the base radio through an Ethernet port link and read the configuration file from the

base radio. See Connecting Through an Ethernet Port Link on page 262.

2 Click System in the System tree and enter a hexadecimal value (between 001 and FFE) in the
System Id field.

3 Click Site in the System tree and complete the fields.

4 Click Channel in the System tree and complete the fields.

5 Click Configuration in the System tree and complete the fields on all four tabs.

NOTICE: As part of RMC configuration, the DIP switches on the RMC/LNA modules
must be set. See RMC Attenuation on page 278.

6 Click Network Services Configuration in the System tree and complete the fields on the three
tabs.

NOTICE: For configuration details for DNS and RADIUS Services, see the Authentication
Services manual. For configuration details for SYSLOG Services, see the Centralized
Event Logging manual.

7 Click Password Configuration in the System tree and complete the fields.

NOTICE: Password Configuration is only required if you have passwords entered for
local accounts. Password Configuration sets the password complexity and controls. For
details on password complexity and controls, see “Password Configuration” in CSS
Online Help.

8 From the menu, select File → Save As to save the configuration data to a new archive file, or
select File → Save to overwrite the existing archive file.

IMPORTANT: Save any configuration changes to a local or network drive in case the
base radio transceiver module fails you can load your settings to a replacement
transceiver module. If the configuration file is not saved to a local or network drive, repeat
the set-up steps after replacing a transceiver module.

9 From the menu, select File → Write Configuration to Device to write the configuration data to
the base radio.

Configuring the Parameters for a GTR 8000 Base Radio
(Conventional)
When and where to use:
Before proceeding with this process, complete the initial configuration of the device in Initially
Configuring a Device in CSS on page 257.
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For configuration parameters for a Conventional GTR 8000 Base Radio, see the following in the CSS
Online Help:

• Analog-only, Digital-only, or Mixed Mode GTR 8000 Base Radio: Conventional Site - ASTRO
7.12 and Later

• Digital-only GTR 8000 Base Radio: Conventional Site - ASTRO 7.11 and Earlier

Process:
1 Connect to the base radio through an Ethernet port link and read the configuration file from the

base radio. See Connecting Through an Ethernet Port Link on page 262.

2 Click Site in the System tree and complete the fields.

3 Click Hardware Configuration in the System tree and complete the fields on the two tabs.

NOTICE: As part of RMC configuration, the DIP switches on the RMC/LNA modules
must be set. See RMC Attenuation on page 278.

4 Click Options in the System tree and complete the fields.

5 Click Infrastructure Interface in the System tree and complete the fields on the three tabs.

6 Click Channel Configuration in the System tree and complete the fields.

7 Click Repeater Configuration in the System tree and complete the fields.

8 Click Receiver Scan in the System tree and complete the fields.

9 Click Repeater Access in the System tree and complete the fields.

10 Click WildCard Tables in the System tree and complete the fields on the three tabs.

11 Click Network Services Configuration in the System tree and complete the fields on the three
tabs.

NOTICE: For configuration details for RADIUS Services, see the Authentication Services
manual. For configuration details for SYSLOG Services, see the Centralized Event
Logging, manual.

12 Click Password Configuration in the System tree and complete the fields.

NOTICE: Password Configuration is only required if you have passwords entered for
local accounts. Password Configuration sets the password complexity and controls. For
details on password complexity and controls, see “Password Configuration” in CSS
Online Help.

13 From the menu, select File → Save As to save the configuration data to a new archive file, or
select File → Save to overwrite the existing archive file.

IMPORTANT: Save any configuration changes to a local or network drive in case the
base radio transceiver module fails you can load your settings to a replacement base
radio. If the configuration file is not saved to a local or network drive, repeat the set-up
steps after replacing a base radio.

14 From the menu, select File → Write Configuration to Device to write the configuration data to
the base radio.

Configuring the Parameters for a GTR 8000 Base Radio (Express)
When and where to use:
This section covers configuration for ASTRO® 25 Express System GTR 8000 Expandable Site
Subsystem using the Configuration Service Software.

Before proceeding with this process, complete the initial configuration of the device in Initially
Configuring a Device in CSS on page 257.
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For configuration parameters for an Express GTR 8000 Expandable Site Subsystem, see the following
in the CSS Online Help:

• GTR 8000 Base Radios: Trunking Site > ASTRO 25 Express System

• GCP 8000 Site Controllers: Site Controller Configuration & Service Help > ASTRO 25 Express
System

Process:
1 Connect to the base radio through an Ethernet port link and then read the configuration file from

the base radio. See Connecting Through an Ethernet Port Link on page 262.

2 Click System in the System tree and complete the fields.

NOTICE: Ensure that all base radios and site controllers have the same values for
WACN ID and System ID.

3 Click Zone in the System tree and enter the following values:

• Set the base radios Grant Timeout Timer (msec) field to 1000 milliseconds (default).

• If the Phase 2 TDMA feature is present in your system, set the Carrier Fade Timeout Timer
(msec) field to 1900 for systems that have a value less than 1900. For systems that have a
value greater than 1900, use the higher value entered for the system.

4 Click Site in the System tree and complete the fields.

5 Click Channel in the System tree and complete the fields.

6 Click Configuration in the System tree and complete the fields on all four tabs.

NOTICE: As part of RMC configuration, the DIP switches on the RMC/LNA modules
must be set. See RMC Attenuation on page 278.

7 Click Password Configuration in the System tree and complete the fields.

NOTICE: Password Configuration is only required if you have passwords entered for
local accounts. Password Configuration sets the password complexity and controls. For
details on password complexity and controls, see “Password Configuration” in CSS
Online Help.

8 From the menu, select File → Save As to save the configuration data to a new archive file, or
select File → Save to overwrite the existing archive file.

IMPORTANT: Save any configuration changes to a local or network drive in case the
transceiver module fails you can load your settings to a replacement transceiver. If the
configuration file is not saved to a local or network drive, repeat the set-up steps after
replacing a transceiver.

9 From the menu, select File → Write Configuration to Device to write the configuration data to
the base radio.

Configuring the Parameters for a GPB 8000 Reference Distribution
Module
Prerequisites:
Before proceeding with this process, complete the initial configuration of the device in Device
Configuration in CSS on page 257.

For configuration details of the GPB 8000 Reference Distribution Module, see Site Controller
Configuration & Service Help → GPB 8000 Reference Distribution in the CSS Online Help.
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Process:
1 Connect to the device through an Ethernet port link and read the configuration file from the

device. See Connecting Through an Ethernet Port Link on page 262.

2 Click Site in the System tree and complete the fields.

3 Click Configuration in the System tree and complete the fields.

4 Click Network Services Configuration in the System tree and complete the fields on the three
tabs.

NOTICE: For configuration details for DNS and RADIUS Services, see the Authentication
Services manual. For configuration details for SYSLOG Services, see the Centralized
Event Logging, manual.

5 Click Password Configuration in the System tree and complete the fields.

NOTICE: Password Configuration is only required if you have passwords entered for
local accounts. Password Configuration sets the password complexity and controls. For
details on password complexity and controls, see “Password Configuration” in CSS
Online Help.

6 Click Switch Configuration in the System tree and complete the fields.

7 From the menu, select File → Save As to save the configuration data to a new archive file, or
select File → Save to overwrite the existing archive file.

IMPORTANT: Save any configuration changes to a local or network drive in case the
device fails you can load your settings to a replacement device. If the configuration file is
not saved to a local or network drive, repeat the set-up steps after replacing a device.

8 From the menu, select File → Write Configuration to Device to write the configuration data to
the device.

Configuring the Parameters for a GCP 8000 Site Controller
For CSS configuration of the GCP 8000 Site Controllers, see the GCP 8000 Site Controller manual or
the CSS Online Help.

For configuration parameters for a GCP 8000 Site Controller within a GTR 8000 Expandable Site
Subsystem, see the following in the CSS Online Help:

• Site Controller Configuration & Service Help > HPD Site Controller

• Site Controller Configuration & Service Help > Repeater Site Controller > GCP 8000

• Site Controller Configuration & Service Help > ASTRO 25 Express System

Configuring Tx Power Values and Battery Type

When and where to use: As part of the site configuration process, the Battery Type, Tx Power Level
(Battery Backup), and Tx Power Out on the Hardware Configuration tab in Configuration/Service
Software (CSS) must be configured.

Procedure:
1 Connect to the device through an Ethernet port link and read the configuration file from the

device. See Connecting Through an Ethernet Port Link on page 262.

2 From the navigation tree, select Configuration.

The Configuration window appears.
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3 Select the Hardware Configuration tab.

4 In the Tx Power Out (Watts) field, enter a value.

5 In the Tx Power Level Battery Backup (Watts) field, enter a value.

6 Select the Battery Type (manufacturer and model, or select the generic listing for the class of
battery).

7 From the menu, select File → Save, or selectFile → Save As to save the configuration to an
archive on your local or network drive.

8 From the menu, select File → Write Configuration to Device to write the configuration to the
device.

RMC Attenuation
To adjust the RF gain for different configurations, the attenuation level applied to receivers can be set
from the DIP switches on the front of Cabinet RMC/LNA modules and Site RMC/LNA modules.

Figure 128: Cabinet RMC/LNA Module (Front View) on page 278 shows the DIP switches on an
individual Cabinet RMC/LNA module. The location of the DIP switches is similar on a Site RMC/LNA
module.

Figure 128: Cabinet RMC/LNA Module (Front View)

The following are examples of how the DIP switch positions (0 and 1) create a binary system for setting
dB attenuation values.
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Figure 129: RMC DIP Switch Example: 0 dB

Figure 130: RMC DIP Switch Example: 12 dB

To determine how to set each DIP switch for your configuration, see RMC Attenuator DIP Switch
Settings on page 280.

• RMC Attenuator Settings for Single Cabinet Site with No Site RMC: If your configuration is a
Single Cabinet with No Site RMC (CA00861AA), set the DIP switches on your Cabinet RMC/LNA
module to the default positions indicated in Table 109: RMC Attenuator Settings for Single Cabinet
Sites with No Site RMC (700/800/900 MHz) on page 282 for 700/800/900 MHz or Table 111: RMC
Attenuator Settings for Single Cabinet Sites with No Site RMC (UHF R2, 435–524 MHz) on page
283 for UHF R2 (450–512 MHz). HPD systems have two sets of RMC/LNA modules.

• RMC Attenuator for All Other Configurations: If your configuration has at least one cabinet with
a Site RMC/LNA (CA00862AA), set the DIP switches on your Site and Cabinet RMC/LNA modules
to the default positions indicated in Table 108: RMC Attenuator Settings for Site with Two or More
Cabinets (700/800/900 MHz) on page 281 for 700/800/900 MHz or Table 110: RMC Attenuator
Settings for Site with Two or More Cabinets (UHF R2, 435–524 MHz) on page 283 for UHF R2
(450–512 MHz). These settings also apply to the Cabinet RMC/LNA modules in any expansion
cabinets (CA00877AA). HPD systems have two sets of RMC/LNA modules.

NOTICE: The default settings may not be appropriate for sites with a high antenna noise or
very large in-band interfering signals. The tables provide alternate optimum settings that allow
trading noise (sensitivity) for better intermodulation performance.

IMPORTANT: If your system has a customer-supplied Tower Top Amplifier (TTA), do not set
the DIP switches to the dB values in the following tables. See Inline Attenuator Value for a GTR
8000 Expandable Site Subsystem with a TTA for UHF R2 and 700/800/900 MHz on page 286.
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RMC Attenuator DIP Switch Settings

NOTICE: Although the DIP switches on the RMC/LNA modules are numbered starting with the
number 1 on the left, as shown in the RMC DIP Switch examples, this table starts with the
number 5 on the left because switch 5 represents the most significant digit in the binary system
that the switches provide for setting a dB value.

Table 107: RMC Attenuator DIP Switch Settings

Required Attenua-
tion (dB) Position 5 Position 4 Position 3 Position 2 Position 1

0dB 0 0 0 0 0

1dB 0 0 0 0 1

2dB 0 0 0 1 0

3dB 0 0 0 1 1

4dB 0 0 1 0 0

5dB 0 0 1 0 1

6dB 0 0 1 1 0

7dB 0 0 1 1 1

8dB 0 1 0 0 0

9dB 0 1 0 0 1

10dB 0 1 0 1 0

11dB 0 1 0 1 1

12dB 0 1 1 0 0

13dB 0 1 1 0 1

14dB 0 1 1 1 0

15dB 0 1 1 1 1

16dB 1 0 0 0 0

17dB 1 0 0 0 1

18dB 1 0 0 1 0

19dB 1 0 0 1 1

20dB 1 0 1 0 0

21dB 1 0 1 0 1

22dB 1 0 1 1 0

23dB 1 0 1 1 1

24dB 1 1 0 0 0

25dB 1 1 0 0 1

26dB 1 1 0 1 0

27dB 1 1 0 1 1

28dB 1 1 1 0 0
Table continued…

6871022P87-C
Chapter 4:  GTR 8000 Expandable Site Subsystem Configuration

280  Send Feedback

http://docsurvey.motorolasolutions.com


Required Attenua-
tion (dB) Position 5 Position 4 Position 3 Position 2 Position 1

29dB 1 1 1 0 1

30dB 1 1 1 1 0

31dB 1 1 1 1 1

RMC Attenuator Settings for Site with Two or More Cabinets (700/800/900
MHz)
The required attenuation dB values are also displayed on the Receive Multicoupler (RMC)
Configuration tab in Configuration/Service Software (CSS), which must be used to set up system gain
according to your GTR 8000 Expandable Site Subsystem configuration.

Table 108: RMC Attenuator Settings for Site with Two or More Cabinets (700/800/900 MHz)

System Noise Fig-
ure (dB)

System Input In-
tercept (dBm)

RFDS Gain
(dB)

Site RMC At-
tenuator Set-

ting (dB)

Cabinet RMC
Attenuator Set-

ting (dB)

3.4 –6.5 24 0 0

4.1 0.9 16 1 7

4.7* 3.4 13 1 10

5.0 4.4 12 2 10

6.0 6.3 10 4 10

7.1 8.2 8 6 10

8.0 9.3 7 8 9

9.2 11.0 5 9 10

10.0 11.9 4 10 10

10.9 12.7 3 11 10

12.0 13.7 2 13 9

12.9 14.5 1 14 9

13.8 15.2 0 15 9

Cabinet RMC Settings must be the same in each cabinet. These settings provide maximum possible
system dynamic range.

* = Default: Recommended setting as shipped from the factory.
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RMC Attenuator Settings for Single Cabinet Sites with No Site RMC
(700/800/900 MHz)
The required attenuation dB values are also displayed on the Receive Multicoupler (RMC)
Configuration tab in Configuration/Service Software (CSS), which must be used to set up system gain
according to your GTR 8000 Expandable Site Subsystem configuration.

Table 109: RMC Attenuator Settings for Single Cabinet Sites with No Site RMC (700/800/900 MHz)

System Noise Fig-
ure (dB)

System Input Inter-
cept (dBm) RFDS Gain (dB) Cabinet RMC Attenuator

Setting (dB)

4.5* 4.8 13 0

4.8 5.8 12 1

5.2 6.7 11 2

5.6 7.7 10 3

6.1 8.6 9 4

6.6 9.6 8 5

7.2 10.5 7 6

7.8 11.3 6 7

8.5 12.2 5 8

9.3 13.0 4 9

10.1 13.8 3 10

10.9 14.6 2 11

11.7 15.3 1 12

12.6 15.9 0 13

13.5 16.5 –1 14

14.4 17.1 –2 15

15.4 17.6 –3 16

16.3 18.0 –4 17

17.3 18.4 –5 18

18.2 18.7 –6 19

19.2 19.0 –7 20

20.2 19.2 –8 21

* = Default: Recommended setting as shipped from the factory. Do no use these settings for Rx
Expansion cabinets.
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RMC Attenuator Settings for Site with Two or More Cabinets (UHF R2,
435–524 MHz)
The required attenuation dB values are also displayed on the Receive Multicoupler (RMC)
Configuration tab in Configuration/Service Software (CSS), which must be used to set up system gain
according to your GTR 8000 Expandable Site Subsystem configuration.

Table 110: RMC Attenuator Settings for Site with Two or More Cabinets (UHF R2, 435–524 MHz)

System Noise
Figure (dB)

System Input In-
tercept (dBm) RFDS Gain (dB) Site RMC Attenu-

ator Setting (dB)

Cabinet RMC
Attenuator Set-

ting (dB)

4.1 –3.1 16 0 13

5.1 1.4 11 2 16

5.5* 2.6 10 4 15

6.1 3.9 8 3 18

7.1 5.7 7 8 14

8.0 7.3 5 8 16

9.1 8.8 3 8 18

10.0 10.0 2 10 17

11.0 11.1 1 12 16

12.1 12.2 0 14 15

13.0 13.1 –1 15 15

14.0 13.9 –3 13 19

Cabinet RMC Settings must be the same in each cabinet. These settings provide maximum possible
system dynamic range.

* = Default: Recommended setting as shipped from the factory.

RMC Attenuator Settings for Single Cabinet Sites with No Site RMC (UHF
R2, 435–524 MHz)
The required attenuation dB values are also displayed on the Receive Multicoupler (RMC)
Configuration tab in Configuration/Service Software (CSS), which must be used to set up system gain
according to your GTR 8000 Expandable Site Subsystem configuration.

Table 111: RMC Attenuator Settings for Single Cabinet Sites with No Site RMC (UHF R2, 435–524
MHz)

System Noise Figure
(dB)

System Input Inter-
cept (dBm) RFDS Gain (dB) Cabinet RMC Attenu-

ator Setting (dB)

4.6 0.0 14 0

4.7* 1.0 13 1

4.9 2.0 12 2

5.2 2.9 11 3
Table continued…
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System Noise Figure
(dB)

System Input Inter-
cept (dBm) RFDS Gain (dB) Cabinet RMC Attenu-

ator Setting (dB)

5.5 3.9 10 4

5.9 4.9 9 5

6.3 5.9 8 6

6.7 6.9 7 7

7.2 7.8 6 8

7.8 8.8 5 9

8.4 9.8 4 10

9.1 10.7 3 11

9.9 11.6 2 12

10.6 12.5 1 13

11.4 13.4 0 14

12.3 14.3 –1 15

13.1 15.1 –2 16

14.0 16.0 –3 17

15.0 16.7 –4 18

15.9 17.4 –5 19

16.8 18.1 –6 20

* = Default: Recommended setting as shipped from the factory. Do no use these settings for Rx
Expansion cabinets.

RMC System Gain
In addition to the DIP switch settings for the Receive Multicoupler (RMC) attenuation, the RMC system
gain must be set up according to your GTR 8000 Base Radio configuration.

NOTICE: System gain is used to calculate RSSI (Receiver Signal Strength Indicator) value and
Illegal Carrier Detection. When system gain is properly configured, the RSSI value read by the
station (displayed in CSS) corresponds to the RF level at the input of the multicoupler system.
System gain is automatically calculated when you select GTR 8000 Expandable Site
Subsystem as your configuration.

Table 112: RMC System Gain for GTR 8000 Expandable Site Subsystem Configurations on page 284
shows what to select on the RMC Configuration tab in Figure 131: CSS RMC Configuration Tab with
GTR 8000 Expandable Site Subsystem Selected on page 285. It also displays the resulting values
that CSS displays in the System Gain field and include in the RMC configuration settings.

Table 112: RMC System Gain for GTR 8000 Expandable Site Subsystem Configurations

Your Configura-
tion Receive Multicoupler (RMC) Configuration Tab Resulting

System Gain

Expandable Site
Subsystem with
Site RMCs

1 GTR 8000 Configuration field: Select GTR 8000 Expanda-
ble Site Subsystem

2 Site RMC Configuration field: select: Installed

12 dB

Table continued…
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Your Configura-
tion Receive Multicoupler (RMC) Configuration Tab Resulting

System Gain

Expandable Site
Subsystem with
no Site RMCs

1 GTR 8000 Configuration field: Select GTR 8000 Expanda-
ble Site Subsystem

2 Site RMC Configuration field: Select Not Installed

11 dB

Figure 131: CSS RMC Configuration Tab with GTR 8000 Expandable Site Subsystem Selected

Setting RMC System Gain
Prerequisites: If you do not know the IP address for the device, it is available through a serial port
connection in the Tools → Set IP Address menu.

Procedure:
1 Connect to the device using Configuration/Service Software (CSS) through an Ethernet port link.

See Connecting Through an Ethernet Port Link on page 262.

2 From the navigation tree in the left pane, select Configuration.

3 Select the Receive Multicoupler (RMC) Configuration tab in the right pane.

4 Select your configuration, using the fields indicated in Table 112: RMC System Gain for GTR
8000 Expandable Site Subsystem Configurations on page 284. Enter the Site RMC
Configuration, Site RMC Attenuation, and Cabinet RMC Configuration.

System gain is automatically calculated and displayed in the System Gain field.

5 From the menu, select File → Save or File → Save As to save your RMC configuration to an
archive on your local or network drive.

6 From the menu, select File → Write Configuration to Device to upload to the device.

The RMCs automatically use the resulting system gain. In addition, an appropriate base radio
attenuation is automatically calculated, saved in the configuration file, and used.
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Inline Attenuator Value for a GTR 8000 Expandable Site Subsystem
with a TTA for UHF R2 and 700/800/900 MHz

NOTICE: For calculating the Inline attenuator value for a GTR 8000 Expandable Site
Subsystem with a TTA for TDMA operation, see the Dynamic Dual Mode for TDMA Operation
manual.

Table 113: RMC Attenuator Settings

Site Type Single Cabinet Site Multiple Cabinet Site

RMC Option CA00861AA CA00862AA, CA00877AA, or CA01821AA

Site RMC Attenuator None 8 dB

Cabinet RMC Attenuator Set-
ting

7 dB 13 dB

Calculating Inline Attenuator When a TTA is Installed
Prerequisites:
The Rx antenna must be disconnected from all base radios when performing this procedure. This
procedure drops All calls present on the site.

When and where to use: This procedure is used to calculate the inline attenuator value only in the
case where a customer-supplied Tower Top Amplifier (TTA) is used. This procedure optimizes the
receive gain of all the base radios in a cabinet/rack and in any expansion cabinets/racks as well. There
is no need to check or test each base radio. If you do not know the IP address for the device, it is
available through a serial port connection in the Tools → Set IP Address menu.

Procedure:
1 Connect to the device using Configuration/Service Software (CSS) through an Ethernet port link.

See Connecting Through an Ethernet Port Link on page 262.

2 From the navigation tree in the left panel, select Configuration.

3 Select the Receive Multicoupler (RMC) Configuration tab.

4 In the GTR 8000 Configuration field, select GTR 8000 Expandable Site Subsystem.

5 Set the DIP switches on the Site RMC/LNA modules and Cabinet RMC/LNA modules to match
the dB values that result from your calculations as described in Table 113: RMC Attenuator
Settings on page 286. Verify that the GTR 8000 Base Radio Configuration and Site RMC
Configuration settings are correct.

6 Connect the analyzer cable from the service monitor to the test cable of the Tower Top
Amplifier.

7 Remove and label the cable from the Branch 1 input at the top of the cabinet (this cable comes
from the TTA control unit). Connect this cable to the service monitor port.

8 Set up the service monitor to generate a V.52 test modulation at a frequency to equal the base
radio frequency and an output level of about –40 dBm. Increase this level by the TTA test port
loss and test cable loss.

9 Adjust the electronic attenuator in the TTA control unit until the level indicates -30 dBm on the
service monitor.

NOTICE: This procedure provides 10 dB gain from the TTA input to the cabinet input.

10 Disconnect the cable from the analyzer.
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11 Reconnect the cable to the branch 1 input at the top of the cabinet.

12 For HPD or TDMA only, repeat for Rx Branch 2, starting at step 5, to apply the same attenuator
adjustments to Rx Branch 2.

Configuring Centralized Authentication on Devices in
VoyenceControl

When and where to use: This process provides the procedures for configuring centralized
authentication on devices using the VoyenceControl component of the Unified Network Configurator
(UNC) application.

NOTICE: VoyenceControl does not apply for a K core or non-networked site.

Process:
1 Configure Domain Name Service (DNS) on the device. See “Configuring DNS on RF Site and

VPM Devices in VoyenceControl” in the Authentication Services manual.

2 Configure Authentication Sources for the device. See “Configuring Authentication Sources for
RF Site and VPM Devices in VoyenceControl in the Authentication Services manual.

3 Configure RADIUS parameters for the device. See “Configuring Radius Parameters for RF Site
and VPM Devices in VoyenceControl” in the Authentication Services manual.

4 Set the Local Cache Size for Centralized Authentication for the device. See “Setting the Local
Cache Size for Central Authentication on RF Site and VPM Devices in VoyenceControl” in the
Authentication Services manual.

5 Enable/Disable Centralized Authentication for the device. See “Enabling/Disabling Centralized
Authentication on RF Site and VPM Devices in VoyenceControl” in the Authentication Services
manual.

6 Enable/Disable Centralized Event Logging for the device. See “Enabling/Disabling Centralized
Event Logging on RF Site Devices and VPMs in VoyenceControl” in the Centralized Event
Logging manual.

1PPS Reference Synchronization
The GPB 8000 Reference Distribution Module (RDM) reports when the available 1PPS references are
out of synchronization. This synchronization validates that all redundant 1PPS signals can be used for
fallback operation. This condition could occur for, example, if there is a failure with one of the GPS
units or if the delay offset applied for the GPS unit cable length is incorrect.

GPS Unit Cable Length Delay Offset Calibration
Due to varying cable lengths between the GPS unit and the RDM, an offset value must be entered to
compensate for the cable delay added to the 1PPS time reference signal.

The GPS unit supports the ability to advance the 1PPS timing reference to compensate for the delay
associated with the cable length. This procedure is done using CSS or UNC to allow for the most
accurate time across sites irrespective of the cable lengths used so as not to impact simulcast
operation. The procedure is typically performed in the following scenarios:

• Installation and configuration of a high availability site.

• Replacement of an RDM.

• Replacement of a GPS unit.
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• Replacement of the cable connecting the GPS unit to the RDM.

If the offset calibration is not performed, the accuracy of time reference is impacted, which causes
simulcast operation to be non-functional.

NOTICE: Maximum GPS unit cable length should not exceed 350 ft. If cable length is between
350 and 800 ft, contact the Motorola Solution Support Center (SSC).

Use Table 114: GPS Cable Length Delay Offset Value on page 288 to determine the delay offset
value for calibration depending on the cable length. The cable is marked every ft, which enables
measuring to be done easily.

Table 114: GPS Cable Length Delay Offset Value

Cable Length Provisioned Delay
(ns)

0 to 12 ft. 119

13 to 37 ft. 168

38 to 62 ft. 232

63 to 87 ft. 297

88 to 112 ft. 362

113 to 137 ft. 426

138 to 162 ft. 476

163 to 187 ft. 526

188 to 212 ft. 576

213 to 237 ft. 626

238 to 262 ft. 676

263 to 287 ft. 726

288 to 312 ft. 775

313 to 337 ft. 825

338 to 350 ft. 863

NOTICE: The table values specified are valid only for the cables supported by Motorola as
specified in the Trunked IP Simulcast Subsystem Remote Site manual. If the installation
requires use of another vendor or gauge of cable, contact Motorola for assistance.

Setting the GPS Unit Cable Length Delay Offset Calibration in the CSS
When and where to use:
Use this procedure to configure the cable length delay offset between the GPB 8000 Reference
Distribution Module (RDM) and the GPS unit for cable lengths less than 350 ft using CSS.

Procedure:
1 Perform the following verification steps:

a The GPS unit is connected to the backplane with the appropriate cable length (less than 350
ft).

b Latest CSS version is installed on the service computer.
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2 Connect to the RDM using Configuration/Service Software (CSS) through an Ethernet port link.
See Connecting Through an Ethernet Port Link on page 262.

3 NOTICE: If the GPS unit has not been calibrated, a GPS Major Failed (Cause Code:
Cable Delay Uncalibrated) Alarm is reported.

From the menu, select Service → Status Report Screen.

The Status Report Screen window appears and the GPS Major Failed (Cause Code: Cable
Delay Uncalibrated) station log is displayed.

4 Enter the cable length delay offset value:

a From the menu, select Service → GPS Information.

a Verify that the GPS is tracking at least four satellites.

b Enter the offset value in the GPS Receiver Cable Delay Offset. See Table 114: GPS Cable
Length Delay Offset Value on page 288.

c Click Set Value.

The GPS Information window appears.

5 Calibrate the RDMs as follows:

a From the menu, select Service → Status Report Screen.

b Wait a few minutes for calibration to complete.

When calibration is successful, the Status Report Screen displays the GPS Enabled station
logs.

NOTICE: If calibration was unsuccessful, the GPS Major Failed station log remains and
the GPS is not enabled. Use the Status Report Screen to source the cause of failure.
Depending on the entered cable delay, the RDM can take up to 10 minutes to output a
1PPS reference that can be used for simulcast.

6 Perform steps 2 through 5 for the other RDM.

7 Validate that both RDMs in the Reference Service Screen are within 250 nsec of each other. If
not, verify the position information (latitude, longitude, and elevation) reported by the GPS units
on both RDMs.

Setting the GPS Unit Cable Length Delay Offset Calibration in the UNC
When and where to use:
Use this procedure to configure the cable length delay offset between the GPB 8000 Reference
Distribution Module (RDM) and the GPS unit for cable lengths less than 350 ft using UNC.

Procedure:
1 Perform the following verification steps:

a The GPS unit is connected to the backplane with the appropriate cable length (less than 350
ft).

b The RDM has already been discovered from the UNC.

c UNC version A7.9 or higher is being used.

2 Log on to the UNC from the NM client, by double-clicking the Internet Explorer icon on the
desktop.

The Internet Explorer browser opens.

3 Enter: http://ucs-unc0<Y>.usc
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where <Y> is the number of the UNC server (01 for primary core UNC server, and 02 for backup
core UNC server).

The UNC client launches and then a login dialog box appears.

4 Type the administrative user name and password. Click OK.

VoyenceControl launches.

5 Expand ASTRO 25 Radio Network in the tree view.

6 Expand Sites in the tree view.

7 Expand Zone in the tree view containing the RDMs for calibration.

8 Double-click Site containing the RDMs for calibration.

9 Calibrate the RDMs as follows:

a Right-click the RDM and select Editor, then Configlet.
The Configlet Editor for the RDM appears.

b Under Common Configlet, enter:GPS 1PPS Cable Delay Offset (ns) = xyz
where xyz is the cable delay in nanoseconds corresponding to the cable length in Table 114:
GPS Cable Length Delay Offset Value on page 288.

c Click Schedule.

The Schedule window appears.

d Type the name of the job. Click Approve and Submit.
The job is approved and submitted.

e Open the job that was submitted and verify that the job was successful.

f Repeat substeps a through e for the other RDM in the site.
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Chapter 5

GTR 8000 Expandable Site Subsystem
Optimization
This chapter contains optimization procedures and recommended settings relating to the GTR 8000
Expandable Site Subsystem.

Your Motorola Field Representative or Motorola Solution Support Center (SSC) can advise you on
optimization activities required for your system, if any. For example, for GTR 8000 Expandable Site
Subsystems, obtain advice on whether a customized cavity combiner tuning procedure is required for
optimizing RF Distribution System (RFDS) performance. See Motorola Solution Support Center on
page 344.

GCP 8000 Site Controller Reference Oscillator Alignment
NOTICE: This alignment is for both active and standby site controllers at a repeater site only.

After an active or standby site controller is installed, the reference oscillator must be aligned.

NOTICE: The base radios must be turned on for at least one week before the reference
oscillator is aligned.

The site controller reference oscillator must be aligned to within 1 ppb (parts per billion). The frequency
reference used to make this alignment should be accurate to within 1 ppb. This accuracy typically
requires test equipment with a double oven or a Rubidium reference oscillator.

The reference oscillator must be aligned:

• Upon installation of the site controller for all bands.

• Once every year after installation for TDMA systems for all bands.

• Once every two years after installation for FDMA, 700/800/900 MHz systems.

• Once every five years after installation for FDMA, UHF systems.

• FDMA, VHF systems do not require alignment after initial installation.

See Site Controller Configuration & Service Help > Site Controller Procedures > Aligning the
Reference Oscillator in the CSS Online Help for the alignment procedures.

Base Radio Internal Frequency Reference Oscillator Alignment
The transceiver option card within a base radio provides an internal 10 MHz frequency reference which
can be used as the primary or backup frequency reference source for the device. For conventional
base radio operation, it also provides the analog interfaces and wildcard I/Os.

After a base radio is installed or after the transceiver option card is replaced, the internal frequency
reference oscillator must be aligned.

The transceiver option card internal frequency reference oscillator must be aligned to within 1 ppb
(parts per billion). The measuring equipment used to make this alignment should be accurate to within
1 ppb. This accuracy typically requires test equipment with a double oven or a Rubidium reference
oscillator.
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NOTICE: The base radio must be turned on for at least one week before the internal frequency
reference oscillator is aligned.

The internal frequency reference oscillator for an OCXO transceiver option card must be aligned:

• Upon installation of the base radio for all bands.

• Once every two years after installation for 700/800/900 MHz systems.

• Once every five years after installation for UHF systems.

• VHF systems do not require alignment after initial installation.

The internal frequency reference oscillator for a TCXO transceiver option card must be aligned:

• Upon installation of the base radio for UHF.

• Every year after installation for UHF.

The internal frequency reference oscillator can be aligned using two methods: manual alignment or
auto alignment.

See Base Radio Service Help > Service Screens > Alignment Screens in the CSS Online Help for the
alignment procedures.

GTR 8000 Base Radio Time and Frequency Inputs
Various external time and frequency inputs can be provided to the base radio for normal operation or
for Internal Frequency Reference Oscillator alignment. The following table provides a list of acceptable
input signal types and levels for each input port.

Table 115: Time and Frequency Inputs

Input Port Frequency Waveform Level Impe-
dance Note

Ext Freq Ref 5 MHz Sine 2.6–5.3 Vpp 100k ohms AC coupled

Ext Freq Ref 5 MHz Square 45–55% duty cycle 100k ohms AC coupled

Ext Freq Ref 10 MHz Sine 2.6–5.3 Vpp 100k ohms AC coupled

Ext Freq Ref 10 MHz Square 45-55% duty cycle 100k ohms AC coupled

Ext Freq Ref 20 MHz Sine 2.6–5.3 Vpp 100k ohms AC coupled

Ext Freq Ref 20 MHz Square 45–55% duty cycle 100k ohms AC coupled

Ext Freq Ref 5 MHz/
1PPS*

Square 2.6–5.3 Vpp 100k ohms AC coupled;
25% modula-
tion 1pps ar-
rives on 75%
duty cycle

1PPS 1PPS Pulse 2.6–5.3 Vpp 100k ohms DC coupled

Front Panel
Ext Freq Ref

5 MHz Sine 2–5 Vpp; 10–18
dBm

50 ohms AC coupled

Front Panel
Ext Freq Ref

5 MHz Square 45–55% duty cycle 50 ohms AC coupled

Front Panel
Ext Freq Ref

10 MHz Sine 2–5 Vpp; 10–18
dBm

50 ohms AC coupled

Table continued…

6871022P87-C
Chapter 5:  GTR 8000 Expandable Site Subsystem Optimization

292  Send Feedback

http://docsurvey.motorolasolutions.com


Input Port Frequency Waveform Level Impe-
dance Note

Front Panel
Ext Freq Ref

10 MHz Square 45–55% duty cycle 50 ohms AC coupled

Front Panel
Ext Freq Ref

5 MHz/
1PPS*

Square 2.6–5.3 Vpp 50 ohms AC coupled;
25% modula-
tion 1pps ar-
rives on 75%
duty cycle

* 25% modulation, 1PPS arrives on 75% duty cycle.

NOTICE: The Front Panel EXT FREQ REF connection is the Frequency Calibrator (BNC
connector) on the transceiver module.

Cavity Combiner Tuning
Figure 132: GTR 8000 Expandable Site Subsystem Cavity Combiner for 700/800 MHz on page 293
and Figure 133: GTR 8000 Expandable Site Subsystem Cavity Combiner for UHF on page 294 show
the GTR 8000 Expandable Site Subsystem cavity combiners for 700/800 MHz and UHF (450–509
MHz), with arrows to assist you in following Tuning the Cavity Combiner For Six Carriers on page 294
and Cavity Combiner Tuning for Twelve Carriers (700/800 MHz) on page 300 to tune the combiner.
The RF input cable, built in circulator, and tuning knob have been identified for one of the six cavities.

Figure 132: GTR 8000 Expandable Site Subsystem Cavity Combiner for 700/800 MHz
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Figure 133: GTR 8000 Expandable Site Subsystem Cavity Combiner for UHF

WARNING: Shock hazard. The GTR 8000 Expandable Site Subsystem contains dangerous
voltages, which can cause electrical shock or damage to equipment. Set the switches on the
front of the power supplies to the off (O) position when servicing this component in the
Expandable Site Subsystem. Also, shut down any other racks that are connected to this GTR
8000 Expandable Subsystem.

IMPORTANT: Powering down the GTR 8000 Expandable Site Subsystem causes any affiliated
subscribers to relocate to another channel at the site or another channel at an adjacent site.
Place the channels in Service Mode before starting the tuning procedure, so that the system
does not attribute the loss of channel to a failure. Placing a channel in Service Mode is
performed using Unified Event Manager (UEM) Diagnostics or the Configuration/Service
Software (CSS).

Tuning the Cavity Combiner For Six Carriers on page 294 summarizes tuning for both 700/800 MHz
and UHF cavity combiners. Cavity Combiner Tuning for Twelve Carriers (700/800 MHz) on page 300
summarizes tuning for only 700/800 MHz cavity combiners. In either frequency sub-band, the tuning
procedure is the same regardless of carrier sequence. In a twelve carrier application, each six channel
combiner is tuned first, followed by the phasing harness installation, then retuning of both combiners to
meet twelve carrier performance.

NOTICE: In all applications, initially tune the combiner to the intended operating frequency by
use of a network analyzer, looking at a composite Output Return Loss (ORL) response curve as
described in Tuning the Cavity Combiner For Six Carriers on page 294. Afterwards, fine-tuning
of the combiner can be performed by keying the base radios, one at a time, and maximizing the
output power for that carrier by use of an externally connected power meter. Tuning should be
accomplished first at low-power levels, approximately –10 dB to –6 dB followed by rated power.

Tuning the Cavity Combiner For Six Carriers
When and where to use: Use this procedure to tune up to six carriers for either the 700/800 MHz
cavity combiner or the UHF cavity combiner. This procedure is also the basis when tuning a 7-12
carrier application for 700/800 MHz. See Changing Frequencies, Adding Channels, and Realigning a
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700/800 MHz and UHF Cavity Combiner on page 299 to change frequencies, add channels, and
realign either the 700/800 MHz or UHF cavity combiner.

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

3 NOTICE: Powering down the GTR 8000 Expandable Site Subsystem causes any
affiliated subscribers to relocate to another channel at an adjacent site. Disable the site
before powering down, so the system does not attribute the loss of channel to a failure.

To disable the site, perform one of the following actions:

If… Then…

The site controllers
are in the cabinet/
rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.

The site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be dis-
abled and choose User Ignore.

The site is disabled.

4 Set all the switches on the front of the power supplies to the Off (O) position to power down the
entire GTR 8000 Expandable Site Subsystem. Allow the combiner to cool for 15 minutes. Also
shut down any other expansion cabinets/racks that are connected to the GTR 8000 Expandable
Site Subsystem.

5 After the combiner has cooled for at least 15 minutes, disconnect and label the cabling from the
front of the combiner:

a Remove the 7/16-inch DIN output cable.

b Label and remove the QN-type RF input connectors.

IMPORTANT: Label the cavities and their associated RF input cables Ch1 through Ch6.
You must know these numbers for the tuning procedure, and for reconnecting the cables.

6 Set up a Network Analyzer (HP/Agilent 8753B or equivalent) in the S11 (reflection) mode to
cover a few hundred kHz below and above the carrier frequency range of the combiner by
performing the following:

a Set number of points to 801.

b Set IF bandwidth to 3 kHz.

c Place a Network Analyzer marker at the desired carrier center frequency for each resonator
being tuned.

d Store calibration in a register.
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NOTICE: It is not a requirement that the electrical delay is known for the type of
connector and adaptors used during calibration; only mag|S11| is used for combiner
tuning.

7 Connect the Network Analyzer to the 7/16 DIN output port.

Figure 134: Cavity Combiner Tuning - Equipment Setup for 700/800 MHz and UHF

8 Starting with combiner channel 1, loosen the locking knob. Holding the locking knob with one
hand, use the other hand to tune channel 1 to the assigned carrier frequency; clockwise to
decrease center frequency, counter clockwise to increase center frequency.

9 With channel 1 tuned and the Network Analyzer marker at an S11 minimum, lightly tighten the
locking knob while continuing to hold the tuning knob.

NOTICE: The tuning knob is adjusted at least once more.

10 Repeat step 7 and step 9 for all remaining combiner channels. A typical ORL response curve
may look like Figure 135: Six-Carrier ORL Response Curve — Untuned on page 297. Note that
channels 5 and 6 ORL are much less than channels 1 and 2. Balanced is compensated for in 
step 12. Closely spaced carriers may require repeating step 7 and step 9 for some channels.
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Figure 135: Six-Carrier ORL Response Curve — Untuned

11 Any unused combiner channel should be tuned to a frequency at least a few hundred kHz away
from any active carrier frequency assigned to a common transmit antenna. However, if an
unused channel carrier frequency is known at this time, this channel can be tuned to that
frequency even though a base radio is not present. This tuning simplifies the process of adding
new carriers at a later date. Any unused channel’s locking knob can be securely tightened at this
time.

12 Balance the ORL response by adjusting the combining manifold knobs. The knows are labeled,
“90º rotation only”. These knobs loosen and tighten the same way as the resonator tuning
knobs.

CAUTION: The combining manifold tuning knobs rotate less than a quarter turn, so be
careful in turning these knobs. Attempting to turn past the mechanical stop can damage
the combining manifold.

13 Observing ORL response for all channels, adjust both combining manifold knobs until the ORL
response curve reaches similar local minimum on all channels as best possible. See Figure 136:
Six-Carrier ORL Response Curve — Tuned on page 297 and Figure 137: Six-Carrier ORL
Response Curve — Tuned and Balanced on page 298. It is desired that all channels achieve a |
dB(S11)| at least 13 dB (a goal, not a requirement). Final adjustment is made under power.

NOTICE: One or more channel center frequency may have changed tuning the manifold.
This center frequency is normal and is compensated in step 14.

Figure 136: Six-Carrier ORL Response Curve — Tuned

6871022P87-C
Chapter 5:  GTR 8000 Expandable Site Subsystem Optimization

Send Feedback   297

http://docsurvey.motorolasolutions.com


Figure 137: Six-Carrier ORL Response Curve — Tuned and Balanced

14 After step 13 it may become necessary to re-adjust one or more channel’s center frequency, as
described in step 7 and step 9. Adjust the appropriate channels so the local minimum is at or
very close to the channel’s marker.

15 After tuning is completed, lightly re-tighten all locking knobs. The combiner is ready for final
adjustment.

16 Reconnect the cabling to the front of the combiner:

a Reconnect the QN-type RF input connectors to the appropriate ports.

b Secure the 7/16-inch RF output cable to the output connector.

c Connect an external wattmeter to the antenna port. The output of the wattmeter should be
terminated with the transmit antenna or an appropriate load.

17 Set the rocker switches on the front of the power supplies to the On (I) position, to power up the
GTR 8000 Expandable Site Subsystem. Also restore power to any other expansion cabinets/
racks that are connected to the GTR 8000 Expandable Site Subsystem.

18 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using fault
management software, including Unified Event Manager, and the Transmitter Metering Screen
in Configuration/Service Software (CSS).

19 Key up each base radio, one at a time, at a low-power level (approximately –10 dB to –6 dB of
rated). The wattmeter should use averaging.

20 Adjust the appropriate combiner’s tuning knob until the power meter registers a maximum.
Lightly secure the locking knob.

21 Go to the next channel until all carriers have been re-adjusted.

22 At this time, it is not essential that the combining manifold knobs be re-adjusted. However, if you
choose to do so, re-apply the same low-power level to all the base radios simultaneously and
adjust the tuning knobs accordingly. These locking knobs can be secured in their final position
once this step is completed.

CAUTION: Be careful during this step, as adjusting the manifold can create an
imbalance between two or more carriers. Since a Network Analyzer is not connected
during this test, it cannot be determined which channel or channels are being adversely
affected.

23 Repeat step 20 at rated power; to all channels simultaneously. Allow system to reach equilibrium
and re-adjust individual tuning knobs to maximize antenna power. Properly secure locking knobs
after tuning is completed.
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24 De-key all radios, remove the wattmeter, and reconnect the antenna.

25 To enable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

Changing Frequencies, Adding Channels, and Realigning a 700/800 MHz
and UHF Cavity Combiner

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Place the base radio corresponding to the cavity being tuned in Service Mode, as follows:

a Connect to the base radio using Configuration/Service Software (CSS) through an Ethernet
port link. See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

3 Open the connections between the circulator load port and the circulator load. A sampling port
adaptor may or may not be used. The sampling port adaptor is available through Motorola
Solution Support Center (SSC). Perform one of the following actions:

If… Then…

If a sampling port
adaptor Is being
used,

perform the following actions:

a Insert the sampling port between the circulator load port and the circu-
lator load.

b Connect the output of the coupler to a power meter or a service moni-
tor. The sampling port adaptor is a 30-40 dB coupler. An attenuator
may be required on the coupled port to protect measurement equip-
ment from excessive power.
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If… Then…

If a sampling port
adaptor is Not be-
ing used,

perform the following actions:

a Connect the output of the circulator load port to a power meter or a
service monitor.

b An attenuator may be required on the coupled port to protect measure-
ment equipment from excessive power.

4 Re-key the radio at –10 dB to –6 dB of rated power.

5 IMPORTANT: If it is necessary to pass over a carrier frequency already in operation, that
carrier will be momentarily affected. It is recommended to temporarily de-key that carrier.
If this is not practical, realize there would be a few dB temporary reduction in power of
the carrier already in operation.

Tune the cavity for minimum power at the desired frequency.

6 Adjust the radio for full rated out power, key-up, and after five minutes re-tune the cavity for
minimum power.

7 De-key the radio and remove test equipment, and reconnect circulator load.

8 Repeat step 2 through step 7 for any additional channels that need to be re-tuned.

9 If no further testing is needed, place the base radio in Normal Mode, as follows:

a From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

b Click Change to Normal Mode.

c At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

Cavity Combiner Tuning for Twelve Carriers (700/800 MHz)
Transmit expansion to 7-12 carriers requires use of a phasing harness (see Figure 138: Phasing
Harness on page 300). In each case, a phasing harness consists of a combining “T” mounting bracket
and two cables. One cable is labeled “primary”; the other is labeled “expansion.” The 700 MHz phasing
harness must be used with the 700 MHz cavity combiner and likewise with 800 MHz.

Figure 138: Phasing Harness

Figure 139: Phasing Harness on page 301 shows the use of a phasing harness in 7-12 carrier
applications. The transmit expansion cabinet is allowed to be placed on either side of the primary
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cabinet as long as cabinets are placed immediately next to one another (one inch or less) and the
combiners are at about the same height.

Figure 139: Phasing Harness

NOTICE: The 700 MHz phasing harness must be used with a 700 MHz cavity combiner and
likewise with 800 MHz.

The phasing harness arrives from the supplier with the “T” attached to the mounting bracket and cables
detached. The mounting bracket arrives with four captive screws. These screws are used to secure the
mounting bracket to the cavity combiner’s mounting handles using a Torx driver, size T20, at a torque
of about 12-15 in.-lbs. The phasing harness is always mounted to the combiner in the same rack/
cabinet as the transmit antenna connection, commonly known as the transmit primary cabinet. The
phasing harness output connects to the transmit filter. This is the same cable used to connect the
combiner directly to the transmit filter in six-carrier (non-transmit expansion) applications.

Tuning the Cavity Combiner for up to Twelve Carriers for 700/800 MHz

Procedure:
1 Follow step 7 through step 11 of Tuning the Cavity Combiner For Six Carriers on page 294 for

the primary and expansion cabinet/rack cavity combiners. If the carrier frequencies are spaced
in such a manner that a portion of the sub-band has a group of carriers, for instance 852-856
MHz, while another portion of the sub-band has a second group of carriers say, 864-867 MHz,
calibrate the Network Analyzer for each separate group of frequencies and store each
calibration in a different register. Figure 135: Six-Carrier ORL Response Curve — Untuned on
page 297 applies for this procedure in the same manner it did for Tuning the Cavity Combiner
For Six Carriers on page 294.

2 Connect the appropriate phasing harness to the combiners. See Figure 139: Phasing Harness
on page 301 and Figure 132: GTR 8000 Expandable Site Subsystem Cavity Combiner for
700/800 MHz on page 293. Attach the Network Analyzer to the phasing harness output. An
example of a twelve carrier response is shown in Figure 140: Twelve-Carrier ORL Response
Curve — Untuned on page 302.
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Figure 140: Twelve-Carrier ORL Response Curve — Untuned

3 Repeat step 12 through step 14 of Tuning the Cavity Combiner For Six Carriers on page 294 for
the twelve carrier setup. Balancing ORL requires adjustment of the manifold tuning knobs on
each combiner a few times, alternating back and forth between combiners ( See Figure 141:
Twelve-Carrier ORL Response Curve — Tuned on page 302 and Figure 142: Twelve-Carrier
ORL Response Curve — Tuned and Balanced on page 303). Note in Figure 141: Twelve-
Carrier ORL Response Curve — Tuned on page 302 how manifold adjustment can appear to
make one carrier disappear (middle of plot). This also occurs when tuning one resonator through
and past another.

Figure 141: Twelve-Carrier ORL Response Curve — Tuned
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Figure 142: Twelve-Carrier ORL Response Curve — Tuned and Balanced

4 Repeat step 19 through step 25 of Tuning the Cavity Combiner For Six Carriers on page 294 for
the phase-harnessed setup.

CAUTION: Care should be exercised during these steps; dealing with high-power levels.
Twelve base radios at rated power results in approximately 600 W average output power
and approximately 25k W Peak Envelope Power (PEP) at the antenna port.

Battery Equalization
Battery Equalization configures the power supply to set the proper charge and capacity for the storage
batteries connected to the base radio. Sites equipped with storage batteries that provide power in case
of primary power failure require that the battery cells be equalized periodically.

See “Base Radio Service Help → Service Screens → Alignment Screens” in the CSS Online Help
for the alignment procedures.

NOTICE: Some batteries do not require equalization. See the battery manufacturer
recommendations.

ASTRO Simulcast Alignment (Trunked Operation)

ASTRO® 25 Simulcast Alignment is used to enter a Launch Time Offset value (range 0.0 to 1000.0
usec), store the value in the base radio, and initiate a simulcast test pattern.

See “Base Radio Service Help → Service Screens → Alignment Screens” in the CSS Online Help for
the alignment procedures.

ASTRO/Analog Simulcast Alignment (Conventional Operation)

In an ASTRO® 25 simulcast subsystem, all station transmitters are synchronized to a 1 pulse per
second (1PPS) signal from a Global Positioning Satellite (GPS) receiver. The 1PPS signal provides a
common time reference for each of the transmitters. The ASTRO® 25 signaling information arriving at
the station transmitter includes timestamps that specify the transmit offset delay for the voice and data
transmissions.

The ASTRO®/Analog Alignment screen allows adjustment of the overlap coverage areas, and to
specify a launch time offset value, with a 0.1 μs resolution. This value is added to the arriving launch
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time value to provide an adjusted launch time. The specified ASTRO® 25 simulcast transmit offset
delay value applies only to ASTRO® 25 simulcast subsystems and is considered optional. The default
offset value is 0 (zero), causing no adjustment to the launch time specified by the arriving timestamp
value.

For Analog Simulcast, the Transmit Offset Delay merely delays the Analog Simulcast Audio to provide
the adjustment in the overlap coverage areas.

See “Base Radio Service Help → Service Screens → Alignment Screens” in the CSS Online Help
for the alignment procedures.

Carrier Squelch Alignment
A Carrier Squelch (CSQ) Alignment is typically performed at an RF level which corresponds to 12 dB
SINAD, or an RF level which corresponds to 20 dB quieting, or any other RF level selected.

The CSQ Alignment screen facilitates the measurement of 12 dB SINAD for the base radio under
testing by allowing the Rx Qualifiers to be set to Open. When the Rx Qualifiers are set to Open, receive
audio is gated to the WL2 wireline port or to the speaker, regardless of the RF input level. The
preferred SINAD measurement port is the WL2 wireline port; however, the speaker can also be used.

When measuring SINAD, the pre-emphasis and high pass filters are set as they would be for analog
voice operation. Because the channel characteristics are different, this procedure allows for CSQ
Alignment and is done for both 12.5 kHz and 25 kHz channel bandwidth. If the station is configured for
only one channel bandwidth, there is no need to perform a CSQ Alignment for the other bandwidth.

See “Base Radio Service Help → Service Screens → Alignment Screens” in the CSS Online Help
for the alignment procedures.

Tx Wireline Alignment 

Tx Wireline Alignment is used to set the levels to result in 60% system deviation for both Wireline Level
Line 1(WL1) and Wireline Level Line 3 (WL3) and for setting the Wireline Squelch levels.

See “Base Radio Service Help → Service Screens → Alignment Screens” in the CSS Online Help
for the alignment procedures.

Rx Wireline Alignment
Rx Wireline Alignment is used only for a base radio that processes analog receive audio and is
connected with a 2- or 4-wire link to a console or a comparator in an analog only topology or an
ASTRO® 25 Analog/Mixed mode topology.

See “Base Radio Service Help → Service Screens → Alignment Screens” in the CSS Online Help
for the alignment procedures.

GTR 8000 Expandable Site Subsystem Performance Testing
with a Service Monitor for Integrated Voice and Data
The service monitor is a diagnostic tool used with a GTR 8000 Expandable Site Subsystem or modem
to test and measure the transmitter and receiver characteristics. The Service Monitor generates
signaling and provides diagnostic information for received signaling.

The Service Monitor is connected to a GTR 8000 Expandable Site Subsystem to perform the
diagnostic tests. These tests are designed to determine whether the equipment is operating within
specification. If a GTR 8000 Expandable Site Subsystem fails to meet specification, service may be
required.
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GTR 8000 Expandable Site Subsystem Performance
Perform these procedures when you first set up your system and afterwards on a regular basis (for
additional tests, see the service monitor manual). While these procedures are not truly configuration or
optimization tasks, they are provided because you may need to perform some of these procedures to
test if the radio performance is correct.

The following procedures are:

• Deviation Standards (Digital Operation) on page 305

• Monitoring the Power Supply Module on page 305

• Verifying Receiver Performance for FDMA Operation on page 306

• Verifying Receiver Performance (Analog Operation) on page 311

• Checking Receiver Sensitivity (Self-test Method) (IV and D) on page 313

• Monitoring the Transmitter Metering Points on page 314

• Verifying Transmitter Performance (Digital Operation) on page 314

• Verifying Transmitter Performance (Analog Operation) on page 316

Deviation Standards (Digital Operation)

NOTICE: These specifications allow a tolerance of ±10%. However, because the accuracy of
the service monitor is only ±5%, the allowable tolerance in the measured deviation is ±5% and
not ±10%.

Table 116: Deviation Standards for ASTRO 25 System Test Patterns

Signal Minimum Devia-
tion Nominal Deviation Maximum Devia-

tion

low signal deviation 0.84 kHz 0.93 kHz 1.02 kHz

sow signal wide pulse deviation undetermined 1.00 kHz undetermined

standard deviation 2.55 kHz 2.83 kHz 3.11 kHz

standard wide pulse deviation undetermined 3.00 kHz undetermined

V.52 deviation 2.91 kHz 3.23 kHz 3.55 kHz

V.52 wide pulse deviation undetermined 3.00 kHz undetermined

C4FM deviation 2.91 kHz 3.23 kHz 3.55 kHz

C4FM wide pulse deviation undetermined 3.00 kHz undetermined

GPS test pattern - simulcast undetermined 3.00 kHz undetermined

ASTRO® 25 system voice 3.24 kHz 3.60 kHz 3.96 kHz

ASTRO® 25 system wide pulse undetermined 3.00 kHz undetermined

Monitoring the Power Supply Module
Perform the following procedure to monitor the power supply.

Procedure:
1 Connect to the base radio in Configuration/Service Software (CSS) through an Ethernet

connection. See Connecting Through an Ethernet Port Link on page 262.

6871022P87-C
Chapter 5:  GTR 8000 Expandable Site Subsystem Optimization

Send Feedback   305

http://docsurvey.motorolasolutions.com


2 From the menu, select Service → Metering Screens.

The Metering Screen window opens on the Power Supply tab.

Figure 143: Metering Screen Window

Verifying Receiver Performance for FDMA Operation

When and where to use: Use this procedure to verify receiver performance by measuring the Bit Error
Rate (BER) and RSSI for the GTR 8000 Expandable Site Subsystem for ASTRO® 25 performance.

Procedure:
1 Connect to the transceiver module in CSS through an Ethernet connection. See Connecting

Through an Ethernet Port Link on page 262.

2 From the menu, select Service → Test Measurement Screen.

The Test And Measurement Screen appears.

3 Select the ASTRO BER RSSI Report tab.

4 Make the following connections to the GTR 8000 Expandable Site Subsystem depending on the
frequency band:

• For 700/800/900 MHz and UHF R2 (435–524 MHz) frequency bands, connect the service
monitor GEN port to the Site Preselector Test Port with a BNC connector. The test port on
the TTA (if present) may also be used.

• For VHF (136–174 MHz) and UHF R1 (380–435 MHz) frequency bands, disconnect the
cable from the Rx Port on the Receiver Input junction panel and connect the service monitor
GEN port to the corresponding Rx Port on the Receiver Input junction panel.

5 Set up the service monitor:

a Set up to generate Project 25 test pattern.

b Set the service analyzer to generate at the receive frequency.

c Set the RF level depending on the frequency band:

• For 700/800/900 MHz and UHF R2 (435–524 MHz) frequency bands, set the RF level to
an initial value of -20 dBm.

• For VHF (136–174 MHz) and UHF R1 (380–435 MHz) frequency bands, set the RF level
to an initial value of -50 dBm.

NOTICE: For 700/800/900 MHz and UHF R2 (435–524 MHz) frequency bands, the
levels are high since the test point coupler loss is +30 dB.
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6 If the base radio is not already in Service Mode, place in Service Mode, as follows:

a Click Change to Service Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

c Re-open the Test And Measurement Screen as described in step 2.

7 Set up the test in CSS:

a From the Pattern Type field, select 1011 Hz (FDMA).
b From the Sampling Period (sec) list box, enter the number of required seconds.

The time specifies the window over which the BER is calculated.

8 Measure the BER and RSSI:

a Click Start BER Measurement.
The Test and Measurement Screen displays the following:

• BER results in percentage

• RSSI results expressed in dBm

NOTICE: With the initial setting of the service monitor set for a carrier level of –20
dBm (>450 MHz) or –50 dBm (<450 MHz), you should expect a BER of 0.0% and an
RSSI level between –48 dBm and –52 dBm. Remember to compensate for the loss of
the cable connecting the service monitor to the base radio.

NOTICE: If the receiver is inhibited, RSSI displays a meaningless value.

b Click Start Log to create a log file for the BER and RSSI measurement.

The Log Save As window appears.

c Change the RF level and read the BER and RSSI again at the level appropriate for the base
radio.

The value should be less than 5%. See GTR 8000 Expandable Site Subsystem
Specifications on page 67 for the appropriate value.

NOTICE: Since the receive antenna and TTA, if installed, is connected during this
measurement, any noise from the antenna can degrade the performance of the
system.

d Key the transmitter in the base radio and readjust the generator output level until 5% BER is
indicated on the service analyzer. Record this level.

Less than 1 dB of degradation should occur due to the transmitters being keyed.

e Dekey the transmitter.

f Click Stop BER Measurement to stop the test.

9 If Rx B is used as a back and the site is not TDMA:

a Disconnect the test cable from the generator to Rx A at the base radio and connect it to Rx
B.

b Increase the generate level to -47 dBm.

c Wait for Branch A to fail. Alarms may be generated during testing.

• This can take up to two (2) minutes.
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• CSS Channel tab Time to Failure (sec) field controls the time to fail.

d Repeat step 8.

10 If no further testing is needed, place the base radio in Normal Mode, as follows:

a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

11 Remove and restore the following connections to the GTR 8000 Expandable Site Subsystem
depending on the frequency band:

• For 700/800/900 MHz and UHF R2 (435–524 MHz) frequency bands, remove the service
monitor GEN port connection from the Site Preselector Test Port or TTA, if present.

• For VHF (136–174 MHz) and UHF R1 (380–435 MHz) frequency bands, remove the service
monitor GEN port from the Rx Port on the Receiver Input junction panel and reconnect the
cable previously removed to the Rx Port on the Receiver Input junction panel.

Verifying Receiver Performance in TTA Operation
This procedure explains how to verify receiver performance in a system where a Tower Top Amplifier
(TTA) is present.

Consult with any documentation that is specific to your system for the value of TTA Reserve Gain. If no
information is available, use the following guidelines:

• For most situations, the TTA Reserve Gain should be in the 5 dB to 10 dB range.

• In the absence of guidance specific to your system, 7.5 dB is a useable value for TTA Reserve
Gain.

NOTICE: This procedure for TTA testing is valid only for FDMA operation. An entirely different
procedure for TTA testing is required for TDMA operation. Contact your system administrator
for guidance, then contact your Motorola Solutions representative for assistance.
The Receive path attenuators must be configured before performing this part of the procedure.
The Rx path to the Rx antenna on the tower must be complete.

When and where to use:
Use this procedure to verify receiver performance in a system where a Tower Top Amplifier (TTA) is
present.

Procedure:
1 Perform test setup:

a Configure the analyzer to generate an STD1011 pattern.

b Connect the Analyzer Gen port (3900) or the RF Generator Out port (S412E) to the TTA Test
Port using a TNC-m (3900) or N-m (S412E) to BNC-m test cable with known loss. Record the
cable loss value on the T tab, Test Cable #4.

c Configure the TTA so that the Antenna port is terminated in a 50 Ω load. If the TTA controller
has a time out feature for the termination, make sure you periodically reset the TTA
termination as needed.

2 Connect to the transceiver module in Configuration/Service Software (CSS) through an Ethernet
connection. See Connecting Through an Ethernet Port Link on page 262.

3 If the base radio is not in service mode perform the following, otherwise go to the next step.

a From the CSS menu, select Service → Test And Measurement Screen.
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b Click Change to Service Mode.

c At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

d Re-open the Test And Measurement Screen.

4 Initiate TTA testing:

a On the Test And Measurement Screen, select the ASTRO BER RSSI Report tab.

b In the Pattern Type field, select Project 25.

c In the Sampling Period (sec) list box, enter 1 for the required seconds.

d Set the Analyzer Generate Frequency equal to the Base Radio Rx Frequency.

5 Test the Rx Noise Level with the TTA terminated:

a Turn the analyzer generator OFF.

b In CSS, click Start RSSI Measurement.
c Record the RSSI Value in the RSSI Level Terminated field of the FDMA Chan sheet.

This Rx Noise Level is a relative value and used for future comparisons.

6 Test the Rx RSSI Test Port Reference Level with the TTA terminated:

a Turn the analyzer generator ON.

b Establish an Analyzer Generate RF Level that produces an RSSI Level of -90.0 dBm.

c Record the Analyzer Generate RF Level in the Gen Level Reference field of the FDMA Chan
sheet.

The sheet calculates the Actual Reference Level.

d In CSS, click Stop RSSI Measurement.
The Actual Reference Level is a relative value used for future comparisons to assist in
troubleshooting.

• This test establishes a known reference that is about 30 dB above the typical noise floor,
which minimizes the contribution of noise to the measurement and is a better indicator of the
gain through the receive system.

• Testing at the sensitivity level is a function of the carrier to noise ratio. Noise has a much
bigger impact when testing at the sensitivity level.

• The goal of this test is to give you the information to determine if you have a gain issue or a
noise issue when troubleshooting a receive problem.

7 Test the Rx Sensitivity with the TTA terminated:

a In CSS, click Start BER Measurement.
b Adjust the Analyzer Generate RF Level for a 5% ± 0.25% BER.

c Record the Analyzer Generate RF Level in the Gen Level Terminated field of the FDMA
Chan sheet.

d In CSS, click Stop BER Measurement.
e Click Start RSSI Measurement.
f Record the RSSI (dBm) value in the RSSI Sensitivity field of the results sheet.

6871022P87-C
Chapter 5:  GTR 8000 Expandable Site Subsystem Optimization

Send Feedback   309

http://docsurvey.motorolasolutions.com


g Click Stop RSSI Measurement.
The Test Result Sheet calculates the Actual Sensitivity Term using Sensitivity Terminated – Test
Cable Loss - TTA Test Port Cable Loss - TTA Test Port Coupling Loss. This result is the
reference used to determine site degradation or de-sense in the following tests.

8 Test Rx De-sense for TTA Normal without other transmitters keyed. The degradation is < 2 dB
@ 700/800/900 MHz, < 6 dB @ 450 MHz, or < 10 dB @ 150 MHz.

CAUTION: This test and the following Rx De-sense TTA Normal with Transmitters Keyed
test cannot be performed accurately if the channel is in use within the coverage area of
the site (for example, a legacy system waiting for cutover).

a Configure the TTA so that the antenna port is connected to the antenna (normal operation).

b In CSS, click Start BER Measurement.
c If needed, readjust the Analyzer Generate RF Level for 5% ± 0.25% BER. Watch the CSS

BER for about 1 minute.

d Record the Analyzer Generate RF Level in the Gen Lvl Desense no Tx field of the result
sheet. The difference between this generator RF level and the level recorded in the Rx
Sensitivity with the TTA Terminated test is the site degradation/de-sense.

NOTICE: If the BER reading is not stable, there is an external interference or a
variable noise floor. Make a note on the Test Result Sheet that Channel X BER went
to Y% while performing this test.

The worksheet calculates the Degradation no Tx value. The degradation should be less than
specified at the beginning of this step.

• If the degradation is higher than recommended, consult with your system administrator to
determine what the impact could have on talk-in coverage.

• The Gen Lvl Desense no Tx level from this test becomes the benchmark for future PM
checks.

9 Test Rx De-sense for TTA Normal with transmitters keyed. The degradation is < 2 dB @
700/800/900 MHz, < 6 dB @ 450 MHz, or < 10 dB @ 150 MHz. This test is optional for
700/800/900 MHz.

CAUTION: This test cannot be performed if the RF channel under test OR any of the RF
channels being keyed up are in use with an operating system in the same coverage area.

a Key up the transmitters at the site.

WARNING: Verify that you have removed the power sensor from the Tx path before
keying up multiple transmitters.

b If needed, readjust the Analyzer Generate RF Level for 5% ± 0.25% BER.

c Record the Analyzer Generate RF Level in the Gen Lvl Desense w/Tx field of the FDMA
Chan sheet.

d De-key the transmitters at the site.

e In CSS, click Stop RSSI Measurement.
The result sheet calculates the Degradation with Tx value. If the degradation is higher than
recommended, consult with the System Engineer to determine what the impact could have on
talk-in coverage.

10 Test the Rx Noise Level with the TTA normal. This test establishes the noise floor of the receive
system:

a Turn the analyzer generator OFF.
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b In CSS, click Start RSSI Measurement.
c Record the CSS RSSI Value in the RSSI Level Antenna field of the FDMA Chan sheet.

d Click Stop RSSI Measurement.
This Rx Noise Level is a relative value.

11 If no further testing is needed, place the base radio into Normal Mode, as follows:

a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

12 Disconnect the Analyzer from the TTA.

Effective Receiver Sensitivity

The result sheet calculates the Effective Sensitivity (ERS) as the maximum of Gen Lvl Desense no Tx
or Gen Lvl Desense w/Tx, – Test Cable #4 loss - TTA Test Port Cable Loss - TTA Test Port Coupling
Loss.

Be sure to discuss this actual value with your system administrator to verify that there are no impacts
to the system talk-in coverage. Channel-to-channel variations should be within ±2 dB.

If this site is utilizing two Rx antennas in a fallback (not diversity) configuration, perform all the steps in 
Verifying Receiver Performance in TTA Operation on page 308 to verify that Rx B is functional. If using
a second TTA, connect to the second TTA test port. Leave the 1st TTA test port disconnected. For a
Dual Diversity TTA, disconnect the A side from the receive distribution system so that no signal is
present at the Rx A connection on the rear of the GTR 8000 Base Radio or the junction panel of the
GTR 8000 Expandable Site Subsystem. Fail Branch A by applying a high-level signal to Branch B and
wait for Branch A to fail.

Create a second Chan Result sheet by copying the original and labeling it Chan x – x Fallback Rx.
Ensure that the ERS for Rx B meets the coverage requirements too.

Verify Receiver Performance for APCO TDMA Operation
See chapter 5 in the Dynamic Dual Mode for TDMA Operation manual for TDMA testing using the
Aeroflex service monitor.

To perform a self-test of the receiver’s sensitivity, see Checking Receiver Sensitivity (Self-test 
Method) (IV and D) on page 313.

Verifying Receiver Performance (Analog Operation)
When and where to use:
Use this procedure to verify receiver performance by measuring the receiver sensitivity (SINAD) for an
analog base radio.

NOTICE: This procedure uses an internal SINAD in the base radio. If a field technician chooses
to use a service monitor as an external SINAD meter, see “SINAD Measurement Procedure
(measured by Service Monitor)” within Base Radio Service Help > Service Screens > Alignment
Screens > Carrier Squelch Alignment Tab in the CSS Online Help.

Procedure:
1 Connect to the transceiver module in CSS through an Ethernet connection. See Connecting

Through an Ethernet Port Link on page 262.
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2 From the menu, select Service → Alignment Screens.

The Alignment Screen appears.

3 If the base radio is not already in service mode perform the follows substeps, otherwise go to 
step 4.

a Click Change to Service Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

c Re-open the Alignment Screen as described in step 2.

4 Select the Carrier Squelch Alignment tab.

5 Make the following connections to the GTR 8000 Expandable Site Subsystem depending on the
frequency band:

• For the 700/800/900 MHz and UHF R2 (435–524 MHz) frequency bands, connect the service
monitor GEN port to the Site Preselector Test Port with a BNC connector. The test port on
the TTA (if present) may also be used.

• For the VHF (136–174 MHz) and UHF R1 (380-435 MHz) frequency bands, disconnect the
cable from the Rx Port on the Receiver Input junction panel and connect the service monitor
GEN port to the corresponding Rx Port on the Receiver Input junction panel.

6 Set up the service monitor.

a For 25 kHz channels, set the modulation to 1 kHz tone at 3 kHz deviation.

b For 12.5 kHz channels, set the modulation to 1 kHz tone at 1.5 kHz deviation.

c Set the service monitor to generate at the receive frequency.

d Set the RF level depending on the frequency band:

• For 700/800/900 MHz and UHF R2 (435–524 MHz) frequency bands, set the RF level to
an initial value of -50 dBm.

• For VHF (136–174 MHz) and UHF R1 (380–435 MHz) frequency bands, set the RF level
to an initial value of -80 dBm.

NOTICE: For 700/800/900 MHz and UHF R2 (435–524 MHz) frequency bands, the
levels are high since the test port coupler loss is +30 dB.

7 In the Carrier Squelch Alignment tab, click 25 kHz to measure 25 kHz channel SINAD. Click
12.5 kHz, to measure 12.5 kHz channel SINAD.

8 Select the SINAD measurement check box.

9 Click Start SINAD Measurement.
The SINAD Measurement Value box displays “wait”, and after 10 seconds starts to display the
SINAD results in dB.

NOTICE: With the initial setting of the service monitor set for a carrier level of –80 dBm,
expect a SINAD of >26 dB. Remember to compensate for the loss of the cable
connecting the service monitor to the base radio. If the receiver is inhibited, SINAD
displays a meaningless value.

10 Change the service monitors RF level and read the SINAD again until the value is 12 dB.
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NOTICE: When the SINAD value is close to 12 dB, wait 10 seconds after changing the
RF signal generator level. The base radio needs 10 seconds to stabilize the SINAD
measurement. Remember to compensate for the loss of the cable connecting the service
monitor to the base radio.

11 Record the signal generator RF level. Compare this value to the sensitivity specifications. See 
GTR 8000 Expandable Site Subsystem Specifications on page 67 for the appropriate value.

a Key the transmitter in the base radio and readjust the generator output level until 5% BER is
indicated on the service analyzer. Record this level.

Less than 1 dB of degradation should occur due to the transmitters being keyed.

b Dekey the transmitter.

12 Click Stop SINAD measurement to stop the measurement.

13 Unselect the SINAD measurement check box.

14 If no further testing is needed, place the base radio in Normal Mode, as follows.

a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

15 Remove and restore the following connections to the GTR 8000 Expandable Site Subsystem
depending on the frequency band:

• For 700/800/900 MHz and UHF R2 (435–524 MHz) frequency bands, remove the service
monitor GEN port connection from the Site Preselector Test Port or TTA, if present.

• For the VHF (136–174 MHz) and UHF R1 (380-435 MHz) frequency bands, remove the
service monitor GEN port from the Rx Port on the Receiver Input junction panel and
reconnect the cable previously removed to the Rx Port on the Receiver Input junction panel.

Checking Receiver Sensitivity (Self-test Method) (IV and D)
When and where to use:
Use this procedure to check the receiver sensitivity for the station without any test equipment. The
receiver uses a factory calibrated low-level noise source at the receiver input to check performance.
This procedure can be performed remotely.

Procedure:
1 Connect to the transceiver module in CSS through an Ethernet connection. See Connecting

Through an Ethernet Port Link on page 262.

2 From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

3 Select the ASTRO BER RSSI Report tab.

4 If the base radio is not already in service mode perform the follows substeps, otherwise go to 
step 5.

a Click Change to Service Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

c Re-open the Test and Measurement Screen as described in step 2.
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5 Select Start Receiver Test.
A confirmation dialog box appears indicating the test progress. After a few seconds, the test
concludes with a pass or fail message.

6 Click OK.

7 If no further testing is needed, place the base radio in Normal Mode, as follows:

a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

Monitoring the Transmitter Metering Points

Procedure:
1 Connect to the transceiver module in Configuration/Service Software (CSS) through an Ethernet

connection. See Connecting Through an Ethernet Port Link on page 262.

2 From the menu, select Service → Metering Screens.

The Metering Screen dialog box appears.

3 Click Transmitter Test to briefly key up the transmitter.

The status bar on the window confirms if the transmitter is operating properly or if it has failed.

4 The Current column displays the values read for the following:

NOTICE: When the base radio is transmitting, the VSWR field on the screen displays a
value of 1 or greater; when the base radio is not keyed, 1 is displayed.

Item Measure

Current Measured Forward Power (Watts) Forward power of the base radio

Current Measured Reflected Power (Watts) Reflected power of the base radio

Current Measured VSWR Voltage Standing Wave Ratio (VSWR) of the
base radio

The following readings are for a conventional base radio:

Current Stored Forward Power (Watts) Forward power of the base radio at the last key
up

Current Stored Reflected Power (Watts) Reflected power of the base radio at the last
key up

Current Stored VSWR VSWR of the base radio at the last key up

Verifying Transmitter Performance (Digital Operation)
When and where to use:
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To verify that the GTR 8000 Expandable Site Subsystem transmitter meets the ASTRO® 25 standards,
the GTR 8000 Expandable Site Subsystem must be forced to transmit a V.52 standard test pattern.

Procedure:
1 Connect to the transceiver module in CSS through an Ethernet connection. See Connecting

Through an Ethernet Port Link on page 262.

2 From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

3 Select the ASTRO Test Pattern tab.

4 If the base radio is not already in service mode perform the follows substeps, otherwise go to 
step 5.

a Click Change to Service Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

c Re-open the Test and Measurement Screen, as described in step 2.

5 Connect the service monitor to the GTR 8000 Expandable Site Subsystem:

a Disconnect the Q-N Type connector cable from the input connector of the Cavity Combiner.

b Connect the Q-N Type connector cable (cable disconnected from step a) to the T/R port of
the service monitor

6 Make the following settings on the service analyzer:

a Click Receiver (TX Test).
b Enter the frequency to match that of the base radio TX channel selected.

c Click INPUT PORT and set to T/R.

d Click ATTEN and set to 20 dB.

e Click DEMOD and set to P25.

f Click IF BW and set to 12.5 kHz.

g Click RF GEN to turn OFF the Signal Generator Output.

7 On the service analyzer, click Options. Enable and make the following selections in the
Spectrum Analyzer, EVM Data, Power Meter, and Modulation Plot, as follows:

a Expand the Power Meter and set to AR (Autorange). If necessary, change to 0. Press
Return. Verify that Cable Loss is 0. If cable loss is anticipated, expand the Power Meter and
enter the cable loss factor.

b Set the RF Error Meter to AR (Autorange).

c Set the Modulation Meter to AR (Autorange).

8 Set up the test in the CSS:

• In the Pattern Type field, select V.52.

9 Click Start Pattern Transmission.

The service monitor displays:

• The test pattern on the modulation scope.

• The amount of deviation of the carrier.

• The Modulation Fidelity as a percentage.
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• The transmitters carrier frequency error.

Figure 144: Configuration for Modulation Fidelity Measurement (Aeroflex 2975 Series
Service Monitor or Equivalent Analyzer)

10 Record the BER, Modulation Fidelity Error, Symbol Deviation, and Carrier Error and FREQ
readings from the P25 Uplink Data (in the Options menu) for use in digital Receiver Testing.

11 Click Stop Pattern Transmission to turn off the test tone.

12 Disconnect the service monitor and reconnect the Q-N Type connector cable to the input
connector of the Cavity Combiner.

13 If no further testing is needed, place the base radio in Normal Mode.

a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

Verifying Transmitter Performance (Analog Operation)

When and where to use:
To verify that the base radio transmitter meets the ASTRO® 25 system standards, the base radio must
be forced to transmit a 1 kHz tone.

Procedure:
1 Connect to the transceiver module in Configuration/Service Software (CSS) through an Ethernet

connection. See Connecting Through an Ethernet Port Link on page 262.

2 From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

3 Select the ASTRO Test Pattern tab.

4 If the base radio is not already in service mode perform the follows substeps, otherwise go to 
step 5.

a Click Change to Service Mode.
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b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

c Re-open the Test And Measurement Screen, as described in step 2

5 Connect the service monitor to the base radio:

a Remove the N-Type connector from the Transmitter Antenna Port.

b Connect an N-to-N cable from the Transmitter Antenna Port to the T/R port of the service
monitor.

6 Make the following settings on the service analyzer:

a Configure the service monitor for Analog Duplex.

b Enter the frequency to match that of the base radio TX channel selected.

c Click INPUT PORT and set to T/R.

d Click ATTEN and set to 20 dB.

e Click IF BW and set to 12.5 kHz for narrow channels. Select 25 kHz or 30 kHz for wide
channels.

f Click DEMOD and set to FM.

g Click RF GEN to turn OFF the Signal Generator Output.

h For the power meter, select W and BB (Broadband).

i Select 0.3–3 kHz for the audio filtering bandwidth.

7 Set up the test in CSS:

• From the Pattern to Transmit field, select 1 kHz Tone at 60% deviation without PL/DPL.

8 Click Start Pattern Transmission.

The service monitor displays:

• The transmit output power (make sure to account for any cable loss).

• The amount of FM deviation of the carrier.

• The Tx SINAD (measure of Tx distortion) in dB.

• The transmitters carrier frequency error.
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Figure 145: Configuration for Modulation Fidelity Measurement (Aeroflex 2975 Series
Service Monitor or Equivalent)

9 Click Stop Pattern Transmission to turn off the test tone.

10 Disconnect the service monitor and reconnect the transmit antenna.

11 If no further testing is needed, place the base radio in Normal Mode, as follows:

a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

GTR 8000 Expandable Site Subsystem Performance Testing
with a Service Monitor for HPD
The HPD Service Monitor is a diagnostic tool used with an HPD GTR 8000 Expandable Site
Subsystem or HPD modem to test and measure the transmitter and receiver characteristics. The HPD
Service Monitor generates HPD signaling and provides diagnostic information for received signaling.
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Figure 146: HPD Service Monitor Test Screen

The HPD Service Monitor is connected with an HPD GTR 8000 Expandable Site Subsystem to perform
the following diagnostic tests (for additional tests, see the HPD service monitor manual). These tests
are designed to determine whether the equipment is operating within specification. If an HPD GTR
8000 Expandable Site Subsystem fails to meet specification, service may be required.

• Measure Transmit Power: See Measuring HPD BR Tx Power, Frequency Accuracy, and Tx EVM
on page 320.

• Measure Frequency Accuracy: See Measuring HPD BR Tx Power, Frequency Accuracy, and Tx
EVM on page 320.

• Measure Error Vector Magnitude (EVM) for Transmitter: See Measuring HPD BR Tx Power,
Frequency Accuracy, and Tx EVM on page 320.

• Measure Receiver Sensitivity: See Measuring HPD BR Rx Sensitivity and Rx BER on page 323.

• Measure Bit Error Rate (BER) for Receiver: See Measuring HPD BR Rx Sensitivity and Rx BER
on page 323.

For additional information about using the service monitor, see the HPD Service Monitor manual or
online help (accessed through the Help button on the front of the Service Monitor).

Setting Up the HPD Service Monitor for Testing the GTR 8000
Expandable Site Subsystem
Prerequisites: The following procedures assume that a USB mouse is connected. If not, for
instructions to click or select you can use the TAB and arrow buttons on the front of the service
monitor. For instructions to select a soft key on the right side of the screen, use the unlabeled buttons
on the front of the service monitor, and press the button next to the soft key on the screen.
The test procedures require the base radios Rx and Tx cables to be connected to the HPD Service
Monitor. Any calls present on the channel associated with the base radio are dropped from that
channel. Place the channel in Service Mode before performing the test procedures so that the system
does not attribute the loss of channel to a failure.

When and where to use:
Use this procedure for setting up the HPD Service Monitor.
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If the HPD Service Monitor runs continuously, periodic calibration is required. See the HPD Service
Monitor manual for instructions.

Procedure:
1 Plug a power cable into the AC port at the rear of the service monitor.

2 Connect a USB mouse to one of the two USB ports in the rear of the Service Monitor.

3 Configure the Speed/Duplex setting in the PCs Ethernet interface to 10 Mb Half Duplex.

4 Connect to the transceiver module in CSS through an Ethernet connection. See Connecting
Through an Ethernet Port Link on page 262.

5 If the base radio being tested is not already in service mode perform the follows substeps,
otherwise go to step 6.

a From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

b Click Change to Service Mode.

c At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

d Re-open the Test and Measurement Screen.

6 Connect the service monitor to the GTR 8000 Expandable Site Subsystem:

a Disconnect the Q-N Type connector cable from the input connector of the Cavity Combiner.

b Connect the Q-N Type connector cable (cable disconnected from step 1) to the RF I/O port of
the service monitor

7 In case you want to measure the GTR 8000 Expandable Site Subsystems receive signal (see 
Measuring HPD BR Tx Power, Frequency Accuracy, and Tx EVM on page 320) connect the
service monitor GEN port to the Site Preselector Test Ports using a splitter.

8 Press the green power button on the front of the service monitor.

9 If the Test Screen is not displayed (see Figure 146: HPD Service Monitor Test Screen on page
319), press the Test button on the front of the service monitor.

10 Locate the specifications configuration for testing. See GTR 8000 Expandable Site Subsystem
Specifications on page 67.

Measuring HPD BR Tx Power, Frequency Accuracy, and Tx EVM
When and where to use:
Use this procedure for the service monitor to receive and provide readings on transmissions from the
base radio.

Procedure:
1 Perform the service monitor setup steps in Setting Up the HPD Service Monitor for Testing the

GTR 8000 Expandable Site Subsystem on page 319.

2 Configure the service monitor T/R port to receive transmissions from the base radio as follows:

• Click the T/R soft key under RF In on the right side of the screen on the service monitor.
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3 Maximize the RF Control Settings window, by clicking the upper left corner of the window.

Figure 147: HPD Service Monitor - RF Control Settings Window

4 Set RF Receiver Frequency on the service monitor, as follows:

a Click the RF Rcvr Freq field in the upper right quadrant of the RF Control Settings window.

b Press the number buttons on the front of the service monitor to enter a value in the RF Rcvr
Freq field.

c If MHz is not already displayed to the right of the RF Receiver Frequency value you entered,
press the unlabeled button on the front of the service monitor next to the MHz soft key.

NOTICE: The value you enter should be within the Frequency Range specification for the
GTR 8000 Expandable Site Subsystem configuration you are testing. See GTR 8000
Expandable Site Subsystem Specifications on page 67.

5 From the drop-down list for Pilot Sync Code (PSC) in the upper right quadrant of the RF Control
Settings window, select 1.

6 Make the following selections in the Receive (Expected) quadrant of the RF Control Settings
window:

a From the drop-down list for Receive Mode, select Manual.
b From the drop-down list for Burst Type, select Outbound.

c From the drop-down list for Modulation, select 16-QAM.

d From the drop-down list for Sync Mode, select Free Run.

7 Minimize the RF Control Settings window, by clicking the upper left corner of the window. (See 
Figure 146: HPD Service Monitor Test Screen on page 319.) Modulation Type is not visible in
the minimized RF Control Settings window but displays with Burst Type and PSC at the bottom
of the screen.

The minimized RF Control Settings window is visible at the top of the screen as long as all
subscreens are minimized.

8 On the CSS Test and Measurement Screen, perform the following actions:

a In the Select Pattern to Transmit field, key up the base radio for 16-QAM modulation by
selecting 16-QAM .

b Click Start Pattern Transmission.
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Figure 148: CSS Test and Measurement Screen

9 Display the base radios transmission readings on the service monitors Rx Meter subscreen, as
follows:

a Click the Rx Meter subscreen.

A panel of soft keys displays on the right side of the screen, including two Reset keys.

Figure 149: HPD Service Monitor - Rx Meter Subscreen, Reset Soft Keys

b Click the Reset Acquire soft key on the right side of the screen.

The test set with the incoming signal re-synchronizes.

c Click the Reset Meters soft key on the right side of the screen.

This stops, clears, and restarts the acquisition of data for the data display fields.

10 Compare the value that displays in the Signal Power field to the HPD Tx Power Out
specification of 50 Watts.

NOTICE: Account for cable loss in this comparison.

11 Note the value that displays in the Freq. Error field. Tolerance should be +/- 50 Hz.

12 Note the value that displays in the EVM avg field. The value should be less than or equal to
10%.

13 If no further testing is needed, place the base radio in Normal Mode:
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a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

Measuring HPD BR Rx Sensitivity and Rx BER
When and where to use:
Use this procedure to test:

• Rx Sensitivity: Does the 1% Bit Error Rate (BER) meet specifications for your GTR 8000
Expandable Site Subsystem configuration?

• Rx BER: Does -70 dBm produce a 0.01% Bit Error Rate (BER) or better, as expected?

Procedure:
1 Perform the service monitor setup steps in Setting Up the HPD Service Monitor for Testing the

GTR 8000 Expandable Site Subsystem on page 319.

2 Using the soft keys on the right side of the screen, configure the service monitor GEN port to
generate inbound signaling to the base radio as follows:

a Under RF Gen, click the ON soft key.

b Under RF Out, click the GEN soft key.

c Under Transmit, click the ENABLE soft key.

3 Maximize the RF Control Settings window, by clicking the upper left corner of the window.

All RF Control Settings fields are displayed.
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Figure 150: HPD Service Monitor - RF Control Settings Window

4 Select the following values in the Transmit quadrant of the RF Control Settings window:

a For Burst Type, select Inbound Reserved.

b Select a Modulation Type.

c For Sync Mode, select TDO.

d For Pattern, select 0.153 Std.

NOTICE: Your selection should be a modulation type from HPD Receive Sensitivity 1%
BER specifications, which include:

• 64 QAM (Quadrature Amplitude Modulation)

• 16 QAM

• QPSK (Quadrature Phase Shift Keying)

See GTR 8000 Expandable Site Subsystem Specifications on page 67.

5 For Sync Mode in the Receive (Expected) quadrant of the RF Control Settings window, select
Free Run .

6 Select the following values in the upper left quadrant of the RF Control Settings window:

a Click the RF Gen Freq field and use the number buttons on the front of the service monitor to
enter a value.

NOTICE: The value you enter should be within the frequency range specification for
the GTR 8000 Expandable Site Subsystem configuration you are testing. See GTR
8000 Expandable Site Subsystem Specifications on page 67.

b Click the RF Gen Level field and enter a dBm value, depending on the length of cable
between the service monitor and the base radio.

NOTICE: The value you enter should match the receive sensitivity 1% BER
specifications for your GTR 8000 Expandable Site Subsystem configuration, for the
Modulation Type you selected. See GTR 8000 Expandable Site Subsystem
Specifications on page 67.

c From the drop-down list for Pilot Sync Code (PSC), select 1.
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7 Minimize the RF Control Settings window, by clicking the upper left corner of the window. See 
Figure 146: HPD Service Monitor Test Screen on page 319. Modulation Type is not visible in the
minimized RF Control Settings window but displays with Burst Type and PSC at the bottom of
the screen.

The minimized RF Control Settings window is visible at the top of the screen as long as all
subscreens are minimized.

8 From the Test and Measurement Screen, set up to display received BER, as follows:

a Select a pattern that matches your Modulation Type selection from the RF Control Settings
in the service monitor.

NOTICE: To match the QPSK Modulation Type on the service monitor screen, select
the 4 QAM pattern in CSS.

b Click Start Pattern Transmission.

c Click Start BER Measurement.
Figure 151: CSS Test and Measurement Screen

9 Display the base radios transmission readings on the service monitor Rx Meter subscreen, as
follows:

a Click the Rx Meter subscreen.

A panel of soft keys displays on the right side of the screen, including two Reset keys.

Figure 152: HPD Service Monitor - Rx Meter Subscreen and Soft Keys
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b Click the Reset Acquire soft key on the right side of the screen.

The test set with the incoming signal re-synchronizes.

c Click the Reset Meters soft key on the right side of the screen.

This stops, clears, and restarts the acquisition of data for the data display fields.

10 On the RF Control Settings window of the service monitor, enter lower values in the RF Gen
Level field until 1% BER is displayed on the CSS Test and Measurement Screen. Compare
the value in the RF Gen Level field to the receive sensitivity 1% BER specifications for your
GTR 8000 Expandable Site Subsystem configuration. See GTR 8000 Expandable Site
Subsystem Specifications on page 67.

NOTICE: Be sure to take the cable and splitter loss into account, along with 30 dB for the
coupling loss of the site preselectors test port.

11 Enter -40 dBm in the RF Gen Level field.

NOTICE: This should produce a 0.01% or better BER on the Test and Measurement
Screen in CSS. If it does not, contact Motorola Solution Support Center (SSC). See 
Motorola Solution Support Center on page 344.

12 When finished testing, perform the following steps in CSS on the Test and Measurement
Screen:

a Click Stop BER Measurement.
b Click Stop Pattern Transmission.

13 If no further testing is needed, place the base radio in Normal Mode:

a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

Checking Receiver Sensitivity (Self-test Method) (HPD)

When and where to use:
Use this procedure to check the High Performance Data (HPD) receiver sensitivity for the base radio
without any test equipment. The base radio uses a factory calibrated low-level noise source at the
receiver input to check performance. This procedure can be performed remotely.

Procedure:
1 Connect to the base radio in Configuration/Service Software (CSS) through an Ethernet

connection. See Connecting Through an Ethernet Port Link on page 262.

2 From the menu, select Service → Test And Measurement Screen.
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Figure 153: CSS Test And Measurement Screen

3 If the base radio is not in service mode perform the follows substeps, otherwise go to step 4.

a Click Change to Service Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

c Re-open the Test And Measurement Screen as described in step 2.

4 Select Start Receiver Test.
A confirmation dialog box appears indicating the test progress. After a few seconds, the test
concludes with a pass or fail message.

5 Click OK.

6 If no further testing is needed, place the base radio in Normal Mode.

a Click Change to Normal Mode.

b At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.
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Chapter 6

GTR 8000 Expandable Site Subsystem
Maintenance
This chapter describes periodic maintenance procedures relating to the GTR 8000 Expandable Site
Subsystem.

Fan Grill Cleaning Instructions
If the station equipment is installed in a dusty environment, take precautions to filter the air used for a
forced cooling of the station. Excessive dust drawn across and into the device circuit modules by the
cooling fans can adversely affect heat dissipation and circuit operation. In such installation, be sure to
clean or replace external filtering devices periodically.

If dust has accumulated on the fan grills, cleaning the fan grills is recommended. When cleaning, take
care to prevent dust from being pulled into the modules. Use a damp cloth to wipe the front of the fan
grills. When removing the power supply, turn off the unit before proceeding.

Base Radio Internal Frequency Reference Oscillator Alignment
The transceiver option card internal frequency reference oscillator in a base radio must be aligned:

NOTICE: The base radio must be turned on for at least one week before the internal frequency
reference oscillator is aligned.

See Base Radio Service Help > Service Screens > Alignment Screens in the CSS Online Help for the
alignment procedures.

GCP 8000 Site Controller Reference Oscillator Alignment

NOTICE: This alignment is for both the active and standby site controllers at a repeater site
only.

After the GCP 8000 Site Controller is installed, the reference oscillator must be aligned.

NOTICE: The base radios must be turned on for at least one week before the reference
oscillator is aligned.

The site controller reference oscillator must be aligned to within 1 ppb (parts per billion). The frequency
reference used to make this alignment should be accurate to within 1 ppb. This accuracy typically
requires test equipment with a double oven or a Rubidium reference oscillator.

See Site Controller Configuration Service Help > Site Controller Procedures > Aligning the Reference
Oscillator in the CSS Online Help for the alignment procedures.
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Chapter 7

GTR 8000 Expandable Site Subsystem
Operation
This chapter details how the GTR 8000 Expandable Site Subsystem operates once it is installed and
operational on your system.

Base Radio Operational States for Trunked Simulcast
GTR 8000 Base Radio modules can be in any one of the following four operational states:

• Standby

• Idle

• Assigned

• Isolated

During initialization, the base radio powers up into the standby state and waits for a status packet from
the comparator. When initial contact with the comparator has been made, the base radio enters idle
mode. The base radio sends a status message back to the comparator indicating that it is ready for the
assignment.

After a base radio has been assigned, it can begin to handle inbound/outbound traffic. In the case
where the base radio fails to receive status packets from the comparator, the base radio enters
isolated mode and dekeys. This isolated mode is reported in the Unified Event Manager (UEM).

If the base radio becomes operational again, and receives the status packets from the comparator, it
again replies with a channel status message. The base radio returns to the idle state and is ready for
an assignment from the comparator.

Adjacent Site Search Holdoff
For IP simulcast subsystems with 16 to 32 subsite capacity, the Transport Network requires longer
than 1 second to recover following a failure. To compensate for the subscriber unit scatter, the
subscriber units are required to remain on the site for a longer duration following a control channel
loss. A message is used to instruct the subscriber units to remain on the site for 10 seconds following
the loss of a control channel. The base radio automatically transmits this message upon loss of
packets from the prime site.

Base Radio Operational States for Trunked Repeater and HPD

A GTR 8000 Base Radio can be in one of four operational states:

• Standby

• Idle

• Assigned

• Isolated

During initialization, the base radio powers up into the standby state and waits for a status packet from
the site controller. After initial contact with the site controller has been made, the base radio enters idle
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mode and sends a status message back to the site controller indicating that it is ready for assignment.
The site controller responds with a channel grant message, and the base radio enables for service. If
the base radio has a greater home channel preference setting than other base radios at the site, then
the zone controller assigns the base radio as the home channel at the site.

After a base radio has been assigned, it can begin to handle inbound/outbound traffic. In the case
where the base radio fails to receive a number of consecutive status packets from the site controller,
the base radio enters isolated mode and dekeys. This isolated mode is reported in the Unified Event
Manager.

If the base radio becomes operational again and receives status packets from the site controller, it
replies with a channel status message. The site controller may then respond with a channel grant, and
the base radio becomes enabled for service again.

Base Radio Operational States for Conventional
A GTR 8000 Expandable Site Subsystem channel can be in one of two operational states:

• Standby/Receiving

• Transmit

During initialization, the base radio powers up into the standby/receiving state and is enabled for
service. The base radio listens for any received transmissions.

After the base radio receives a transmission, it can then key-up and transmit.

Packet Data interactions with Multiple NACs

If a base radio supports multiple NACs, such as when using the community base radio feature (F7F/
F7E), in addition to a default NAC, inbound data can be received on any incoming NAC and is
forwarded to its destination. Outbound data is only transmitted to the default NAC. Outbound data
cannot be routed to a selected NAC, it is always sent on the default NAC. Repeated data is only
transmitted on the default NAC and does not follow the inbound NAC when community repeater (F7F)
is being used.

Supplementary Signaling interactions with Multiple NACs

If a base radio supports multiple NACs, such as when using the community base radio feature (F7F/
F7E), in addition to a default NAC, inbound supplementary signaling can be received on any incoming
NAC and is forwarded to its destination. If using F7F/F7E, the same that voice would be transmitted,
the outbound supplementary signaling is transmitted on either the default NAC or the currently selected
NAC. Outbound supplementary signaling cannot be routed to a selected NAC, it is always sent using
either the default NAC or the same NAC that voice would be transmitted on according to F7F/F7E
functionality.

Site Initialization for the GCP 8000 Site Controller (HPD and
Repeater Sites)
The GCP 8000 Site Controller at a remote site follows the general site initialization process.
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Figure 154: Site Initialization

Site Initialization Process
Process:

1 After the site controller is powered up, it enters the standby mode and checks for status
messages from the standby site controller.

2 If status messages are not received before a time-out period, the site controller becomes active,
monitors the LAN for base radios, and begins sending status messages.

3 When the standby site controller is powered up, it enters the standby mode and receives status
messages from the active site controller. The standby site controller remains in the standby
mode.

4 When the active site controller detects a base radio on the LAN, it sends a report status
message to the base radio through the site LAN. This activity takes place with all base radios
simultaneously.

5 The base radio responds with a channel status reply to the active site controller. The base radio
then begins to monitor periodic status messages from the active site controller.

6 The active site controller receives the channel status response from the base radio and begins
to send background messages to the base radio, then sends a channel grant to the base radio.

7 The base radio enters the assigned operational state and keys up. It is now available for
operation. If the zone controller has the greatest preference setting in the UNC, the base radio
may be assigned as the control channel.

GPB 8000 Reference Distribution Module Operational States
The GPB 8000 Reference Distribution Modules (RDMs) provide redundant reference and Ethernet
switching to the base radios. If a failure occurs with one of the RDMs, the other RDM maintains the
site. If a GPS unit on an RDM fails, the RDM switches to using the 1PPS reference from the GPS unit
on the other RDM.

If both GPS units are non-operational, both RDMs maintain 1PPS reference accuracy for at least four
hours. If both RDMs fail, the remote site loses connection to the prime site.

An optional backup for the frequency and time references supplied to the base radios is available
either through a TRAK 8835-3 SSR or a TRAK 9100 SSR. The backup SSR provides an extended
holdover of at least 72 hours when redundant GPS or certain RDM failures occur.
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Illegal Carrier Determination Feature (Trunked)
The Illegal Carrier Determination feature allows base radio channels to continue operating with system-
configurable levels of channel interference. In an ASTRO® 25 system, the base radio uses Received
Signal Strength Indicator (RSSI), an RF Threshold Value, and the Malfunction Timer Value to
implement this feature.

Table 117: Illegal Carrier Determination

If the channel receives a... and is assigned: and is not assigned:

Valid Network Access Code (NAC) The base radio does not change since
the carrier is considered valid.

If the RF Threshold Value is exceed-
ed, the base radio enters the Illegal
Carrier state and generates an Illegal
Carrier message to Unified Event
Manager (UEM).

Invalid Network Access Code (NAC)
OR Carrier activity without NAC

If the RF Threshold Value level is exceeded, the Malfunction Timer Value is ac-
tivated. After the timer expires, the base radio enters the Illegal Carrier state
and generates an Illegal Carrier message to UEM.
If the illegal carrier disappears or drops below the RF Threshold Value for
12.5%, but not less than 10 seconds of the time period defined by the Malfunc-
tion Timer Value, an event is sent to UEM.

RF Channel Interference Determination Feature (Conventional)
The RF Channel Interference Determination Feature allows radio channels to detect RF interference
and log it to the station log. RF Channel Interference is declared when the Carrier Squelch level is
exceeded and none of the receive qualifiers are met. Receive qualifiers are the programmed Private
Line (PL), Digital Private Line (DPL), or receive Network Access Code (NAC) for the currently active
channel.
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Chapter 8

GTR 8000 Expandable Site Subsystem
Troubleshooting
This chapter provides fault management and troubleshooting information relating to the GTR 8000
Expandable Site Subsystem.

GTR 8000 Expandable Site Subsystem troubleshooting requires an understanding of hardware-based
and software-based diagnostics, as well as testing tools. Support is available from Motorola to assist
with all steps in the troubleshooting process.

GTR 8000 Base Radio General Troubleshooting

Table 118: GTR 8000 Base Radio General Troubleshooting

Problem Troubleshooting

General connectivity
problems

1 If you have access to the equipment, check the LEDs to verify that each piece
of equipment is connected and operational. See GTR 8000 Base Radio Trans-
ceiver LEDs on page 429.

2 In CSS, check the condition of the base radio and all associated devices and
links.

3 Verify the configuration of the base radio through UNC and CSS. Verify that
the IP address for the base radio is correct. In CSS, send a diagnostic com-
mand to enable the base radio.

4 Verify that the DNS Hostname for the base radio is correct. If the DNS Host-
name was incorrect and then corrected, further corrections may be needed on
the DNS server, UNC, and UEM. See the Troubleshooting chapter in the Au-
thentication Services manual.

5 Verify that the physical cabling is firmly connected and in good condition.
Check for any sharp bends or kinks in cabling. Test suspected cabling for
noise, continuity, attenuation, and crosstalk. Replace the cabling if necessary.

6 Run ping, traceroute, pathping, and other network administration commands to
identify any link or intermediate devices (switch or routers) with high latency or
connection problems.

7 If the connection fails to operate normally, send a restart command to the base
radio through CSS. Consider cycling power to the base radio if necessary.

8 If the base radio still fails to operate properly, create a backup of the current
configuration, then reinstall the software and re-configure the base radio.

9 Replace the base radio if necessary.

Device will not pow-
er up

1 If you have access to the equipment, check the LEDs to determine which
equipment is connected and operational. See GTR 8000 Base Radio Trans-
ceiver LEDs on page 429.

2 In CSS, check the alarms for the base radio.

Table continued…
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Problem Troubleshooting

3 Check the power cabling and verify that the power source for the base radio is
supplying the appropriate voltage. Try connecting the base radios transceiver
module to another power source or replace the power cabling if necessary.

NOTICE: Check all power sources as there may be more than one.

4 Check for any physical damage to the modules and check whether the mod-
ules were properly grounded.

5 Replace any defective modules.

Device is in a con-
tinuous reset state

Assure reference inputs are connected to the appropriate input.

Analog (4-wire) Por-
tion of V.24 Hybrid
Link Failure

In a mixed mode configuration, with hybrid links, and when analog link monitor
tone is enabled (Analog Link Idle Check is enabled in the CSS), the base radio de-
tects a link failure when the analog link monitor tone and call activity are absent on
the receive line (WL1). Analog Idle Link Check in the CSS should be disabled
when the comparator type is ASTRO-TAC with DIGI-TAC or ASTRO-TAC with
MLC 8000. When these failure conditions are met, the base radio will:

1 Log an occurrence of the failure in the base radios local event log, which is re-
trievable through the configuration interface.

2 If connected to centralized fault management equipment (optional) then the
base radio transmits an alarm indication to the fault manager to alert the sys-
tem administrator of the failure.

3 A local visual indication is active due to this failure.

Recovery of the link failure results in a similar set of actions to indicate that the fail-
ure event cleared. A failure of the transport line or a failure of the opposing host on
the wireline link both appears to the base radio as a link failure. The base radio
cannot distinguish between these two cases.

V.24 Portion of Hy-
brid Link Fails

In a mixed mode configuration, with hybrid links, the base radio detects a V.24 link
failure when packet activity is absent for a period of time on the outbound transmit
line. When these failure conditions are met, the base radio will:

1 Log an occurrence of the failure in the base radios local event log, which is re-
trievable through the configuration interface.

2 If connected to centralized fault management equipment (optional) then the
base radio transmits an alarm indication to the fault manager to alert the sys-
tem administrator of the failure.

3 A local visual indication is active due to this failure.

4 Invoke a failure announcement for the 4-wire link because the activity on the 4-
wire link is driven by control signaling on the V.24 link. 4-wire link cannot be
used when the V.24 link is down.

Recovery of the link failure results in a similar set of actions to indicate that the fail-
ure event cleared. A failure of the transport line or a failure of the opposing host on
the wireline link both appears to the base radio as a link failure. The base radio
cannot distinguish between these two cases.

Transceiver Option
Card Hardware Mal-
function

In the event the base radio detects a hardware issue with the transceiver option
card, when used for analog and mixed mode operation, it will:

Table continued…
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Problem Troubleshooting

1 Log an occurrence of the failure in the base radios local event log, which is re-
trievable through the configuration interface.

2 If connected to centralized fault management equipment (optional), then the
base radio transmits an alarm indication to the fault manager to alert the sys-
tem administrator of the failure. The alarm is associated with the base radios
control module.

3 A local visual indication is active due to this failure.

Front Fan Malfunc-
tion

In the event the fan assembly malfunctions, the base radio will:

1 Log an occurrence of the failure in the base radios local event log, which is re-
trievable through the configuration interface.

2 If connected to centralized fault management equipment (optional), then the
base radio transmits an alarm indication of “warning” severity to the fault man-
ager to alert the system administrator of the failure. The alarm is associated
with the base radios control module.

3 The base radio provides a local visual indication associated with the failure.

4 In the event the base radio detects the maximum operable temperature has
been exceeded, then the base radio transitions to a critical malfunction state,
log the state change, and generate a fault indication if connected to the UEM.

Power Consumption
is greater than 35 W
with power efficien-
cy package

The following conditions must be met to obtain a power consumption of less than
or equal to 35 W:

• DC source only

• Speaker turned OFF (if equipped with a transceiver option card)

• No activation of Aux Out Relays (if equipped with a transceiver option card)

• No 29 V AUX loads. For example: site controllers, XHubs, GPB 8000 Refer-
ence Distribution Modules, RMCs, etc.

• CSS configured for applications not requiring receiver diversity

• CSS Fan Holdover configured to “short” (length of time the base radio fan
stays ON after transmission)

• Ambient temperature of 104 °F (40 °C) or less

• Transceiver, power amplifier, power supply, fan, and optional TCXO transceiv-
er option card are all power efficiency package versions

Unable to perform a
password reset

If the device module has been replaced and serial port access is not available to
configure the IP address, the device may have the account locked out or the back-
plane slot has passwords enabled. Connect to the front-panel local Ethernet serv-
ice port using a fixed IP address and perform the password reset.
See Connecting Through an Ethernet Port Link on page 262 and Setting the Local
Password Configuration in CSS on page 271.
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GCP 8000 Site Controller General Troubleshooting

Table 119: GCP 8000 Site Controller - General Troubleshooting

Problem Troubleshooting

General connectivity
problems

1 If you have access to the equipment, check the LEDs to verify if each piece
of equipment is connected and operational. See GCP 8000 Site Controller
LEDs on page 433.

2 In the CSS, check the alarms of the site controller and all associated devi-
ces and links.

3 Verify that the IP address, subnet mask, Site Controller Number, and de-
fault gateway for the site controller is correct. In the CSS, send a diagnostic
command to enable the site controller.

4 Verify if the physical cabling is firmly connected and is in good condition.
Check for any sharp bends or kinks in cabling. Test suspected cabling for
noise, continuity, attenuation, and crosstalk. Replace the cabling if necessa-
ry.

5 If the connection fails to operate normally, check the diagnostics, and if
needed, contact the Motorola Solution Support Center (SSC).

6 If the site controller still fails to operate properly, create a backup of the cur-
rent configuration, then reinstall the software and reconfigure the site con-
troller.

7 Replace the site controller if necessary.

Unit will not power up 1 If you have access to the equipment, check the LEDs to verify if each piece
of equipment is connected and is operational. See GCP 8000 Site Control-
ler LEDs on page 433.

2 Check the power cabling and verify if the power source for the site controller
is supplying the appropriate voltage. Connect the site controller to another
power source or replace the power cabling if necessary.

NOTICE: Check all power sources if there is more than one.

3 Check for any burn marks or physical damage to the site controller and
check whether the site controller is properly grounded.

4 Replace the site controller if necessary.

Table continued…
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Problem Troubleshooting

Unable to perform a
password reset

If the device module has been replaced and serial port access is not available
to configure the IP address, the device may have the account locked out or the
backplane slot has passwords enabled. Perform the following steps:

1 Move the device module to a different chassis or to a different slot in the
backplane where local passwords are not configured.

2 Configure the IP address and reset the device through the front panel
RS-232 serial service port using CSS.

3 Perform the local password reset operation (to clear account information
stored in the FRU) through and Ethernet port link using CSS.

4 Move the device module back to the original chassis or slot.

5 Perform the local password reset operation again (to clear account informa-
tion stored in the backplane).

See Connecting Through an Ethernet Port Link on page 262 and Setting the
Local Password Configuration in CSS on page 271.

GPB 8000 Reference Distribution Module General
Troubleshooting

Table 120: GPB 8000 Reference Distribution Module General Troubleshooting

Problem Troubleshooting

General connectivity
problems

1 If you have access to the equipment, check the LEDs to verify that each piece
of equipment is connected and operational.

2 In the Configuration/Service Software (CSS), check the alarms of the GPB
8000 Reference Distribution Module (RDM) and all associated devices and
links. See GPB 8000 Reference Distribution Module LEDs on page 437.

3 Verify the configuration of the RDM through Unified Network Configurator
(UNC) and CSS. Verify that the IP address for the RDM is correct. In CSS,
send a diagnostic command to enable the RDM.

4 Verify that the DNS Hostname for the RDM is correct, if applicable. If the DNS
Hostname was incorrect and then corrected, further corrections may be need-
ed on the DNS server, UNC, and UEM. See the Troubleshooting chapter in the
Authentication Services manual.

5 Verify redundancy configuration of both RDMs through UNC and CSS. Verify
that port 0_Port_Sw-to-Sw is set to Enabled on both RDMs in the Switch Con-
figuration in CSS. If necessary, connect locally to verify RDM #2.

6 Verify that the physical cabling is firmly connected and is in good condition.
Check for any sharp bends or kinks in cabling. Test suspected cabling for
noise, continuity, attenuation, and crosstalk. Replace the cabling if necessary.

7 If the connection fails to operate normally, check the diagnostics, and if need-
ed, contact Motorola Solution Support Center (SSC).

8 If the RDM still fails to operate properly, create a backup of the current configu-
ration, then reinstall the software and reconfigure the RDM.

Table continued…
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Problem Troubleshooting

9 Replace the RDM if necessary.

Unit will not power
up

1 If you have access to the equipment, check the LEDs to verify that each piece
of equipment is connected and is operational. See GPB 8000 Reference Distri-
bution Module LEDs on page 437.

2 In the CSS, check the alarms for the RDM.

3 Check the power cabling and verify that the power source for the RDM is sup-
plying the appropriate voltage. Connect the RDM to another power source or
replace the power cabling if necessary.

NOTICE: Check all power sources if there is more than one.

4 Check for any burn marks or physical damage to the RDM and check whether
the RDM is properly grounded.

5 Replace the RDM if necessary.

Unable to perform a
password reset

If the device module has been replaced and serial port access is not available to
configure the IP address, the device may have the account locked out or the back-
plane slot has passwords enabled. Perform the following steps:

1 Move the board module to a different chassis or to a different slot in the back-
plane where local passwords are not configured.

2 Configure the IP address and reset the device through the front panel RS-232
serial service port using CSS.

3 Perform the local password reset operation (to clear account information stored
in the FRU) through and Ethernet port link using CSS.

4 Move the board module back to the original chassis or slot.

5 Perform the local password reset operation again (to clear account information
stored in the backplane).

See Connecting Through an Ethernet Port Link on page 262 and Setting the Local
Password Configuration in CSS on page 271.

Troubleshooting Tools
Several tools are available for viewing and monitoring equipment and troubleshooting suspecting
problems:

• LEDs

• Unified Event Manager (UEM) to monitor links and components

• Unified Network Configurator (UNC)

• Configuration/Service Software (CSS)

• MOSCAD Network Fault Management (NFM)

In addition, see Quick Connect RF Coaxial Adapters for GTR 8000 Base Radio Support on page 243
for testing system performance.

6871022P87-C
Chapter 8:  GTR 8000 Expandable Site Subsystem Troubleshooting

340  Send Feedback

http://docsurvey.motorolasolutions.com


Links and Components Monitoring in Unified Event Manager
The Unified Event Manager (UEM) monitors critical links and components in the system. Monitoring
may take place remotely from a central operations center. Two types of monitoring include:

• Real-time monitoring of UEM Topology Maps, which alert faults as they occur.

• Evaluation of UEM Active Alarms Window on a regularly scheduled basis.

Unified Event Manager Active Alarm Window Analyzation

The Unified Event Manager (UEM) Active Alarms Window is useful for troubleshooting because it
captures alarms that may occur intermittently or during off-hours. For example, you can review the
Active Alarms Window to correlate reported loss of service with patterns of critical alarms for links
and equipment.

When analyzing the Active Alarms Window, look for the following patterns:

• Failures sent with time stamps on or about the same time

• Failures from related equipment:

- Cards in the same device

- Equipment part of the same subsystem

Many devices send out events that report both critical and non-critical events. Learn to distinguish
between critical and non-critical events.

See the Unified Event Manager manual or UEM Online Help for further details.

Diagnostic Options in UEM

Table 121: Device Diagnostic Options in UEM

Option Description

Restart Requests that the device perform a reset.

Service Requests that the base radio enters service mode, allowing a technician
to make alignment adjustments and run other tests while the base radio
is offline.

User Disabled Requests that the selected site controller disable. After disabling, the
site controller isolates itself from the other site controller and the RNG. If
the site controller was the active site controller and the standby site con-
troller is not isolated from the system, then the standby site controller
becomes active and takes over operations at the site.

Enabled Requests that the device enter the enabled mode and handle traffic.

MOSCAD Network Fault Management
If MOSCAD Network Fault Management (NFM) equipment is supported at the site, additional status,
and alarm information for a device can be viewed through the MOSCAD NFM.
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Figure 155: MOSCAD Network Fault Management – Example

When an alarm condition occurs, the alarm device for one of the modules begins to flash red. Selecting
the LED box opens an alarm pop-up window indicating details of the alarm. To view the status of all
alarms for a particular module within the device, select the alarm LED box corresponding to the
particular module. Alarms can be acknowledged by pressing the Acknowledge button on the screen.

See the MOSCAD Network Fault Management manual for details.

Device Troubleshooting in Unified Network Configurator
Use the Unified Network Configurator (UNC) to verify configuration data during system commissioning
and later when you maintain or expand the system. Use UNC to do the following to the device:

• Verify configuration

• Correct configuration errors

See the Unified Network Configurator manual for further details.

GTR 8000 Expandable Site Subsystem Troubleshooting in
Configuration/Service Software (CSS)
The GTR 8000 Expandable Site Subsystem can be locally or remotely configured or serviced through
Configuration/Service Software (CSS). CSS provides access to alarms, status information, and
configuration settings for the GTR 8000 Expandable Site Subsystem.

Use CSS for the following tasks which may be useful when troubleshooting the GTR 8000 Expandable
Site Subsystem. See the CSS Online Help for specific details and instructions when performing these
tasks.

• Enable and disable channels and services.

• View and save a log of alarms.

• Verify configurations.

• Gather troubleshooting information that can be escalated to Motorola for evaluation.

• Check the active VLANs for the site controller.

6871022P87-C
Chapter 8:  GTR 8000 Expandable Site Subsystem Troubleshooting

342  Send Feedback

http://docsurvey.motorolasolutions.com


Internal Diagnostic Test Alarm Log

The base radio has been designed with internal diagnostic tests that occur on power up and reset.
Diagnostic tests are available for the control module and power supply. If a problem occurs during
operation, it is reported as an alarm. All alarms are stored in the Alarm Log, accessible with
Configuration/Service Software (CSS). The alarm log contains the name of the diagnostic test that
failed and the time since the last power up.

Local Password and SNMPv3 Passphrase Troubleshooting

The password reset mechanism in the Configuration/Service Software (CSS) application can be
enabled/disabled. See “Secure Remote Access Configuration > Device Security Configuration -
Security Services (Serial)” in the CSS Online Help for information. To obtain the keys for resetting
either password or SNMPv3 passphrases for the device, contact Motorola Solution Support Center
(SSC).

NOTICE: The default values for the local passwords and SNMPv3 passphrases, as well as the
keys for the local password reset procedure, may vary by system release. These default values
and keys are treated as sensitive information and are provided to your organization through
secured communication.

Table 122: Local Password and SNMPv3 Passphrase Troubleshooting

Scenario
SNMPv3

Passphrase
Known

Local
Pass-
word

Known

To Reset SNMPv3
Passphrase

To Reset Local Login
Password

User is locked out of
the local login, but
knows SNMPv3
passphrases

See the CSS Online
Help “SNMPv3 User
Configuration”.

See the CSS Online
Help “Resetting Device
Passwords.”

User knows the lo-
cal login, but not the
SNMPv3 pass-
phrases

See the CSS Online
Help “Reset SNMPv3
Configuration (Serial)”.

See the CSS Online
Help “Device Security
Configuration – Securi-
ty Services (Serial)”.

User knows both
passphrases and
local service pass-
word

See the CSS Online
Help “SNMPv3 User
Configuration”.

See the CSS Online
Help “Device Security
Configuration – Securi-
ty Services (Serial)”.

User does not know
SNMPv3 pass-
phrase nor service
account password

Contact Motorola SSC. Contact Motorola SSC.

Site Controller Failure Impact on GTR 8000 Base Radio for
Trunked Operation

If the link fails between the base radio and the site controller, the base radio dekeys and does not
handle any MSU traffic. MSUs attempt to operate on another channel at the site. If another channel is
not available, the MSUs attempt to register at another site.

6871022P87-C
Chapter 8:  GTR 8000 Expandable Site Subsystem Troubleshooting

Send Feedback   343

http://docsurvey.motorolasolutions.com


For HPD and repeater site operation, the base radio receives external frequency reference and
network time synchronization from the active site controller over the Ethernet link. If there is a loss of
the external time and frequency reference source, the base radio continues to maintain its own time
and frequency stability to continue operations for a specified amount of time without degradation.
Afterwards, operation continues with minimal degradation.

GPB 8000 Reference Distribution Module and GPS Failure
Impact on GTR 8000 Base Radios
The base radios receive redundant 1PPS site reference from GPS units through the GPB 8000
Reference Distribution Modules (RDMs). If a failure or interruption of both GPS units occurs, the RDMs
can supply the site reference to the base radios for at least four hours.

If both RDMs fail, the remote site loses connection to the prime site.

Motorola Solution Support Center
Motorola Solution Support Center (SSC) can help technicians and engineers resolve system problems,
and ensure that warranty requirements are met. Check your contract for specific warranty information.

Motorola assigns a tracking ticket number that identifies each support call. This ticket number allows
Motorola to track problems, resolutions, and activities for the call, and if possible, communicate the
resolution and a status of call so that the SSC can note the resolution and close the ticket.

Information to Gather Before Calling Motorola
Before calling the Motorola Solution Support Center (SSC), log all steps taken to troubleshoot the
problem and any results of those steps. The SSC can use this information to determine the appropriate
support actions.

Listed is the following information to collect before calling the SSC:

• System ID number (such as 2CB5). Each zone in the system has a unique system ID number

• Location of the system

• Date the system was put into service

• Software and firmware versions

• Symptom or observation of the problem, such as:

- When did it first appear?

- Can it be reproduced?

- Are there any other circumstances contributing to the problem (for example, loss of power)?

• Maintenance action preceding the problem, such as:

- Upgrade of software or equipment

- Changes to hardware or software configuration

- Reload of software from a backup disk, CD, or DVD with the version and date

Where to Call for Service
After collecting the required information and writing a detailed problem report, contact the Motorola
Solution Support Center (SSC) to help with the problem.
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Motorola Solution Support Center

The Motorola Solution Support Center (SSC) is the primary Motorola contact. Call Motorola SSC:

• Before any software reload

• To confirm troubleshooting results and analysis before removing and replacing a Field Replaceable
Unit (FRU) or Field Replaceable Equipment (FRE) to repair the system

Motorola SSC contact information:

• Phone: (800) 221-7144 for domestic calls and (302) 444–9800 for international calls

• Fax: (847) 725-4073

Subcontractors
The Motorola Solution Service Subcontractor Assessment program ensures that service people
Motorola contracts meet strict minimum requirements before they can work on any system. For more
information on this program, contact the Motorola representative.
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Chapter 9

GTR 8000 Expandable Site Subsystem
FRU Procedures
This chapter lists the Field Replaceable Units (FRUs) and Field Replaceable Entities (FREs) and
includes replacement procedures applicable to the GTR 8000 Expandable Site Subsystem.

Field Replaceable Units (FRUs) and Parts
The GTR 8000 Expandable Site Subsystem is comprised of numerous field replaceable units (FRUs)
and field replaceable parts. If replacing a FRU or part, it is essential to obtain the precise FRU Kit
Number or Part Number and to review the replacement procedures provided, including all safety
precautions and system impact information.

When ordering field replaceable units (FRUs), provide the FRU Kit Number. When ordering field
replaceable parts, provide the Part Number. Contact Motorola Solution Support Center (SSC) as
needed for numbers not provided here (for cables that are internal to a GTR 8000 Expandable Site
Subsystem, the part numbers are not listed in this documentation, but you can locate the part number
on the cable itself before contacting Motorola Solution Support Center (SSC). See Motorola Solution
Support Center on page 344.

WARNING: To guard against personal injury and/or damage to equipment, switch a trunked
base radio to Service Mode when performing service. The GTR 8000 Base Radio periodically
keys up to pseudo train its linear transmitter autonomously when it is not assigned by the zone
controller. Tx Inhibiting the base radio also prevents the transmitter from keying. Remember to
switch the base radio back to Normal Mode when service is complete.

Table 123: GTR 8000 Expandable Site Subsystem Field Replaceable Units

Component Type FRU Kit Num-
ber Replacement Procedure

Transceiver Module (700/800
MHz)**

DLN6885A

Replacing a GTR 8000 Base Radio Transceiver
Module on page 358

Transceiver Module (900 MHz)** DLN6882A

Transceiver Module (VHF 136–
174 MHz)**

DLN6892A

Transceiver Module (UHF R1,
380–435 MHz)**

DLN6888A

Transceiver Module (UHF R2,
435–524 MHz)**

DLN6884A

Transceiver Module w/OCXO
Transceiver Option Card
(700/800 MHz)**

DLN6883A

Transceiver Module w/OCXO
Transceiver Option Card (900
MHz)**

DLN6923A

Table continued…
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Component Type FRU Kit Num-
ber Replacement Procedure

Transceiver Module w/OCXO
Transceiver Option Card (UHF
R1, 380–435 MHz)**

DLN6889A

Transceiver Module w/OCXO
Transceiver Option Card (UHF
R2, 435–524 MHz)**

DLN6886A

Transceiver Module w/OCXO
Transceiver Option Card (VHF
136–174 MHz)**

DLN6893A

Power Efficiency Transceiver
Module w/TCXO* Transceiver
Option Card (UHF R1, 380–435
MHz)**

DLN6890A

Power Efficiency Transceiver
Module w/TCXO* Transceiver
Option Card (UHF R2, 435–524
MHz)**

DLN6887A

GCP 8000 Site Controller Mod-
ule

DLN6569A Replacing the GCP 8000 Site Controller Module
on page 364

GPB 8000 Reference Distribu-
tion Module

DLN6569A Replacing a GPB 8000 Reference Distribution
Module (RDM) on page 368

GGM 8000 Gateway Module The GGM 8000 Gateway has different FRU kit
numbers depending on its functional use. See
the System Gateways – GGM 8000 manual.

Expansion Hub Module DLN6677A Replacing the Expansion Hub on page 373

Fan Module DLN6898A Replacing the Fan Assembly on page 374

AC/48 V DC Power Supply DLN6781A
(0182516W14)

Replacing a Power Supply on page 376
Power Efficiency AC/48V DC
Power Supply

DLN6793A
(0182516W15)

Power Amplifier Module
(700/800 MHz)

DLN6895A

Replacing a Power Amplifier on page 379

Power Amplifier Module (900
MHz)

DLN6894A

Power Amplifier Module (UHF
R1, 380–435 MHz)

DLN6891A

Power Amplifier Module (UHF
R2, 435–524 MHz)

DLN6896A

Power Amplifier Module (VHF,
136–174 MHz)

DLN6897A

AC/DC Power Distribution Mod-
ule

0184847Y02

Table continued…
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Component Type FRU Kit Num-
ber Replacement Procedure

AC/DC Power Distribution Mod-
ule

0184847Y02 Replacing the AC/DC Power Distribution Module
on page 396

GTR 8000 Expandable Site Sub-
system Backplane

0180706K61 Replacing a GTR 8000 Expandable Site Sub-
system Backplane on page 383

Power Supply Backplane 0180706G75 Replacing a GTR 8000 Expandable Site Sub-
system Power Supply Backplane on page 389

Primary Subpanel #1 0180706J79

Replacing a Subpanel on the GTR 8000 Ex-
pandable Site Subsystem Junction Panel on
page 391

Primary Subpanel #2 0180706J82

Expansion Subpanel #1 0180706J80

Rx Expansion Subpanel 0180706H26

Network Expansion Subpanel 0180706J81

Six Receiver Input Subpanel 0180706H52

Six Transmit Output Subpanel 0180706J78

Circuit Audio Subpanel 64009329001

3600 Simulcast Subpanel* 15009710001,
RJ-45 and
DB-25
15009710002,
Telco

* Available only for non-IP simulcast systems.

** The transceiver field replacement units are not compatible with ASTRO® 25 base radio software
distributed before July 2013. BEFORE installing the replacement transceiver, ensure that all base
radios at the site meet the minimum software version requirements listed. Contact Motorola Customer
Support at 800-422-4210 if you do not have access to compatible software. See Transceiver Software
and Feature Compatibilities on page 353 for details.

Table 124: GTR 8000 Expandable Site Subsystem RFDS Field Replaceable Parts

Component Type Part Number Replacement Procedure

Power Supply Fan Module 5985167Y02 Replacing a Power Supply Fan on page 377

Site Preselector 700/800 MHz CFF6056A Replacing Filters/Preselectors (700/800/900
MHz) on page 398

Site Preselector UHF 455–458.5
MHz

9171232H01

Replacing a Site Preselector (UHF, 455–512
MHz) on page 401

Site Preselector UHF 456.5–460
MHz

9171232H02

Site Preselector UHF 459.3–
462.8 MHz

9171232H19

Site Preselector UHF 465–468.5
MHz

9171232H03

Table continued…
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Component Type Part Number Replacement Procedure

Site Preselector UHF 466.5–470
MHz

9171232H04

Site Preselector UHF 473–475
MHz

9171232H05

Site Preselector UHF 474–476
MHz

9171232H06

Site Preselector UHF 479–481
MHz

9171232H07

Site Preselector UHF 480–482
MHz

9171232H08

Site Preselector UHF 485–487
MHz

9171232H09

Site Preselector UHF 486–488
MHz

9171232H10

Site Preselector UHF 491–493
MHz

9171232H11

Site Preselector UHF 492–494
MHz

9171232H12

Site Preselector UHF 497–499
MHz

9171232H13

Site Preselector UHF 498–500
MHz

9171232H14

Site Preselector UHF 503–505
MHz

9171232H15

Site Preselector UHF 504–506
MHz

9171232H16

Site Preselector UHF 509–511
MHz

9171232H17

Site Preselector UHF 510–512
MHz

9171232H18

Site LNA Module (Site RMC)
700/800/900 MHz

DLN6634A Replacing a Site RMC/LNA Module or Tray on
page 407

Cabinet LNA Module (Cabinet
RMC) 700/800/900 MHz

DLN1306A Replacing an Individual Cabinet RMC/LNA Mod-
ule on page 412

Site LNA Module (Site RMC)
UHF R2, 435–524 MHz

DLN1375A Replacing a Site RMC/LNA Module or Tray on
page 407

Cabinet LNA Module (Cabinet
RMC) UHF R2, 435–524 MHz

DLN1374A Replacing an Individual Cabinet RMC/LNA Mod-
ule on page 412

Pass Through Module VHF
136–174 MHz and UHF R1,
380–435 MHz

DLN1380A Replacing an Individual Pass Through Module
on page 415

6 Channel Combiner 700 MHz 0184590Y01 Replacing a Cavity Combiner (700/800 MHz) on
page 4166 Channel Combiner 800 MHz 0184590Y02

Table continued…
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Component Type Part Number Replacement Procedure

6 Channel Combiner UHF 450–
465 MHz

0171245H01

Replacing a Cavity Combiner (UHF) on page
419

6 Channel Combiner UHF 470–
491 MHz

0171245H02

6 Channel Combiner UHF 494–
509 MHz

0171245H03

Hybrid Combiner Fan Module DLN6780A Replacing a Hybrid Combiner Fan Assembly on
page 422

Hybrid Combiner 900 MHz (1/2–
1/2)

DLN6782A

Replacing a Hybrid Combiner Module (900
MHz) on page 422

Hybrid Combiner 900 MHz (2/3–
1/3)

DLN6783A

Hybrid Combiner 900 MHz (3/5–
2/5)

DLN6784A

Single Duplexer 900 MHz 0182452V23
Replacing a Duplexer (900 MHz) on page 424

Dual Duplexer 900 MHz 0182452V22

Transmit Post Filter 700 MHz 9184680Y01
Replacing Filters/Preselectors (700/800/900
MHz) on page 398Transmit Post Filter 800 MHz 9184680Y02

Transmit Post Filter 900 MHz 9184680Y04

Transmit Post Filter UHF 450–
453.5 MHz

9171244H01

Replacing Transmit Filters (UHF, 450–509 MHz)
on page 402

Transmit Post Filter UHF 451.5–
455 MHz

9171244H02

Transmit Post Filter UHF 460–
463.5 MHz

9171244H03

Transmit Post Filter UHF 461.5–
465 MHz

9171244H04

Transmit Post Filter UHF 466.9–
468.1 MHz

9171244H19

Transmit Post Filter UHF 470–
472 MHz

9171244H05

Transmit Post Filter UHF 471–
473 MHz

9171244H06

Transmit Post Filter UHF 476–
478 MHz

9171244H07

Transmit Post Filter UHF 477–
479 MHz

9171244H08

Transmit Post Filter UHF 482–
484 MHz

9171244H09

Transmit Post Filter UHF 483–
485 MHz

9171244H10

Table continued…
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Component Type Part Number Replacement Procedure

Transmit Post Filter UHF 488–
490 MHz

9171244H11

Transmit Post Filter UHF 489–
491 MHz

9171244H12

Transmit Post Filter UHF 494–
496 MHz

9171244H13

Transmit Post Filter UHF 495–
497 MHz

9171244H14

Transmit Post Filter UHF 500–
502 MHz

9171244H15

Transmit Post Filter UHF 501–
503 MHz

9171244H16

Transmit Post Filter UHF 506–
508 MHz

9171244H17

Transmit Post Filter UHF 507–
509 MHz

9171244H18

Diplexer 700/800 MHz 9184680Y03 For customer configurations. Contact your Mo-
torola Field Representative or Motorola Solution
Support Center (SSC). See Motorola Solution
Support Center on page 344.

Phasing Harness 700 MHz 0184590Y03

Phasing Harness 800 MHz 0184590Y04

Power Monitor Unit (PMU) 900
MHz

01009421001

Replacing a Power Monitor Unit (PMU)
(UHF/VHF/900 MHz) on page 427

Power Monitor Unit (PMU) VHF
136–174 MHz

0171259H01

Power Monitor Unit (PMU) UHF
R1 350–435 MHz

0171206H01

Power Monitor Unit (PMU) UHF
R2 435–524 MHz

0171206H02

Expansion to Net AUX Conver-
sion Cable Kit

CLN8731A

System Connector Cable –
SCS12 GTR 8000 Expandable
Site Subsystem to Champ

30009466001

Microphone Kit GMM4063B

External Speaker Kit HSN1006A

External Speaker Cable 0185180U01

Cable DC Red/Black 2806mm 30009459002

Cable DC Black/Blue 2806mm 30009459004

Battery Temp Sensor 3000mm 30009478001
Table continued…

6871022P87-C
Chapter 9:  GTR 8000 Expandable Site Subsystem FRU Procedures

352  Send Feedback

http://docsurvey.motorolasolutions.com


Component Type Part Number Replacement Procedure

Cable Battery Temp Extension
15500mm

30009461003

GPS Antenna/Receiver DS0900382701

Mounting Kit for GPS Timing
Unit

DS0900382701

GPS Primary Surge Protector DS0971017AA1

GPS Antenna/Receiver to RDM
Cable (125 ft)

DS30C87465CO
1

GPS Antenna/Receiver to RDM
Cable (350 ft)

DS30C87465CO
2

GPS Antenna/Receiver to RDM
Cable (500 ft)

DS30C87465CO
3

GPS Antenna/Receiver to RDM
Cable (1,000 ft)

DS30C87465CO
4

ASYNC Zone Control Cable 30009455004

Dongle Adapter – Telco to
Trunking Control and DSM

30009467002

Analog Simulcast Cable Assem-
bly

30009468002

V.24 or Wireline Cable 30009455003

Transceiver Hardware Generations
As of July 2013, the GTR 8000 Base Radio is shipped with a new generation of transceiver hardware
(referred to in this manual as GEN 2). The hardware updates are intended to extend the life of the
device as seamlessly as possible. This section details relevant differences and compatibility
requirements for GEN 1 and GEN 2 hardware.

Transceiver Software and Feature Compatibilities
The GEN 2 transceiver hardware is backwards compatible and interchangeable with GEN 1
transceiver hardware on ASTRO® 25 7.7 and later systems. GEN 1 transceivers can no longer be
ordered; however, spare inventory of GEN 1 transceivers can be used as Field Replaceable Unit
(FRU) replacements.

All ASTRO® 25 system features are supported on GEN 1 and GEN 2 transceivers, with the following
exceptions.

Table 125: System Feature Exceptions

Feature GEN 1 Transceiver GEN 2 Transceiver

X2 TDMA Supported Not Supported

3600 Operation Not Supported Supported

GEN 2 transceiver hardware is not compatible with ASTRO® 25 GTR 8000 Base Radio software
distributed before July 2013. The transfer operation fails if you perform a software download using a
SWDL application released before July 2013.
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BEFORE installing a FRU replacement or expansion channel at an existing site, ensure that you are
using the latest available SWDL application, and that all base radios and receivers at the site meet the
minimum software version requirements listed. Contact Motorola Solution Support Center (SSC) at
800-422-4210 if you do not have access to compatible software.

Table 126: Minimum Software Download Version Requirements

ASTRO® 25 Sys-
tem Release HPD Site Repeater Multi-Site Conventional 3600

7.6 and earlier Not Supported N/A N/A

7.7 HPDBR_
R07.7X.023

SiteRptrBR_
R07.7X.031

MsBR_
R07.7X.033

N/A N/A

7.8 HPDBR_
R07.8X.033

SiteRptrBR_
R07.8X.038

MsBR_
R07.8X.038

N/A N/A

7.9 HPDBR_
R07.9X.049

SiteRptrBR_
R07.9X.050

MsBR_
R07.9X.051

ConvRptrBR_
R07.9X.051

Any Version

7.11 HPDBR_
R07.BX.098

SiteRptrBR_
R07.BX.102_P2

SiteRptrBR_
R07.BX.102_P2

MsBR_
R07.BX.102_X2

MsBR_
R07.BX.102_P2

ConvBR_
R07.BX.100

Any Version

7.12 HPDBR_
R07.CX.051

SiteRptrBR_
R07.CX.051_X2

SiteRptrBR_
R07.CX.051_P2

MsBR_
R07.CX.051_X2

MsBR_
R07.CX.051_P2

ConvBR_
R07.CX.057

Any Version

7.13 HPDBR_
R07.DX.073

SiteRptrBR_
R07.DX.079_X2

SiteRptrBR_
R07.DX.079_P2

MsBR_
R07.DX.079_X2

MsBR_
R07.DX.079_P2

ConvBR_
R07.DX.074

Any Version

7.14 and later Any Version

CAUTION: It is crucial that a site software download is performed at a trunked ASTRO® 25 site
to ensure that all devices are on the same software version, VLAN, and active bank. Failure to
perform this step, results in the replacement transceiver or expansion channel to have a
mismatch in software versions. If a mismatch in software versions occurs, the transceiver may
go into a configuration mode of operation with a reason of ‘Invalid Software Version’.
A site software download is not available for conventional or trunked 3600 devices.

Identifying Transceiver Hardware Generation

Label
GEN 1 and GEN 2 transceiver modules can be identified by examining the physical hardware label.
GEN 2 modules have a light blue label with ‘GEN 2’ clearly noted on it, while GEN 1 modules have a
white label with no GEN identification.
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Figure 156: GEN 1 Transceiver Module

Figure 157: GEN 2 Transceiver Module

Configuration/Service Software
GEN 1 and GEN 2 transceiver modules already installed in a system can be identified through the
Hardware Version screen of the Configuration/Service Software (CSS).

Transceiver FRU Number Mappings

Table 127: Transceiver FRU Number Mappings

Transceiver FRU Number
GEN 1
(Shipped before Nov 2013)

GEN 2
(Shipped starting July 2013)

Transceiver Module (900 MHz) DLN6778A DLN6882A

Transceiver Module w/OCXO
Transceiver Option Card (900
MHz)

N/A DLN6923A

Transceiver Module (700/800
MHz)

DLN6566A DLN6885A

Transceiver Module w/OCXO
Transceiver Option Card
(700/800 MHz)

DLN1430A DLN6883A

Transceiver Module (UHF R2,
435–524 MHz)

DLN1346A

DLN6884APower Efficiency Transceiver
Module (UHF R2, 435–524
MHz)

DLN6789A

Table continued…
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Transceiver FRU Number
GEN 1
(Shipped before Nov 2013)

GEN 2
(Shipped starting July 2013)

Transceiver Module w/OCXO
Transceiver Option Card (UHF
R2, 435–524 MHz)

DLN1433A DLN6886A

Power Efficiency Transceiver
Module w/TCXO Transceiver
Option Card (UHF R2, 435–524
MHz)

DLN6790A DLN6887A

Transceiver Module (UHF R1,
380–435 MHz)

DLN1395A

DLN6888APower Efficiency Transceiver
Module (UHF R1, 380–435
MHz)

DLN6786A

Transceiver Module w/OCXO
Transceiver Option Card (UHF
R1, 380–435 MHz)

DLN1432A DLN6889A

Power Efficiency Transceiver
Module w/TCXO Transceiver
Option Card (UHF R1, 380–435
MHz)

DLN6787A DLN6890A

Transceiver Module (VHF, 136–
174 MHz)

DLN1376A DLN6892A

Transceiver Module w/OCXO
Transceiver Option Card (VHF
136–174 MHz)

DLN1431A DLN6893A

Power Amplifier Hardware Generations
Starting in July 2013, the GTR 8000 Base Radio is shipped with a new generation of power amplifier
hardware (referred to in this manual as GEN 2). The hardware updates extend the life of the base radio
as seamlessly as possible. This section details relevant differences and compatibility requirements for
GEN 1 and GEN 2 hardware.

Power Amplifier Software and Feature Compatibilities
The GEN 2 power amplifier hardware is fully backwards compatible and completely interchangeable
with GEN 1 power amplifier hardware. GEN 1 power amplifiers can no longer be ordered; however,
spare inventory of GEN 1 power amplifiers can be used as Field Replaceable Unit (FRU)
replacements.

All ASTRO® 25 system features are supported on GEN 1 and GEN 2 power amplifiers. All ASTRO® 25
system release software is supported on GEN 1 and GEN 2 power amplifiers.
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Identifying Power Amplifier Hardware Generation

Label
GEN 1 and GEN 2 power amplifier modules can be identified by examining the physical hardware
label. GEN 2 modules have a light blue label with ‘GEN 2’ clearly noted on it, while GEN 1 modules
have a white label with no GEN identification.

Figure 158: GEN 1 Power Amplifier Module

Figure 159: GEN 2 Power Amplifier Module

CSS
GEN 1 and GEN 2 power amplifier modules already installed in a system can be identified through the
Hardware Version screen of the Configuration/Service Software (CSS).

Power Amplifier FRU Number Mappings

Table 128: Power Amplifier FRU Number Mappings

Power Amplifier FRU Number
GEN 1
(Shipped before Nov 2013)

GEN 2
(Shipped starting July 2013)

Power Amplifier Module (900
MHz)

DLN6779A DLN6894A

Power Amplifier Module
(700/800 MHz)

DLN6567A DLN6895A

Power Amplifier Module (UHF
R2, 435–524 MHz)

DLN1347A DLN6896A

Table continued…
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Power Amplifier FRU Number
GEN 1
(Shipped before Nov 2013)

GEN 2
(Shipped starting July 2013)

Power Efficiency Power Amplifi-
er Module (UHF R2, 435–524
MHz)

DLN6792A

Power Amplifier Module (UHF
R1, 380–435 MHz)

DLN1396A

DLN6891APower Efficiency Power Amplifi-
er Module (UHF R1, 380–435
MHz)

DLN6788A

Power Amplifier Module (VHF,
136–174 MHz)

DLN1377A DLN6897A

Replacing a GTR 8000 Base Radio Transceiver Module
Figure 160: GTR 8000 Base Radio Transceiver Module

To help you locate the correct transceiver module, the metal card cage is stamped with numbers
matching the numbers in Figure 161: GTR 8000 Expandable Site Subsystem (repeater shown) on
page 359.
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Figure 161: GTR 8000 Expandable Site Subsystem (repeater shown)

Prerequisites: Before replacing the transceiver, pull configuration and hardware information from the
base radio into the Unified Network Configurator (UNC) by performing a “Pull All” procedure from the
UNC. For instructions on “How to Perform a Pull All”, see the Unified Network Configurator manual.
This step may not be possible if communication is severed between the base radio and the UNC or if
the base radio is within a K core or non-networked site. If this scenario exists, perform any one of the
following:

• Use the last known good configuration files from the UNC

• Extract the configuration files from the base radio directly

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

CAUTION: Wear the ESD throughout this procedure to prevent ESD damage to any
components.

2 Locate the transceiver module being replaced.

NOTICE: See Figure 161: GTR 8000 Expandable Site Subsystem (repeater shown) on
page 359 to help you locate the correct module. The metal card cage is stamped with
numbers matching the numbers in the diagram.

3 If the transceiver module is not operational, go to step 9.
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4 Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

5 Save the configuration to the laptop PC as follows:

a From the menu, select File → Read Configuration From Device.

b At the confirmation screen, click OK.

c When the Progress Monitor screen is complete, click OK.

d From the menu, select File → Save As.

e On the Properties Screen, enter the IP address of the base radio. Click OK.

f On the Save window, select the directory where you want to save the configuration file, type
a meaningful name for the file (use cpl as the extension or do not type an extension). Press
ENTER.

The configuration is saved to the location indicated. The configuration file is reloaded later to the
replacement transceiver module.

6 For a trunked base radio, place the base radio into Service Mode, so the system does not
attribute the loss of channel to a failure.

a From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

b Click Change to Service Mode.

c At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

7 Optional: It is not necessary to turn off the power supply for the transceiver module you are
replacing, as the modules are designed to be swapped out with the power on. If you choose to
turn off the power, set the rocker switch on the front of the associated power supply to the Off
(O) position.

8 Disconnect the Ethernet cable from the service port on the transceiver being replaced.

9 Remove the fan assembly unit to gain access to the transceiver module. See Replacing the Fan
Assembly on page 374.

IMPORTANT: Although the transceiver module is designed to be swapped out without
shutting the power off, you should minimize the amount of time that the fan assembly is
removed, so the circuitry that remains powered on does not overheat and shut down.

10 Label and disconnect all cables from the ports on the transceiver.

11 Using a T20 bit, loosen the two captive screws on the front of the transceiver module, so they
disengage from the chassis.

12 Using the handle, gently pull the transceiver module straight out, along the guides on which it
sits.

13 Slide the replacement transceiver module in the card cage slot stamped with the letters XCVR
and the number of the transceiver module you are replacing. Slide the transceiver module along
the guiding rails until it is engaged. A slight push may be needed to engage the module.

IMPORTANT: If the transceiver module stops well before it is engaged, it is in an
incorrect position. Either it is in the wrong slot or it is rotated 180 °. The module has a
keying feature that prevents it from going all the way into an incorrect slot, or going into
the correct slot but rotated 180 °. Do not try to force the module.

LEDs on the transceiver turn on when it is engaged.
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14 Secure the transceiver module to the chassis with the two captive screws on the front of the
module.

15 Reconnect all cables to the ports on the transceiver.

16 Reinstall the fan assembly unit. See Replacing the Fan Assembly on page 374.

17 Optional: If you chose to turn off the power, set the rocker switch on the front of the associated
power supply to the On (I) position.

18 Perform basic device configuration in CSS using the serial port. See Connecting Through a
Serial Port Link on page 258.

a Set the IP Address and BR_CM Pairing Number for the device. See Setting the Device IP
Address and Pairing Number in CSS on page 260.

b Set the Serial Security Services. See Setting the Serial Security Services in CSS on page
261.

19 Disconnect the laptop PC from the base radios serial service port.

20 Perform basic device configuration in CSS using the Ethernet port. See Connecting Through an
Ethernet Port Link on page 262.

a Set the current date and time. See Setting the Date and Time in CSS on page 265.

b Set up the local Password Configuration (optional). See Setting the Local Password
Configuration in CSS on page 271.

NOTICE: An IP address must be configured to set up the local password. If the serial
port access is not available to configure the IP address, the transceiver may have the
account locked out or the backplane slot has passwords enabled. Connect to the
front-panel local Ethernet service port using a fixed IP address to perform the
password reset. See Connecting Through an Ethernet Port Link on page 262.

21 Complete the configuration of the Information Assurance features using CSS, as follows:

a Change the SNMPv3 configuration and user credentials. See Changing SNMPv3
Configuration and User Credentials in CSS on page 265.

b Create, update, or delete an SNMPv3 user. See Adding or Modifying an SNMPv3 User in
CSS on page 268.

c Verify the SNMPv3 credentials. See Performing an SNMPv3 Connection Verification in CSS
on page 268.

d Set the SWDL transfer mode. See Setting the SWDL Transfer Mode in CSS on page 269.

e Configure for DNS. See Chapter 7, “Configuring DNS in CSS” in the Authentication Services
manual.

f Configure for SSH. See Chapter 4, “Configuring SSH for RF Site Devices VPMs in CSS” in
the Securing Protocols with SSH manual or see “Device Security Configuration Remote
Access/Login Banner (Ethernet)” in the CSS Online Help.

NOTICE: Restore the Clear Protocols parameters.

g Enable RADIUS Authentication. See Chapter 7, “Configuring RADIUS Sources and
Parameters in CSS” in the Authentication Services manual.

h Enable Centralized Authentication. See Chapter 7, “Enabling/Disabling Centralized
Authentication in CSS” in the Authentication Services manual.

i Set the Local Cache Size for Centralized Authentication. See Chapter 7, “Setting the Local
Cache Size for Central Authentication in CSS” in the Authentication Services manual.

j Enable Centralized Event Logging (if required by your organization). See Chapter 6,
“Enabling/Disabling Centralized Event Logging on Devices in CSS” and Chapter 1, “Event
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Logging Client Configuration” for proper hostnames in the Centralized Event Logging
manual.

k Set the NTP Server Settings. See NTP Server Settings in CSS on page 270.

22 For a conventional or trunked 3600 device, perform a single device software download to
transfer and install the latest base radio software using Software Download as follows:

a Open the Software Download application.

CAUTION: Make sure to load the correct version of the software. There is a possibility
of a mismatch in software versions when replacing the transceiver module with an on-
hand spare. If a mismatch in software versions occurs, this mismatch may cause all
base radios at the site to go into a configuration mode of operation with a reason of
‘Invalid Software Version’. To exit out of configuration mode, see CSS Procedures >
Changing from Configuration to Normal Mode in the CSS Online Help.

b
c From the menu, select File Manager → File.

The Software Depot File Manager opens.

d From the menu, select Component Operations → Import Fileset.
The Import a Fileset Into the Software Depot dialog box appears.

e Click Browse and search for the swdlv3.cfg file on the CD, or follow path E:\swdl
\swdlv1.cfg or swdlv3.cfg. Click Open.

f In the Software Depot list, click Generate to add the file to the Components. Click OK.

g Exit the Software Depot File Manager.
h From Software Download, select Single Device Mode.

i Enter the <IP address> of the device. Click Connect.

A Security Level screen appears.

j Choose the required security level. Click OK.

k In the Select an option window, select Upgrade Software Application. Click Continue.

l In the Operations Type field, select Transfer and Install.
m In the Application Type field , select the application to install.

n From the Software Component drop-down list, select a configuration fileset.

o Select Start Operation.

23 Perform a site download and installation for trunked ASTRO® 25 devices. See Performing a Site
Download on page 458.

A site software download is not available for conventional or trunked 3600 devices.

CAUTION: It is crucial that a site software download is performed at the site to ensure
that all devices are on the same software version, VLAN, and active bank. Failure to
perform this step, results in the replacement transceiver or expansion channel to have a
mismatch in software versions. If a mismatch in software versions occurs, the transceiver
may go into a configuration mode of operation with a reason of ‘Invalid Software Version’.

24 Restore the Codeplug Archive from backup. Reload the base radio configuration file on the new
base radio using CSS, as follows:

a From the menu, select File → Open.

b Locate and open the previously saved configuration file for the base radio.
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NOTICE: If you were not able to back up the configuration from the previous base
radio, you can use the configuration from your system build book or use the default
base radio configuration file. Specific settings for the base radio must still be
configured. See the CSS Online Help for GTR 8000 Base Radio for detailed
configuration instructions. If the base radio is part of a Power Efficiency Package,
make sure that the base radio Tx Power Out in the CSS is limited to 50 W.

c On the Properties window, click OK.

d When the Progress Monitor screen is complete, click OK.

e From the menu, select File → Write Configuration To Device. Click OK.

f On the Ethernet connection confirmation screen, click OK.

g On the Connection screen, enter the <IP address> and click Connect.

h On the SNMPv3 PassPhrase Prompt dialog box, enter the User Information and
Passphrase Information. Click OK. If Authentication Services are not enabled on a device,
click OK when the dialog box appears.

i On the confirmation screen, click OK.

j When the Progress Monitor screen is complete, click OK.

The configuration from the file selected is loaded into the base radio. Communication with the
base radio is not available until the reset is complete.

25 Read the base radio, as follows:

a From the menu, select File → Read Configuration From Device.

b On the confirmation screen, click OK.

c When the Progress Monitor screen is complete, click OK.

26 Place the base radio into Normal Mode, as follows:

a From the menu, select Service → Mode Screen.

The Mode Screen appears.

b Click Change to Normal Mode.

a At the confirmation screen, click OK.

The base radio goes through a reset sequence, which takes a few minutes, and switches
operation to the requested mode.

27 On systems with MAC Port locking, disable the locking and then re-enable the locking with the
MAC address of the base radio. The device being replaced may be connected to an Ethernet
port on a switch which implements MAC Port locking (HP switch, site controller, RDM, or XHub).
If so, the Ethernet switch port must be unlocked and relocked to the MAC address of the
replacement device. See the MAC Port Lockdown manual for instructions on how to disable and
enable MAC Port locking.

NOTICE: Following the device restoration, if it was connected to an HP switch port, the
HP switch port may have been disabled due to an unexpected MAC address. If so, re-
enable the port on the HP switch.

28 Replace the base radio in the UNC. See Chapter 4, “Replacing a Device” Unified Network
Configurator manual.

29 Discover the base radio in the UEM. See the Unified Event Manager manual.

30 Verify that the base radio is operating properly:

• The Status LED on the front of the base radio is green.
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• Proper operation is confirmed using software tools, such as Unified Event Manager (UEM),
and the Transmitter Metering Screen in Configuration/Service Software (CSS).

Replacing the GCP 8000 Site Controller Module
IMPORTANT: The site controller module can be hot swapped out without losing functionality.
The standby site controller automatically becomes the active site controller and takes over if the
active site controller is the one being swapped out.

Figure 162: GCP 8000 Site Controller FRU Module

Prerequisites: Before replacing the site controller, pull configuration and hardware information from
the site controller module into the Unified Network Configurator (UNC) by performing a “Pull All”
procedure from the UNC. For instructions on “How to Perform a Pull All” procedure, see the “Unified
Network Configurator” manual. This step may not be possible if communication is severed between the
site controller and the UNC or if the site controller is within a K1/K2 or non-networked site. If this
scenario exists, perform any one of the following:

• Use the last known good configuration files from the UNC.

• Extract the configuration files from the site controller directly.

Procedure:
1 Wear an Electrostatic Discharge (ESD) strap and connect its cable to a verified good ground.

CAUTION: Wear the ESD strap throughout this procedure to prevent ESD damage to
any components.

2 Locate the site controller module to be replaced.

NOTICE: See Figure 161: GTR 8000 Expandable Site Subsystem (repeater shown) on
page 359 to help you locate the correct module. The metal card cage is stamped with
numbers matching the numbers in the diagram.

3 If the site controller module is non-operational, go to step 8.

4 Connect to the site controller Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

5 Save the site controller configuration to the laptop PC as follows:

a From the menu, select File → Read Configuration From Device.

b At the success message, click OK.

c From the menu, select File → Save As.

d On the Properties window, enter the <IP address> of the device. Click OK.
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e Specify the directory location where you want to save the configuration file, type a meaningful
name for the file. Press ENTER.

The site controller configuration is saved to the location indicated. The configuration file is
reloaded later to the replacement site controller module.

6 Disable the site controller module as follows:

a From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

b Select the Site Controller tab.

c From the User Requested Site Controller State list box, select User Disabled.

The site controller module resets. After approximately two minutes, it is disabled. If this is the
active site controller module, control switches over to the standby site controller module.

7 Disconnect the Ethernet cable from the service port on the site controller being replaced.

8 Remove the fan assembly to gain access to the site controller module. See Replacing the Fan
Assembly on page 374.

IMPORTANT: The site controller module is designed to be swapped out without shutting
the power off. The fan assembly, however, must be in place within a reasonable amount
of time so the redundant site controller module does not overheat and shut down.

9 Label and disconnect all cabling on the front of the site controller module.

10 Loosen the two captive screws holding the site controller module to the chassis.

11 Using the handle, gently pull the used module straight out, along the guides on which it sits.

12 Slide in the replacement site controller module into the card cage slot stamped with the letters
SC and the number of the site controller module being replaced. Slide the site controller module
along the guiding rails until it is engaged. A slight push is needed to engage the module.

IMPORTANT: If the site controller module stops well before it is engaged, it is in an
incorrect position. Either it is in the wrong slot or it is rotated 180 °. The module has a
keying feature that prevents it from going all the way into an incorrect slot, or going into
the correct slot but rotated 180 °. Do not try to force the module.

13 Secure the site controller module with the two captive screws.

14 Reconnect all the cabling to the correct ports as previously labeled.

15 Reinstall the fan assembly. See Replacing the Fan Assembly on page 374.

16 Perform basic device configuration in CSS through the serial port. See Connecting Through a
Serial Port Link on page 258.

a Set the IP address of the device. See Setting the Device IP Address and Pairing Number in
CSS on page 260.

b Set the serial security services. See Setting the Serial Security Services in CSS on page 261.

17 Disconnect the laptop PC from the device modules DB-9 serial service port.

18 Perform basic device configuration in CSS through the Ethernet port. See Connecting Through
an Ethernet Port Link on page 262.

a Set the current date and time. See Setting the Date and Time in CSS on page 265.

b Set up the local Password Configuration (optional). See Setting the Local Password
Configuration in CSS on page 271.
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An IP address must be configured to set up the local password. If the serial port access is not
available to configure the IP address, the device may have the account locked out or the
backplane slot has passwords enabled. Perform the following:

1 Move the device module to a different slot in the backplane where local passwords are not
configured.

2 Configure the IP address and reset the device through the front panel RS-232 serial
service port using CSS.

3 Perform the local password reset operation (to clear account information stored in the
FRU) through and Ethernet port link using CSS.

4 Move the device module back to the original slot.

5 Perform the local password reset operation again (to clear account information stored in
the backplane).

19 Complete the configuration of the Information Assurance features using CSS, as follows:

a Change the SNMPv3 configuration and user credentials. See Changing SNMPv3
Configuration and User Credentials in CSS on page 265.

b Create, update, or delete an SNMPv3 user. See Adding or Modifying an SNMPv3 User in
CSS on page 268.

c Verify the SNMPv3 credentials. See Performing an SNMPv3 Connection Verification in CSS
on page 268.

d Set the SWDL transfer mode. See Setting the SWDL Transfer Mode in CSS on page 269.

e Configure for DNS. See Chapter 7, “Configuring DNS in CSS” in the Authentication Services
manual.

f Configure for SSH. See Chapter 4, “Configuring SSH for RF Site Devices and VPMs in CSS”
in the Securing Protocols with SSH manual or see “Device Security Configuration Remote
Access/Login Banner (Ethernet)” in the CSS Online Help.

NOTICE: Restore the Clear Protocols parameters.

g Enable RADIUS Authentication. See Chapter 7, “Configuring RADIUS Sources and
Parameters in CSS” in the Authentication Services manual.

h Enable Centralized Authentication. See Chapter 7, “Enabling/Disabling Centralized
Authentication in CSS” in the Authentication Services manual.

i Set the Local Cache Size for Centralized Authentication. See Chapter 7, “Setting the Local
Cache Size for Central Authentication in CSS” in the Authentication Services manual.

j Enable Centralized Event Logging (if required by your organization). See Chapter 6, “How to
Enable/Disable Centralized Event Logging on Devices in CSS” and Chapter 1, “Event
Logging Client Configuration” for proper hostnames in the Centralized Event Logging
manual.

20 Restore the Codeplug Archive from the backup. Using an Ethernet port link connection, reload
the site controller configuration file on to the new site controller using CSS, as follows:

a From the menu, select File → Open.

b Locate and select the previously saved configuration file for the site controller module. Click
OK.
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NOTICE: If you were not able to back up the configuration from the previous site
controller module, you can use the configuration from your system build book or use
the default configuration file for the site controller module. Specific settings for the site
controller module must still be configured. See CSS Online Help for detailed
configuration instructions.

c c) On the Properties window, click OK.

d When the Progress Monitor screen is complete, click OK.

e From the menu, select File → Write Configuration To Device. Click OK on the confirmation
message.

The configuration from the file you selected is loaded into the new site controller module.

21 Enable the site controller module as follows:

a From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

b Select the Site Controller tab.

c From the User Requested Site Controller State list box, select Enabled.

The site controller module is enabled after approximately two minutes.

22 Perform a site software download (SWDL) with the SNMPv3 package (if SNMPv3 is desired) of
the device and associated site devices. See Performing a Site Download on page 458.

23 Restore the 802.1x / MAC Port Lockdown feature as follows:

a Capture the MAC address of the device on the GCP 8000 switch for all devices connected to
the GCP 8000 Site Controller. See “Capturing the MAC Address of a Device Connected to a
GCP 8000” in the MAC Port Lockdown manual.

b Update/verify the site controller MAC Port Lockdown Configuration. See Chapter 6,
“Enabling/Disabling 802.1x and MAC Port Lockdown for GCP 8000 in CSS" and “Validating
MAC Port Lockdown on a GCP 8000 or GPB 8000” in the MAC Port Lockdown manual.

c Update/verify the site controller 802.1x configuration on HPD and repeater site controllers.
See “Enabling/Disabling 802.1x and MAC Port Lockdown for GCP 8000 in CSS” in the
802.1x Service Ports on Switches manual.

24 Replace the site controller in the UNC. See Chapter 4, “Replacing a Device” in the Unified
Network Configurator manual.

25 Discover the site controller in the UEM. See the Unified Event Manager manual.

26 Verify that the site controller module is operating properly:

• The Link Status LED for the RJ-45 Service port on the front of the new site controller module
is green.

• The Status LED on the front of the site controller is green.

• Use software tools, such as Unified Event Manager (UEM) and CSS, to verify the status of
the equipment.
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Replacing a GPB 8000 Reference Distribution Module (RDM)
Figure 163: GPB 8000 Reference Distribution Module

To help you locate the correct RDM, the metal card cage is stamped with numbers matching the
numbers in Figure 164: GTR 8000 Expandable Site Subsystem (trunked IP simulcast high availability
shown) on page 369.
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Figure 164: GTR 8000 Expandable Site Subsystem (trunked IP simulcast high availability
shown)

Prerequisites: Before replacing the device, pull configuration and hardware information from the
device into the Unified Network Configurator (UNC) by performing a “Pull All” procedure from the UNC.
For instructions on “How to Perform a Pull All”, see the Unified Network Configurator manual.
This step may not be possible if communication is severed between the device and the UNC. If this
scenario exists, perform any one of the following:

• Use the last known good configuration files from the UNC.

• Extract the configuration files from the device directly.

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

CAUTION: Wear the ESD strap throughout this procedure to prevent ESD damage to
any components.

2 Locate the RDM being replaced.

NOTICE: See Figure 164: GTR 8000 Expandable Site Subsystem (trunked IP simulcast
high availability shown) on page 369 to help you locate the correct module. The metal
card cage is stamped with numbers matching the numbers in the diagram.

3 If the RDM is not operational, go to step 9.
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4 Connect to the RDM Ethernet service port using Configuration/Service Software (CSS). See 
Connecting Through an Ethernet Port Link on page 262.

5 Save the configuration to the laptop PC as follows:

a From the menu, select File → Read Configuration From Device.

b At the success message, click OK.

c From the menu, select File → Save As.

d On the Properties Screen, enter the <IP address> of the RDM. Click OK.

e Specify the directory location where you want to save the configuration file, type a meaningful
name for the file (use cpl as the extension or do not type an extension). Press ENTER.

The configuration is saved to the location indicated. The configuration file is reloaded later to the
replacement RDM.

6 Disable the RDM as follows:

a From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

b Select the Reference Distribution Module tab.

c From the User Requested State list box, select User Disabled.

The RDM resets, after approximately two minutes, it is disabled.

7 Optional: If you choose to turn off the power, set the rocker switch on the front of the associated
power supply to the Off (O) position.

8 Disconnect the Ethernet cable from the service port on the RDM module being replaced.

9 Remove the fan assembly to gain access to the RDM. See Replacing the Fan Assembly on
page 374.

IMPORTANT: Although the RDM is designed to be swapped out without shutting the
power off, minimize the amount of time that the fan assembly is removed, so the circuitry
that remains powered on does not overheat and shut down.

10 Label and disconnect all cabling on the front of the RDM.

11 Using a T20 bit, loosen the two captive screws on the front of the RDM, so they disengage from
the chassis.

12 Using the handle, gently pull the RDM straight out, along the guides on which it sits.

13 Slide in the replacement RDM into the card cage slot stamped with the letters SC and the
number of the RDM being replaced. Slide the RDM along the guiding rails until it is engaged. A
slight push may be needed to engage the module.

IMPORTANT: If the RDM stops well before it is engaged, it is in an incorrect position.
Either it is in the wrong slot or it is rotated 180 °. The module has a keying feature that
prevents it from going all the way into an incorrect slot, or going into the correct slot but
rotated 180 °. Do not try to force the module.

The LEDs on the RDM turn on when it is engaged.

14 Using a T20 bit, secure the RDM to the chassis with the two captive screws on the front of the
module.

15 Reconnect all the cabling to the correct ports as previously labeled.

16 Reinstall the fan assembly. See Replacing the Fan Assembly on page 374.
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17 Optional: If you chose to turn off the power, set the rocker switch on the front of the associated
power supply to the On (I) position.

18 Perform basic device configuration using the serial port. See Connecting Through a Serial Port
Link on page 258.

a Set the IP Address and the Box Number for the device. See Setting the Device IP Address
and Pairing Number in CSS on page 260.

b Set the Serial Security Services. See Setting the Serial Security Services in CSS on page
261.

19 Disconnect the laptop PC from the RDMs DB-9 serial service port.

20 Perform basic device configuration using the Ethernet port. See Connecting Through an
Ethernet Port Link on page 262.

a Set the current date and time. See Setting the Date and Time in CSS on page 265.

b Set up the local Password Configuration (optional). See Setting the Local Password
Configuration in CSS on page 271.

An IP address must be configured to set up the local password. If the serial port access is not
available to configure the IP address, the device may have the account locked out or the
backplane slot has passwords enabled. Perform the following:

1 Move the device module to a different slot in the backplane where local passwords are not
configured.

2 Configure the IP address and reset the device through the front panel RS-232 serial
service port using CSS.

3 Perform the local password reset operation (to clear account information stored in the
FRU) through and Ethernet port link using CSS.

4 Move the device module back to the original slot.

5 Perform the local password reset operation again (to clear account information stored in
the backplane).

21 Complete the configuration of the Information Assurance features in CSS, as follows:

a Change the SNMPv3 configuration and user credentials. See Changing SNMPv3
Configuration and User Credentials in CSS on page 265.

b Create, update, or delete an SNMPv3 user. See Adding or Modifying an SNMPv3 User in
CSS on page 268.

c Verify the SNMPv3 credentials. See Performing an SNMPv3 Connection Verification in CSS
on page 268.

d Set the Software Download Manager (SWDL) transfer mode. See Setting the SWDL Transfer
Mode in CSS on page 269.

e Configure DNS using the CSS. See Chapter 7, “Configuring DNS in CSS” in the
Authentication Services manual.

f Configure for Secure SHell (SSH). See Chapter 4, “Configuring SSH for RF Site Devices and
VPMs in CSS” in the Securing Protocols with SSH manual or see “Device Security
Configuration Remote Access/Login Banner (Ethernet)” in the CSS Online Help.

g Restore the following Clear Protocols parameters in the Remote Access Configuration tab on
the Device Security Configuration screen in CSS. See “Device Security Configuration
Remote Access/Login Banner (Ethernet)” in the CSS Online Help.

h Enable RADIUS Authentication . See Chapter 7, “Configuring RADIUS Sources and
Parameters in CSS” in the Authentication Services manual.
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i Enable Centralized Authentication. See Chapter 7, “Enabling/Disabling Centralized
Authentication in CSS” in the Authentication Services manual.

j Set the Local Cache Size for Centralized Authentication in CSS. See Chapter 7, “Setting the
Local Cache Size for Central Authentication in CSS” in the Authentication Services manual.

k Enable Centralized Event Logging (if required by your organization). See Chapter 6,
“Enabling/Disabling Centralized Event Logging on Devices in CSS” and Chapter 1, “Event
Logging Client Configuration” for proper hostnames in the Centralized Event Logging
manual.

l Set the NTP Server Settings. See NTP Server Settings in CSS on page 270.

22 Perform a single device download to transfer and install the latest RDM software using Software
Download as follows:

a Open the Software Download application.

CAUTION: Load the correct version of the software. There is a possibility of a
mismatch in software versions when replacing the RDM with an on-hand spare. If a
mismatch in software versions occurs, it may cause all base radios at the site to go
into a configuration mode of operation with a reason of 'Invalid Software Version'. To
exit the base radios out of configuration mode, see CSS Procedures > Changing from
Configuration to Normal Mode in the CSS Online Help.
If a mismatch in software versions occurs with an RDM, the mismatch may cause a
'critical malfunction', or if the RDM becomes active, may bring the entire site into a
configuration mode of operation.

b From the menu, select File → File Manager.
The Software Depot File Manager opens.

c From the menu, select Component Operations → Import Fileset.
The Import a Fileset Into the Software Depot dialog box appears.

d Click Browse and search for the swdlv3.cfg file on the CD, follow the path E:\swdl
\swdlv1.cfg or swdlv3.cfg. Click Open.

e Click Generate to add the file to the Components In the Software Depot list. Click OK.

f Exit the Software Depot File Manager.
g From Software Download, select Single Device Mode.

h Enter the <IP address> of the device. Click Connect.

A Security Level screen appears.

i Choose the required security level. Click OK.

j In the Select an Option drop down list, select Upgrade Software Application. Click
Continue.

k In the Operations Type drop down list, select Transfer and Install.
l In the Application Type drop down list, select the application to install.

m Select Start Operation.

The software is transferred and installed on to the device. The transfer and install takes
several minutes to complete. When completed, the two progress bars on the Transfer and
Install window display 100% and a completion message displays in the Transfer message
box.

23 Restore the Codeplug Archive from the backup. Reload the configuration file into the RDM using
CSS as follows:
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a From the CSS menu, select File → Open.

b Locate and open the previously saved configuration file for the RDM.

NOTICE: If you were not able to back up the configuration from the previous RDM,
you can use the configuration from your system build book or use the default RDM
configuration file. Specific settings for the RDM must still be configured. See Site
Controller Configuration & Service Help > GPB 8000 Reference Distribution in the
CSS Online Help for RDM detailed configuration instructions.

c On the Properties window, click OK.

d When the Progress Monitor screen is complete, click OK.

e From the menu, select File → Write Configuration To Device. Click OK on the confirmation
message.

The configuration from the file you selected is loaded into the RDM. Communication with the
RDM is not available until the reset is complete.

24 Enable the RDM as follows:

a From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

b Select the Reference Distribution tab.

c From the User Requested State list box, select Enabled.

The RDM is enabled.

25 On systems with MAC Port locking, disable the locking and then re-enable the locking with the
MAC address of the RDM. The device being replaced may be connected to an Ethernet port on
a switch which implements MAC Port locking (XHub). If so, the Ethernet switch port must be
unlocked and relocked to the MAC address of the replacement device. See the MAC Port
Lockdown manual for instructions on how to disable and enable MAC Port locking.

26 Replace the RDM in the UNC. See Chapter 4, “Replacing a Device” in the Unified Network
Configurator manual.

27 Discover the RDM in the UEM. See the Unified Event Manager manual.

28 Verify that the RDM is operating properly:

• The Status LED on the front of the RDM is green.

• Proper operation is confirmed using software tools, such as UEM, and Configuration/Service
Software (CSS).

• Recalibrate the GPS Unit Cable Length Delay Offset. See 1PPS Reference Synchronization
on page 287.

Replacing the Expansion Hub
When an Expansion Hub is removed, the GCP 8000 Site Controller detects the XHub is not in place
and sends a switch fault to the Unified Event Manager. When the XHub is replaced, the site controller
automatically detects the new one, enables it, and sends a message to clear the fault in the Unified
Event Manager.
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Figure 165: Expansion Hub FRU

IMPORTANT: The Expansion Hub can be hot swapped out without losing functionality. The
redundant Expansion Hub automatically becomes active and takes over.

Procedure:
1 Wear an Electrostatic Discharge (ESD) strap and connect its cable to a verified good ground. Be

sure to wear this strap throughout this procedure to prevent ESD damage to any components.

2 Remove the fan assembly to gain access to the Expansion Hub module. See Replacing the Fan
Assembly on page 374.

IMPORTANT: The Expansion Hub module can be swapped out without shutting the
power off.

3 Label and disconnect all cabling on the front of the Expansion Hub.

4 Using T20 bit, loosen the two captive screws holding the Expansion Hub to the chassis.

5 Using the handle, gently pull the used Expansion Hub straight out, along the guides on which it
sits.

6 Slide in the replacement Expansion Hub module into the card cage slot stamped with the letters
SC. Slide the Expansion Hub module along the guiding rails until it is engaged. A slight push is
needed to engage it.

IMPORTANT: If the Expansion Hub stops well before it is engaged, then it is in an
incorrect position. Either it is in the wrong slot or it is rotated 180 °. The module has a
keying feature that prevents it from going all the way into an incorrect slot, or going into
the correct slot but rotated 180 °. Do not try to force it.

7 Using a T20 bit, secure the Expansion Hub module with the two captive screws.

8 Reconnect all the cabling to the correct ports as previously labeled.

9 Reinstall the fan assembly. See Replacing the Fan Assembly on page 374.

10 Verify that the Expansion Hub module is operating properly:

• The Link Status LED for the RJ-45 EXPSN Input port on the front of the new Expansion Hub
is green.

• The Status LED on the front of the Expansion Hub is green.

• Use software tools, such as Unified Event Manager, to check the alarms of the equipment.

Replacing the Fan Assembly
To prevent overheating, this fan must be in place at all times, except during servicing.
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WARNING: When removing a fan module, care should be taken to avoid contacting moving fan
blades before and after removal with tools, hands, or other objects. If you are removing the fan
module to access or replace the modules behind it, turn off the equipment power and allow the
modules to cool before performing any work, as the surfaces of the modules can be extremely
hot.

IMPORTANT: The fan assembly can be swapped out without shutting the power off. The
replacement fan assembly must be in place within a reasonable amount of time, so that the
device module does not overheat and shut down.

Figure 166: Fan Assembly

Procedure:
1 Wear an electrostatic discharge (ESD) wrist strap and connect its cable to a verified good

ground. This strap must be worn throughout this procedure to prevent ESD damage to any
components.

2 Using a T20 bit, loosen the three captive screws on the front of the fan assembly, so they
disengage from the chassis.

3 Using the handle on one end and the edge on the other side, gently pull the fan assembly
straight out to disengage the connector.

4 NOTICE: If the GTR 8000 Expandable Site Subsystem is part of a power efficiency
package configuration, the DLN6898A fan module must be used. If the replacement fan
module was converted for single fan operation, make sure to convert it for dual fan
operation before installing. The DLN6898A fan module can also be used in a non power
efficiency package configuration.

Convert for dual fan operation:

a Lift each connector end out of the pockets of the rubber retainer.

b Connect the connector ends together.

c Place the connector harness back into the rubber retainer.

5 Using the guide pins and the connector on the back of the new fan assembly, push the new fan
assembly into place until it feels secure.

6 Using a T20 bit, tighten the three captive screws. Torque to 17 ± 2 in-lb.
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7 Verify that the fan assembly is operating properly, and the fan Alarm LED is off. You can also
use software tools, such as Unified Event Manager or Configuration/Service Software (CSS) to
verify the status of the equipment.

Replacing a Power Supply
WARNING: The power supply module contains dangerous voltages which can cause electrical
shock to personnel or damage to equipment.

IMPORTANT: The MCPN1082 and 01825165W12 power supplies are not compatible in the
900 MHz frequency band.

NOTICE: The power supply output is directly mapped to a Power Amplifier (PA)/transceiver
combination. Removal of a power supply results in a loss of the associated transmit channel
until the replacement power supply is inserted and turned ON.
Place the channel into Service Mode before replacing the module so that the system does not
attribute the loss of channel to a failure. Placing a channel into Service Mode is performed
using either the Unified Event Manager (UEM) or the Configuration/Service Software (CSS).

The power supply can be removed without disabling the site controllers. Auxiliary power is
available to the site controllers from any other power supply in the cabinet. An AUX DC bus is
automatically set up to provide backup power to the site controllers.

Figure 167: Power Supply

Procedure:
1 Wear an Electrostatic discharge (ESD) wrist strap and connect its cable to a verified good

ground.

CAUTION: Wear The ESD strap throughout this procedure to prevent ESD damage to
any components.

2 Place the base radio using the power supply module being replaced into Service Mode.

a Connect to the base radio transceiver module Ethernet service port using CSS. See 
Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.
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c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

3 Push the power rocker switch to Off (O) on the power supply unit.

4 Using a T20 bit, loosen the two captive screws on the front of the power supply to disengage
them from the chassis.

WARNING: Let the power supply module cool before performing the following step which
exposes surfaces of the module that can be extremely hot.

5 Pull on the metal handle to disengage the power supply from the backplane, and remove it
completely from the chassis.

6 Slide the replacement power supply into place, pushing gently until it seats.

7 Using a T20 bit, tighten the two captive screws on the front of the power supply.

8 Turn the power button to On (I), and verify that the power supply is operating properly:

• The power supply Status LED is green.

• The power supply Alarm LED is off.

• The power supply Fan LED is off.

• Confirm proper operation using software tools, such as the UEM, and the Power Supply
Metering Screen in CSS.

9 Place the base radio into Normal Mode, as follows:

a From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

b Click Change to Normal Mode.

c At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

Replacing a Power Supply Fan
WARNING: The power supply module contains dangerous voltages which can cause electrical
shock to personnel or damage to equipment.

NOTICE: Replacing the power supply fan requires removing the power supply module. The
power supply output is directly mapped to a Power Amplifier (PA)/transceiver combination.
Removal of a power supply results in a loss of the associated transmit channel until the
replacement power supply is inserted and turned ON.
Place the channel into Service Mode before replacing the module so that the system does not
attribute the loss of channel to a failure. Placing the channel into Service Mode is performed
using either the Unified Event Manager (UEM) or Configuration/Service Software (CSS).

A power supply can be removed without disabling site controllers if the site controllers are
cabled to auxiliary power. Auxiliary power is available from any transceiver still connected to a
power supply. An AUX DC bus is automatically set up to provide backup power to the site
controllers.
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Figure 168: Power Supply Fan

Procedure:
1 Wear an Electrostatic Discharge (ESD) wrist strap and connect its cable to a verified good

ground.

CAUTION: Wear the ESD strap throughout this procedure to prevent ESD damage to
any components.

2 Place the base radio associated with the power supply fan being replaced into Service Mode.

a Connect to the device module Ethernet service port using CSS. See Connecting Through an
Ethernet Port Link on page 262.

b From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

3 Set the rocker switch on the front of the power supply to Off (O).

4 Using a T20 bit, loosen the two captive screws on the front of the power supply module to
disengage them from the chassis.

WARNING: Let the power supply module cool before performing the following step,
which exposes surfaces of the module that can be extremely hot.
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5 Pull on the metal handle to disengage the power supply from the backplane, and remove it
completely from the chassis.

6 Remove the fan cover from the power supply module:

a Using a T15 bit, remove the four screws that connect the cover to the sides of the power
supply module.

b Slide the cover off (tilting the top edge out and lifting the bottom edge above the power
supply handle).

7 Disconnect the power cable located above the fan.

8 Remove the two screws that secure the fan to the power supply.

9 Remove the fan and insert the new fan.

10 Secure the fan to the power supply with the two screws removed in step 8.

11 Attach the power cable for the fan to the connection on the power supply.

12 Replace the fan cover:

a Slide the cover on, tilting the bottom edge in, past the power supply handle.

b Using a T15 bit, insert and tighten the four screws that connect the cover to the sides of the
power supply module.

13 Slide the power supply into place, pushing gently until it seats.

14 Using a T20 bit, tighten the two captive screws on the front of the power supply module.

15 Turn the power button to On (I), and verify that the power supply is operating properly:

• The power supply Status LED is green.

• The power supply Alarm LED is off.

• The power supply Fan LED is off and the fan is operating.

• Proper operation is confirmed using software tools, such as the UEM, and the Power Supply
Metering Screen in CSS.

16 Place the base radio into Normal Mode, as follows:

a From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

b Click Change to Normal Mode.

c At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

Replacing a Power Amplifier
Figure 169: Power Amplifier Module on page 380 shows the power amplifier FRU module and the
captive screws that secure the power amplifier module to the metal card cage. The location of these
screws is similar for the GTR 8000 Expandable Site Subsystem, except the module is positioned
vertically.
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Figure 169: Power Amplifier Module

See Figure 170: GTR 8000 Expandable Site Subsystem (repeater shown) on page 381 to help you
locate the correct module. The metal card cage is stamped with numbers matching the numbers.
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Figure 170: GTR 8000 Expandable Site Subsystem (repeater shown)

Procedure:
1 Wear an electrostatic discharge (ESD) wrist strap and connect its cable to a verified good

ground. This strap must be worn throughout this procedure to prevent ESD damage to any
components.

2 If the power amplifier is not operational, go to step 5.

3 Place the base radio associated with the power amplifier module being replaced into Service
Mode so the system does not attribute the loss of channel to a failure.

a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test and Measurement Screen.

c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

4 Optional: If you choose to turn off the power, set the rocker switch on the front of the associated
power supply to the Off (O) position.

It is not necessary to turn off the power supply for the power amplifier module you are replacing,
as the power amplifier modules can be swapped out with the power on.
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5 Remove the fan assembly to gain access to the power amplifier module. See Replacing the Fan
Assembly on page 374.

WARNING: Let the power amplifier module cool before performing the following step,
which exposes surfaces of the module that can be extremely hot.

IMPORTANT: The power amplifier module is designed to be swapped out without
shutting the power off. However, minimize the amount of time that the fan is removed, so
the circuitry that remains powered on does not overheat and shut down.

6 Using a T20 bit, loosen the two captive screws on the front of the power amplifier module so
they disengage from the chassis.

7 Remove the RF output QN connector from the front of the power amplifier module, as follows.

a Pull the power amplifier out of the chassis far enough so that the QN (quick-N) RF output
connector is accessible.

b Disconnect the cable from the power amplifier.

Figure 171: Power Amplifier RF Cable (Front)

8 Using the handle, gently pull the power amplifier module straight out, along the guides on which
it sits.

9 Reconnect the RF cable to the RF output QN connector on the front of the power amplifier
module, as follows:

a While holding the RF cable, slide in the replacement power amplifier module along the
guiding rails until the RF cable connector can reach the RF connection on the front of the
module.

b Push the RF cables connector on to the modules connector until it snaps securely into place.

10 Slide in the replacement power amplifier module into the correct card cage until it engages with
the backplane. A slight push may be needed to engage the module.

IMPORTANT: If the power amplifier module stops well before it is engaged, it is in an
incorrect position. Either it is in the wrong slot or it is rotated 180 °.

11 Using a T20 bit, secure the power amplifier module to the chassis with the two captive screws
on the front of the module.

12 Reinstall the fan assembly. See Replacing the Fan Assembly on page 374.

13 Optional: If you chose to turn off the power, set the rocker switch on the front of the associated
power supply to the On (I) position.
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14 Verify that the power amplifier is operating properly.

• The power amplifier Status and Transmit LEDs are green.

• The Alarm LED is off.

• Proper operation is confirmed using software tools, such as Unified Event Manager, and the
Transmitter Metering Screen in Configuration/Service Software (CSS).

15 Place the base radio into Normal Mode, as follows:

a From the menu, select Service → Test and Measurement Screen.

b Click Change to Normal Mode.

c At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

Replacing a GTR 8000 Expandable Site Subsystem Backplane
The backplane is the circuit board at the rear of the GTR 8000 Expandable Site Subsystem which
connects the base radios and site controller modules. Figure 172: GTR 8000 Expandable Site
Subsystem Backplane Diagram on page 384 shows the metal cover and screws that must be removed
to access the backplane.

NOTICE: Powering down the GTR 8000 Expandable Site Subsystem causes any affiliated
subscribers to relocate to another channel at the site or another channel at an adjacent site.
Place the channels into Service Mode before powering down, so that the system does not
attribute the loss of channel to a failure.
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Figure 172: GTR 8000 Expandable Site Subsystem Backplane Diagram

IMPORTANT: Contact Motorola before and after performing this procedure to obtain
instructions for essential additional steps. See Motorola Solution Support Center on page 344.

NOTICE: The procedure assumes the following service access clearances:

• At least 2 ft access at the front of the cabinet or rack

• At least 6 in. at the rear of the cabinet or rack

See Figure 173: GTR 8000 Expandable Site Subsystem (repeater shown) on page 385 to help you
label each module as you remove it from the backplane. The metal card cage is engraved with
numbers matching the numbers.
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Figure 173: GTR 8000 Expandable Site Subsystem (repeater shown)

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 If the GTR 8000 Expandable Site Subsystem is not operational, go to step 6.

3 Place all channels that are using the backplane being replaced into Service Mode, as follows:

a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

4 Disable the RDM modules, if installed in the cabinet/rack as follows:

a Connect to the RDM Ethernet service port using Configuration/Service Software (CSS). See 
Connecting Through an Ethernet Port Link on page 262.
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b From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

c Select the Reference Distribution Module tab.

d From the User Requested State list box, select User Disabled.

The RDM resets, after approximately two minutes, it is disabled. If this is the active RDM,
control switches over to the standby RDM.

e Repeat steps a through d for the other RDM module.

5 Disable the site controller modules, if installed in the cabinet/rack as follows:

a Connect to the network and access the appropriate site controller using Configuration/
Service Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

c Select the Site Controller tab.

d From the User Requested Site Controller State list box, select User Disabled.

The site controller module resets, after approximately two minutes, it is disabled. If this is the
active site controller module, control switches over to the standby site controller module.

e Repeat steps a through d for the other site controller module.

6 Push the power rocker switch to Off (O) on each power supply unit.

7 Remove the fan assembly units to gain access to the transceiver, power amplifier, site controller,
XHubs, or RDMs. See Replacing the Fan Assembly on page 374.

8 Using a T20 bit, loosen the two captive screws on the front of the power amplifier modules so
they disengage from the card cage.

9 Remove the RF output QN connector from the front of the power amplifier modules, as follows.

a Pull the power amplifier out of the card cage far enough so the QN (quick-N) RF output
connector is accessible.

b Disconnect the cable from the power amplifier.

Figure 174: Power Amplifier RF Cable (Front)
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10 Using the handle, gently pull the power amplifier modules straight out, along the guides on which
it sits, to completely remove it from the card cage.

11 Label each power amplifier module with the letters PA and the number engraved in the metal
card cage above the slot from which you are removing the module.

12 Label and disconnect all cabling on the front of each transceiver, site controller, XHub, or RDM
modules.

13 Remove each transceiver, site controller, XHub, or RDM modules from the card cage as follows:

a Using a T20 bit, loosen the two captive screws on the front of each module, so that they
disengage from the card cage.

b Using their handles, gently pull the modules until they disengage from the backplane.

c Label each module with letters (XCVR, SC, XHUB, or RDM) and the number engraved in the
metal card cage above the slot from which you are removing the module.

d Slide the modules out of the card cage.

14 Remove the fan multi-pin connectors from their ports on the backplane, working from the front of
the card cage, with the backplane still secured to the card cage by squeezing the sides of the
connector and tilting the connector to one side while disengage it from the backplane.

15 Label, then disconnect all cables from the rear of the main GTR 8000 Expandable Site
Subsystem card cage. The cables do not need disconnecting from the power supply card cage.

16 Remove the four corner screws and the thirteen additional screws that secure the metal
backplane cover and the backplane circuit board to the rear of the card cage.

17 Remove the metal backplane cover and the backplane circuit board.

18 Place the new backplane circuit board in the same location and orientation as the one that you
removed.

19 Secure the new backplane circuit board and the backplane cover to the rear of the card cage
with the screws previously removed.

20 Connect the fan cables multi-pin connectors to the new backplane, working from the front of the
card cage, with the backplane secured to the card cage.

21 Reconnect the RF cable to the RF output QN connector on the front of each power amplifier
module, as follows:

a While holding the RF cable, slide in the power amplifier module into the card cage slot
engraved with the letters PA and along the guiding rails until the RF cable connector reaches
the RF connection on the front of the module.

b Push the RF cables connector on to the modules connector until it snaps securely into place.

22 Slide in each power amplifier module until it engages with the backplane. A slight push may be
needed to engage the module.

IMPORTANT: If the power amplifier module stops well before it is engaged, it is in an
incorrect position. Either it is in the wrong slot or it is rotated 180 °.

23 Slide each transceiver, site controller, XHub, or RDM modules into the card cage slot engraved
with the appropriate number of the module you are reinstalling. A slight push may be needed to
engage the modules.

IMPORTANT: If the module stops well before it is engaged, it is in an incorrect position.
Either it is in the wrong slot or it is rotated 180 °.

24 Using a T20 bit, secure all modules to the card cage with the two captive screws on the front of
each module.

25 Reinstall the fan assembly units. See Replacing the Fan Assembly on page 374.
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26 Reconnect all cables to the card cage backplane.

27 Reconnect all cables to the transceiver, site controller, XHub, or RDM modules.

28 Set the power supply rocker switches to On (1).

29 Enable the site controller modules, if installed in the cabinet/rack as follows:

a Connect to the network and access the appropriate site controller using Configuration/
Service Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Service Panel Screen.

The Status Panel Screens window appears.

c Select the Site Controller tab.

d From the User Requested Site Controller State list box, select Enabled.

The site controller module is enabled after approximately two minutes.

e Repeat steps a through d for the other site controller module.

30 Enable the RDM modules, if installed in the cabinet/rack as follows:

a Connect to the RDM’s Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

c Select the Reference Distribution tab.

d From the User Requested State list box, select Enabled.

The RDM is enabled.

e Repeat steps a through d for the other RDM module.

31 Place each base radio into Normal Mode, as follows:

a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Normal Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

32 Verify that the LEDs indicate the modules you removed and reinstalled are operational.

• The Status LEDs are green.

• The Alarm LEDs are off.

• The power supply Fan LED is off.

33 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using software tools,
such as Unified Event Manager, and Configuration/Service Software (CSS).

34 Reconfigure the Security Settings into the Backplane. See Setting the Serial Security Services in
CSS on page 261.
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Replacing a GTR 8000 Expandable Site Subsystem Power
Supply Backplane
The power supply backplane is the circuit board at the rear of the GTR 8000 Expandable Site
Subsystem which connects the power supplies. The battery temperature sensor cable also connects to
this backplane. Figure 175: GTR 8000 Expandable Site Subsystem Power Supply Backplane Diagram
on page 389 shows the metal cover that must be removed to access the backplane, and the ports for
cables that must be disconnected to remove the cover.

Figure 175: GTR 8000 Expandable Site Subsystem Power Supply Backplane Diagram

Prerequisites: The procedure assumes the following service access clearances:

• At least 2 ft access at the rear of the cabinet or rack, or

• At least 2 ft access on one side of the cabinet or rack, and at least 6 inches at the rear of the
cabinet or rack

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 If the GTR 8000 Expandable Site Subsystem is not operational, go to step 6.

3 Place each channel using the power supply backplane being replaced into Service Mode so that
the system does not attribute the loss of channel to a failure, as follows:

a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

4 Disable the RDM modules, if installed in the cabinet/rack as follows:

a Connect to the RDM Ethernet service port using Configuration/Service Software (CSS). See 
Connecting Through an Ethernet Port Link on page 262.
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b From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

c Select the Reference Distribution Module tab.

d From the User Requested State list box, select User Disabled.

The RDM resets, after approximately two minutes, it is disabled. If this is the active RDM,
control of trunking switches over to the standby RDM.

e Repeat steps a through d for the other RDM module.

5 Disable the site controller modules, if installed in the cabinet/rack as follows:

a Connect to the network and access the appropriate site controller using Configuration/
Service Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

c Select the Site Controller tab.

d From the User Requested Site Controller State list box, select User Disabled.

The site controller module resets, after approximately two minutes, it is disabled. If this is the
active site controller module, control switches over to the standby site controller module.

e Repeat steps a through d for the other site controller module.

6 Push the power rocker switch to Off (O) on each power supply unit.

7 Disengage each power supply from the backplane as follows:

a Using a T20 bit, loosen the two captive screws on the front of the power supply, so they
disengage from the chassis.

WARNING: Let the power supply module cool before performing the following step,
which exposes surfaces of the module that can be extremely hot.

b Pull on the metal handle to disengage the power supply from the backplane.

8 Label, then disconnect all cables from the rear of the power supply card cage.

9 Remove the screws that secure the metal backplane cover and the backplane circuit board to
the rear of the power supply card cage.

10 Remove the metal backplane cover and the backplane circuit board.

11 Place the new backplane circuit board in the same location and orientation as the one that you
removed.

12 Secure the new backplane circuit board and the backplane cover to the rear of the power supply
card cage with the screws previously removed.

13 Slide each power supply into place, pushing gently until it engages with the backplane.

14 Tighten the two captive screws on the front of each power supply.

15 Reconnect all cables to the power supply card cage backplane.

16 Set the power supply rocker switches to On (I), and verify that each power supply is operating
properly.

• The power supply Status LED is green.

• The power supply Alarm LED is off.

• The power supply Fan LED is off.

17 Enable the site controller modules, if installed in the cabinet/rack as follows:
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a Connect to the network and access the appropriate site controller using Configuration/
Service Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Service Panel Screen.

The Status Panel Screens window appears.

c Select the Site Controller tab.

d From the User Requested Site Controller State list box, select Enabled.

The site controller module is enabled after approximately two minutes.

e Repeat steps a through d for the other site controller module.

18 Enable the RDM modules, if installed in the cabinet/rack as follows:

a Connect to the RDM Ethernet service port using Configuration/Service Software (CSS). See 
Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Status Panel Screen.

The Status Panel Screens window appears.

c Select the Reference Distribution tab.

d From the User Requested State list box, select Enabled.

The RDM is enabled.

e Repeat steps a through d for the other RDM module.

19 Place each base radio into Normal Mode, as follows:

a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Normal Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

20 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using software tools,
such as:

• Configuration/Service Software (CSS)

• Unified Event Manager

Replacing a Subpanel on the GTR 8000 Expandable Site
Subsystem Junction Panel
The subpanels on the GTR 8000 Expandable Site Subsystem junction panel provide the locations for
all the connections to external devices.
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Figure 176: Example of a GTR 8000 Expandable Site Subsystem Subpanels

WARNING: Shock hazard. The GTR 8000 Expandable Site Subsystem contains dangerous
voltages, which can cause electrical shock or damage to equipment. Remove the AC and DC
sources when servicing the junction panel. Also, for a GTR 8000 Expandable Site Subsystem,
shut down any other expansion cabinet/racks that are connected to it. Electrical installation
work shall be carried out in accordance with the current edition of the NFPA 70 and local
building codes. Where required, only a qualified and licensed electrician shall be used for all
electrical installations.

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

3 NOTICE: Powering down the GTR 8000 Expandable Site Subsystem causes any
affiliated subscribers to relocate to another channel at an adjacent site. Disable the site
before powering down, so that the system does not attribute the loss of channel to a
failure.

To disable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.
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If… Then…

c Click in the User Requested Site State cell of the subsite to be
disabled and choose User Ignore.

The site is disabled.

4 Push the power rocker switch to Off (O) on each power supply unit.

5 Set all the AC supply breakers to the OFF position and open up the DC battery disconnects to
power down the entire GTR 8000 Expandable Site Subsystem. Also shut down any other
expansion cabinets/racks that are connected to the GTR 8000 Expandable Site Subsystem.

6 Label all cables going into the top-side and bottom-side of the junction panel for the subpanel
being removed.

7 Disconnect all cables from the top-side of the subpanel. Cables disconnect with twist-lock
features, threaded housings, snap tabs, or screw locks.

8 Disconnect all cables from the bottom-side of the subpanel. For cables connected directly to the
subpanel, this can typically be accomplished by removing fasteners or jam nuts. Some cables,
such as Telco networking cables, plug into a panel mount coupler.

9 Using a T20 bit, remove the two M4 fasteners that secure the subpanel to the junction panel
frame and remove the old subpanel.

10 Place the new subpanel into the opening.

11 Using a T20 bit, secure the subpanel with the two M4 fasteners. Torque to 15 in.-lbs.

12 Reconnect all cables to the top- and bottom-side of the subpanel.

13 For configuration changes, review the upgrade instructions for required cable connections.
Some subpanels are not used in all configurations.

a Remove cables in the rack no longer required. One or more fan assembly units may be
removed to access all connections. See Replacing the Fan Assembly on page 374.

b Install any required new cabling to the rack.

c Install any new site level cabling from external devices to the junction panel.

d Label the ends of any new cabling that connect to the subpanels for reference.

e Remove the plastic label knockouts of the new cables being installed. Leave all unused
knockouts in place to prevent debris from entering the cabinet/rack.

f Install new Telco panel mount couplers, if required.

g Install all rack equipment cables to the subpanel and install each cable.

h Reconnect reused and new site cabling going to the cabinet/rack to the appropriate
connections.

i Reinstall any fan assembly units. See Replacing the Fan Assembly on page 374.

14 Set all the AC supply breakers to the ON position and connect the DC battery to power up the
GTR 8000 Expandable Site Subsystem. Also restore power to any other expansion cabinets/
racks that are connected to the GTR 8000 Expandable Site Subsystem.

15 Set the power supply rocker switches to On (I).

16 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

17 To enable the site, perform one of the following actions:
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If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

18 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using software tools,
such as Unified Event Manager, and Configuration/Service Software (CSS).

AC/DC Power Distribution Module Replacement
The power distribution module in the GTR 8000 Expandable Site Subsystem includes all AC and DC
output cables that power the GTR 8000 Expandable Site Subsystem. This cabling is in place when you
receive the system.

Figure 177: AC/DC Distribution Module for the GTR 8000 Expandable Site Subsystem (Cabinet
Version, Side View) on page 394 shows the location of the power distribution module output cables,
and the metal plate that secures the power distribution module to the junction panel in the cabinet
version of the GTR 8000 Expandable Site Subsystem.

Figure 177: AC/DC Distribution Module for the GTR 8000 Expandable Site Subsystem (Cabinet
Version, Side View)

Figure 178: AC/DC Power Distribution Module (Access Panel Removed) on page 395 shows the
power distribution module with the terminal block access panel removed. The power distribution
module is wired for six AC outputs, not three as shown.
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Figure 178: AC/DC Power Distribution Module (Access Panel Removed)

See Figure 179: Power Distribution Module- AC Distribution Block Diagram on page 395 for the
correct wiring and for the terminal block connections. The figure also shows the AC distribution block of
the power distribution module. In the diagram:

• L indicates Line or Hot AC power feed.

• N indicates Neutral AC power feed.

• Input cable ground wires should be terminated to the ground bus bar.

Figure 179: Power Distribution Module- AC Distribution Block Diagram

See Replacing the AC/DC Power Distribution Module on page 396 for replacement procedures.
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Replacing the AC/DC Power Distribution Module
WARNING: Shock hazard. The GTR 8000 Expandable Site Subsystem contains dangerous
voltages, which can cause electrical shock or damage to equipment. Remove the AC and DC
sources when servicing the power distribution module. Also, for a GTR 8000 Expandable Site
Subsystem, shut down any other expansion cabinet/racks that are connected to it.
Electrical installation work shall be carried out in accordance with the current edition of the
NFPA 70 and local building codes. Where required, only a qualified and licensed electrician
shall be used for all electrical installations.

CAUTION: The power distribution module and its cables are heavy. To avoid injury and
damage to equipment, have another person help lift and support the equipment when installing
or removing the distribution module.

Prerequisites:
The procedure assumes the following service access clearances:

• At least 2 ft access at the rear of the cabinet or rack

• At least 2 ft access on both sides of the cabinet or rack

When and where to use:
Follow this procedure to replace the power distribution module, including its AC and DC output cables.

Procedure:
1 Wear an electrostatic discharge (ESD) wrist strap and connect its cable to a verified good

ground. This strap must be worn throughout this procedure to prevent ESD damage to any
components.

2 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

3 NOTICE: Powering down the GTR 8000 Expandable Site Subsystem causes any
affiliated subscribers to relocate to another channel at an adjacent site. Disable the site
before powering down, so the system does not attribute the loss of channel to a failure.

To disable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
disabled and choose User Ignore.

The site is disabled.

4 Push the power rocker switch to Off (O) on each power supply unit.

5 Set all the AC supply breakers to the OFF position and open up the DC battery disconnects to
power down the entire GTR 8000 Expandable Site Subsystem. Also shut down any other
expansion cabinets/racks that are connected to the GTR 8000 Expandable Site Subsystem.
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6 Label and disconnect all input AC and DC power cables from the power distribution module.

7 Ensure that all power cables in the GTR 8000 Expandable Site Subsystem are free to be
removed.

a Disconnect all six AC and six DC junction panel power cables that feed from the power
supply backplane.

b If the cables are tied to the rack, remove the ties.

8 Disengage the power distribution module from the junction panel as follows:

For the rack version of the GTR 8000 Expandable Site Subsystem:
• Using a T30 bit, remove the two screws on each side of the power distribution module.

For the cabinet version of the GTR 8000 Expandable Site Subsystem:
a Using a T30 bit, remove the screw on each side of the power distribution module that

secures it to a metal plate next to the junction panel.

b Remove the side panel of the cabinet to reach the bolts holding the eyenuts that are on each
side of the power distribution module. This prevents them from rotating as the eyenuts are
removed, and to prevent them from dropping down into the cabinet.

c Remove the eyenuts on each side of the power distribution module that secures the metal
plate to the cabinet.

d Move the plate back to free the power distribution module from the clips on the metal plate.

9 Lift the power distribution module to remove it, and feed its power cables to remove them from
the rack or cabinet.

10 Place the new power distribution module next to the junction panel in the same position and
orientation as the module you removed.

11 Secure the power distribution module to the junction panel as follows:

For the rack version of the GTR 8000 Expandable Site Subsystem:
• Using a T30 bit, secure the two screws on each side of the power distribution module to the

junction panel.

For the cabinet version of the GTR 8000 Expandable Site Subsystem:
a Slide the metal plate toward the power distribution module until the module is captured under

the clips on the metal plate.

b Using a T30 bit, secure the screw on each side of the power distribution module to the metal
plate.

c Secure the metal plate to the cabinet on each side of the power distribution module, using
the eyenuts removed previously.

IMPORTANT: Thoroughly review the information in this documentation regarding the
proper torque for tightening eyenuts, to prevent accidents or injury when using them to lift
the cabinet. See Lifting Equipment Racks Vertically on page 135.

12 Connect the new power distribution module power cables to the appropriate backplane input
ports. For backplane connection information, see Backplanes and Card Cages on page 115.

13 Reconnect all input AC and DC input power cables to the appropriate ports in the power
distribution module. See Figure 179: Power Distribution Module- AC Distribution Block Diagram
on page 395 for the terminal block connections.

14 Secure the cables to the rack with cable ties.

15 Set all the AC supply breakers to the ON position and connect the DC battery to power up the
GTR 8000 Expandable Site Subsystem. Also restore power to any other expansion cabinets/
racks that are connected to the GTR 8000 Expandable Site Subsystem.
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16 Set the power supply rocker switches to On (I).

17 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

18 To enable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

19 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using software tools,
including:

• Unified Event Manager

• Power Supply Metering Screen in Configuration/Service Software (CSS)

Replacing Filters/Preselectors (700/800/900 MHz)
For the GTR 8000 Expandable Site Subsystem, receive filters (preselectors) and transmit filters can be
replaced individually, or the modules may already be secured to a filter tray.

Figure 180: Site Preselector Filter (700/800 MHz)
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Figure 181: Transmit Filter (700/800/900 MHz)

WARNING: Shock hazard. The GTR 8000 Expandable Site Subsystem contains dangerous
voltages, which can cause severe electrical shock or damage to equipment. Set the rocker
switches on the front of the associated power supplies to the Off (O) position before servicing
this component in the GTR 8000 Expandable Site Subsystem. Also, shut down any external
base radios connected to the system.

IMPORTANT: When using the following procedure to replace or remove the Transmit
filter, the warning applies and the site must be powered down before starting the replacement
procedure if the entire site is connected to the Transmit filter being removed. Powering down
the site causes any affiliated subscribers to relocate to another channel at an adjacent site.
Disable the site before powering down so the system does not attribute the loss of channel to a
failure. The site can be disabled using Unified Event Manager or the Configuration/Service
Software (CSS).
If replacing one preselector filter, it can be replaced without shutting the power down.

When and where to use: The following procedure includes instructions for replacing a filter tray or
replacing individual filters on the tray.

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

3 NOTICE: Powering down the GTR 8000 Expandable Site Subsystem causes any
affiliated subscribers to relocate to another channel at an adjacent site. It is
recommended to disable the site before powering down, so the system does not attribute
the loss of channel to a failure.

To disable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.
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If… Then…

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
disabled and choose User Ignore.

The site is disabled.

4 Set the rocker switches on the front of the power supplies to the Off (O) position to power down
the entire system. For the GTR 8000 Expandable Site Subsystem, power down any external
base radios connected to the system.

5 To remove the filter or filter tray from the rack, perform one of the following actions:

If… Then…

If you are re-
placing an indi-
vidual filter,

perform the following actions:

a For a tray that combines receive and transmit filters, label and disconnect
the RF input, RF output, ground, and Power Monitor Unit (PMU) cables
from the front of the transmit filter.

b For a preselector, label and disconnect the RF input, RF output, and
ground cables from the front of the filter.

c Remove the T20 screws that secure the filter to the tray.

d Remove the filter from the tray.

e Place the new filter in the tray in the same location and orientation as the
filter removed.

f Secure the new filter to the existing tray using the T20 screws previously
removed.

g For a preselector, reconnect the RF input, RF output, and ground cables to
the filter.

h For a tray that combines receive and transmit filters, reconnect the RF in-
put, RF output, ground, and Power Monitor Unit (PMU) cables to the trans-
mit filter.

If you are re-
placing the filter
and tray,

perform the following actions:

a For a tray that combines receive and transmit filters, label and disconnect
the RF input, RF output, ground, and Power Monitor Unit (PMU) cables
from the front of the transmit filter.

b For a preselector, label and disconnect the RF input, RF output, and
ground cables from the front of the filter.

c Using a T30 bit, remove the two screws which secure the filter tray to the
rack.

d Slide the tray out the front of the rack.

e Slide the new filter and tray into the appropriate location through the front
of the rack.

f Secure the slide rail to the rack using the two screws which were previous-
ly removed.
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If… Then…

g For a preselector, reconnect the RF input, RF output, and ground cables to
the filter.

h For a tray that combines receive and transmit filters, reconnect the RF in-
put, RF output, ground, and Power Monitor Unit (PMU) cables to the trans-
mit filter.

6 Set the rocker switches on the front of the power supplies to the On (I) position, to power up the
system. Also, power up any external base radios that were previously powered down.

7 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

8 To enable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

9 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using fault
management software, including:

• Unified Event Manager

• Transmitter Metering Screen in Configuration/Service Software (CSS)

Replacing a Site Preselector (UHF, 455–512 MHz)
Figure 182: Site Preselector Filter (UHF)
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IMPORTANT: You can replace a site preselector without shutting the power down.

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Remove the site preselector from the rack, as follows:

a Label and disconnect the left and right QMA cables from the front of the site preselector

b Remove the four screws securing the site preselector and 2RU cable guide to the extension
bracket using a T20 bit.

c Disconnect the ground wire.

3 Install the site preselector to the extension bracket, as follows:

a Secure the site preselector and 2RU cable guide to the extension bracket using the four
screws previously removed.

b Reconnect the left and right QMA cables to the site preselector.

c Attach the ground wire.

4 Verify that the system is operating properly by checking the receiver sensitivity.

Replacing Transmit Filters (UHF, 450–509 MHz)
Figure 183: GTR 8000 Transmit Filter (UHF, 450–509 MHz)

WARNING: Shock hazard. The GTR 8000 Expandable Site Subsystem contains dangerous
voltages which can cause severe electrical shock or damage to equipment. Set the rocker
switches on the front of the associated power supplies to the Off (O) position before servicing
this component.
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IMPORTANT: When using this procedure to replace or remove the transmit filter, the
warning applies and the site must be powered down before starting the replacement procedure
if the entire site is connected to the Transmit filter being removed. Powering down the site
causes any affiliated subscribers to relocate to another channel at an adjacent site. Disable the
site before powering down so the system does not attribute the loss of channel to a failure. The
site can be disabled using Unified Event Manager or the Configuration/Service Software (CSS).

Procedure:
1 Wear an electrostatic discharge (ESD) wrist strap and connect its cable to a verified good

ground. This strap must be worn throughout this procedure to prevent ESD damage to any
components.

2 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

3 NOTICE: Powering down the GTR 8000 Expandable Site Subsystem causes any
affiliated subscribers to relocate to another channel at an adjacent site. It is
recommended to disable the site before powering down so the system does not attribute
the loss of channel to a failure.

To disable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
disabled and choose User Ignore.

The site is disabled.

4 Set the rocker switches on the front of the power supplies to the OFF (O) position.

5 Remove the Tx filter from the rack, as follows:

a Label and disconnect the Tx input, antenna output, and ground cables from the transmit filter.

b Remove the four screws securing the Tx filter to the flange of the transceiver using T20 bit.

6 Install the new Tx filter to the rack, as follows:

a Secure the slide rail to the transceiver flange using the four screws previously removed.

b Reconnect the Tx input, Antenna output, and ground cables to the transmit filter.

7 Set the rocker switches on the front of the power supplies to the ON (I) position.

8 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

9 To enable the site, perform one of the following actions:
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If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

10 Verify that the system is operating properly by checking the output power.

Site RMC/LNA Module or Tray Replacement
Each Receive Multicoupler/Low Noise Amplifier (RMC/LNA) module is a field replaceable unit (FRU).

For an HPD GTR 8000 Expandable Site Subsystems, two Site RMCs/LNAs are included if the
CA00862AA option was purchased with the system. For GTR 8000 Expandable Site Subsystems with
TDMA dual diversity, two Site RMCs/LNAs are included if the CA01943AA option was purchased. In 
Figure 184: Site RMC/LNA Modules in GTR 8000 Expandable Site Subsystem for HPD or TDMA on
page 405, the Site RMC FRU modules are shown for HPD or TDMA with dual diversity site.
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Figure 184: Site RMC/LNA Modules in GTR 8000 Expandable Site Subsystem for HPD or TDMA

In Figure 185: Site RMC/LNA Modules in GTR 8000 Expandable Site Subsystem for Repeater Site on
page 406, the Site RMC FRU modules are shown for a repeater site.
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Figure 185: Site RMC/LNA Modules in GTR 8000 Expandable Site Subsystem for Repeater Site

Figure 186: Site RMC/LNA Module (Front View) on page 406 shows two Site RMC modules. It
identifies the connectors and features on the Site RMC module on the left.

Figure 186: Site RMC/LNA Module (Front View)

In addition, the tray with the backplane that connects the Site RMC modules is a FRU.
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Figure 187: GTR 8000 Site RMC Tray (Rear View)

For replacement procedures see, Replacing a Site RMC/LNA Module or Tray on page 407.

Replacing a Site RMC/LNA Module or Tray
NOTICE: The RMC/LNA modules and backplane connections are designed so the RMC/LNA
modules can be swapped out without shutting the power down. The GTR 8000 Expandable Site
Subsystem is designed with dual receive paths, so it may be possible to replace one RMC/LNA
module without losing channels. However, system performance may be degraded.
If the RMC tray is being replaced, both modules must be removed, resulting in the loss of
channels. Place the channels in Service Mode before replacing the tray, so the system does not
attribute the loss of channel to a failure. Placing a channel in Service Mode is performed using
Unified Event Manager or the Configuration/Service Software (CSS).

When and where to use: This procedure provides instructions for replacing an individual Site RMC or
a Site RMC tray.

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Disable the site if both RMC/LNA modules are being removed by connecting to the network and
access the appropriate site controller using Configuration/Service Software (CSS). See 
Connecting Through an Ethernet Port Link on page 262. Perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.
The appears.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
disabled and choose User Ignore.

The site is disabled.

3 Set the rocker switches on the front of the power supplies to the Off (O) position.

4 Perform one of the following actions:
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If… Then…

If you are replacing an individual
RMC/LNA module, not the RMC
tray,

perform the following actions:

a Label and disconnect the QMA input connectors from
the front of the RMC module. The QMA connectors
can be disconnected by hand.

b Label and disconnect any cables that are connected to
the three center expansion connectors. These BNC
connectors can be disconnected by hand.

c Using a T20 bit, remove the two captive screws which
secure the RMC module to the tray.

d Using the handle, gently pull the RMC module straight
out, along the guides on which it sits.

e Set the DIP switches on the new RMC/LNA module,
using the information in RMC Attenuation on page
278.

f Install the new RMC/LNA module, by following the
substeps in step 5.

If you are replacing the RMC tray,
not the RMC/LNA modules,

perform the following actions:

a Remove both Site RMC/LNA modules, by following
the previous substeps for replacing an individual mod-
ule.

b Disconnect the ground cabling from the lugs on the
rear of the tray.

c Disconnect the RMC cable from the 15-pin connector
on the rear of the tray.

NOTICE: If there is no rear or side access,
perform substeps 4 and 5 first, disconnect-
ing the RMC cable as soon as you can
reach it as you slide the tray forward.

d Using a T30 bit, remove the two captive screws which
secure the tray to the rack.

e Slide the tray out the front of the rack.

f Slide the RMC tray into the appropriate location
through the front of the rack.

g Secure the slide rail to the rack using the two T30
screws which were previously removed.

h Reconnect the RMC cable to the 15-pin connector on
the back of the tray.

i Reconnect the ground cabling from the lugs on the
rear of the tray.

j Re-install both RMC/LNA modules, by following step
5. Repeat for each module.

5 Install the RMC/LNA modules as follows:

a Slide in the module along the guiding rails.

b Secure the module to the existing tray using the two T20 captive screws.
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c Reconnect the input RF cables to the QMA connectors on the front of the RMC module.

d Reconnect any cables that were connected to the three center BNC expansion connectors.

6 Set the rocker switches on the front of the power supplies to the On (I) position.

7 If the site was disabled, enable the site by connecting to the network and access the appropriate
site controller using Configuration/Service Software (CSS). See Connecting Through an
Ethernet Port Link on page 262. Perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

8 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using fault
management software, including:

• Unified Event Manager

• Configuration/Service Software (CSS)

9 Verify that the RMC/LNA modules are operating properly.

• The Status LED on the front of each RMC/LNA module should be green.

• The red Alarm LED on the front of each RMC/LNA module should be off.

Individual Cabinet RMC/LNA Module Replacement
The GTR 8000 Expandable Site Subsystem for HPD or TDMA dual diversity includes two Cabinet
Receive Multicoupler/Low Noise Amplifier (RMC/LNA) modules to split the receive path among multiple
radios. In Figure 188: Cabinet RMC/LNA Modules in GTR 8000 Expandable Site Subsystem for HPD
or TDMA on page 410, the Cabinet RMC (A and B) modules are shown between the row of power
amplifiers (PAs) and the row of XCVR / SC modules. The GTR 8000 Expandable Site Subsystem
for trunked IV&D includes one Cabinet Receive Multicoupler/Low Noise Amplifier module.
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Figure 188: Cabinet RMC/LNA Modules in GTR 8000 Expandable Site Subsystem for HPD or
TDMA

In Figure 189: Cabinet RMC/LNA Modules in GTR 8000 Expandable Site Subsystem for Repeater Site
on page 411, the Cabinet RMC module is shown between the row of power amplifiers (PAs) and
the row of XCVR / SC modules.
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Figure 189: Cabinet RMC/LNA Modules in GTR 8000 Expandable Site Subsystem for Repeater
Site

Figure 190: Individual Cabinet RMC/LNA Module (Front View)
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For replacement procedures for an Individual Cabinet RMC/LNA Module, see Replacing an Individual
Cabinet RMC/LNA Module on page 412.

Replacing an Individual Cabinet RMC/LNA Module
IMPORTANT: The RMC/LNA modules and backplane connections are designed so the
modules can be swapped out without shutting the power down. In addition, the GTR 8000
Expandable Site Subsystem is designed with dual receive paths, so it may be possible to
replace one RMC/LNA module without losing the channels. However, system performance may
be degraded.
If you choose to power down the subsystem, this causes any affiliated subscribers to relocate to
another channel at the site or another channel at an adjacent site. Place the channels in
Service Mode before powering down so the system does not attribute the loss of channel to a
failure. Placing a channel in Service Mode is performed using Unified Event Manager or the
Configuration/Service Software (CSS).

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Optional: Place all channels in Service Mode if you choose to shut down the power, as follows:

a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

3 Optional: If you choose to shut down the power, set the rocker switches on the front of the power
supplies to the Off (O) position.

4 Remove the individual Cabinet RMC/LNA module, as follows:

a Label and disconnect the QMA input connectors from the front of the RMC/LNA module. The
QMA connectors can be disconnected by hand.

b Using a T20 bit, remove the two captive screws securing the RMC module to the tray.

c Using the handle, gently pull the module straight out, along the guides on which it sits.

5 Set the DIP switches on the new Cabinet RMC/LNA module. See RMC Attenuation on page
278.

6 Install the replacement Cabinet RMC/LNA module, as follows:

a Slide in the module along the guiding rails.

b Secure the module to the chassis using the two T20 captive screws.

c Reconnect the RF input cables to the QMA connector on the front of the RMC/LNA module.

7 Optional: If you chose to shut down the power, set the rocker switches on the front of the power
supplies to the On (I) position.

8 Optional: If the channels were placed in Service Mode, place the channels in Normal Mode, as
follows:
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a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Normal Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

9 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using fault
management software, including:

• Unified Event Manager

• Configuration/Service Software (CSS)

10 Verify that the RMC/LNA modules are operating properly.

• The Status LED on the front of each RMC/LNA module should be green.

• The red Alarm LED on the front of each RMC/LNA module should be off.

Individual Pass Through Module Replacement
Figure 191: Pass Through Module on page 414 shows the pass through module between the row of
power amplifiers (PAs) and the row of XCVR / SC modules.
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Figure 191: Pass Through Module

Figure 192: Individual Pass Through Module (Front View)

For replacement procedures of the Pass Through Module, see Replacing an Individual Pass Through
Module on page 415.
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Replacing an Individual Pass Through Module
IMPORTANT: The pass through modules and backplane connections are designed so the
modules can be swapped out without shutting the power down.
If you choose to power down the subsystem, this causes any affiliated subscribers to relocate to
another channel at the site or another channel at an adjacent site. Place the channels in
Service Mode before powering down so the system does not attribute the loss of channel to a
failure. Placing a channel in Service Mode is performed using Unified Event Manager or the
Configuration/Service Software (CSS).

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Optional: Place all channels in Service Mode if you choose to shut down the power, as follows:

a Connect to the base radio’s Ethernet service port using Configuration/Service Software
(CSS). See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Service Mode.

d At the confirmations screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

3 Optional: If you choose to shut down the power, set the rocker switches on the front of the power
supplies to the Off (O) position.

4 Remove the individual pass through module as follows:

a Label and disconnect the BNC connectors from the pass through module. The BNC
connectors can be disconnected by hand.

b Using a T20 bit, remove the two captive screws which secure the pass through module to the
tray.

c Using the handle, gently pull the module straight out, along the guides on which it sits.

5 Install the replacement pass through module as follows:

a Slide in the module along the guiding rails.

b Secure the module to the chassis using the two T20 captive screws.

c Reconnect the RF input cables to the BNC connectors on the pass through module.

6 Optional: If you chose to shut down the power, set the rocker switches on the front of the power
supplies to the On (I) position.

7 Optional: If the channels were placed in Service Mode, place the channels in Normal Mode, as
follows:

a Connect to the base radio transceiver Ethernet service port using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Normal Mode.
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d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

8 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using fault
management software, including:

• Unified Event Manager

• Configuration/Service Software (CSS)

9 Verify that the pass through module is operating properly.

• The Status LED on the front of the pass through module should be green.

• The red Alarm LED on the front of the pass through module should be off.

Cavity Combiner (700/800 MHz) Replacement
The RF input cable, built in isolator, and tuning knob are shown for one of the six cavities.

Figure 193: Cavity Combiner (700/800 MHz)

For replacement procedures, see Replacing a Cavity Combiner (700/800 MHz) on page 416

Replacing a Cavity Combiner (700/800 MHz)
The RF input cable, built in isolator, and tuning knob are shown for one of the six cavities.
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Figure 194: Cavity Combiner (700/800 MHz)

WARNING: Shock hazard. The GTR 8000 Expandable Site Subsystem contains dangerous
voltages, which can cause electrical shock or damage to equipment. Set the switches on the
front of the power supplies to the Off (O) position when servicing this component in the GTR
8000 Expandable Site Subsystem. Also, shut down any other expansion cabinets/racks that are
connected to this GTR 8000 Expandable Subsystem.
Burn Hazard. Some surfaces of the combiner can be extremely hot. Remove power and allow
the modules to cool before handling or attempting to remove the combiner.

CAUTION: The cavity combiner is heavy. To avoid injury and damage to equipment, have
another person help to lift and support the equipment when installing or removing the combiner
from the rack. Make certain that the combiner is fully supported when it is free from its mounting
rails.

IMPORTANT: Powering down the GTR 8000 Expandable Site Subsystem causes any affiliated
subscribers to relocate to another channel at an adjacent site. Disable the site before starting
the combiner replacement procedure so the system does not attribute the loss of channel to a
failure. You can disable the site using Unified Event Manager or the Configuration/Service
Software (CSS).

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

CAUTION: Wear the ESD strap throughout this procedure to prevent ESD damage to
any components

2 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

3 To disable the site, perform one of the following actions:
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If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
disabled and choose User Ignore.

The site is disabled.

4 Set all the switches on the front of the power supplies to the Off (O) position to power down the
entire site. Allow the combiner to cool for 15 minutes. Also shut down any other expansion
cabinets/racks connected to the GTR 8000 Expandable Site Subsystem.

5 After the combiner has cooled for at least 15 minutes, disconnect the cabling from the front of
the combiner:

a Remove the 7/16-inch DIN output cable.

b Label and remove the QN-type RF input connectors.

6 Remove the combiner from the rack:

a Remove the T30 screws that attach the combiner slide rail to the rack.

b Lift the rear of the combiner slightly to unseat the combiner bracket from the rack.

c With the help of another person, slide the combiner out through the front of the rack. Be sure
to support both the front and rear of the combiner as it is removed from the rack.

7 Install the replacement combiner in the rack:

a With the help of another person, slide the replacement combiner into the front of the rack in
the same position and orientation as the previous combiner.

b Lift the rear of the combiner slightly to engage the combiner to its bracket in the rack.

c Secure the combiner slide rail to the rack with the screws which were previously removed.

8 Tune the cavity combiner. See Cavity Combiner Tuning on page 293.

9 Reconnect the cabling to the front of the combiner:

a Reconnect the QN-type RF input connectors to the appropriate ports.

b Secure the 7/16-inch RF output cable to the output connector.

10 Set the rocker switches on the front of the power supplies to the On (I) position to power up the
GTR 8000 Expandable Site Subsystem. Also, restore power to any other expansion cabinets/
racks that are connected to the Expandable Site Subsystem.

11 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

12 To enable the site, perform one of the following actions:
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If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

13 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using fault
management software, including:

• Transmitter Metering Screen in Configuration/Service Software (CSS).

• Unified Event Manager

Replacing a Cavity Combiner (UHF)
The RF input cable, built in isolator, and tuning knob is shown for one of the six cavities.

Figure 195: Cavity Combiner (UHF)
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WARNING: Shock hazard. The GTR 8000 Expandable Site Subsystem contains dangerous
voltages, which can cause electrical shock or damage to equipment. Set the switches on the
front of the power supplies to the Off (O) position when servicing this component in the GTR
8000 Expandable Site Subsystem. Also, shut down any other expansion cabinets/racks that are
connected to this GTR 8000 Expandable Subsystem.
Burn Hazard. Some surfaces of the combiner can be extremely hot. Remove power and allow
the modules to cool before handling or attempting to remove the combiner.

CAUTION: The combiner is heavy. To avoid injury and damage to equipment, have another
person to help lift and support the equipment when installing or removing the combiner from the
rack. Ensure the combiner is fully supported when it is free from its mounting rails.

IMPORTANT: Powering down the GTR 8000 Expandable Site Subsystem causes any affiliated
subscribers to relocate to another channel at an adjacent site. Disable the site before starting
the combiner replacement procedure, so that the system does not attribute the loss of channel
to a failure. You can disable a site using Unified Event Manager or the Configuration/Service
Software (CSS).

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

3 To disable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select
The appears.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
disabled and choose User Ignore.

The site is disabled.

4 Set all the switches on the front of the power supplies to the Off (O) position to power down the
entire GTR 8000 Expandable Site Subsystem. Allow the combiner to cool for 15 minutes. Also
shut down any other expansion cabinets/racks that are connected to the GTR 8000 Expandable
Site Subsystem.

5 After the combiner has cooled for at least 15 minutes, disconnect the cabling from the front of
the combiner:

a Remove the 7/16-inch DIN output cable.

b Label and remove the QN-type RF input connectors.

6 Remove the combiner from the rack:

a Remove the T30 screws attached to the combiner slide rail to the rack.
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b Lift the rear of the combiner slightly to unseat the combiner bracket from the rack.

c With the help of another person, slide the combiner out through the front of the rack. Be sure
to support both the front and rear of the combiner as it is removed from the rack.

7 Install the replacement combiner in the rack:

a With the help of another person, slide the replacement combiner into the front of the rack in
the same position and orientation as the previous combiner.

b Lift the rear of the combiner slightly to engage the combiner to its bracket in the rack.

c Secure the combiner slide rail to the rack with the screws which were previously removed.

8 Tune the cavity combiner. See Cavity Combiner Tuning on page 293.

9 Reconnect the cabling to the front of the combiner:

a Reconnect the QN-type RF input connectors to the appropriate ports.

b Secure the 7/16-inch RF output cable to the output connector.

10 Set the rocker switches on the front of the power supplies to the On (I) position, to power up the
GTR 8000 Expandable Site Subsystem. Also restore power to any other expansion cabinets/
racks that are connected to the GTR 8000 Expandable Site Subsystem.

11 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

12 To enable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

13 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using fault
management software, including:

• Transmitter Metering Screen in Configuration/Service Software (CSS).

• Unified Event Manager
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Replacing a Hybrid Combiner Fan Assembly
Figure 196: Hybrid Combiner Fan Assembly (Front View)

WARNING: When removing a fan module, care should be taken to avoid contacting moving fan
blades before and after removal with tools, hands, or other objects. If you are removing the fan
module to access or replace the modules behind it, turn off the equipment power and allow the
modules to cool before performing any work, as the surfaces of the modules can be extremely
hot.

IMPORTANT: The fan assembly is designed to be swapped out without shutting the power off.
However, you should minimize the amount of time before the new fan is operational, so the
hybrid combiner modules do not overheat.

Procedure:
1 Wear an electrostatic discharge (ESD) wrist strap and connect its cable to a verified good

ground. This strap must be worn throughout this procedure to prevent ESD damage to any
components.

2 Cut any of the tie wraps, if necessary, to allow room for the fan assembly removal.

3 Using a T20 bit, loosen the four captive screws on the front of the fan assembly, so they
disengage from the chassis.

4 Gently pull the fan assembly straight out to disengage the connector.

5 Align the new fan assembly to fit into the opening of the chassis. Push the fan assembly into
place to secure the connector on the back of the fan assembly.

6 Tighten the four captive screws. Torque to 17 ± 2 in-lb.

7 Verify that the fan assembly is operating properly, and the fan Alarm LED is off.

8 Use software tools, such as MOSCAD, to verify the status of the fan.

Replacing a Hybrid Combiner Module (900 MHz)
The hybrid combiner modules in the GTR 8000 Expandable Site Subsystem are field replaceable units
(FRUs).
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Figure 197: Hybrid Combiner Modules (900 MHz)

IMPORTANT: Powering down a base radio causes any affiliated subscribers to relocate to
another channel at an adjacent site. Place any channels connected to the hybrid combiner in
Service Mode before starting the combiner replacement procedure, so the system does not
attribute the loss of channel to a failure. Placing a channel in Service Mode is performed using
Unified Event Manager or the Configuration/Service Software (CSS).

There are at least eight variations of combining that are supported. If the combining scheme is being
changed due to the addition or removal of base radios, ensure that:

• the proper modules are used (1/2–1/2, 2/3–1/3, or 3/5–2/5)

• the connections from the base radios to the modules are correct

• the cables between the modules are correct for the desired configuration

See the figures in RFDS - Hybrid Combiner (900 MHz) on page 117.

Procedure:
1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.

This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Remove the hybrid combiner fan assembly to gain access to the hybrid combiner modules. See 
Replacing a Hybrid Combiner Fan Assembly on page 422.

3 Locate and place any base radios connected to the hybrid combiner module being replaced in
Service Mode, as follows:

a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.
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b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

4 Set the switches on the front of the power supplies to the Off (O) position to power down the
base radios. Allow the hybrid combiner module to cool for 15 minutes.

5 After the hybrid combiner module has cooled for at least 15 minutes, label and disconnect the
cabling from the front of the hybrid combiner module.

6 Remove the hybrid combiner module from the chassis:

a Remove the two M4 screws using a T20 bit that attach the hybrid combiner module to the
chassis.

b Slide the hybrid combiner module out from the chassis.

7 Install the replacement hybrid combiner module into the chassis:

a Slide the hybrid combiner module into the chassis in the same position as the previous
module.

b Secure the hybrid combiner module to the chassis with the M4 screws which were previously
removed. Torque to 17 in-lb.

8 Reconnect the cabling to the front of the hybrid combiner module.

9 Reinstall the fan assembly unit. See Replacing a Hybrid Combiner Fan Assembly on page 422.

10 Set the rocker switches on the front of the power supplies to the On (I) position, to power up the
base radios.

11 Place the base radio in Normal Mode, as follows:

a Connect to the base radio’s Ethernet service port using Configuration/Service Software
(CSS). See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Normal Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

12 Verify that the GTR 8000 Expandable Site Subsystem is operating properly using fault
management software, including:

• Transmitter Metering Screen in Configuration/Service Software (CSS).

• Unified Event Manager

Replacing a Duplexer (900 MHz)
Figure 198: Duplexer Module (900 MHz) on page 425 shows dual duplexers installed on a tray for 900
MHz.
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Figure 198: Duplexer Module (900 MHz)

WARNING: Shock hazard. The device contains dangerous voltages which can cause electrical
shock or damage to equipment. Set the power supply switches for the affected equipment to
the Off (O) position when servicing this component.

IMPORTANT: Powering down the base radio causes any affiliated subscribers to relocate to
another channel at the site or another channel at an adjacent site. Place the channel in Service
Mode before powering down, so the system does not attribute the loss of channel to a failure.
Placing a channel in Service Mode is performed using Unified Event Manager or the
Configuration/Service Software (CSS).

Procedure:
1 Wear an electrostatic discharge (ESD) wrist strap and connect its cable to a verified good

ground. This strap must be worn throughout this procedure to prevent ESD damage to any
components.

2 Locate and place any base radios connected to the duplexer being replaced in Service Mode, as
follows:

a Connect to the transceiver Ethernet service port using Configuration/Service Software (CSS).
See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Service Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.

3 Set the rocker switches on the front of the power supply to the OFF (O) position.

4 Replace the duplexer equipment. Perform one of the following actions:

If… Then…

If you want to re-
place the duplex-
er and tray from
the rack,

perform the following actions:

a Label and disconnect the Rx output, Tx input, antenna output, and
ground cables from the duplexer.

b Using a T30 bit, remove the two M6 screws securing the tray to the rack.
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If… Then…

c Slide the tray out the front of the rack.

d Slide the new tray into the front of the rack.

e Using a T30 bit, secure the tray to the rack with the two M6 screws previ-
ously removed. Torque to 60 in-lb.

f Connect the Rx output, Tx input, Antenna output, and ground cables to
the duplexer.

If you want to re-
place a duplexer
from the tray,

perform the following actions:

a Label and disconnect the Rx output, Tx input, antenna output, and
ground cables from the duplexer.

b Remove the two outer captive M4 fasteners securing the duplexer to the
tray.

c Slide the duplexer out of the tray.

d Slide the new duplexer into the tray, in the same location and orientation
as the module that you removed, ensuring to insert the tab on the tray in-
to the slot on the duplexer bracket.

e Secure the replacement duplexer to the tray, using the two captive M4
fasteners previously removed. Torque to 17 in-lb.

f Connect the Rx output, Tx input, Antenna output, and ground cables to
the duplexer.

5 Set the rocker switches on the front of the power supply to the ON (I) position.

6 Place the base radios in Normal Mode, as follows:

a Connect to the base radio transceiver Ethernet service port using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

b From the menu, select Service → Test Measurement Screen.

The Test and Measurement Screen appears.

c Click Change to Normal Mode.

d At the confirmation screen, click OK.

The base radio halts activity in the current mode, which takes a few minutes, and switches
operation to the requested mode.
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Replacing a Power Monitor Unit (PMU) (UHF/VHF/900 MHz)
Figure 199: GTR 8000 Power Monitor Unit (PMU) (UHF/VHF/900 MHz)

WARNING: Shock hazard. The GTR 8000 Expandable Site Subsystem contains dangerous
voltages, which can cause electrical shock or damage to equipment. Set the switches on the
front of the power supplies to the Off (O) position when servicing this component in the GTR
8000 Expandable Site Subsystem. Also, shut down any other expansion cabinets/racks that are
connected to this GTR 8000 Expandable Site Subsystem.

IMPORTANT: Powering down the GTR 8000 Expandable Site Subsystem causes any affiliated
subscribers to relocate to another channel at an adjacent site. Disable the site before starting
the PMU replacement procedure, so the system does not attribute the loss of channel to a
failure. You can disable a site using Unified Event Manager or the Configuration/Service
Software (CSS).

Procedure:
1 Wear an electrostatic discharge (ESD) wrist strap and connect its cable to a verified good

ground. This strap must be worn throughout this procedure to prevent ESD damage to any
components.

2 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

3 To disable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Site OFF.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.
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If… Then…

c Click in the User Requested Site State cell of the subsite to be
disabled and choose User Ignore.

The site is disabled.

4 Set all switches on the front of the power supplies to the Off (O) position to power down the
entire GTR 8000 Expandable Site Subsystem. Also, shut down any other expansion cabinets/
racks that are connected to the GTR 8000 Expandable Site Subsystem.

5 Remove the PMU module from the rack, as follows:

a Label and disconnect the PMU Out, Tx In, Tx Out, and ground cables from the PMU.

b Remove the four screws which secure the PMU to the rack using a T20 bit.

6 Install the PMU to the rack, as follows:

a Secure the PMU to the rack using the four screws which were previously removed.

b Reconnect the PMU Out, Tx In, Tx Out, and ground cables to the PMU.

7 Set the rocker switches on the front of the power supplies to the On (I) position, to power up the
GTR 8000 Expandable Site Subsystem. Also, restore power to any other expansion cabinets/
racks that are connected to the GTR 8000 Expandable Site Subsystem.

8 Connect to the network and access the appropriate site controller using Configuration/Service
Software (CSS). See Connecting Through an Ethernet Port Link on page 262.

9 To enable the site, perform one of the following actions:

If… Then…

If the site controllers
are in the cabinet/rack,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Site Info tab.

c In the User Requested Site State list box, select Wide Trunking.

If the site controllers
are at the prime site,

perform the following actions:

a From the menu, select Service → Status Panel Screen.

b In the Status Panel Screens window, select the Subsite tab.

c Click in the User Requested Site State cell of the subsite to be
enabled and choose Enabled.

The site is enabled.

10 Verify that the system is operating properly by checking the output power.

GGM 8000 Gateway Replacement
For details on replacing a GGM 8000 Gateway, see the System Gateways – GGM 8000 manual.
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Chapter 10

GTR 8000 Expandable Site Subsystem
Reference
Reference information for the GTR 8000 Expandable Site Subsystem includes LED states and
specifications for individual GTR 8000 RFDS modules.

This chapter contains supplemental reference information relating to the GTR 8000 Expandable Site
Subsystem.

LEDs
Many of the LEDs on the GTR 8000 Expandable Site Subsystem devices provide an indication for one
or more the following conditions:

Lamp Test
The Lamp Test state is used to verify that the indicators are operational. For Lamp Test, the LEDs
stay in this state for only a second or less

Failure
Indicates a failure that can only be fixed through replacement. If anything other than a hardware
fault is causing the state, an Impaired state is indicated.

Impaired
The device is not fully operational due to internal or external causes. Some corrective action must
be taken to get back to 100% operation.

Booting Up
The device is not in service due to running of diagnostics or initializing.

Online
The LEDs for the site controller, RDM, transceiver, and power amplifier modules can be viewed
through the door to the left of the fans, with the door opened, or closed.

GTR 8000 Base Radio Transceiver LEDs

Figure 200: Transceiver LEDs (viewable through a drop-down door)
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Transceiver Status and Alarm LEDs

The Status LED is green, and the Alarm LED is red. These LEDs are either off, on, or blinking
depending on the condition of the transceiver.

Table 129: Transceiver Status and Alarm LEDs

Condition Green (Status LED) Red (Alarm LED)

No Power Off Off

Lamp Test (During
Test)

On On

Impaired Operation On Blinking

Critical Failure Off On

Booting Up Blinking Off

Operational On Off

For detailed information on current operation and fault status, use the Configuration/Service Software
(CSS) Status Panel screen.

Transceiver Ethernet Link Status LEDs
The following LEDs (see Figure 200: Transceiver LEDs (viewable through a drop-down door) on page
429) indicate Ethernet link connections between the transceiver, site controllers, RDMs, or XHubs, and
the front panel service port.

Table 130: Transceiver Ethernet Link Status LEDs

LED Name Indication LED Status

ENET SC-A (connection to
SITE CTRL A)

Ethernet link inactive (Remote PHY/MAC not de-
tected.)

Off

Ethernet link established (Remote PHY/MAC de-
tected and auto-negotiation completed.)

Green

Ethernet link active (Actively transmitting or receiv-
ing data.)

Amber (blinking)

ENET SC-B (connection to
SITE CTRL B)

Ethernet link inactive (Remote PHY/MAC not de-
tected.)

Off

Ethernet link established (Remote PHY/MAC de-
tected and auto-negotiation completed.)

Green

Ethernet link active (Actively transmitting or receiv-
ing data.)

Amber (blinking)

ENET SVC (front panel serv-
ice port)

Ethernet link inactive (Remote PHY/MAC not de-
tected.)

Off

Ethernet link established (Remote PHY/MAC de-
tected and auto-negotiation completed.)

Green

Ethernet link active (Actively transmitting or receiv-
ing data.)

Amber (blinking)
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Transceiver Application-Controlled LEDs

The application-controlled LEDs can be green, red, or amber depending on the conditions.

Table 131: Transceiver Application-Controlled LEDs

Condition

LED 1 Re-
ceive Sta-

tus

LED 2
Control
Channel
Status

LED 3 Tx/
Service Sta-

tus

LED 4 Infrastruc-
ture Payload
Link Status

Booting Up* Green Green Green Green

Lamp Test Amber Amber Amber Amber

Receiver Inhibited Amber
(blinking)

Receiver Active Green

RF Channel Interference Red (blink-
ing)

Monitor Before Data Transmit Green

Illegal Carrier Red (blink-
ing)

Control Channel (Operating) Green

Control Channel (Failsoft) Green
(blinking)

Service Mode Amber

Transmitter Inhibited Amber (blink-
ing)

Infrastructure Link Connected (V.
24, IP, and 4–wire/V.24)

Green

Partial Infrastructure Link Estab-
lished (V.24 link established, 4–
wire link not established)

Amber

Infrastructure Link Disconnected
(V.24, IP, and 4–wire/V-24)

Green (blinking)

* During a normal boot up sequence, LEDs 1 through 4 blink from left to right and from right to left
continuously for several seconds.
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Transceiver Services-Controlled LEDs

For the service-controlled LEDs, the color of all LEDs must be observed to interpret the condition of the
transceiver.

Table 132: Transceiver Services-Controlled LEDs

Condition
LED 5 SWDL/

VLAN LED 6 Fault LED 7

Lamp Test Amber Amber Amber

Receiver Inhibited Red

Receiver Reference Failure Red

Transmitter Inhibited Red

SWDL (Software Download trans-
fer in progress)

Green

Warning Amber

Minor Hardware Failure Amber (blinking)

Major Hardware Failure Red (blinking)

Critical Hardware Failure Red

VSWR Fault Red

Transceiver Option Card Intercom LED
The Transceiver Option Card has a single Intercom LED that indicates the intercom function between
the ON (amber) and OFF (green) states.

Figure 201: Transceiver Option Card Intercom LED (viewable behind the fan module)

Power Amplifier LEDs
Figure 202: Power Amplifier LEDs, viewable through a drop-down door
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The power amplifier LED color must be observed to interpret the power amplifiers condition. For
example:

• If the Alarm LED is red and the Transmit and Status LEDs are not lit, the condition is “PA Failure”
and the power amplifier module should be replaced.

Table 133: Power Amplifier LEDs

Condition Transmit (XMIT) Status Alarm

Power Off Off Off Off

Lamp Test Amber Green Red

Not Transmitting Off Green Off

Transmitting at Full Requested
Output Power

Green Green Off

Transmitting at Less Than Re-
quested Power

Amber Green Red

PA Failure Red Off Red

Receive Only Off Off Off

Transmitter Inhibited Off Green Red (blinking)

GCP 8000 Site Controller LEDs
Green LEDs indicate that the device is fine. Yellow warns of a potential problem that requires attention,
though not an immediate issue. Red is indicative of a problem requiring immediate attention.

LED colors and states are listed here in order of severity:

• Green - Good/Active

• Green Flashing - Good, In progress, Standby

• Yellow - Warning

• Yellow Flashing - Minor

• Red Flashing - Major Fault

• Red - Critical

GCP 8000 Site Controller Software and Services-Controlled LEDs 

Software and Services-Controlled LEDs are visible on the front of a GCP 8000 Site Controller with the
service door open.
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Figure 203: GCP 8000 Site Controller – Software and Services-Controlled LEDs

GCP 8000 Site Controller Software-Controlled LEDs

NOTICE: The trunking and ZC Link LEDs are only valid if the GCP 8000 Site Controller is the
active or standby site controller in a fully Enabled state. In a Disabled or Critical Malfunction
(CR Malf) state, the LEDs are off. A site controller in one of these states does not know the
state of the site nor does it try to communicate with the zone controller.

Table 134: Trunked GCP 8000 Site Controller Software-Controlled LEDs

LED
Applica-
tion Use

Green
On

Green
Blinking

Yellow
On

Yellow
Blinking

Red Blink-
ing Red On Off

1 SC state Active Standby Disabled
(User
Req)

CR Malf (in-
cludes VV fail-
ure for SWDL)

2 RNG link Link Up Establishing
link with
RNG

CR Malf or
Disabled state,
standby, data
unconfigured

3 Trunking
State

Wide
Area

Site Off Local area
(site trunk-
ing)

Failsoft (IV&D
only)

CR Malf or dis-
abled state,
standby
Table continued…
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LED
Applica-
tion Use

Green
On

Green
Blinking

Yellow
On

Yellow
Blinking

Red Blink-
ing Red On Off

4 ZC Link Active Standby Down CR Malf or
Disabled state

Table 135: Conventional GCP 8000 Site Controller Software-Controlled LEDs

LED
Applica-
tion Use

Green
On

Green
Blinking Yellow On

Yellow
Blinking Red Blinking Red On Off

1 SC state Enabled Disabled
(User Req)

CR Malf

2 Unused Unused

3 Unused Unused

4 Unused Unused

GCP 8000 Site Controller Services-Controlled LEDs

NOTICE: The hardware controls LED 7, the Hardware Active LED. When active, it indicates
that the site controller has ownership of the site controller shared external interfaces.

Table 136: GCP 8000 Site Controller Services-Controlled LEDs

LED
Services

Use
Green

On
Green

Blinking Yellow On
Yellow

Blinking
Red

Blinking Red On Off

5 SWDL/
VLAN

Version
validation
or auto-
VLAN de-
tection

SWDL
with com-
mon VLAN

SWDL with
split VLAN

Not in SWDL
with split
VLAN

Not in SWDL
with Common
VLAN

6 Local hard-
ware failure
(all hard-
ware includ-
ing GPS)

Warning
(such as
fan un-
plugged)

Minor hard-
ware failure

Major
hardware
failure

Critical hard-
ware failure
(such as inop-
erable fans or
switch failure)

Good – no faults

7 Hardware
Active

Active Inactive

GCP 8000 Site Controller Status and Alarm LEDs

The status and alarm LED assignment for the GCP 8000 Site Controller are shown and definitions for
each status follow the assignment table.

Table 137: GCP 8000 Site Controller Status and Alarm LED Assignment

LED No Pow-
er

Lamp
Test Failure Impaired Booting

Up Online

Status LED
(green)

Off On Off On Flash On

Table continued…
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LED No Pow-
er

Lamp
Test Failure Impaired Booting

Up Online

Alarm LED (red) Off On On Flash Off Off

Table 138: GCP 8000 Site Controller Status/Alarm LEDs Definitions

Status Definitions

No Power The device is currently without power, both primary power and auxiliary power. The
No Power state tells the service technician that there is a fundamental problem.

Lamp Test The Lamp Test state is used to verify if the indicators are operational.

Booting Up The Booting Up state indicates that the device is booting or is undergoing diagnostics
and is not yet ready to place into service. Even though no failure or impairment is
identified, the device is not ready to place into service.

Online The site controller is fully operational, whether in Active or Standby mode. The Online
state is used to indicate that the site controller is fully operational. It may be in a
Standby mode or In service. The Online state indicates that the site controller should
not be removed as it is possibly involved in active calls.
The Standby mode is included in this state, it is important that a field technician should
not remove a standby site controller without first informing the system of what he is
about to do. This keeps the system from switching over to the standby site controller
as it is pulled from the frame.

Impaired The site controller is not fully operational due to internal or external causes. Some cor-
rective action must be taken to return to 100% functionality. The impaired state also
indicates that the current state does not equal the User Requested State of the site.
For example, a site in the Site Trunking state due to the diagnostic state from the Net-
work Manager has the Online state. If the site is staying out of Wide Trunking due to a
reason other than the User Requested State, such as zone controller Link failure, the
Impaired LED is lit.
The device state, Enabled/Disabled, is always User Requested. Therefore, the Im-
paired LED is not shown for this state.

Failure This status indicates a failure that is fixed only through replacement. If something oth-
er than a hardware fault is causing the state, the status is Impaired.

If both site controllers are disabled, one site controller still provides the site reference to the base
radios, so the channels can maintain failsoft functionality.

GCP 8000 Site Controller Active/Inactive Status LEDs

The four active/inactive status LEDs are found on the top of the service port area of each site controller
module. They are visible by opening the service door.

Table 139: GCP 8000 Site Controller Active/Inactive Status LEDs

Active/Inactive LEDs Description

SW Status of connection between the active site controller and the
standby site controller.

CPU Status of connection between the active CPU and the standby
site controller.

Table continued…
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Active/Inactive LEDs Description

CP2 Status of connection between the site controller and the base ra-
dio

SVC Status of connection between the site controller and the service
computer.

Table 140: GCP 8000 Site Controller Active/Inactive LEDs

Information State Link Status LED

Link Inactive Off

Link Established (assumes no activity) Green

Link Active Yellow or Amber

GCP 8000 Site Controller Link LEDs 

The Link LEDs include the LEDs associated with the service port, site controller expansion ports, Net
AUX port, and the gateway port.

Table 141: GCP 8000 Site Controller Link LEDs

LED Link Inactive Link Established (as-
sumes no activity) Link Active

Activity LED (yellow/
amber)

Off Off Yellow/Amber - con-
stant

Link LED (green) Off Green - constant Green - constant

GPB 8000 Reference Distribution Module LEDs
This information for the GPB 8000 Reference Distribution Module (RDM) covers the LED states. Green
LEDs indicate that the device is fine. Yellow warns of a potential problem that requires attention,
though not an immediate issue. Red is indicative of a problem requiring immediate attention.

LED colors and states are listed here in order of severity:

• Green - Good/Active

• Green Flashing - Good, In progress, Standby

• Yellow - Warning

• Yellow Flashing - Minor

• Red Flashing - Major Fault

• Red - Critical

GPB 8000 Reference Distribution Module Software and Services-
Controlled LEDs

The Software and Services-Controlled LEDs, visible on the front of a GPB 8000 Reference Distribution
Module (RDM) with the service door open.
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Figure 204: RDM Software and Services-Controlled LEDs

GPB 8000 Reference Distribution Module Software-Controlled LEDs

Table 142: RDM Software-Controlled LEDs

LE
D

Applica-
tion Use

Green
On

Green
Blinking

Yellow
On

Yellow
Blinking

Red
Blinking

Red
On Off

1 RDM state RDM A:
Active

RDM B:
Active

Disabled
(User
Req)

Critical
Mal-
func-
tion
(VV
failure
for
SWDL
)

2 Unused

3 Unused

4 Unused
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GPB 8000 Reference Distribution Module Services-Controlled LEDs

NOTICE: The hardware controls LED 7, the Hardware Active LED. When active, it indicates
that the GPB 8000 Reference Distribution Module (RDM) has ownership of the shared external
interfaces.

Table 143: RDM Services-Controlled LEDs

LED Services
Use

Green
On

Green
Blinking

Yellow
On

Yellow
Blinking

Red
Blink-

ing
Red On Off

5 SWDL/
VLAN

Version
validation
or auto-
VLAN de-
tection

SWDL
with
common
VLAN

SWDL
with split
VLAN

Not in
SWDL
with split
VLAN

6 Local
hard-
ware fail-
ure (all
hard-
ware in-
cluding
GPS)

Warning
(such as
fan un-
plugged)

Minor
hard-
ware fail-
ure

Major
hard-
ware
failure

Critical
hardware
failure
(such as
switch fail-
ure)

Good
– no
faults

7 Hard-
ware Ac-
tive

Active

GPB 8000 Reference Distribution Module Status and Alarm LEDs 

Definitions for each GPB 8000 Reference Distribution Module (RDM) status and alarm follow the
assignment table.

Table 144: RDM Status and Alarm LED Assignment

LED No Pow-
er

Lamp
Test Failure Impaired Booting

Up Online

Status LED (green) Off On Off On Flash On

Alarm LED (red) Off On On Flash Off Off

Table 145: RDM Status Definitions for the Status/Alarm LEDs

Status Definitions

No Power The RDM is currently without power, both primary power and auxiliary power. The No
Power state is needed to tell the service technician that there is a fundamental prob-
lem.

Lamp Test The Lamp Test state is used to verify that the indicators are operational.
Table continued…
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Status Definitions

Booting Up The Booting Up state indicates that the device is booting or is undergoing diagnostics
and is not yet ready to place into service. Even though no failure or impairment is
identified, the RDM is not ready to place into service.

Online The Online state is used to indicate that the RDM is fully operational. It may also be in
an In Service mode. The Online state indicates that the device should not be removed
as it is possibly involved in active calls.

Impaired The RDM is not fully operational due to internal or external causes. Some corrective
action must be taken to return to 100% functionality.

Failure This status indicates a failure that is fixed only through replacement. If something oth-
er than a hardware fault is causing the state, the status is Impaired.

If both RDMs are Impaired, one RDM still provides the site reference to the base radios.

GPB 8000 Reference Distribution Module Active/Inactive Status LEDs

The four active/inactive status LEDs are found on the top of the service port area of each GPB 8000
Reference Distribution Module (RDM). They are visible by opening the service door.

Table 146: RDM Active/Inactive Status LEDs

Active/Inactive LEDs Description

SW Status of connection between the RDMs.

CPU Status of connection between the active CPU and the RDMs.

CP2 Status of connection between the RDM and the base radios.

SVC Status of connection between the RDM and the service comput-
er.

Table 147: RDM Active/Inactive LEDs

Information State Link Status LED

Link Inactive Off

Link Established (assumes no activity) Green

Link Active Yellow or Amber

GPB 8000 Reference Distribution Module Link LEDs 

The Link LEDs include the LEDs associated with the service port, GPB 8000 Reference Distribution
Module (RDM) expansion ports, Net AUX port, and the Gateway port.

Table 148: RDM Link LEDs

LED Link Inactive Link Established (as-
sumes no activity) Link Active

Activity LED (yellow/
amber)

Off Off Yellow/Amber constant

Link LED (green) Off Green constant Green constant
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Expansion Hub LEDs
The LEDs on the Expansion Hub are in the front of the Expansion Hub.

Figure 205: Expansion Hub LEDs

Table 149: Expansion Hub LEDs with Description

LED Label LED Description

1 A hardware controlled green “MODE” LED. When illuminated, it indicates that
the XHub is operating in the ‘Normal’ or ‘Impaired Normal’ mode.

7 A hardware controlled green “ACTIVE” LED. When illuminated, it indicates that
the XHub has ownership of the redundant XHub shared external interfaces.

Reset Not in use.

Status LED is software-controlled when the XHub is operating in the Normal mode.
When illuminated, Green = Online.

Alarm LED is software-controlled when the XHub is operating in the Normal mode.
When illuminated, Red = Failure.

The Status and Alarm LEDs work together to indicate status on the Expansion Hub. The Impaired
State of the XHub indicates No Connection with the GCP 8000 Site Controller or GPB 8000 Reference
Distribution Module.

Table 150: Expansion Hub Status/Alarm LED Assignment

LED No Pow-
er

Lamp
Test Failure Impaired Online

Status LED (green) Off On Off On On

Alarm LED (red) Off On On Flash Off

Fan Module LED
The fan module has one Fan Alarm LED visible on the lower right corner of its front panel. The Alarm is
red during Lamp Test (for 1 second or less), and remains red if the fan failures. A fan failure alarm
occurs if the built-in speed sensor detects if either fan drops 30% below rated speed. A red Fan Alarm
indicates that the fan module must be replaced.
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Figure 206: Fan Module-Alarm LED (lower right corner)

NOTICE: The fan operates at full capability for at least seven days after the fan alarm first
occurs, allowing normal operation without requiring an immediate service call.

Hybrid Combiner Fan Module LED
Figure 207: Fan Module-Alarm LED (in the lower left corner)

The fan module has one Fan Alarm LED visible on the lower left corner of its front panel. The Alarm is
red during Lamp Test (for a second or less), and remains red if there is a fan failure. A fan failure alarm
occurs if the built-in speed sensor detects that either fan drops 30% below rated speed. A red Fan
Alarm indicates that the fan module must be replaced.

NOTICE: The GTR 8000 Expandable Site Subsystem operates at full capability for at least
seven days after the fan alarm first occurs, allowing normal operation without requiring an
immediate service call.

Power Supply LEDs
The power supply has three LEDs visible from the front panel. To interpret its condition, observe the
color of all the power supply LEDs. For example:

• If the Alarm and Fan LEDs are red and the Status LED is green, the condition is "Lamp Test"
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• If the Alarm LED is red and the Fan and Status LEDs are not lit, the condition is "Power Supply
Failure"

Figure 208: Power Supply Module

Table 151: Power Supply LEDs

Condition Fan Status Alarm

Power Off Off Off Off

Lamp Test Red Green Red

Online Off Green Off

Impaired Off Green Red (blinking)

Power Supply Failure Off Off Red

Power Supply Fan Failure Red Off Red
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RMC/LNA Alarm and Status LEDs
Figure 209: Cabinet RMC/LNA Module

Receive multicouplers/low noise amplifiers (RMCs/LNAs) have a green Status LED and red Alarm LED
next to the DIP switches. These LEDs are either off or on, depending on the condition of the module.

Table 152: RMC/LNA Module LED States

Information State Alarm LED (red) Status LED (green)

No Power Off Off

Failure On Off

Online Off On

RFDS Equipment Specifications 
This section provides specifications for all the RFDS equipment: transmit filter, diplexer, preselector
filters, cavity combiner, and receiver multicoupler / low noise amplifier.

IMPORTANT: Specifications are subject to change without notice.

GTR 8000 Expandable Site Subsystem RFDS Elevation Derating
Above 3000 meters (9800’), the peak power derating for the transmit filter and phasing harness is
1dB/1km (0.3 dB/1000ft). So at 5000 meters (16400’) full power is limited to 9-way transmitter
combining for 700/800/900 MHz or 4-way for UHF.
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Transmit Filter Specifications (700/800/900 MHz)

Table 153: Transmit Filter Specifications (700/800/900 MHz)

Tx Filter Spec Limit
(700/800/900 MHz) Typical Notes

Frequency Range 764--776 MHz,
851–870 MHz,
935–941 MHz

Insertion Loss 0.3 dB 0.15 dB

Port Return Loss 14 dB 25 dB

Rx Selectivity
(700/800 MHz)

35 dB 40 dB

Rx Selectivity
(900 MHz)

25 dB 30 dB

RMS Input Power
(700/800 MHz)

650 W

RMS Input Power
(900 MHz)

500 W

Peak Instantaneous Power
(700/800 MHz)

32k W

Peak Instantaneous Power
(900 MHz)

11k W

Passive Intermodulation –135 dBc 2 x 43 dBm

RF Connector Type 7/16 DIN female

Power Monitor Connector
Type

D-Sub 9-pin male

Forward and Reflected
Power Range

0-500 W 0-5V DC out

Transmit Filter Specifications (UHF)

Table 154: Transmit Filter Specifications (UHF)

Tx Filter Spec Limit
(UHF) Typical Notes

Frequency Range 450–453.5 MHz
451.5–455 MHz
460–463.5 MHz
461.5–465 MHz
470–472 MHz
471–473 MHz

Table continued…
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Tx Filter Spec Limit
(UHF) Typical Notes

476–478 MHz
477–479 MHz
482–484 MHz
483–485 MHz
488–490 MHz
489–491 MHz
494–496 MHz
495–497 MHz
500–502 MHz
501–503 MHz
506–508 MHz
507–509 MHz

Insertion Loss
<470 MHz
>470 MHz

0.95 dB
1.05 dB

0.5 dB
0.7 dB

Port Return Loss 15 dB 21 dB

Rx Selectivity 24 dB 26 dB

RMS Input Power 400 W

Peak Instantaneous Power 9.7 kW

Passive Intermodulation -125 dBc 2 x 43 dBm

RF Connector Type 7/16 DIN female

Power Monitor Connector
Type

D-Sub 9-pin male

Forward and Reflected
Power Range

0–400 W 0-4V DC out

Diplexer Specifications (700/800 MHz)
If 700/800 MHz channels are at the same site, a diplexer is used in place of the transmit filter and a
custom configuration is required.

Table 155: Diplexer Specifications

Diplexer Spec Limit Typical Notes

Frequency Range 764--776 MHz
851--870 MHz

Filter Insertion Loss 0.3 dB 0.15 dB

Expansion Cable
Insertion Loss

0.4 dB

Port Return Loss 14 dB 25 dB

Rx Selectivity 35 dB 40 dB
Table continued…
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Diplexer Spec Limit Typical Notes

RMS Input Power
Peak Instantaneous Power

370 W
9.0k W

Each input port

Passive Intermodulation -135 dBc 2 x 43 dBm

RF Connector Type 7/16 DIN female

Power Monitor Connector
Type

D-Sub 9–pin male

Forward and Reflected
Power Range

0–500 W 0-5V DC out

Site Preselector Filter Specifications (700/800 MHz)

Table 156: Site Preselector Filter Specifications (700/800 MHz)

Site Preselector Spec Limit
(700/800 MHz) Typical

Frequency Range 792–825 MHz

Insertion Loss 1 dB 0.6 dB

VSWR max. 1.5:1 1.3:1

Tx Selectivity 75 dB 78 dB

Test Port Coupling –30 dB

Input Connector QMA

Output Connector QMA

Test Port Connector BNC

Site Preselector Filter Specifications (UHF, 455–512 MHz)

Table 157: Site Preselector Filter Specifications (UHF 455–512 MHz)

Site Preselector Spec
Limit (UHF) Typical Notes

Frequency Range 455–458.5 MHz
456.5–460 MHz
465–468.5 MHz
466.5–470 MHz
473–475 MHz
474–476 MHz
479–481 MHz
480–482 MHz
485–487 MHz
486–488 MHz
491–493 MHz
492–494 MHz

Table continued…
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Site Preselector Spec
Limit (UHF) Typical Notes

497–499 MHz
498–500 MHz
503–505 MHz
504–506 MHz
509–511 MHz
510–512 MHz

Insertion Loss
<470 MHz
>470 MHz

2.2 dB
2.4 dB

1.5 dB
1.7 dB

Port Return Loss 15 dB 21 dB

Tx Selectivity 68 dB 71 dB at Rx ban-
dedge

Test Port Coupling –28 to –32 dB

RF Connector Type QMA female

Test Port Connector
Type

BNC female

Cavity Combiner Specifications (700/800 MHz)

Table 158: Cavity Combiner Specifications (700/800 MHz)

Combiner Spec
Limit Typical Notes

Frequency Range 764--776 MHz,
851--870 MHz

12-way expandable
12-way expandable
6-way only

Insertion Loss Over power temperature

150 kHz Tx-Tx 4.8 dB 2.5 dB 5.3 dB 12-way limit (700/800 MHz)

250 kHz Tx-Tx 4.3 dB 2.0 dB

500 kHz Tx-Tx 1.8 dB

1.0 MHz Tx-Tx 1.7 dB

3.0 MHz Tx-Tx 1.7 dB

Frequency Stability ± 40 kHz Over power temperature

RMS Input Power
(700/800 MHz)

100 W 240 W PEP Max

Tx-Tx Isolation Over power temperature

150 kHz Tx-Tx 27 dB 35 dB

250 kHz Tx-Tx 30 dB 39 dB

500 kHz Tx-Tx 44 dB
Table continued…
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Combiner Spec
Limit Typical Notes

1.0 MHz Tx-Tx 51 dB

3.0 MHz Tx-Tx 58 dB

Input Return Loss 17 dB

Output Return Loss 11 dB

Minimum Carrier Spac-
ing

150 kHz Any valid carrier on any input port

Tx Rejection in Rx
Band

40 dB 40 dB

Passive
Intermodulation

–125 dBc 2 x 43 dBm

Input Connector
Type

QN female On circulator

Output Connector
Type

7/16 DIN female On circulator

Cavity Combiner Specifications (UHF)

Table 159: Cavity Combiner Specifications (UHF)

Combiner Spec
Limit Typical Notes

Frequency Range 450–465 MHz
470–491 MHz
494–509 MHz

6–way only

Insertion Loss Over power temperature

150 kHz Tx-Tx 5.3 dB 3.8 dB

250 kHz Tx-Tx 3.2 dB

500 kHz Tx-Tx 2.8 dB

Frequency Stability ± 40 kHz Over power temperature

RMS Input Power 110 W 200 W PEP Max

Tx-Tx Isolation Over power temperature

150 kHz Tx-Tx 26 dB 35 dB

250 kHz Tx-Tx 39 dB

500 kHz Tx-Tx 44 dB

Input Return Loss
Output Return Loss

17 dB
11 dB

Minimum Channel Spacing 150 kHz Any valid carrier on any input
port

Table continued…
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Combiner Spec
Limit Typical Notes

Tx rejection in Rx
Band
<470 MHz
>470 MHz

21 dB
18 dB

24 dB
21 dB

Passive Intermodulation –125 dBc 2 x 43 dBm

Input Connector Type QN female On circulator

Output Connector Type 7/16 DIN female On circulator

Receiver Multicoupler/Low Noise Amplifier (RMC/LNA)
Specifications (700/800/900 MHz)

Table 160: Site Receiver Multicoupler/Low Noise Amplifier (RMC/LNA) Specifications (700/800/900
MHz)

Site RMC/LNA
Spec Limit

Site RMC/LNA
Typical Notes

Frequency Range 776–902 MHz

Attenuator Range 0-31 dB

Default Attenuator Setting 1 dB Factory preset

Default Gain
Primary Output
Expansion Outputs

9 dB
11.8 dB

10.5 dB
12.3 dB

Factory preset

Noise Figure
Primary Output
Expansion Outputs

2.6 dB
2.4 dB

2.0 dB
1.8 dB

Factory preset

Third Order Output Intercept
Primary Output
Expansion Outputs

23 dBm
25 dBm

Factory preset

Input Connector Type QMA

Output Connector Type
Primary Output
Expansion Outputs

QMA
BNC (3)

VSWR max 1.5:1 All ports

Table 161: Cabinet Receiver Multicoupler/Low Noise Amplifier (RMC/LNA) Specifications (700/800/900
MHz)

Cabinet
RMC/LNA Spec
Limit

Cabinet
RMC/LNA Typical Notes

Frequency Range 776–902 MHz
Table continued…
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Cabinet
RMC/LNA Spec
Limit

Cabinet
RMC/LNA Typical Notes

Attenuator Range 0-31 dB

Default Attenuator Setting
No Site RMC
With Site RMC

0 dB
10 dB

Factory preset

Default Overall Gain
No Site RMC
With Site RMC

15 dB
5 dB

16.3 dB
6.4 dB

Factory preset

Noise Figure
No Site RMC
With Site RMC

2.4 dB
4.5 dB

1.7 dB
3.7 dB

Factory preset

Third Order Output Intercept
No Site RMC
With Site RMC

29 dBm
24 dBm

Factory preset

Input Connector Type QMA

Output Connector Type Harting 6–way

VSWR max 1.5:1 1.5:1 All ports

Receiver Multicoupler/Low Noise Amplifier (RMC/LNA)
Specifications (UHF)

Table 162: Site Receiver Multicoupler/Low Noise Amplifier (RMC/LNA) Specifications (UHF)

Site RMC/LNA
Spec Limit

Site RMC/LNA
Typical Notes

Frequency Range 380–524 MHz

Attenuator Range 0-31 dB

Default Attenuator Setting 4 dB Factory preset

Default Gain
Primary Output
Expansion Outputs

11.0 dB
11.5 dB

12.4 dB
13.0 dB

Factory preset

Noise Figure
Primary Output
Expansion Outputs

2.8 dB
2.7 dB

2.1 dB
2.1 dB

Factory preset

Third Order Output Intercept
Primary Output
Expansion Outputs

28.5 dBm
29 dBm

Factory preset

Input Connector Type QMA

Output Connector Type

Table continued…
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Site RMC/LNA
Spec Limit

Site RMC/LNA
Typical Notes

Primary Output
Expansion Outputs

QMA
BNC (3)

VSWR max 1.5:1 1.5:1 All ports

Table 163: Cabinet Receiver Multicoupler/Low Noise Amplifier (RMC/LNA) Specifications (UHF)

Cabinet RMC/LNA
Spec Limit

Cabinet RMC/LNA
Typical Notes

Frequency Range 380–524 MHz

Attenuator Range 0-31 dB

Default Attenuator Setting
No Site RMC
With Site RMC

1 dB
15 dB

Factory preset

Default Overall Gain
No Site RMC
With Site RMC

14 dB
0 dB

15.4 dB
1.4 dB

Factory preset

Noise Figure
No Site RMC
With Site RMC

2.5 dB
7.0 dB

1.8 dB
6.3 dB

Factory preset

Third Order Output Intercept
No Site RMC
With Site RMC

30 dBm
19.5 dBm

Factory preset

Input Connector Type QMA

Output Connector Type Harting 6–way

VSWR max 1.5:1 1.5:1 All ports

Cabinet RMC Pass Through Module Specifications

Table 164: Cabinet RMC Pass Through Module Specifications

Cabinet RMC Pass
Through Spec Limit Typical Notes

Frequency Range 136–174 MHz
380–435 MHz

Insertion Loss

VHF: 0.5 dB 0.4 dB

UHF R1: 1.0 dB 0.9 dB

Port Return Loss 16 dB All ports

Input Connector Type BNC female

Output Connector Type Harting 6–way
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Power Monitor Unit (PMU) Specifications (UHF/VHF/900 MHz)

Table 165: PMU (UHF/VHF/900 MHz)

Power Monitor Unit
Spec Limit
(UHF/VHF/900 MHz)

Typical Notes

Operating Frequency Range 136–174 MHz
350–435 MHz
435–524 MHz
935–941 MHz

Insertion Loss Tx 0.1 dB

Port Return Loss 14 dB 22 dB

RMS Input Power

VHF 500 W

UHF 400 W

900 MHz 500 W

Peak Instantaneous Power

VHF 12kW

UHF 10kW

900 MHz 11kW

Passive Intermodulation –150 dBc 2 x 43 dBm

RF Connector Type
Power Monitor Connector
Type

7/16 DIN female
D-Sub 9–pin male

Forward and Reflected
Power Range

0–500 W 0–5 Vdc out

Hybrid Module Specifications (900 MHz)

Table 166: Hybrid Module Specifications (900 MHz)

Hybrid Module Spec Limit
(900 MHz) Typical Notes

Frequency Range 935–941 MHz

Port Return Loss 20 dB 24 dB All ports

Input Ports Isolation 20 dB 26 dB All modules

Hybrid Module, 1/2–1/2
Input 1 Insertion Loss
Input 2 Insertion Loss

3.5 dB
3.5 dB

3.2 dB
3.2 dB

Hybrid Module, 2/3–1/3

Table continued…
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Hybrid Module Spec Limit
(900 MHz) Typical Notes

Input 1 Insertion Loss
Input 2 Insertion Loss

2.2 dB
5.5 dB

1.9 dB
5.2 dB

Hybrid Module, 3/5–2/5
Input 1 Insertion Loss
Input 2 Insertion Loss

2.7 dB
4.7 dB

2.4 dB
4.4 dB

Connector Type QN female All ports

Hybrid Combiner Specifications (900 MHz)

Table 167: Hybrid Combiner Specifications (900 MHz)

Hybrid Combiner Spec Limit
(900 MHz) Typical Notes

Frequency Range 935–941 MHz

Port Return Loss 20 dB 23 dB All ports

Input Ports Isolation 20 dB 25 dB

RMS Input Power 120 W

Insertion Loss
Single 2–way
Single 3–way
Single 4–way
Single 5–way
Single 6–way

3.4 dB
5.6 dB
6.9 dB
8.3 dB
9.1 dB

3.2 dB
5.2 dB
6.5 dB
7.7 dB
8.5 dB

Dual 2-way also
Dual 3-way also

RMS Output Power
Single 2–way
Single 3–way
Single 4–way
Single 5–way
Single 6–way

37 W
22 W
17 W
12 W
10 W

44 W
28 W
21 W
16 W
13 W

Dual 2-way also
Dual 3-way also

Connector Type QN female All ports

Duplexer Specifications (900 MHz)

Table 168: Duplexer Specifications (900 MHz)

Duplexer Spec Limit
(900 MHz) Typical Notes

Rx Frequency Range
Tx Frequency Range

896–902 MHz
935–941 MHz

Rx Insertion Loss
Tx Insertion Loss

1.3 dB
1.2 dB

0.7 dB
0.6 dB

Table continued…
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Duplexer Spec Limit
(900 MHz) Typical Notes

Port Return Loss 17 dB 23 dB All ports

Rx Isolation
Tx Isolation

80 dB
65 dB

86 dB
72 dB

Ant-Tx path
Ant-Rx path

3rd Order
Intermodulation

-90 dBc Tx sub-band IM3

Max Input RMS Power
Peak Instantaneous Power

120 W
2.2kW

Rx Connector Type
Ant Tx Connector Type

QMA female
QN female
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Chapter 11

GTR 8000 Expandable Site Subsystem
Disaster Recovery
This chapter provides references and information that assist in the recovery of a GTR 8000 Base
Radio, GCP 8000 Site Controller, or GPB 8000 Reference Distribution Module in the event of a failure.

Recovering the GTR 8000 Base Radio
Process:

1 To set up the cabinet/rack, connect power, and cable the base radio, see GTR 8000
Expandable Site Subsystem Installation on page 145.

2 To replace the GTR 8000 Base Radio transceiver module, see Replacing a GTR 8000 Base
Radio Transceiver Module on page 358 and follow steps 1 through 17.

3 To replace other hardware devices, such as the power supply, power amplifier, and RFDS, see 
GTR 8000 Expandable Site Subsystem FRU Procedures on page 347

4 To perform basic device configuration and SWDL download, see Replacing a GTR 8000 Base
Radio Transceiver Module on page 358 and follow steps 18 through 30.

Recovering the GPB 8000 Reference Distribution Module
When and where to use: Perform this procedure to recover the GPB 8000 Reference Distribution
Module (RDM) in the event of failure.

Process:
1 To set up the cabinet/rack, connect power, and cable the RDM, see GTR 8000 Expandable Site

Subsystem Installation on page 145.

2 To replace the RDM, see Replacing a GPB 8000 Reference Distribution Module (RDM) on page
368 and follow steps 1 through 17.

3 To replace other hardware devices, such as the power supply, power amplifier, XHub, and
RFDS, see GTR 8000 Expandable Site Subsystem FRU Procedures on page 347.

4 To perform basic device configuration and SWDL download, see Replacing a GPB 8000
Reference Distribution Module (RDM) on page 368 and follow steps 18 through 28.

Recovering the GCP 8000 Site Controller
Process:

1 To set up the cabinet/rack, connect power, and cable the site controller, see GTR 8000
Expandable Site Subsystem Installation on page 145.

2 To replace the site controller module, see Replacing the GCP 8000 Site Controller Module on
page 364 and follow steps 1 through 15.

3 To replace other hardware devices, such as the power supply, power amplifier, XHub, and
RFDS, see GTR 8000 Expandable Site Subsystem FRU Procedures on page 347.
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4 To perform basic device configuration and SWDL download, see Replacing the GCP 8000 Site
Controller Module on page 364 and follow steps 16 through 26.

Performing a Site Download
Procedure:

1 Connect an Ethernet straight through cable between the Ethernet port on the computer and the
site controller. The laptop IP address must be set to an address on the subnet of the local site,
which varies depending on the site and zone numbers. See Connecting Through an Ethernet
Port Link on page 262.

2 Open the Software Download application.

A site software download is not available for conventional devices, GPB 8000 Reference
Distribution Modules, or Trunked 3600 devices.

CAUTION: Load the correct version of the software. There is a possibility of a mismatch
in software versions when replacing a device with an on-hand spare. If a mismatch in
software versions occurs, this mismatch may cause all base radios at the site to go into a
configuration mode of operation with a reason of 'Invalid Software Version'. To exit the
base radios out of configuration mode, see CSS Procedures > Changing from
Configuration to Normal Mode in the CSS Online Help.
If a mismatch in software versions occurs with a site controller, this mismatch may cause
a 'critical malfunction', or if it becomes active, to bring the entire site into a configuration
mode of operation.

3 Download and install the necessary software onto the site controllers and devices as follows:

a From the menu, select File → File Manager.
The Software Depot File Manager opens.

b From the menu, select Component Operations → Import Fileset.
The Import a Fileset Into the Software Depot dialog box appears.

c Click Browse and search for the swdlv3.cfg file on the CD, or follow the path E:\swdl
\swdlv1.cfg or swdlv3.cfg. Click Open.

d To add the file to the Components In the Software Depot list, click Generate. Click OK.

e Exit the Software Depot File Manager.
f From Software Download, select Action → Use DNS Server.

NOTICE: Typically, the site is part of an ASTRO® 25 system equipped with a DNS
server, and therefore the Use DNS Server setting (default setting) should be
selected. For ASTRO® 25 site upgrade scenarios when the system DNS server
cannot be reached, select Use Standard ASTRO IPs.
The Load DNS File selection should only be used in situations where a custom DNS
configuration file has been provided. Typically, this option is selected when the site IP
addresses are not configured to be part of an ASTRO® 25 system.

g From the ASTRO Site Type drop down list, select the type of site.

h Select the Zone, Site, and if applicable, the Subsite. The Subsite ID is only available when
the Site ID is between 1-64.

i Click Connect.
j If the device supports SNMPv3 protocol, a pop-up window appears with the security level

option. Choose the required security level. Click OK.
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NOTICE: Depending on the size of the system, the window takes a few minutes to
update.
If the Ethernet connection to the site uses the Site Controller Service Port, you might
need to enter an 802.1x login account to connect to the SC Service Port. An 802.1x
account is a centrally managed account.

The system connects to the specified zone and site.

k In the Operations Type, select Transfer and Install.
l In the Application Type select one of the following:

• For an HPD site: select both HPD Site Controller and HPD Base Radio.

• For a repeater site: select both Repeater Site Controller and Site Repeater.
• For a simulcast site: select Multisite Controller, Comparator, and Multisite Base

Radio.

m In the Software Component drop down list, select the version for each site device.

n Click Start Operation to download and install the software.

The site controller and base radio software are loaded and installed with the new software.

o Verify that the select devices have installed the desired version of software.

NOTICE: After installation, the new software version is present in the Running
Version column. If the new version is not present, it indicates a problem.
For more information, consult the “Fixing a Transfer Failure” section of the Software
Download manual.

In many cases, a second attempt at transferring the software corrects the failure. If further
attempts continue to fail, contact System Support.
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